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GV TX/MAM 2.7 
Quick Start Guide 
 


For more information 


1. Unpack the following items. 


 


 See the GV TX/MAM documentation on the USB stick or download the latest GV 
Edge Documentation Set from the Grass Valley website. 


GV TX/MAM items 
• Licenses 
• Dell documentation 
• Rack mount kit 
• Front 


USB stick contents: 
• GV Edge 4.2 Documentation Set 


 


 


2. Find the GV TX/MAM documentation on the USB stick or download 
the latest GV Edge Documentation Set from the Grass Valley 
website. 


3. Read the following documentation to install the GV TX/MAM 
Server: 
a. Release Notes 
b. Quick Start Guide 
c. TX/MAM Server 2.7 Service and Installation Manual 


 


¡ See the Dell documentation for safety, environmental and regulatory 
Information. 
 


 ¡ Do not use the Dell Installation Guide or DVD if provided with the product. 
Do not install an operating system. The GV TX/MAM server is pre-installed. 


¡ 
See the Dell Getting Started manual for instructions about how to 
install the systems on the rack and set them up. 


  


 


 
 


 
 



http://www.grassvalley.com/docs/Manuals/ips/gv_edge/071-8929-00_GV_Edge_4.2_Documentation_Set.pdf

http://www.grassvalley.com/docs/Manuals/ips/gv_edge/071-8929-00_GV_Edge_4.2_Documentation_Set.pdf

http://www.grassvalley.com/docs/Manuals/ips/gv_edge/071-8929-00_GV_Edge_4.2_Documentation_Set.pdf
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1 Grass Valley Product Support 
Contact information: http://www.grassvalley.com/support/contact 
U.S Technical Support: +1 800-547-4989 or +1 530 478 4148 or E-mail: Please use our online form 
All other countries Technical Support: +800 80 80 20 20 or +33 1 48 25 20 20 or E-mail: 
callcentre@grassvalley.com 
FAQ: http://grassvalley.novosolutions.net/ 
Training: https://grassvalley.csod.com/LMS/catalog/Main.aspx?tab_page_id=-67&tab_id=6 
 
 
 
END-OF-LIFE-RECYCLING-NOTICE 
 
Grass Valley’s innovation and excellence in product design also extends to the programs we’ve 
established to manage the recycling of our products. Grass Valley has developed a comprehensive 
end-of-life product take back program for recycle or disposal of end-of-life products. Our program 
meets the requirements of the European Union’s WEEE Directive, the United States Environmental 
Protection Agency, and U.S. state and local agencies. 
 
Grass Valley’s end-of-life product take back program assures proper disposal by use of Best Available 
Technology. This program accepts any Grass Valley branded equipment. Upon request, a Certificate 
of Recycling or a Certificate of Destruction, depending on the ultimate disposition of the product, can 
be sent to the requester. 
 
Grass Valley will be responsible for all costs associated with recycling and disposal, including freight. 
However, you are responsible for the removal of the equipment from your facility and packing the 
equipment to make it ready for pickup. 
 


 


For further information on the Grass Valley product take back system please 
contact Grass Valley at + 800 80 80 20 20 or +33 1 48 25 20 20 from most 
other countries. In the U.S. and Canada please call 800-547-8949, and ask to 
be connected to the EH&S Department. Additional information concerning the 
program can be found at: www.grassvalley.com/about/environmental-policy. 


 
 
 
  



https://grassvalley.csod.com/LMS/catalog/Main.aspx?tab_page_id=-67&tab_id=6
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2 Safety Summaries 
Safety Summary 
Read and follow the important safety information below, noting especially those instructions related to 
risk of fire, electric shock or injury to persons. Additional specific warnings not listed here may be found 
throughout the manual. 


 WARNING: Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any servicing other than that contained in the operating 
instructions unless you are qualified to do so. 


 
 
Safety terms and symbols 
Terms in this manual 
Safety-related statements may appear in this manual in the following form: 
 


 WARNING: Warning statements identify conditions or practices that may result in 
personal injury or loss of life. 


 CAUTION: Caution statements identify conditions or practices that may result in damage to 
equipment or other property, or which may cause equipment crucial to your business 
environment to become temporarily non-operational. 


 
 
Terms on the product 
These terms may appear on the product: 
 
DANGER — A personal injury hazard is immediately accessible as you read the marking. 
WARNING — A personal injury hazard exists but is not immediately accessible as you read the 
marking. 
CAUTION — A hazard to property, product, and other equipment is present. 
 
 
Symbols on the product 
The following symbols may appear on the product: 


  
Indicates that dangerous high voltage is present within the equipment enclosure that may be 
of sufficient magnitude to constitute a risk of electric shock. 


 Indicates that user, operator or service technician should refer to product manual(s) for 
important operating, maintenance, or service instructions. 


 This is a prompt to note fuse rating when replacing fuse(s). The fuse referenced in the text 
must be replaced with one having the ratings indicated. 


 Identifies a protective grounding terminal which must be connected to earth ground prior to 
making any other equipment connections. 


 Identifies an external protective grounding terminal which may be connected to earth ground 
as a supplement to an internal grounding terminal. 


 Indicates that static sensitive components are present which may be damaged by electrostatic 
discharge. Use anti-static procedures, equipment and surfaces during servicing. 
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Warnings 
The following warning statements identify conditions or practices that can result in personal injury or 
loss of life. 
Dangerous voltage or current may be present — Disconnect power and remove battery (if applicable) 
before removing protective panels, soldering, or replacing components. 
 
Do not service alone — Do not internally service this product unless another person capable of 
rendering first aid and resuscitation is present. 
 
Remove jewelry — Prior to servicing, remove jewelry such as rings, watches, and other metallic 
objects. 
 
Avoid exposed circuitry — Do not touch exposed connections, components or circuitry when power is 
present. 
 
Use proper power cord — Use only the power cord supplied or specified for this product. 
 
Ground product — Connect the grounding conductor of the power cord to earth ground. 
 
Operate only with covers and enclosure panels in place — Do not operate this product when 
covers or enclosure panels are removed. 
 
Use correct fuse — Use only the fuse type and rating specified for this product. 
 
Use only in dry environment — Do not operate in wet or damp conditions. 
 
Use only in non-explosive environment — Do not operate this product in an explosive atmosphere. 
 
High leakage current may be present — Earth connection of product is essential before connecting 
power. 
 
Dual power supplies may be present — Be certain to plug each power supply cord into a separate 
branch circuit employing a separate service ground. Disconnect both power supply cords prior to 
servicing. 
 
Double pole neutral fusing — Disconnect mains power prior to servicing. 
 
Use proper lift points — Do not use door latches to lift or move equipment. 
 
Avoid mechanical hazards — Allow all rotating devices to come to a stop before servicing. 
 
 
Cautions 
The following caution statements identify conditions or practices that can result in damage to 
equipment or other property 
 
Use correct power source — Do not operate this product from a power source that applies more than 
the voltage specified for the product. 
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Use correct voltage setting — If this product lacks auto-ranging power supplies, before applying 
power ensure that the each power supply is set to match the power source. 
 
Provide proper ventilation — To prevent product overheating, provide equipment ventilation in 
accordance with installation instructions. 
 
Use anti-static procedures — Static sensitive components are present which may be damaged by 
electrostatic discharge. Use anti-static procedures, equipment and surfaces during servicing. 
 
Do not operate with suspected equipment failure — If you suspect product damage or equipment 
failure, have the equipment inspected by qualified service personnel. 
 
Ensure mains disconnect — If mains switch is not provided, the power cord(s) of this equipment 
provide the means of disconnection. The socket outlet must be installed near the equipment and must 
be easily accessible. Verify that all mains power is disconnected before installing or removing power 
supplies and/or options. 
 
Route cable properly — Route power cords and other cables so that they are not likely to be damaged. 
Properly support heavy cable bundles to avoid connector damage. 
 
Use correct power supply cords — Power cords for this equipment, if provided, meet all North 
American electrical codes. Operation of this equipment at voltages exceeding 130 VAC requires power 
supply cords which comply with NEMA configurations. International power cords, if provided, have the 
approval of the country of use. 
 
Use correct replacement battery — This product may contain batteries. To reduce the risk of explosion, 
check polarity and replace only with the same or equivalent type recommended by manufacturer. 
Dispose of used batteries according to the manufacturer’s instructions. 
 
Troubleshoot only to board level — Circuit boards in this product are densely populated with surface 
mount technology (SMT) components and application specific integrated circuits (ASICS). As a result, 
circuit board repair at the component level is very difficult in the field, if not impossible. For warranty 
compliance, do not troubleshoot systems beyond the board level. 
 
 


Sicherheit – Überblick 
Lesen und befolgen Sie die wichtigen Sicherheitsinformationen dieses Abschnitts. Beachten Sie 
insbesondere die Anweisungen bezüglich 
Brand-, Stromschlag- und Verletzungsgefahren. Weitere spezifische, hier nicht aufgeführte Warnungen 
finden Sie im gesamten Handbuch. 
 


 WARNUNG: Alle Anweisungen in diesem Handbuch, die das Abnehmen der 
Geräteabdeckung oder des Gerätegehäuses erfordern, dürfen nur von qualifiziertem 
Servicepersonal ausgeführt werden. Um die Stromschlaggefahr zu verringern, führen 
Sie keine Wartungsarbeiten außer den in den Bedienungsanleitungen genannten Arbeiten 
aus, es sei denn, Sie besitzen die entsprechende Qualifikationen für diese Arbeiten. 
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Sicherheit – Begriffe und Symbole 
In diesem Handbuch verwendete Begriffe 
Sicherheitsrelevante Hinweise können in diesem Handbuch in der folgenden Form auftauchen: 
 


 WARNUNG: Warnungen weisen auf Situationen oder Vorgehensweisen hin, die 
Verletzungs- oder Lebensgefahr bergen. 
 


 VORSICHT: Vorsichtshinweise weisen auf Situationen oder Vorgehensweisen hin, die zu 
Schäden an Ausrüstungskomponenten oder anderen Gegenständen oder zum zeitweisen 
Ausfall wichtiger Komponenten in der Arbeitsumgebung führen können. 
 


Hinweise am Produkt 
Die folgenden Hinweise können sich am Produkt befinden: 
GEFAHR – Wenn Sie diesen Begriff lesen, besteht ein unmittelbares Verletzungsrisiko.  
WARNUNG – Wenn Sie diesen Begriff lesen, besteht ein mittelbares Verletzungsrisiko. 
 VORSICHT – Es besteht ein Risiko für Objekte in der Umgebung, den Mixer selbst oder andere 
Ausrüstungskomponenten. 
 
Symbole am Produkt 
Die folgenden Symbole können sich am Produkt befinden: 


  
Weist auf eine gefährliche Hochspannung im Gerätegehäuse hin, die stark genug sein kann, 
um eine Stromschlaggefahr darzustellen. 


 Weist darauf hin, dass der Benutzer, Bediener oder Servicetechniker wichtige Bedienungs-, 
Wartungs- oder Serviceanweisungen in den Produkthandbüchern lesen sollte. 


 Dies ist eine Aufforderung, beim Wechsel von Sicherungen auf deren Nennwert zu achten. Die 
im Text angegebene Sicherung muss durch eine Sicherung ersetzt werden, die die 
angegebenen Nennwerte besitzt. 


 Weist auf eine Schutzerdungsklemme hin, die mit dem Erdungskontakt verbunden werden 
muss, bevor weitere Ausrüstungskomponenten angeschlossen werden. 


 Weist auf eine externe Schutzerdungsklemme hin, die als Ergänzung zu einem internen 
Erdungskontakt an die Erde angeschlossen werden kann. 


 Weist darauf hin, dass es statisch empfindliche Komponenten gibt, die durch eine 
elektrostatische Entladung beschädigt werden können. Verwenden Sie antistatische 
Prozeduren, Ausrüstung und Oberflächen während der Wartung. 


 
 
Warnungen 
Die folgenden Warnungen weisen auf Bedingungen oder Vorgehensweisen hin, die Verletzungs- oder 
Lebensgefahr bergen: 
 
Gefährliche Spannungen oder Ströme – Schalten Sie den Strom ab, und entfernen Sie ggf. die Batterie, 
bevor sie Schutzabdeckungen abnehmen, löten oder Komponenten austauschen. 
 
Servicearbeiten nicht alleine ausführen – Führen Sie interne Servicearbeiten nur aus, wenn eine 
weitere Person anwesend ist, die erste Hilfe leisten und Wiederbelebungsmaßnahmen einleiten kann. 
 
Schmuck abnehmen – Legen Sie vor Servicearbeiten Schmuck wie Ringe, Uhren und andere 
metallische Objekte ab. 
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Keine offen liegenden Leiter berühren – Berühren Sie bei eingeschalteter Stromzufuhr keine offen 
liegenden Leitungen, Komponenten oder Schaltungen. 
 
Richtiges Netzkabel verwenden – Verwenden Sie nur das mitgelieferte Netzkabel oder ein Netzkabel, 
das den Spezifikationen für dieses Produkt entspricht. 
 
Gerät erden – Schließen Sie den Erdleiter des Netzkabels an den Erdungskontakt an. 
 
Gerät nur mit angebrachten Abdeckungen und Gehäuseseiten betreiben – Schalten Sie dieses 
Gerät nicht ein, wenn die Abdeckungen oder Gehäuseseiten entfernt wurden. 
 
Richtige Sicherung verwenden – Verwenden Sie nur Sicherungen, deren Typ und Nennwert den 
Spezifikationen für dieses Produkt entsprechen. 
 
Gerät nur in trockener Umgebung verwenden – Betreiben Sie das Gerät nicht in nassen oder 
feuchten Umgebungen. 
 
Gerät nur verwenden, wenn keine Explosionsgefahr besteht – Verwenden Sie dieses Produkt nur 
in Umgebungen, in denen keinerlei Explosionsgefahr besteht. 
 
Hohe Kriechströme – Das Gerät muss vor dem Einschalten unbedingt geerdet werden. 
 
Doppelte Spannungsversorgung kann vorhanden sein – Schließen Sie die beiden Anschlußkabel 
an getrennte Stromkreise an. Vor Servicearbeiten sind beide Anschlußkabel vom Netz zu trennen. 
 
Zweipolige, neutrale Sicherung – Schalten Sie den Netzstrom ab, bevor Sie mit den Servicearbeiten 
beginnen. 
 
Fassen Sie das Gerät beim Transport richtig an – Halten Sie das Gerät beim Transport nicht an 
Türen oder anderen beweglichen Teilen fest. 
 
Gefahr durch mechanische Teile – Warten Sie, bis der Lüfter vollständig zum Halt gekommen ist, 
bevor Sie mit den Servicearbeiten beginnen. 
 
Vorsicht 
Die folgenden Vorsichtshinweise weisen auf Bedingungen oder Vorgehensweisen hin, die zu Schäden an 
Ausrüstungskomponenten oder anderen Gegenständen führen können: 
 
Gerät nicht öffnen – Durch das unbefugte Öffnen wird die Garantie ungültig. 
 
Richtige Spannungsquelle verwenden – Betreiben Sie das Gerät nicht an einer Spannungsquelle, 
die eine höhere Spannung liefert als in den Spezifikationen für dieses Produkt angegeben. 
 
Gerät ausreichend belüften – Um eine Überhitzung des Geräts zu vermeiden, müssen die 
Ausrüstungskomponenten entsprechend den Installationsanweisungen belüftet werden. Legen Sie 
kein Papier unter das Gerät. Es könnte die Belüftung behindern. Platzieren Sie das Gerät auf einer 
ebenen Oberfläche. 
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Antistatische Vorkehrungen treffen – Es gibt statisch empfindliche Komponenten, die durch eine 
elektrostatische Entladung beschädigt werden können. Verwenden Sie antistatische Prozeduren, 
Ausrüstung und Oberflächen während der Wartung. 
 
CF-Karte nicht mit einem PC verwenden – Die CF-Karte ist speziell formatiert. Die auf der CF-Karte 
gespeicherte Software könnte gelöscht werden. 
 
Gerät nicht bei eventuellem Ausrüstungsfehler betreiben – Wenn Sie einen Produktschaden oder 
Ausrüstungsfehler vermuten, lassen Sie die Komponente von einem qualifizierten Servicetechniker 
untersuchen. 
 
 
Kabel richtig verlegen – Verlegen Sie Netzkabel und andere Kabel so, dass Sie nicht beschädigt 
werden. Stützen Sie schwere Kabelbündel ordnungsgemäß ab, damit die Anschlüsse nicht beschädigt 
werden. 
 
Richtige Netzkabel verwenden – Wenn Netzkabel mitgeliefert wurden, erfüllen diese alle nationalen 
elektrischen Normen. Der Betrieb dieses Geräts mit Spannungen über 130 V AC erfordert Netzkabel, die 
NEMA-Konfigurationen entsprechen. Wenn internationale Netzkabel mitgeliefert wurden, sind diese für 
das Verwendungsland zugelassen. 
 
Richtige Ersatzbatterie verwenden – Dieses Gerät enthält eine Batterie. Um die Explosionsgefahr zu 
verringern, prüfen Sie die Polarität und tauschen die Batterie nur gegen eine Batterie desselben Typs 
oder eines gleichwertigen, vom Hersteller empfohlenen Typs aus. Entsorgen Sie gebrauchte Batterien 
entsprechend den Anweisungen des Batterieherstellers. 
 
Das Gerät enthält keine Teile, die vom Benutzer gewartet werden können. Wenden Sie sich bei 
Problemen bitte an den nächsten Händler. 
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Consignes de sécurité 
Il est recommandé de lire, de bien comprendre et surtout de respecter les informations relatives à la 
sécurité qui sont exposées ci-après, notamment les consignes destinées à prévenir les risques 
d’incendie, les décharges électriques et les blessures aux personnes. Les avertissements 
complémentaires, qui ne sont pas nécessairement repris ci-dessous, mais présents dans toutes les 
sections du manuel, sont également à prendre en considération. 
 


 VERTISSEMENT: Toutes les instructions présentes dans ce manuel qui concernent 
l’ouverture des capots ou des logements de cet équipement sont destinées 
exclusivement à des membres qualifiés du personnel de maintenance. Afin de diminuer 
les risques de décharges électriques, ne procédez à aucune intervention d’entretien 
autre que celles contenues dans le manuel de l’utilisateur, à moins que vous ne soyez 
habilité pour le faire. 
 


Consignes et symboles de sécurité 
Termes utilisés dans ce manuel 
Les consignes de sécurité présentées dans ce manuel peuvent apparaître sous les formes suivantes: 
 


 AVERTISSEMENT: Les avertissements signalent des conditions ou des pratiques 
susceptibles d’occasionner des blessures graves, voire même fatales. 
 


 MISE EN GARDE: Les mises en garde signalent des conditions ou des pratiques 
susceptibles d’occasionner un endommagement à l’équipement ou aux installations, ou 
de rendre l’équipement temporairement non opérationnel, ce qui peut porter préjudice à 
vos activités. 
 


Signalétique apposée sur le produit 
La signalétique suivante peut être apposée sur le produit : 
DANGER — risque de danger imminent pour l’utilisateur. 
AVERTISSEMENT — Risque de danger non imminent pour l’utilisateur. 
MISE EN GARDE — Risque d’endommagement du produit, des installations ou des autres equipements. 
 
Symboles apposés sur le produit 
Les symboles suivants peut être apposés sur le produit: 


  
Signale la présence d’une tension élevée et dangereuse dans le boîtier de l’équipement ; 
cette tension peut être suffisante pour constituer un risque de décharge électrique. 


 Signale que l’utilisateur, l’opérateur ou le technicien de maintenance doit faire référence au(x) 
manuel(s) pour prendre connaissance des instructions d’utilisation, de maintenance ou 
d’entretien. 


 Il s’agit d’une invite à prendre note du calibre du fusible lors du remplacement de ce dernier. Le 
fusible auquel il est fait référence dans le texte doit être remplacé par un fusible du même 
calibre. 


 Identifie une borne de protection de mise à la masse qui doit être raccordée correctement 
avant de procéder au raccordement des autres équipements. 


 Identifie une borne de protection de mise à la masse qui peut être connectée en tant que 
borne de mise à la masse supplémentaire. 


 Signale la présence de composants sensibles à l’électricité statique et qui sont susceptibles 
d’être endommagés par une décharge électrostatique. Utilisez des procédures, des 
équipements et des surfaces antistatiques durant les interventions d’entretien. 
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Avertissements 
Les avertissements suivants signalent des conditions ou des pratiques susceptibles d’occasionner des 
blessures graves, voire même fatales: 
 
Présence possible de tensions ou de courants dangereux — Mettez hors tension, débranchez et 
retirez la pile (le cas échéant) avant de déposer les couvercles de protection, de défaire une soudure 
ou de remplacer des composants. 
 
Ne procédez pas seul à une intervention d’entretien — Ne réalisez pas une intervention d’entretien 
interne sur ce produit si une personne n’est pas présente pour fournir les premiers soins en cas 
d’accident. 
 
Retirez tous vos bijoux — Avant de procéder à une intervention d’entretien, retirez tous vos bijoux, 
notamment les bagues, la montre ou tout autre objet métallique. 
 
Évitez tout contact avec les circuits exposés — Évitez tout contact avec les connexions, les 
composants ou les circuits exposés s’ils sont sous tension. 
 
Utilisez le cordon d’alimentation approprié — Utilisez exclusivement le cordon d’alimentation fourni 
avec ce produit ou spécifié pour ce produit. 
 
Raccordez le produit à la masse — Raccordez le conducteur de masse du cordon d’alimentation à 
la borne de masse de la prise secteur. 
 
Utilisez le produit lorsque les couvercles et les capots sont en place — N’utilisez pas ce produit 
si les couvercles et les capots sont déposés. 
 
 
Utilisez le bon fusible — Utilisez exclusivement un fusible du type et du calibre spécifiés pour ce 
produit. 
 
Utilisez ce produit exclusivement dans un environnement sec — N’utilisez pas ce produit dans un 
environnement humide. 
 
Utilisez ce produit exclusivement dans un environnement non explosible — N’utilisez pas ce 
produit dans un environnement dont l’atmosphère est explosible. 
 
Présence possible de courants de fuite — Un raccordement à la masse est indispensable avant la 
mise sous tension. 
 
Deux alimentations peuvent être présentes dans l’équipement — Assurez vous que chaque 
cordon d’alimentation est raccordé à des circuits de terre séparés. Débranchez les deux cordons 
d’alimentation avant toute intervention. 
 
Fusion neutre bipolaire — Débranchez l’alimentation principale avant de procéder à une intervention 
d’entretien. 
 
Utilisez les points de levage appropriés — Ne pas utiliser les verrous de la porte pour lever ou 
déplacer l’équipement. 
 







13 
 


Évitez les dangers mécaniques — Laissez le ventilateur s’arrêter avant de procéder à une intervention 
d’entretien. 
 
 
Mises en garde 
Les mises en garde suivantes signalent les conditions et les pratiques susceptibles d’occasionner des 
endommagements à l’équipement et aux installations : 
 
N’ouvrez pas l’appareil — Toute ouverture prohibée de l’appareil aura pour effet d’annuler la garantie. 
 
Utilisez la source d’alimentation adéquate — Ne branchez pas ce produit à une source 
d’alimentation qui utilise une tension supérieure à la tension nominale spécifiée pour ce produit. 
 
Assurez une ventilation adéquate — Pour éviter toute surchauffe du produit, assurez une ventilation 
de l’équipement conformément aux instructions d’installation. Ne déposez aucun document sous 
l’appareil – ils peuvent gêner la ventilation. Placez l’appareil sur une surface plane. 
 
Utilisez des procédures antistatiques - Les composants sensibles à l’électricité statique présents 
dans l’équipement sont susceptibles d’être endommagés par une décharge électrostatique. Utilisez 
des procédures, des équipements et des surfaces antistatiques durant les interventions d’entretien. 
 
N’utilisez pas la carte CF avec un PC — La carte CF a été spécialement formatée. Le logiciel 
enregistré sur la carte CF risque d’être effacé. 
 
N’utilisez pas l’équipement si un dysfonctionnement est suspecté — Si vous suspectez un 
dysfonctionnement du produit, faites inspecter celui-ci par un membre qualifié du personnel 
d’entretien. 
 
Acheminez les câbles correctement — Acheminez les câbles d’alimentation et les autres câbles de 
manière à ce qu’ils ne risquent pas d’être endommagés. Supportez correctement les enroulements de 
câbles afin de ne pas endommager les connecteurs. 
 
Utilisez les cordons d’alimentation adéquats — Les cordons d’alimentation de cet équipement, s’ils 
sont fournis, satisfont aux exigences de toutes les réglementations régionales. L’utilisation de cet 
équipement à des tensions dépassant les 130 V en c.a. requiert des cordons d’alimentation qui 
satisfont aux exigences des configurations NEMA. Les cordons internationaux, s’ils sont fournis, ont 
reçu l’approbation du pays dans lequel l’équipement est utilisé. 
 
Utilisez une pile de remplacement adéquate — Ce produit renferme une pile. Pour réduire le risque 
d’explosion, vérifiez la polarité et ne remplacez la pile que par une pile du même type, recommandée par 
le fabricant. Mettez les piles usagées au rebut conformément aux instructions du fabricant des piles. 
 
Cette unité ne contient aucune partie qui peut faire l’objet d’un entretien par l’utilisateur. Si un 
problème survient, veuillez contacter votre distributeur local. 
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Certifications and compliances 
 
Canadian certified power cords 
Canadian approval includes the products and power cords appropriate for use in the North America 
power network. All other power cords supplied are approved for the country of use. 
 
FCC emission control 
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. Changes or modifications not 
expressly approved by Grass Valley can affect emission compliance and could void the user’s authority 
to operate this equipment. 
 
Canadian EMC Notice of Compliance  
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital 
apparatus set out in the Radio Interference Regulations of the Canadian Department of 
Communications. 
 
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables 
aux appareils numériques de la classe A préscrites dans le Règlement sur le brouillage radioélectrique 
édicté par le ministère des Communications du Canada. 
 
EN55013 1/2 Class A warning 
This product has been evaluated for Electromagnetic Compatibility under the EN 55013-1/2 standards for 
Emissions and Immunity and meets the requirements for E4 environment. 
This product complies with Class A (E4 environment). In a domestic environment this product may 
cause radio interference in which case the user may be required to take adequate measures. 
 
FCC emission limits 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesirable operation. 
 
Safety certification 
This product has been evaluated and meets the following Safety Certification Standards: 
Standard Designed/tested for compliance with: 
ANSI/UL 60950-1 
 


Safety of Information Technology Equipment, including 
Electrical Business Equipment (Second edition 2007). 


IEC 60950-1 with CB cert. Safety of Information Technology Equipment, including 
Electrical Business Equipment (Second edition, 2005). 
 


CAN/CSA C22.2 No. 60950-1 Safety of Information Technology Equipment, including 
Electrical Business Equipment (Second edition 2007). 


BS EN 60950-1 Safety of Information Technology Equipment, including 
Electrical Business Equipment 2006. 
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ESD Protection 
Electronics today are more susceptible to electrostatic discharge (ESD) damage than older equipment. 
Damage to equipment can occur by ESD fields that are smaller than you can feel. Implementing the 
information in this section will help you protect the investment that you have made in purchasing Grass 
Valley equipment. This section contains Grass Valley’s recommended ESD guidelines that should be 
followed when handling electrostatic discharge sensitive (ESDS) items. These minimal 
recommendations are based on the information in the Sources of ESD and Risks area. The 
information in Grounding Requirements for Personnel is provided to assist you in selecting an 
appropriate grounding method. 
 
Recommended ESD Guidelines 
Follow these guidelines when handling Grass Valley equipment: 


• Only trained personnel that are connected to a grounding system should handle ESDS items. 
• Do not open any protective bag, box, or special shipping packaging until you have been 


grounded. 
NOTE: When a Personal Grounding strap is unavailable, as an absolute minimum, 
touch a metal object that is touching the floor (for example, a table, frame, or rack) to 
discharge any static energy before touching an ESDS item. 


• Open the anti-static packaging by slitting any existing adhesive tapes. Do not tear the tapes 
off. 


• Remove the ESDS item by holding it by its edges or by a metal panel. 
• Do not touch the components of an ESDS item unless it is absolutely necessary to configure 


or repair the item. 
• Keep the ESDS work area clear of all nonessential items such as coffee cups, pens, wrappers 


and personal items as these items can discharge static. If you need to set an ESDS item 
down, place it on an anti-static mat or on the anti-static packaging. 


 
 
Sources of ESD and Risks 
The following information identifies possible sources of electrostatic discharge and can be used to help 
establish an ESD policy. 
 
Personnel 
One of the largest sources of static is personnel. The static can be released from a person’s clothing 
and shoes. 
 
Environment 
The environment includes the humidity and floors in a work area. The humidity level must be controlled 
and should not be allowed to fluctuate over a broad range. Relative humidity (RH) is a major part in 
determining the level of static that is being generated. For example, at 10% - 20% RH a person walking 
across a carpeted floor can develop 35kV; yet when the relative humidity is increased to 70% - 80%, 
the person can only generate 1.5kV. 
Static is generated as personnel move (or as equipment is moved) across a floor’s surface. Carpeted 
and waxed vinyl floors contribute to static build up. 
 
Work Surfaces 
Painted or vinyl-covered tables, chairs, conveyor belts, racks, carts, anodized surfaces, plexiglass 
covers, and shelving are all static generators. 
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Equipment 
Any equipment commonly found in an ESD work area, such as solder guns, heat guns, blowers, etc., 
should be grounded. 
 
Materials 
Plastic work holders, foam, plastic tote boxes, pens, packaging containers and other items commonly 
found at workstations can generate static electricity. 
 
Grounding Requirements for Personnel 
The information in this section is provided to assist you in selecting a grounding method. This 
information is taken from ANSI/ESD S20.20-2007 (Revision of ANSI/ESD S20.20-1999). 
 
Product Qualification 
Personnel Grounding 
Technical Requirement 
 


Test Method 
 


Required Limits 


Wrist Strap System* 
 


ANSI/ESD S1.1 (Section 5.11) < 3.5 x 107 ohm 
 


Flooring / Footwear System – 
Method 1 
 


ANSI/ESD STM97.1 < 3.5 x 107 ohm 


Flooring / Footwear System – 
Method 2 (both required) 
 


ANSI/ESD STM97. 
1ANSI/ESD STM97.2 
 


< 109 ohm 
 


ANSI/ESD STM97.2 < 100 V 
 


 
Product qualification is normally conducted during the initial selection of ESD control products and 
materials. Any of the following methods can be used: product specification review, independent 
laboratory evaluation, or internal laboratory evaluation. 
 
 
Compliance Verification 
Personnel Grounding 
Technical Requirement 
 


Test Method 
 


Required Limits 


Wrist Strap System* 
 


ESD TR53 Wrist Strap Section 
 


< 3.5 x 107 ohm 
 


Flooring / Footwear System – 
Method 1 
 


ESD TR53 Flooring Section and 
ESD TR53 Footwear Section 


< 3.5 x 107 ohm 


Flooring / Footwear System – 
Method 2 (both required) 
 


ESD TR53 Flooring Section and 
ESD TR53 Footwear Section 


< 1.0 x 109 ohm 
 


 
* For situations where an ESD garment is used as part of the wrist strap grounding path, the total 
system resistance, including the person, garment, and grounding cord, must be less than 3.5 x 
107ohm.  
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3 About this document 
This document applies to the GV Edge release 4.2.1. This manual describes following topics: 


• server installation 
• initial setup  
• service instructions 


 


 The GV Edge Integrated Playout System Commissioning Manual describes how to commission a 
Channel. 
 
 


4 Shipping kit contents 
The shipping kit contains: 


• GV Edge server 
• USB-stick with documentation 
• If applicable: software dongle 
• Licenses and warranties 


 
 


5 Credentials 
The default credentials for the GV Edge are: 
 
The IP Manager: 
User: admin 
Password: proot123 
 
Accessing the system via command line: 
User: root 
Password: proot123 
 
 


6 Site preparation  
6.1 Physical Specifications 


Size (WxHxD) 436 x 44x620mm/17.2"x 1.7"x 24.4"  (excl. connectors & front panel) 


 
6.2 Environmental Requirements 


Operating environment 10˚C to 25˚C / 32˚F to 86˚F 


Relative humidity 10% to 90% non-condensing 


 


 
CAUTION: Wait until the server has acclimatized to server room temperature and 
humidity before power on.  
 


6.3 Cable advice 
For HD-environments: use CAT 6/ CAT 6e cables and compatible connectors. 
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7 GV Edge Front Panel 
 


 
GV Edge front panel with LCD-panel (IP Manager). 
 
 


8 GV Edge Back Panel (connectors) 


 
GV Edge back panel. 
 


 


  


Connectors 


IPM IP Manager 


M Mouse (not connected) 


KBD Keyboard 


USB USB 


COM Serial COM 


VGA VGA 


eth0-3 eth0-3 


LTC LTC 


GPIo GPIo (open collector) 


AC Power supplies 


GL blackburst/trilevel sync 


IO1-IO8 SDI IOs.  
Presets are defined for port configuration. 
Bypass can be enabled on IO1 (in) and IO2 (out). 
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9 Indicators and status information 
9.1 Power supply indicator 


green ON 


red Failure 


LED off Standby 


 
9.2 IP Manager connection indicator 


Left LED 


yellow (blink) System online 
 


Right LED 


green Speed 100 Mbps 
 
9.3 LAN connection indicator 


Left LED 


green (blink) System online 
 


Right LED 


green Speed 100 Mbps 


orange Speed 1 Gbps 
 
9.4 LEDs (hard disks)  


Top LED (activity) 


green  Indicates read/write actions on the disk. 
 
 


Bottom  LED 


green Hard disk OK. 


red (blink) Hard disk not in RAID and probably broken. 


orange (blink) Hard disk will fail soon. 


blue (blink) No hard disk detected. 


blue  Hard disk seems slower than usual. 


green (pulse) Hard disk is being added to the RAID (RAID rebuild). 
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10 The IP Manager: introduction  
The IP Manager enables remote server configuration, monitoring and administration.  The IP Manager 
is accessible via web, or via the LCD-panel on the front of the server. Two menus are available: 


• the GV Edge-menu: standard menu 


• the IP Manager menu: also available when the system is unreachable (note that this menu 


has less options) 


If the system is unreachable, press the knob for 3 seconds to switch from the GV Edge menu to the IP 
Manager menu. 
 


 
Changing settings and executing commands via the IP Manager can interrupt a broadcast. 
 
 
10.1 Starting the IP Manager web interface 


To access the IP Manager, enter the IP Manager's IP-address in a web browser and log in with the 
credentials for the IP Manager.  


 
10.2 The LCD front panel 


Use the rotary knob to operate the IP Manager via the front panel: 
 


• Turn the rotary knob backwards and forwards to scroll through 


options. 


• Press the rotary knob to select an item. Selected items are marked by 


[], <>, an arrow, or are highlighted. 


 


 
To confirm changes, rotate the knob to the OK option, and then press the knob. 
Some changes in Channel settings require a restart of the nexos processes: 
select OK to set changes and then Activate settings to activate changes. Note 
that you may have to scroll to this option.  
To discard changes, return to the main menu from a sub menu or rotate the 
knob to the back/cancel/discard option, and then press the knob. 
 
 
 


 


GV Edge with IP Manager LCD-panel and knob. 
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10.3 Starting the IP Manager web interface 
To access the IP Manager, enter the IP Manager's IP-address in a web browser and log in.  
 


 
 
Example IP Manager menu. The system’s hostname is shown in the upper right corner and on the 
web page’s tab. The highlighted menu item shows where you are in the navigation tree. 
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11 Server installation and initial setup 


 The steps for installation and network configuration of the GV Edge nodes are: 
1) Place the servers in the rack and connect cables and IOs. 


2) Configure the IP Manager. 


3) Configure the GV Edge network settings via the IP Manager web interface. 


4) Select a preset for Channel configuration. 


5) If applicable, configure time settings. 


6) If applicable, configure licenses. 


 
11.1 Connecting the server to the LAN and connecting the IP Manager 
Following cables must be connected: 
 


Network cable LAN Connect to  eth0 


Network cable for the IP Manager Connect to IPM 
 
 
 
11.2 Connecting the IOs 


IO1-IO8 
Note that presets are defined for port configuration [see chapter 
12].  Bypass can be enabled on IO1 (in) and IO2 (out). 
 


 
 
11.3 Connecting the VGA-monitor (optional) 


VGA-monitor (console) Connect to VGA  


Keyboard (console) Connect to KBD 
 
 
 
11.4 Connecting blackburst, GPIO and LTC (optional) 


Blackburst Connect to GL 


GPIo Connect to  GPIo [see the appendix for pinning] 


LTC Connect to LTC [see the appendix for pinning] 
 
 
11.5 Connecting the power cables and power on 


Power cables (redundant) Connect the ACs 


GV Edge automatically powers on when connected to a power source. To power on manually, press 
the rotary knob. When powered on, the LCD panel illuminates. 
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11.6 Configuring the IP Manager 
After power on and startup, first configure the IP Manager via the GV Edge's LCD-panel:  


 Go to Network configuration > IP-manager. 
 Specify: 


• Use DHCP: On/Off  
• IP-address: note that the IP Manager has its own IP-address.  
• Netmask 
• Gateway 
• Nameserver 


 
 Select Set/OK to save changes. 


You can now access the IP Manager via a web browser. 


 
11.7 Configuring the GV Edge hostname and network settings 
Once you configured the IP Manager web interface, you can continue configuration of the GV Edge 
via the IP Manager web interface: enter the IP Manager's IP-address in a web browser and log in with 
your IP Manager credentials. 


To specify a hostname: 


 Go to Network configuration > Hostname 


 Specify the GV Edge hostname. 
 Click Set to save changes. 


 
To configure the GV Edge’s network settings: 
 
 Go to Network configuration > GVEdge. 


 Specify network settings for the GV Edge server.  


• Default port 0 is used: 


 Method: Auto, using DHCP/Manual or Manual 


 IP-Address 
 Netmask 
 The system’s MAC address is displayed. 


 Gateway 
 Nameserver 


 


 Click Set to save changes. 


11.8 Specifying the TX/MAM database IP-address 
Specify the TX/MAM servers’ virtual IP-address: 
 
 Go to Network configuration > TX/MAM server virtual IP. 


 Click Set to save changes. 
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12 Channel Presets 
12.1 Introduction 
De GV Edge contains 8 bidirectional SDI-ports. A number of presets have been defined for the GV 
Edge. These presets can be selected via the IP Manager. 


Possible Channel configurations on a single GV Edge server: 
Single  Simulcast  Preview  Preset 
HD or SD - - hd1/hd2/sd1/sd2 
HD  - Preview hdpr1/hdpr2 
SD  Preview sdpr1/sdpr2 
HD SD - sim1 
 


 
Note that available options depend on licenses purchased. 
 
 
Single Channel SD 


• Preset 1 


o Channel Single Inputs: IO1(SD),IO3(SD),IO5(SD),IO6(SD) 


o Channel Single Outputs: IO2(SD),IO4(SD),IO7(SD), IO8(SD) 


• Preset 2 


o Channel Single Inputs: IO1(SD),IO3(SD),IO5(HD),IO6(HD) 


o Channel Single Outputs: IO2(SD),IO4(SD),IO7(SD),IO8(SD) 


Single Channel HD 


• Preset 1 


o Channel Single Inputs: IO1(HD),IO3(HD),IO5(HD),IO6(HD) 


o Channel Single Outputs: IO2(HD),IO4(HD),IO7(HD),IO8(HD) 


• Preset 2 


o Channel Single Inputs: IO1(HD),IO3(HD),IO5(SD),IO6(SD) 


o Channel Single Outputs: IO2(HD),IO4(HD),IO7(HD),IO8(HD) 


Single Channel SD + Preview 


• Preset 1 


o Channel Single Inputs: IO1(SD), IO3(SD), IO4(SD) 


o Channel Single Output: IO2(SD), IO5(SD), IO6(SD) 


o Preview Channel Input: IO7(HD) 


o Preview Channel Output: IO8(HD) 
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• Preset 2 


o Channel Single Inputs: IO1(SD), IO3(HD), IO4(HD) 


o Channel Single Output: IO2(SD), IO5(SD), IO6(SD) 


o Preview Channel Input: IO7(HD) 


o Preview Channel Output: IO8(HD) 


 
Single Channel HD + Preview 


• Preset 1 


o Channel Single Inputs: IO1(HD), IO3(HD), IO4(HD) 


o Channel Single Output: IO2(HD), IO5(HD), IO6(HD) 


o Preview Channel Input: IO7(HD) 


o Preview Channel Output: IO8(HD) 


• Preset 2 


o Channel Single Inputs: IO1(HD), IO3(SD), IO4(SD) 


o Channel Single Output: IO2(HD), IO5(HD), IO6(HD) 


o Preview Channel Input: IO7(HD) 


o Preview Channel Output: IO8(HD) 


 
Simulcast 


 Preset 1 


o Channel HD Inputs: IO1(HD), IO3(HD) 


o Channel HD Output: IO2(HD), IO4(HD) 


o Channel SD Input: IO5(SD), IO6(SD) 


o Channel SD Output: IO7(SD), IO8(SD) 


2x SD 


 Preset 1 


o Channel 1 SD Inputs: IO1(SD), 3(SD) 


o Channel 1 SD Output: IO2(SD), 4(SD) 


o Channel 2 SD Inputs: IO5(SD), 7(SD)  


o Channel 2 SD Output: IO6(SD), 8(SD 


 







26 
 


3x SD 


 Preset 1 


o Channel 1 SD Inputs: IO1(SD) 


o Channel 1 SD Output: IO2(SD) 


o Channel 2 SD Inputs: IO3(SD)  


o Channel 2 SD Inputs: IO4(SD)  


o Channel 3 SD Inputs: IO5(SD) 


o Channel 3 SD Output: IO6(SD), 6(SD) 


 


Customized Preset 
Not covered in this manual. 
 


On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD content 
containing a maximum bitrate of 25000 Kbit/s. 
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12.2 Configuring GV Edge Channels and ports 
 
 Open the IP Manager via the web interface and log in with your IP Manager credentials. 


 To select a preset, go to Channel Configuration > Channel layout. 


• Audio Channel Routing 1: Decoded Dolby E audio routing for channel 1 
• Audio Channel Routing 2: Decoded Dolby E audio routing for channel 2 
• Audio Channel Routing 3: Decoded Dolby E audio routing for channel 3 
• Video Bypass: enable (activate) or disable the bypass  
• Channel layout: select one of the following presets: 


o  1xSD (1) : single SD (with preset 1) 
o  1xSD (2) : single SD (with preset 2) 
o  1xHD (1) : single HD (with preset 1) 
o  1xHD (2) : single HD (with preset 2) 
o  1xSD+preview (1) : single SD + preview (preset 1) 
o  1xSD+preview (2) : single SD + preview (preset 2) 
o  1xHD+preview (1) : single HD + preview (preset 1) 
o  1xHD+preview (2) : single HD + preview (preset 2) 
o  2x SD 
o  3x SD 
o  Simulcast 
o  Custom setup 


• Region: select PAL or NTSC 
• HD-format: for HD-channels, select 720p or 1080i 
• Genlock: select Blackburst or Trilevel sync 
• Audio channels: specify audio groups per SDIO 


o SDIO1-8:  
 Single audio group 
 Two audio groups 
 Three audio groups 
 Four audio groups 


• SDI port misc:  
o SDIO in 


 VBI: Enabled/Disabled 
 HBI: Enabled/Disabled 


o SDIO out 
 Key/Fill 


• Enable recording channel: enable or disable the recording channel: On/Off 
• Enable JIP channel: enable or disable the JIP channel: On/Off 
• Delay: not used for the GV Edge, only for VDS (Video Delay Server) 
• GPIO: configure one or multiple GPIO services 
• TS-over-IP 1: Configure TS-over-IP for channel 1 
• TS-over-IP 2: Configure TS-over-IP for channel 2 
• TS-over-IP 3: Configure TS-over-IP for channel 3 
• Watermarking 1: Configure audio watermarking for channel 1 
• Watermarking 2: Configure audio watermarking for channel 2 
• Watermarking 3: Configure audio watermarking for channel 2 
• Time Settings 
• Click Set to save changes, then Activate to activate changes. 
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On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD 
content containing a maximum bitrate of 25000 Kbit/s. 


 
 


12.3 Time settings 
 Go to System configuration > Time settings: set the system date and time. 


o Current date: yyyy-mm-dd 


o Current time: hh:mm 


 Click Set to save changes.  
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13 Service Instructions 


 
WARNING: When working with the server’s internal components, make sure to avoid 
electrostatic discharge. Shutdown the GV Edge via the IP Manager web interface or front 
panel and remove the mains plug to avoid electric shock. 


13.1 Server Power  


13.1.1 Powering on the Server  
GV Edge automatically powers on when connected to a power source. To power on manually, press 
the rotary knob on the front panel. 
 
When powered on, the LCD panel illuminates. When system start has completed, color bars are 
visible on the SDI (video) output screen. 
 


13.1.2 Powering off the Server (shutdown) 


 CAUTION: Always use the IP manager option Shutdown (includes halt) or halt the server 
from the command line before power off to avoid data loss or corruption. 
A forced power-off or reset can lead to data loss or corruption. 


To power off the GV Edge: 
 Shutdown the GV Edge via the IP Manager web interface or front panel. 
 
When powered off, the LCD panel turns off. 
 
In emergency cases following IP Manager options can be used: 


• Forced power-off: forced hardware power down (no software halt, for emergency use only)  
• Forced reset: forced hardware reset (no software halt, for emergency use only)  
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13.2 Replacing the front bezel 


 
CAUTION: To avoid electrostatic discharge, make sure that you are properly grounded. 
You do not have to halt or power off the GV Edge when replacing a single power supply. 
Hard disks are hot swappable and redundant.  
 
WARNING: Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any servicing other than that contained in the operating 
instructions unless you are qualified to do so. 
 


 Unfasten the thumb screws from the unit. 


 


 
 Carefully slide out the bezel and disconnect the display cable. Pull the display cable from 


the connector and not from the wire. A small flat screw driver can be used to push the 
connector’s tabs out. 


 
 


 
 


  







31 
 


 
 Remove the bezel from the unit by lifting up the hinges on the side. 
 Remove the two hinges from the sides of the bezel by unfastening the screws. 


 


 


 
 Fasten the hinges to the new bezel (FRU 761051600) using a torque of 6 to 8 kgfcm (5.2 


to 6.9 lbs). 
 Insert the front assembly replacement in the GV-Edge unit and reconnect the display 


cable. 
 


 
 Make sure the bezel is flushed and aligned with the frame. 
 Fasten the thumb screws. 
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13.3 Replacing a hard disk 


 
CAUTION: To avoid electrostatic discharge, make sure that you are properly grounded. 
You do not have to halt or power off the GV Edge when replacing a single power supply. 
Hard disks are hot swappable and redundant.  
 
WARNING: Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any servicing other than that contained in the operating 
instructions unless you are qualified to do so. 
 


 
Hard disks are hot swappable. You do not have to halt and shut down the GV Edge when 
replacing a single disk. 


The disk/HDD physical positions on the GV Edge are: 
 
HDD 1 HDD 3 HDD 5  
HDD 0 HDD 2 HDD 4 


 
To replace a hard disk: 


 Open the front panel. 
 Push the red button on front of the disk to the right. 


 
 Slide the disk out from its bay and remove from the server.  


 
 


 
 
 Slide the replacing hard disk into its bay. The hard drive automatically engages with its 


connector. 
 Close the front panel. 
 


 
To rebuild the disk, contact Support.  
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13.4 Replacing a redundant power supply module 


 
CAUTION: To avoid electrostatic discharge, make sure that you are properly grounded. 
You do not have to halt or power off the GV Edge when replacing a single power supply. 
Hard disks are hot swappable and redundant.  
 
WARNING: Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any servicing other than that contained in the operating 
instructions unless you are qualified to do so. 
 


To replace a power supply: 
 


 Open the front panel. 
 Pull the level to the left and keep in this position while pulling the power supply forward to 


remove from the server. 
 Slide the replacing power supply in its bay and close the front panel. 
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14 Appendix: The IP Manager Quick Reference 
The IP Manager enables remote server configuration, monitoring and administration.  The IP Manager 
is accessible via web, or via the LCD-panel on the front of the server. Two menus are available: 


• the GV Edge-menu: standard menu 


• the IP Manager menu: also available when the system is unreachable (note that this menu 


has less options) 


If the system is unreachable, press the knob for 3 seconds to switch from the GV Edge menu to the IP 
Manager menu. 
 


 
Changing settings and executing commands via the IP Manager can interrupt a broadcast. 
 
 
14.1 Starting the IP Manager web interface 


To access the IP Manager, enter the IP Manager's IP-address in a web browser and log in with the 
credentials for the IP Manager.  


 
14.2 The LCD front panel 


Use the rotary knob to operate the IP Manager via the front panel: 
 


• Turn the rotary knob backwards and forwards to scroll through 


options. 


• Press the rotary knob to select an item. Selected items are marked by 


[], <>, an arrow, or are highlighted. 


 


 
To confirm changes, rotate the knob to the OK option, and then press the knob. 
Some changes in Channel settings require a restart of the nexos processes: 
select OK to set changes and then Activate settings to activate changes. Note 
that you may have to scroll to this option.  
To discard changes, return to the main menu from a sub menu or rotate the 
knob to the back/cancel/discard option, and then press the knob. 
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14.3 The IP Manager menu 


 
Example IP Manager menu via the web browser. The system’s hostname is shown in the upper right 
corner and on the web page’s tab. The highlighted menu item shows where you are in the navigation 
tree. 
 


 
To confirm changes, click Set. 
Some changes in Channel settings require a restart of the nexos processes: select OK to set changes 
and then Activate to activate changes. 
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14.4 System configuration > Network configuration 


• Hostname: the GV Edge hostname 
 


• IP-manager: specify network settings for the IP Manager. Note that the IP Manager has its own 
IP-address. 


• Use DHCP: On/Off  
• IP-address  
• Netmask 
• Gateway 
• Nameserver 


 
• GVEdge: specify network settings for the GV Edge server 


• Network port <nr> 
 Method: Auto, using DHCP/Manual or Manual 
 IP-Address 
 Netmask 
 The system’s MAC address is displayed. 


• Gateway 
• Nameserver 


 
• TX/MAM server virtual IP: the TX/MAM servers’ virtual IP-address 


 
 


14.5 System configuration > Channel configuration 


• Audio Channel Routing 1: Decoded Dolby E audio routing for channel 1 
• Audio Channel Routing 2: Decoded Dolby E audio routing for channel 2 
• Audio Channel Routing 3: Decoded Dolby E audio routing for channel 3 
• Video Bypass: enable (activate) or disable the bypass  


 
• Channel layout: select one of the following presets: 


•  1xSD (1) : single SD (with preset 1) 
•  1xSD (2) : single SD (with preset 2) 
•  1xHD (1) : single HD (with preset 1) 
•  1xHD (2) : single HD (with preset 2) 
•  1xSD+preview (1) : single SD + preview (preset 1) 
•  1xSD+preview (2) : single SD + preview (preset 2) 
•  1xHD+preview (1) : single HD + preview (preset 1) 
•  1xHD+preview (2) : single HD + preview (preset 2) 
• Simulcast 
• 2xSD 
• 3xSD 
•  Custom setup 


 


 



http://10.250.51.129/?path=0:

http://10.250.51.129/?path=0:
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• Region: select PAL or NTSC 
 
 


• HD-format: for HD-channels, select 720p or 1080i 
 
 


• Genlock: select Blackburst or Trilevel sync 
 
 


• Audio channels: specify audio groups per SDIO 
• SDIO1-8:  


 Single audio group 
 Two audio groups 
 Three audio groups 
 Four audio groups 


 


• SDI port misc 
• SDIO in 


 VBI: Enabled/Disabled 
 HBI: Enabled/Disabled 


 
 


• SDIO out 
 Key/Fill 


 
• Enable recording channel: enable or disable the recording channel: On/Off 
• Enable JIP channel: enable or disable the JIP channel: On/Off 
• GPIO: configure one or multiple GPIO services 


• TS-over-IP 1: Configure TS-over-IP for channel 1 


• TS-over-IP 2: Configure TS-over-IP for channel 2 


• TS-over-IP 3: Configure TS-over-IP for channel 3 


• Watermarking 1: Configure audio watermarking for channel 1 


• Watermarking 2: Configure audio watermarking for channel 2 


• Watermarking 3: Configure audio watermarking for channel 3 


• Time Settings 


• Delay: not used for the GV Edge, only for VDS (Video Delay Server) 


 
On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD content 
containing a maximum bitrate of 25000 Kbit/s 
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14.6 System configuration > Time settings  


Set the system date and time. 
• Current date: yyyy-mm-dd 
• Current time: hh:mm 


 


 


14.7 System monitoring > SNMP monitoring 
• SNMP monitoring:  


• Enable SNMP: On / Off 
• RO community 
• RW community 
• Enable SNMP traps: On / Off 
• Trap IP: IP number where to the trap needs to be send 
• Trap community: trap community name 
• Trap re-send interval (minutes) 
• MIB type:   


 GVEdge MIB   
 Legacy MIB 


 
14.8 System monitoring > System info 


• System info: 
• RAID partition free space (K) 
• Memory installed (MB) 
• CPU usage (percentage) 
• Non-running programs 
• Serial number and system installer version 
• PSU status 
• GPU Temperature (Celsius) 
• HD raid status 
• HD SMART status 
• HD temperature (Celsius) 
• Fans (speed in rotations per minute) 


 


14.9 System monitoring > UDP Monitoring 


• UDP Monitoring: use this option to monitor Channel 0 (the single HD or SD Channel, or the HD 
Channel in a simulcast setup) via IP. When enabled, a MPEG- transport stream with encoded 
video, graphics, subtitles and audio (first stereo track) is sent over Ethernet using the UDP-
protocol. A video player such as VLC is installed on a workstation to view output. 


  
The UDP-monitoring option is described in more detail in the GV Edge User Manual. 
 


• Resolution: 320x240/ 240x180/ 160x120 
• Aspect Ratio: 4:3/ 16:9 
• Video Bitrate: in kbit/s 



http://10.250.51.129/?path=0:

http://10.250.51.129/?path=1:

http://10.250.51.129/?path=1:
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• Audio Enabled: On/Off  
• Audio Bitrate: in kbit/s 
• Ethernet Output: select On to enable monitoring and start streaming, Off to disable. 
• IP-address: IP-address of the target workstation (can be a multicast address) 
• IP-port: port the player will listen to. Default 4000  


 


14.10 System administration 


• Server start/stop 
• Reboot 
• shutdown 
• Forced power off: only use when a shutdown is not possible. 
• Forced reset: only use when a Reboot is not possible. 


 
• Manage services 


Services are: 
• assetsync 
• database 
• dataserver 
• encoderd 
• firebird 
• nexos 
• playout_distri 
• pt_guard 
• schedulesync0 
• sequencer0 
• txsettings 


 
Options for each service are: 


• View the service’s version and status. 
• Start the service. 
• Stop the service. 
• Restart the service. 


 
  



http://10.250.51.129/?path=2:
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15 Appendix: Time Settings 
Preferably a LTC-signal (Linear Timecode) is used to synchronize time codes. If this is not possible, 
other options are:  


• NTP sync (Network Time Protocol) to a NTP- server. 


• Free running (system  uses an internal clock) 


 


Setting up NTP: 


Edit /system/objects/code/setdate 
 


• NTPSERVER: specify the NTP-server's IP-address  


• ZONE: specify time zone [see options below], the ZONE-setting determines offset relative to 
CET/GMT. 
 


To test settings, from Linux command line enter:  
/system/objects/code]# setdate -ntp [enter] 
 
If settings are incorrect, an error message will be displayed. 


To ensure that time is regularly synced, edit /etc/crontab. Remove the "#" in front of the line: 


#00 * * * * root /system/objects/code/setdate -ntp >/dev/null 2>&1 
 


Result: 


00 * * * * root /system/objects/code/setdate -ntp >/dev/null 2>&1 
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Configuring time manually:  


 To set the date, log in via putty (ssh) as user root. 


 Go to the /system/objects/code folder: 


 ...code]#  cd /system/objects/code [enter] 


 Execute script setdate, use the –help option for an explanation: 
...code]# ./setdate –help [enter] 


Example:  


...code]# ./setdate -m 07/29/08 11:37:47 [enter] 


Explanation: 


-m = manual 


07 = month 


29 = day of month 


08 = year 


11 = hours 


37 = minutes 


47 = seconds 
 


Requesting the NTP date and time: 


To request the date from the NTP server configured in setdate: 


 ...code]# ./setdate -ntp [enter] 
 


ZONE options are listed on the next pages. 


 
Notes: 


• Options listed below are case sensitive.  


• Insert a “/” sign behind continent names.  


• Place ZONE names between quotes. 


 


Example: “Europe/Amsterdam” 
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CET 
CST6CDT 
Cuba 
EET 
EST 
EST5EDT 
Egypt 
Eire 
Factory 
GB 
GB-Eire 
GMT 
GMT+0 
GMT-0 
GMT0 
Greenwich 
HST 
Hongkong 
Iceland 
Iran 
Israel 
Jamaica 
Japan 
Kwajalein 
Libya 
MET 
MST 
MST7MDT 
NZ 
NZ-CHAT 
Navajo 
PRC 
PST8PDT 
Poland 
Portugal 
ROK 
Singapore 
Turkey 
UCT 
UTC 
Universal 
W-SU 
WET 
Zulu 
iso3166.tab 
posixrules 
zone.tab 
 
Africa/ 
Abidjan 
Accra 
Addis_Ababa 
Algiers 
Asmara 
Asmera 
Bamako 
Bangui 
Banjul 
Bissau 
Blantyre 
Brazzaville 
Bujumbura 
Cairo 
Casablanca 
Ceuta 
Conakry 
Dakar 
Dar_es_Salaam 
Djibouti 
Douala 
El_Aaiun 
Freetown 
Gaborone 
Harare 
Johannesburg 


Kampala 
Khartoum 
Kigali 
Kinshasa 
Lagos 
Libreville 
Lome 
Luanda 
Lubumbashi 
Lusaka 
Malabo 
Maputo 
Maseru 
Mbabane 
Mogadishu 
Monrovia 
Nairobi 
Ndjamena 
Niamey 
Nouakchott 
Ouagadougou 
Porto-Novo 
Sao_Tome 
Timbuktu 
Tripoli 
Tunis 
Windhoek 
 
America/ 
Adak 
Anchorage 
Anguilla 
Antigua 
Araguaina 
Argentina 
Aruba 
Asuncion 
Atikokan 
Atka 
Bahia 
Barbados 
Belem 
Belize 
Blanc-Sablon 
Boa_Vista 
Bogota 
Boise 
Buenos_Aires 
Cambridge_Bay 
Campo_Grande 
Cancun 
Caracas 
Catamarca 
Cayenne 
Cayman 
Chicago 
Chihuahua 
Coral_Harbour 
Cordoba 
Costa_Rica 
Cuiaba 
Curacao 
Danmarkshavn 
Dawson 
Dawson_Creek 
Denver 
Detroit 
Dominica 
Edmonton 
Eirunepe 
El_Salvador 
Ensenada 
Fort_Wayne 
Fortaleza 
Glace_Bay 


Godthab 
Goose_Bay 
Grand_Turk 
Grenada 
Guadeloupe 
Guatemala 
Guayaquil 
Guyana 
Halifax 
Havana 
Hermosillo 
Indiana 
Indianapolis 
Inuvik 
Iqaluit 
Jamaica 
Jujuy 
Juneau 
Kentucky 
Knox_IN 
La_Paz 
Lima 
Los_Angeles 
Louisville 
Maceio 
Managua 
Manaus 
Martinique 
Mazatlan 
Mendoza 
Menominee 
Merida 
Mexico_City 
Miquelon 
Moncton 
Monterrey 
Montevideo 
Montreal 
Montserrat 
Nassau 
New_York 
Nipigon 
Nome 
Noronha 
North_Dakota 
Panama 
Pangnirtung 
Paramaribo 
Phoenix 
Port-au-Prince 
Port_of_Spain 
Porto_Acre 
Porto_Velho 
Puerto_Rico 
Rainy_River 
Rankin_Inlet 
Recife 
Regina 
Rio_Branco 
Rosario 
Santiago 
Santo_Domingo 
Sao_Paulo 
Scoresbysund 
Shiprock 
St_Johns 
St_Kitts 
St_Lucia 
St_Thomas 
St_Vincent 
Swift_Current 
Tegucigalpa 
Thule 
Thunder_Bay 
Tijuana 
Toronto 
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Tortola 
Vancouver 
Virgin 
Whitehorse 
Winnipeg 
Yakutat 
Yellowknife 
 
Antarctica/ 
Casey 
Davis 
DumontDUrville 
Mawson 
McMurdo 
Palmer 
Rothera 
South_Pole 
Syowa 
Vostok 
 
Arctic/ 
Longyearbyen 
 
Asia/ 
Aden 
Almaty 
Amman 
Anadyr 
Aqtau 
Aqtobe 
Ashgabat 
Ashkhabad 
Baghdad 
Bahrain 
Baku 
Bangkok 
Beijing 
Beirut 
Bishkek 
Brunei 
Calcutta 
Choibalsan 
Chongqing 
Chungking 
Colombo 
Dacca 
Damascus 
Dhaka 
Dili 
Dubai 
Dushanbe 
Gaza 
Harbin 
Hong_Kong 
Hovd 
Irkutsk 
Istanbul 
Jakarta 
Jayapura 
Jerusalem 
Kabul 
Kamchatka 
Karachi 
Kashgar 
Katmandu 
Krasnoyarsk 
Kuala_Lumpur 
Kuching 
Kuwait 
Macao 
Macau 
Magadan 
Makassar 
Manila 


Muscat 
Nicosia 
Novosibirsk 
Omsk 
Oral 
Phnom_Penh 
Pontianak 
Pyongyang 
Qatar 
Qyzylorda 
Rangoon 
Riyadh 
Riyadh87 
Riyadh88 
Riyadh89 
Saigon 
Sakhalin 
Samarkand 
Seoul 
Shanghai 
Singapore 
Taipei 
Tashkent 
Tbilisi 
Tehran 
Tel_Aviv 
Thimbu 
Thimphu 
Tokyo 
Ujung_Pandang 
Ulaanbaatar 
Ulan_Bator 
Urumqi 
Vientiane 
Vladivostok 
Yakutsk 
Yekaterinburg 
Yerevan 
 
Atlantic/ 
Azores 
Bermuda 
Canary 
Cape_Verde 
Faeroe 
Faroe 
Jan_Mayen 
Madeira 
Reykjavik 
South_Georgia 
St_Helena 
Stanley 
 
Australia/ 
ACT 
Adelaide 
Brisbane 
Broken_Hill 
Canberra 
Currie 
Darwin 
Eucla 
Hobart 
LHI 
Lindeman 
Lord_Howe 
Melbourne 
NSW 
North 
Perth 
Queensland 
South 
Sydney 
Tasmania 
Victoria 


West 
Yancowinna 
 
Brazil/ 
Acre 
DeNoronha 
East 
West 
 
Canada/ 
Atlantic 
Central 
East-Saskatchewan 
Eastern 
Mountain 
Newfoundland 
Pacific 
Saskatchewan 
Yukon 
 
Chile/ 
Continental 
EasterIsland 
 
Etc/ 
GMT 
GMT+0 
GMT+1 
GMT+10 
GMT+11 
GMT+12 
GMT+2 
GMT+3 
GMT+4 
GMT+5 
GMT+6 
GMT+7 
GMT+8 
GMT+9 
GMT-0 
GMT-1 
GMT-10 
GMT-11 
GMT-12 
GMT-13 
GMT-14 
GMT-2 
GMT-3 
GMT-4 
GMT-5 
GMT-6 
GMT-7 
GMT-8 
GMT-9 
GMT0 
Greenwich 
UCT 
UTC 
Universal 
Zulu 
 
Europe/ 
Amsterdam 
Andorra 
Athens 
Belfast 
Belgrade 
Berlin 
Bratislava 
Brussels 
Bucharest 
Budapest 
Chisinau 
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Copenhagen 
Dublin 
Gibraltar 
Guernsey 
Helsinki 
Isle_of_Man 
Istanbul 
Jersey 
Kaliningrad 
Kiev 
Lisbon 
Ljubljana 
London 
Luxembourg 
Madrid 
Malta 
Mariehamn 
Minsk 
Monaco 
Moscow 
Nicosia 
Oslo 
Paris 
Podgorica 
Prague 
Riga 
Rome 
Samara 
San_Marino 
Sarajevo 
Simferopol 
Skopje 
Sofia 
Stockholm 
Tallinn 
Tirane 
Tiraspol 
Uzhgorod 
Vaduz 
Vatican 
Vienna 
Vilnius 
Volgograd 
Warsaw 
Zagreb 
Zaporozhye 
Zurich 
 
Indian/ 
Antananarivo 
Chagos 
Christmas 
Cocos 
Comoro 
Kerguelen 
Mahe 
Maldives 
Mauritius 
Mayotte 
Reunion 
 
Mexico/ 
BajaNorte 
BajaSur 
General 
 
 
Mideast/ 
Riyadh87 
Riyadh88 
Riyadh89 
 
Pacific/ 
Apia 


Auckland 
Chatham 
Easter 
Efate 
Enderbury 
Fakaofo 
Fiji 
Funafuti 
Galapagos 
Gambier 
Guadalcanal 
Guam 
Honolulu 
Johnston 
Kiritimati 
Kosrae 
Kwajalein 
Majuro 
Marquesas 
Midway 
Nauru 
Niue 
Norfolk 
Noumea 
Pago_Pago 
Palau 
Pitcairn 
Ponape 
Port_Moresby 
Rarotonga 
Saipan 
Samoa 
Tahiti 
Tarawa 
Tongatapu 
Truk 
Wake 
Wallis 
Yap 
 
US/ 
Alaska 
Aleutian 
Arizona 
Central 
East-Indiana 
Eastern 
Hawaii 
Indiana-Starke 
Michigan 
Mountain 
Pacific 
Samoa







45 
 


16 Appendix: Changing an IP-address 
After changing the playout nodes’, TX/MAM or FTP-servers’ IP-address, following adjustments need to 
be made: 
 
16.1 After changing the IP-address of the playout nodes 


1) Change the playout node’s IP-address in the TX/MAM Channel settings. 


 
16.2 After changing the virtual IP-address of the TX/MAM-servers 


1) On the GVEdge nodes, in /etc/hosts adjust MAIN-DB. Specify the virtual IP of the TX/MAM 


servers. 


Example: 


10.250.51.51 MAIN-DB 
  


 
You can also set the IP-address of the TX/MAM server via the IP Manager. 
 
2) On both the TX/MAM servers, in /usr/local/apache2/application/config/txmam.ini, adjust 


project_options.serverip. Specify the virtual IP of the TX/MAM servers. 


Example: 


project_options.serverip = "10.250.51.51" 
 
3) On both the TX/MAM servers, in /usr/local/apache2/application/config/txmam.ini, adjust 


ingest.assetHostIp. Specify the virtual IP of the TX/MAM servers. 


Example: 


ingest.assetHostIp = "10.250.51.51" 
 


4) To change the IP-address in the POC desktop shortcut properties  


Right-click the POC icon on your desktop > Properties > Shortcut.  


In the Target field fill in the TX/MAM servers’ virtual IP-address.  


 
 
16.3 After changing the IP-address of the FTP-server 


1) On both the TX/MAM servers, in /usr/local/apache2/application/config/txmam.ini, adjust: 


videoFtp.host to the FTP-server IP 
videoFtp.user to FTP-server user 
videoFtp.password to FTP-server password 
videoFtp.path to FTP-server path 
 
Preferably adjust both the FTP and SMB-settings. 
Example (SMB): 
;Global 
videoFtp.protocol = Smb 
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;Smb 
videoFtp.Smb.user="delta" 
videoFtp.Smb.password="delta" 
videoFtp.Smb.host="10.250.51.51" 
videoFtp.Smb.path="/system/objects/cobassets/media/browse/" 
 
2) On the main TX/MAM server in /system/objects/cobassets/bin/transfer_ftp.xml, adjust the 


transfer metadata.  


3) Then run the /system/objects/cobassets/bin/set.sh script. 


 
16.4 After changing the IP-address of a standalone demo server 


1) Run the script /system/txmam_fix_ip.sh. 
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17 Appendix: GV Edge network ports 


FTP Default port 20 and 21 


SSH/SCP Default port 22 


Cobalt database access Default port 5020 


Webbased interface Default port 80 on IP manager network/IP 


ptsockse Default port 5000  


nexos complex socket  Default port 5001 


UDP-monitoring Default port 4000 
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18 Appendix: GV Edge IOs 
18.1 Tiles 
De GV Edge contains 8 bidirectional SDI-ports. One video format can be configured per tile. IO1 is 
always configured as input and IO2 as output to be able to use the bypass relay. A number of presets 
have been defined for the GV Edge. These presets are selected via the IP Manager.  


  
IOs and tiles. 


18.2 Bypass 
Ports IO1 (input) and IO2 (output) can be internally connected to bypass a Channel. When set to 
bypass, the signal of the main Channel is ignored, and instead the feed received at IO1 is made 
available at IO2. Bypass is enabled via the IP Manager. 
 
18.3 Master and Slaves 
To make a Channel's signal available on several SDI-outputs, one or more of the IO-ports can be 
configured to become slave outputs. By default, the signal provided by a slave output is an exact copy 
of the master output signal. A slave output uses the properties of the master Output it refers to, and 
thus cannot introduce another broadcast format for the same Channel. 


 
18.4 Genlock 
If enabled, the SDI-output synchronizes to the frame rhythm of the genlock (blackburst) signal 
connected to the blackburst BNC-socket on the back of the server. If disabled, or when no genlock 
signal can be detected, the output will synchronize to an internal clock. Genlock can only be set for 
master outputs. 
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19 Appendix: GPIO  
19.1 GPIO and LTC pinning 


Internal GPIO: DB9M  
External GPIO: 410E 
GPIO is an open collector port. 
 
LTC - DB9M 
LTC_out + (positive) pin 2 


LTC_out - (negative) pin 4 


LTC_out GND GND ground) pin 1 


LTC_in + (positive) pin 7 


LTC_in - (negative) pin  8 


LTC_in GND  GND (ground) pin 9 
 
 
GPIO - DB9M 


GPI0 pin 1 
GPI1 pin 2 
GPI2 pin 3 
GPI3 pin 4 
GPI4 pin 5 
GPI5 pin 6 
GPI6 pin 7 
GPI7 pin 8 
GND pin 9 
 
 
19.2 Configure the GPIO pins 
The GV Edge Server GPIO pins have no special purpose defined, and go unused by default. This 
chapter describes how you can create four types of rules to define the purpose of GPIO pins with the 
GV Edge IP Manager. These are rules for the following GPIO types: 
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• GPIO for internal GPIO devices connected through the DB9 socket on the back of the GV Edge 
Server (DB9M). 


• GPIO for incoming dual-tone multi-frequency signals (DTMF), such as sub-audible cue tones that 
are often used to prompt the insertion of a TV commercial. 


• GPIO over vertical blanking interval (VBI) data streams (SD PAL, 1080@50i and 720@50p). Virtual 
device names such as VBI0 and VBI1 can be assigned to GPIO devices dedicated to channels 0, 
1, et cetera.  


 
 


19.2.1 Set a rule for a DB9M device 
The IP manager contains two default rules for DB9M devices: 
• The first rule triggers a ‘LOGO IN’ template to display a logo on screen. 
• The second rule triggers a ‘LOGO OUT’ template that removes a logo from the screen. 
 
To change a default rule: 
1. Open the IP Manager web interface and log in as usual. 
2. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
3. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
4. Repeat step 5 for the other seven pins. 
5. If you want a time cheat to be applied, select the Timecheat check box. 
6. If you do not want a time cheat to be applied, continue with the next step. 
7. If you do not want to trigger an action for the trigger signal, select None. 
8. If you want to run a Linux shell script, do the following: 


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. In the Cheat delay box, type the delay you want to apply in hh:mm:ss:ff. for the incoming 


stream. 
d. Click Set. 


9. If you want to trigger a Channel Composer template, do the following: 
a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


10. If you want to disable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


11. If you want to enable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: on. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


12. If you want to disable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


13. If you want to enable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 
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To add and setup a new DB9M rule:  
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click DB9M. 
3. In the DB9M pane, click New DB9M rule. 
4. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
5. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
6. Repeat step 5 for the other seven pins. 
7. If you want a time cheat to be applied, select the Timecheat check box. 
8. If you do not want a time cheat to be applied, continue with the next step. 
9. If you do not want to trigger an action for the trigger signal, select None. 
10. If you want to run a Linux shell script, do the following: 


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. In the Cheat delay box, type the delay you want to apply in hh:mm:ss:ff. for the incoming 


stream. 
d. Click Set. 


11. If you want to trigger a Channel Composer template, do the following: 
a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


12. If you want to disable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


13. If you want to enable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: on. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


14. If you want to disable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


15. If you want to enable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 
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19.2.2 Set a rule for an incoming DTMF signal 
The GV Edge render engine (nexos) can decode and recognize DTMF signals in the incoming audio 
streams from the incoming SDI feed or media files. Nexos monitors all incoming audio channels to 
detect DTMF signals. When a pre-defined signal is detected, you can let nexos use that signal as a 
trigger for a certain system action.  
 
To set a rule for how all channels must handle an incoming DTMF signal: 
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click DTMF. 
3. In the DTMF pane, click New DTMF rule. 
4. In the DTMF sequence box, enter the trigger signal, such as 123*. 
5. If you want to trigger no action for the trigger signal, select None in the type box. 
6. If you want to run a Linux shell script, do the following: 


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. Click Set. 


7. If you want to trigger a Channel Composer template: 
a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


8. If you want to disable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


9. If you want to enable DB9M outgoing GPIO, do the following: 
a. Select DB9M GPI out: on in the type box. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


10. If you want to disable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


11. If you want to enable the censor on a SDI output port, do the following:  
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


 


19.2.3 Set a rule for a single channel GPIO-over-VBI device 
 
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click the applicable VBI device (VBI0, VBI1, etc.). 
3. In the DTMF pane, click New VBI rule. 
4. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
5. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
6. Repeat step 5 for the other seven pins. 
7. If you want a time cheat to be applied, select the Timecheat check box. 
8. If you do not want a time cheat to be applied, continue with the next step. 
9. If you want to trigger no action for the trigger signal, select None. 
10. If you want to run a Linux shell script,  


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
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c. In the Cheat delay box, type the delay you want to apply in hh:mm:ss:ff. for the incoming 
stream. 


d. Click Set. 
11. If you want to trigger a Channel Composer template,  


a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


12. If you want to disable DB9M outgoing GPIO,  
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


13. If you want to enable DB9M outgoing GPIO,  
a. In the type box, select DB9M GPI out: on. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


14. If you want to disable the censor on a SDI output port,  
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


15. If you want to enable the censor on a SDI output port,  
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


 
19.3 Delete a GPIO rule 
 
To delete a rule: 
■ Click Delete. 
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20 Appendix: Yast 
 
You can also configure network settings using Yast. To start Yast: 
 


 Login on the GV Edge as root. On the command line enter: yast [enter]. 
 


 
 


 Use [TAB] to select [Next], then press [Enter]. 


 The next screen opens. 
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Example Yast screen. 


 
 Select the network card that is already configured (here Super Micro). 
 Select [Edit], then press [Enter]. 
 The next screen opens. 
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Example Yast screen. 


 
 Use [TAB] to navigate through and change applicable settings. 
 To change the hostname or name server, select [Hostname and Name Server], then 


press [Enter]. 
 To change the gateway, select [Routing], then press [Enter]. 
 To save settings, select [Next]. To discard, select [Abort].  
 In the initial screen, select [Finish] to activate the settings. 


 
The system can now be accessed with SSH, FTP, Cobalt, etcetera. 
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1 About this guide 
The GV TX/MAM 2.7 user Guide gives users the latest information and instructions about how to use 
GV TX/MAM 2.7 for GV Edge. 
 
 


1.1 What’s in this guide 
This document describes how to work with GV TX/MAM 2.7. Chapter 1 explains how to use this user 
guide. Chapter 2 explains the GV TX/MAM back pane, the web interface and the elements that you 
can manage through the web interface. Subsequently, this manual is divided in the following 
sections: 
 
• Configuring GV TX/MAM   
• Asset Management with GV TX/MAM 
• Channel Management 
• User Management for Channels 
• Flag Configuration 
• Quick Reference 
 
 


1.2 Document conventions 


The formatting of this user guide is designed to help you easily and quickly find information. The 
following table explains what the different formats in this document mean. 
 
Format Refers to Example 
Bold An onscreen object for which a user 


action is needed. Keyboard keys are not 
emphasized. 


Click Save As. 


Italic Placeholder text. 
Hyperlink or cross-reference. 


type password. 
See Chapter 2, Get to know GV TX/MAM 
2.7. 


■  Single-step procedures. ■ On the View menu, click Ruler. 
1.  Multiple-step procedures. 1. On the Tools menu, click Options. 


2. Click the Edit tab. 
& Note:   A note. & Note: Only administrators can 


publish to a server. 


•  A list item. A user can edit: 
• Objects 
• Materials 
• Visual effects. 


 


1.3 Useful resources 


The following related resources might also help you to learn about the features of Composer: 
• Dell documentation for Safety Instructions. 
• Dell documentation for an explanation of indicators and status information.  
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& Do not use the Dell Quick Installation Guide provided with the Dell CD-ROM package. This guide 
includes instructions for using the OpenManage software CD-ROM to install an operating system, 
which is not necessary on the Grass Valley product. 


 


1.4 Contact support 


Do you have a specific question and was the answer not in this user guide? Please visit our website 
or contact Grass Valley support. 
 
To contact Grass Valley support, do one of the following: 
■ Call one of our international support centers with 24/7 availability: 


o France, +800 8080 2020 or +33 1 48 25 20 20. 
o US and Canada, +1 800 547 8949 or +1 530 478 4148. 


■ Call one of our local support centers, open during normal business hours: 
o Asia 


 Hong Kong, Taiwan, Korea and Macau: +852 2531 3058. 
 Indian Subcontinent: +91 22 24933476. 
 Southeast Asia/Malaysia: +603 7492 3303. 
 Southeast Asia/Singapore: +65 6379 1313. 
 China: +861 0660 159 450 Japan: +81 3 5484 6868. 


o Australia and New Zealand: +61 1300 721 495. 
o Central and South America: +55 11 5509 3443. 
o Middle East: +971 4 299 64 40. 
o Near East and Africa: +800 8080 2020 or +33 1 48 25 20 20. 
o Europe 


 Belarus, Russia, Tadzikistan, Ukraine, Uzbekistan: +7 095 2580924 225. 
 Switzerland: +41 1 487 80 02. 
 Italy (Rome): +39 06 87 20 35 28. 
 Italy (Milan): +39 02 48 41 46 58. 
 Spain:  +34 91 512 03 50. 
 Belgium: +32 (0) 2 334 90 30. 
 Netherlands: +31 (0) 35 62 38 42 1. 
 Benelux and Northern Europe: +45 45 96 88 70. 
 Germany, Austria, Eastern Europe: +49 6150 104 444. 
 UK, Ireland, Israel: +44 118 923 0499. 
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2 Get to know GV TX/MAM 
2.1 The GV TX/MAM Server Back panel 
 


 
GV TX/MAM back panel. 
 
Item 
1. iDrAC6 Enterprise port (n/a) 
2. VFlash media slot (n/a) 
3. Serial connector 
4. PCIe slot 
5. Video connector 
6. USB connectors 
7. PCIE slot 
8. Ethernet connectors GB1-4 
9. System status indicator 
10. System status indicator 
11. System identification button 
12. Power supply 
13. Power supply 
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2.2 The GV TX/MAM web interface 


Example GV TX/MAM Interface (including super user and administrator tabs). 
 


A Use the left hand menu to select the information that you want to display in the main window 
(C). While a number of items are fixed, this menu can be customized as described in 
paragraph 5.1. 


B The toolbar in the top right corner shows a number of basic options such as ‘Create’, ‘Search’ 
and ‘Profile’. Options available differ depending on the contents of the main window. 
Click the ‘About’ option to view the GV TX/MAM version and release notes. 


C The main window shows the information as selected in the left hand menu.  


D The refresh option. 


E Delete asset options. 


F Page options. 


G Export assets options.  


 
 The GV TX/MAM interface is described in more detail in the Quick Reference. 
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GV TX/MAM asset management functionality includes: 
• Create and manage assets. 
• Trim, soft part segments. 
• Low-res proxy quality control. 
• Edit metadata. 
• Asset jobs. 
• Channel Management. 
• User Management. 
• Manage Flags. 
• Automatic file ingest. 


 


2.3 Assets 
Asset info is created in GV TX/MAM, or imported using the Schedule or asset Importer. Until a file 
has been ingested, assets are called empty assets. Asset info is stored in the GV TX/MAM database.  
Files (Essences) are ingested via Inboxes on the Storage Server.  


ASSET 


Asset info [GV TX/MAM database] Essence [Storage] 


Metadata and info that describes the asset. 
 


• Metadata 
Fixed metadata such as file type, external 
reference, duration and customizable 
metadata, for instance artist or episode.  


• Jobs and statuses 
assets can have configurable jobs and 
statuses, which are visible in GV TX/MAM. 
Jobs can be executed automatically and/or 
manually. 


• Workflow 
Workflow steps can be defined using the 
status of an asset or asset Job. 
 


Essence(s) are the media files that belong to the 
asset.  
 


Mostly, assets and Essences are linked via the asset’s External reference. Example: 


External reference  Filename 


abc123 abc123.mpg 
 


& See chapter 9 for an explanation of the GV Edge and ingest workflow. 


 
When a Schedule is imported and assets in the Schedule do not yet exist, empty assets are created.  
You can also create empty assets (assets for which the file has not yet been ingested in GV 
TX/MAM). Note that empty assets can be scheduled, but cannot be played out. Before playout, the 
Essence must be available. 
 
In GV TX/MAM, assets are described on several tabs. Configurable metadata tab pages. In the 
default setup: 
• Info: asset info such as Artist and Track. 
• Technical: asset info such as Media type and Aspect ratio. 
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• Images: shows the graphic (only for TGA-assets). 
• Essences: the file(s) linked to an asset and their status (only for video assets). 
• Spotcheck: file quality check and segmenting (only for video assets). 
• Jobs: the Jobs linked to an asset and their status. 
• Sharing: assets are linked to a user Group, Channel1 in the example below.  This group has 


access to the asset. To give other Groups access, assets can be shared. 
• History: lists all actions performed for this asset. 


 


Example asset (video) in GV TX/MAM.  
 


2.4 Metadata 
Metadata such as ID, External reference, tx_status describes the asset.  Asset info is displayed on the 
asset’s Info and Technical tabs, and is also shown in the columns in the assets list. Custom metadata 
tabs can be defined. 


Example assets list with asset info (External reference, Artist, track, ID …) 
 
Asset info can be used for scheduling (for example schedule clips based on Genre) and for playout 
(for example play out Artist and Track info with a clip). 
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2.5 Essences 


The media file(s) linked to an asset are named Essences. The tx_status column on the Essences tab 
shows the status of file ingest. 


Example Essences tab for a Music Video. 
 


2.6 Spotcheck and segmenting 


GV TX/MAM’s spotcheck functionality lets you verify the Essences’ quality. You can also define 
segments- using Tc-in and Tc-out (time code in and out) - when only part of a file is used.  
 


& Segments can be scheduled (drag into POC), but are not listed in the assets list. 
& Since 4.2.1, a new HTML 5 web player has been introduced, which is much faster. The browse 


copy of an asset should be re-created in order to make use of this player. Please contact support 
for more information about this subject. 


Example of the spotcheck player.  
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2.7 Asset jobs 


Jobs and procedures can be defined and linked to asset types and will then automatically be 
executed for all assets of that type. Example jobs: 
■ A job Browse copy to create a low resolution copy of files. The status Browse created is displayed 


in the asset list’s tx_status column. 
■ A job Get media info, used to retrieve info about file duration and type. This info can then be 


displayed in the asset list. 
 
The Jobs tab shows the status of Jobs for an asset. You can change this status or in some cases 
manually execute Jobs.  


Example Jobs tab. 
 


2.8 Share and export assets 


Assets are linked to a user group. Only this user group has access to the asset. To enable access for 
other user groups, the asset can be shared. Assets can also be exported to pre-defined folders, such 
as a folder monitored by the DIVA Archive Gateway. 


Example Sharing tab; the asset is not shared with other user Groups. ‘Channel1’ in the asset’s title refers 
to the user Group that has access to this asset. 
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To export a selected asset: 
1. In an asset list, double-click the asset that you want to export. 
2. Click on the Sharing tab. 
3. Click the Export button. 
4. In the Outbox folder to export box, select the outbox folder to which you want to export the asset. 


 
For information about how to set a pre-defined outbox folder, see section 4.4, Manage folders. For 
information about how to automatically store assets in the DIVA Archive, see the DIVA Gateway 
documentation.  
 


2.9 History 


The asset’s History lists the asset Jobs or user actions performed for the asset. 


Example History tab. 
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2.10 Asset types 


Asset types define groups of assets with the same file type and metadata definition. Example file 
types are: AVF (for video files), TGA (for graphics) and WAV.  
 
Metadata fields such as External reference and Duration are fixed for all asset types. Custom 
metadata can be configured per asset type.  
Below you find the custom metadata definition for asset type Music Videos. The name attribute 
defines the custom metadata fields for assets of this type, such as Artist, Track and Album.  
 
<XML> 
<WINDOW width="535" height="220"> 
  <PAGE name="Info"> 
    <LABEL x="10" y="27" height="16" width="80">Artist:</LABEL> 
    <TEXTFIELD name="artist" x="100" y="25" height="20" width="200" search="true"></TEXTFIELD> 
    <LABEL x="10" y="57" height="16" width="80">Track:</LABEL> 
    <TEXTFIELD name="track" x="100" y="55" height="20" width="200" search="true"></TEXTFIELD> 
    <LABEL x="10" y="87" height="16" width="80">Album:</LABEL> 
    <TEXTFIELD name="album" x="100" y="85" height="20" width="200" search="true"></TEXTFIELD> 
    <LABEL x="10" y="117" height="16" width="80">Record label:</LABEL> 
    <TEXTFIELD name="record" x="100" y="115" height="20" width="200"    
search="true"></TEXTFIELD> 
    <LABEL x="10" y="147" height="16" width="80">Genre:</LABEL> 
    <COMBOBOX name="genre" x="100" y="145" height="20" width="100"           
search="true">None#13Disco#13Dance#13Launce#13Rap</COMBOBOX> 
    <LABEL x="10" y="177" height="20" width="80">Year:</LABEL> 
    <SPINEDIT name="year" x="100" y="175" height="20" width="90" search="true">2010</SPINEDIT> 
  </PAGE> 
  <PAGE name="Technical"> 
    <LABEL x="10" y="27" height="16" width="80">Media type:</LABEL> 
    <COMBOBOX name="media_type" x="100" y="25" height="20" width="120" search="true">#13MPEG2-
SD#13MPEG2-HD#13MXF-SD#13MXF-HD</COMBOBOX> 
    <LABEL x="10" y="57" height="16" width="80">Aspect ratio:</LABEL> 
    <COMBOBOX name="aspect_ratio" x="100" y="55" height="20" width="120" 
search="true">#134:3#1316:9 Anamorphic#1316:9 Letterbox</COMBOBOX> 
    <LABEL x="10" y="87" height="16" width="80">Loudness:</LABEL> 
    <LABEL x="20" y="107" height="16" width="100">Integrated:</LABEL> 
    <TEXTFIELD name="integrated_loudness" x="120" y="105" height="20" width="45" 
search="true"></TEXTFIELD> 
    <LABEL x="20" y="127" height="16" width="100">Max Momentary:</LABEL> 
    <TEXTFIELD name="momentary_loudness" x="120" y="125" height="20" width="45" 
search="true"></TEXTFIELD> 
    <LABEL x="20" y="147" height="16" width="100">Max Short term:</LABEL> 
    <TEXTFIELD name="shortterm_loudness" x="120" y="145" height="20" width="45" 
search="true"></TEXTFIELD> 
    <LABEL x="20" y="167" height="16" width="100">Range:</LABEL> 
    <TEXTFIELD name="loudness_range" x="120" y="165" height="20" width="45" 
search="true"></TEXTFIELD> 
    <LABEL x="10" y="197" height="16" width="100">Parental guide:</LABEL> 
    <COMBOBOX name="parental_guide_age" x="100" y="195" width="51" height="20" 
search="true">#13AL#136#139#1312#1316#1318</COMBOBOX> 
    <COMBOBOX name="parental_guide_icon1" x="190" y="195" width="100" height="20" 
search="true">#13fear#13sex#13violence#13drugs#13language#13discrimination</COMBOBOX> 
    <COMBOBOX name="parental_guide_icon2" x="300" y="195" width="100" height="20" 
search="true">#13fear#13sex#13violence#13drugs#13language#13discrimination</COMBOBOX> 
    <COMBOBOX name="parental_guide_icon3" x="410" y="195" width="100" height="20" 
search="true">#13fear#13sex#13violence#13drugs#13language#13discrimination</COMBOBOX> 
  </PAGE> 
</WINDOW> 
</XML> 
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3 Get started 
3.1 Install GV TX/MAM 


3.1.1 System requirements 


The GV TX/MAM web interface requires a networked Windows PC with a Mozilla Firefox web browser 
and the GV TX/MAM Player installed. 
 


3.1.2 Installation 


The GV TX/MAM Player is included in the Cobalt Installer and installed when installing Cobalt. 
 


3.2 Configure an IP address 
The GV TX/MAM servers do not use their own IP address for communication with the Integrated 
Playout System applications and servers, as to keep this IP address available for the backup GV 
TX/MAM server. Instead, a virtual IP address is used. 
• Configure the GV TX/MAM servers’ real IP addresses, for example using Yast. 
• Configure the GV TX/MAM servers’ virtual IP address as described in the next paragraph. 
 


3.3 Configure the main and backup database and virtual IP address 
The main server automatically writes its backups to the backup server, and vice versa. 


To configure the GV TX/MAM server 


1. run the script db_configure: # /system/db_configure <enter>  
 
Now follow the screens below. 


 


2. Click Yes to continue, No to cancel. 
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3. Click No. 


 


4. Click Yes if you are configuring the main database server, No to configure the backup database 
server. 


The examples below and above describe configuration of the main database server. Both servers 
need to be configured: 


 


5. Enter the GV TX/MAM servers’ virtual IP address. 
Keep in mind that you need to specify the same virtual IP for the main and backup database 
server. Note that the IP address in the picture above is an example. 


6. Click Submit to continue, Cancel to cancel. 
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7. Click Yes to continue, No to cancel. 
Note that the IP address in the picture above is an example. 


 


8. Enter the database server's real IP address. 
Note that the IP address in the picture above is an example. 


9. Click Submit to continue, Cancel to cancel. 
10. Now reboot the server. 


 
11. Repeat these steps for the second server.  


Use the same virtual IP address for the main and backup server. 
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3.4 Configure the time mode of the video player 
On both the GV TX/MAM servers, set the time mode for the GV TX/MAM video player. The default is 
Relative. To change to absolute:  
Edit the file /usr/local/apache2/application/configs/txmam.ini. 


 
[production] 


VideoPlayer.timeMode=Absolute  


 
On both the GV TX/MAM servers, edit the file /system/objects/cobassets/bin/seq_brX.ini (X= 0 to 3)  
Example: 


 
[SequencerSettings] 


BladeIniFile=/system/blade.ini 


BroadcastSet=BROADCAST0 


AppNiceParameter=-n20 


SendFormatCounter=1 


NoDuplicateOptOutBlock= 


PreloadTime(sec)=30 


SendScriptCueCommand=0 


TimeCodeStarttype=Absolute  


TimeCodeNoTCEnd= 


 


3.5 Configure the time settings 


On the GV TX/MAM servers, edit the file /etc/ntp.conf. 
1. Go to: 
## Outside source of synchronized time 


## 


## server xx.xx.xx.xx      # IP address of server 


 


2. Edit the following line:  ## server xx.xx.xx.xx     # IP address of server 
a. Remove the  # hastags. 
b. Specify the NTP-server’s IP address. 


 


Example: 


## Outside source of synchronized time 


## 


server 192.33.96.102           # IP address of server 


 


3. To activate, run the following command: service ntp restart 
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3.6 Configure the GV TX/MAM main and backup server 
1. On the active (main) GV TX/MAM server, the file /system/STATUS should contain: 


active=yes 
2. On the standby (backup) GV TX/MAM server, the file /system/STATUS should contain: 


active=no 
 


& Via samba (windows network share) the STATUS file can be found here: \\<GV TX/MAM server IP 
address>\delta\STATUS 


& When working from command line: /system/STATUS   


 


To change a GV TX/MAM server from main to backup: 


1. On the main server, edit and safe the file /system/STATUS:  
Change active=yes to active=no and save the file. 


2. Run the /system/nexusproc restart all command. 


To change a GV TX/MAM server from backup to main: 


1. On the backup server, edit and safe the file /system/STATUS: 
Change active=no to active=yes and save the file. 


2. Run the /system/nexusproc restart all command. 
 


3.7 Failover, manual backup and restore 
An automatic backup is created and restored from the active to the standby database every hour by 
the /etc/cron.backup/cob-bak and /etc/cron.restore/cob-restore commands. 
 


Workflow Main GV TX/MAM server Backup (standby) GV TX/MAM 
server 


Normal situation The main server is active and writes a 
backup to the backup server every hour. 


The backup server is inactive. 
Database backups are written 
from the main to the backup 
server. 


Create a manual backup from 
the main server (usually not 
needed). 


# /etc/cron.backup/cob-bak 


<enter> 
The database backup is written to 
the backup server. 


Failover from the main to the backup GV TX/MAM server 


Deactivate the main server. Deactivate the main server first: 
 
Stop all services: 
# /system/nexusproc stop all 


 
Edit the file /system/STATUS, set yes to 
no: 
active=no 
 


The backup server is inactive. 
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Restore the database on the 
backup. 


The main server is inactive. Run the script: 
/etc/cron.restore/cob-


restore 


Activate the backup (standby) 
server. 


 Edit the file /system/STATUS, set 
no to yes: 
active=yes 


 


Start all services: 
# /system/nexusproc start 


all 
 


The backup server is now 
active. 


 The backup server is active. 


Clear ARP cache on Windows 
clients: 
 
Open a command Window, 
click start, run, type cmd and 
press enter. 
 
Give the command: 
Arp –a  –d 
 


  


Going back from the backup to the main GV TX/MAM server 


The backup server is active. The main server is inactive. The backup server is active and 
writes a database backup to the 
main server every hour. 


To manually create a backup 
from the backup server (if no 
backup of the database is 
available on the main). 


The database backup is written to the 
main server. 


To manually create a backup on 
the backup server and write to the 
main: 
# /etc/cron.backup/cob-


bak <enter> 
 


Restore the database on the 
main. 


/etc/cron.restore/cob-restore  


Deactivate the backup server.  Stop all services: 
# /system/nexusproc stop 


all 


 
Edit the file /system/STATUS, set 
yes to no: 
active=no 
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Activate the main. Edit the file /system/STATUS, set no to 
yes: 
active=yes 


 


Start all services: 
# /system/nexusproc start all 


 


 


 


Normal situation. The main is active. The backup server is inactive. 
Database backups are written to 
the backup server. 


Clear ARP cache on Windows 
clients: 
 
Open a command Window, 
click start, run, type cmd and 
press enter. 
 
Give the command: 
Arp –a  –d 


  


 
3.8 Open the GV TX/MAM web interface 
 


 
1. Open a Firefox web browser on your workstation. 
2. Enter the GV TX/MAM servers’ virtual IP-address and press [Enter]. 
3. Log in using the GV TX/MAM credentials [chapter 2].   
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4 Manage GV TX/MAM 
GV TX/MAM configuration options include:  
• Define users and user groups to manage access and authorization levels for Folders, asset types 


and assets. 
• Modify the GV TX/MAM menu to specify customized asset lists. 
• Define Folders for automatic ingest, asset sharing and export.  
• Link Jobs to asset types. 
 


& You need superuser or administrator rights to configure GV TX/MAM. 


 


4.1 Manage users and user groups 
4.1.1 Introduction 


GV TX/MAM lets you define users and user groups to manage access and authorization levels for 


Folders, asset types and assets.  


■ Example users: Operator, Supervisor and Administrator. 
■ Example user groups (for a service provider): Customer1 and Customer2. 


  
The table below shows different authorization levels that can be set for users and user groups. 
user group allowed asset types 


allowed assets (defined when creating an asset as a property of the asset assets can be 
shared with other groups) 
allowed Folders (defined when creating a Folder) 
assign administrator and superuser rights 
set rights for TX/Dashboard 


user allowed applications (Cobalt, GV TX/MAM) 
authorization levels (create, read, delete, …) 
allowed tabs (Metadata, Essences, …) 
allowed menu items (Inbox and Outbox) 


 


4.1.2 Administrator and superuser 


Administrator and superuser rights can be assigned to Groups. 
Administrator and 
Superuser 


Read/write rights for: 
Menu Item List 
user groups 
users 
Categories: not used 


Superuser 
 


Read/write rights for: 
Folders 
Options 
TX-statuses and values 
asset types 
asset Jobs 
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4.1.3 Create or modify a user group 


Example user Group. 
 
1. Click the user groups menu item. 
2. Click the Add button to add a user group or select the user group you want to edit. 
3. Specify a Name for the group. 
4. Add a short description of the Group in the Description field. 
5. Activate the Administrators option if you want to assign administrator rights to the group. 
6. Activate the Superuser option if you want to assign superuser rights to the group. 
7. Select the asset type(s) this group is allowed to work with.  
8. Click Save to save changes, Cancel to discard. 
 


4.1.4 Delete a user group 


1. Click the user groups menu item. 
2. Select the user group you want to delete. 
3. The Edit group window opens, now click the Delete button. Click OK to delete the group, Cancel 


to discard. 
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4.1.5 Create or modify a user 


Example user. 
 
1. Click the users menu item. 
2. Click the Create button to add a user, or select a user from the list to edit.. 
3. Specify a username. 
4. Specify a Password. 
5. Specify the user’s Real name. 
6. Specify the user’s E-Mail address. 
7. Specify a Secret question. 
8. Specify the user’s Secret answer. 
9. Don’t display metadata tabs: If applicable, specify metadata tabs this user is not allowed to see.  
10. You can specify a Date and Time Format for the user. The ‘a’ (for example hh:mm:ss a) stands 


for: AM. 
11. Select the applications the user will be given access to.  
12. Select the user groups the user belongs to. 
13. Specify Authorization level, Tabs allowed to mutate (only visible when the Authorization level > 


Mutate option has been activated), Allowed menu items list and Allowed menu items. 
14. Click Save to save changes, Cancel to discard. 
 


4.1.6 Delete a user 


1. Click the users tab. 
2. Select the user you want to delete. 
3. The View user window opens, now click the Delete button.  
4. Click OK to delete the user, Cancel to discard. 
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4.1.7 Assign super user or administrator rights 


1. Create a Group with superuser or administrator rights: go to user groups > Add > define a group 
and select the Administrators or Superuser option. 


2. Click Save, or Cancel to discard. 
3. Add the user to the Group with superuser/administrator rights: go to users > select the user > 


user groups and add the user to the group with superuser/administrator rights. 
 


4.2 Manage user rights 


Read/write rights for Playout Control (POC), Format Control and Channels are set in GV TX/MAM.  


  
Example user rights. 


A number of users are predefined. 
 
To set read/write user rights for POC, Format Control and/or channels: 
■ Click on user Rights and select or unselect the R/W options per user. 
 


To set user rights for user groups concerning asset types, admin or super user rights and 
TX/Dashboard: 
■ Click user groups. 


 
To set user rights per individual user for GV TX/MAM (such as Authorization Level, Tabs allowed to 
mutate, Allowed menu items list, Allowed menu items, user Groups and read/write rights) and 
TX/Dashboard: 
■ Go to users and click the individual user to edit the user rights. 
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4.3 Manage asset types  


4.3.1 Introduction  


Asset types group assets with the same file type and metadata definition.  
The metadata definition consists of a default and custom part.  In addition to custom metadata 
fields, custom GV TX/MAM tabs can be added. The default tabs are Info and Technical. 
 


Example asset type in GV TX/MAM. 
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4.3.2 Define an asset type 


To create an asset type: 
1. Select the asset type menu option and click the Create button. 
2. Specify the asset type name in the Title field. 
3. Link as essence to type: if applicable, link this asset type as an essence to an asset type. Note: 


from GV Edge version 4.1 not used for subtitles anymore. 
4. Definition XML: to add custom metadata fields for this asset type, add the metadata definition 


here [see paragraph 4.3.3 for an explanation]. 
5. Transfer protocol: Specify a transfer protocol for files of this asset type. Transfer settings 


specify amongst others the storage location and are used by the playout_distri process when 
fetching files from storage for playout.  
 


Use global config: 
Transfer metadata in /system/objects/cobassets/bin/transfer_ftp.xml (as set with the 
/system/objects/cobassets/bin/set.sh script) is used.  
Leave the Transfer metadata field as is: <XML></XML> 
 
FTP  
Select this option if you do not want to use the global settings, but specific transfer 
settings for this asset type.  
Example: 
<XML> 


<FIELD name="username">delta</FIELD> 
<FIELD name="password">delta</FIELD> 
<FIELD name="ip">10.250.51.20</FIELD> 
<FIELD name="port">21</FIELD> 
<FIELD name="path">/system/ftp-mount/txmam-media/</FIELD> 


</XML> 
 


& A warning when specifying the value for the path field in the transfer xml:  
Paths that start with a slash will be interpreted as an absolute path. Be sure that when 
specifying an absolute path that this path is accessible by a FTP-client and the given 
user/password. This can be tested using the standard FTP command-line client by 
trying to change the directory to the desired absolute path after logging in (e.g. “cd 
/mydata/media”). The standard FTP command-line client is called “ftp”.  


 
LOCAL:  
Files are stored on the GV TX/MAM server.  
Leave the Transfer metadata field as is: <XML></XML> 


 
The GV Edge Smart Playout Center Commissioning and Engineering Manuals describe the Ingest 
process and configuration of the Storage Server in more detail. 
 
1. Required: not active. 
2. Quality Check required: not active. 
3. Select the File extension for assets of this type. This file extension will be added to files that are 


added to this asset type. 
4. Select the TX Statuses and asset jobs that you want to link to this asset type.  
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& Note that asset jobs and TX Statuses must match. 


 
5. Specify the Format that will be linked to Events when an asset is Plain/CTRL/SHIFT/ALT + 


dragged into a POC-Playlist. Use the dummy DFLT format when you do not want to link a fixed 
Format. 


 
In GV TX/MAM, Formats are linked to asset types. A dummy Format is available in the Smart Playout 
Center installation: DFLT. This Format can be used if you do not want to link a fixed Format to an 
asset type. Events will initially be scheduled with this dummy Format. Then Format Control can be 
used to apply Formats when the Playlist is activated. 
Formats can also be linked to Events in the Schedule [see the Schedule Importer user Manual]. The 
Format defined in the Schedule will overwrite the Format linked to the Event’s main asset type, if 
applicable. 
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4.3.3 Customize the asset type’s metadata definition  


The example below shows the custom metadata fields for an asset type:  
<XML> 


<WINDOW width="535" height="200"> 


  <PAGE name="Info"> 


    <LABEL x="10" y="27" height="20" width="80">Title:</LABEL> 


    <TEXTFIELD name="title" x="100" y="25" height="20" width="200" search="true"></TEXTFIELD> 


    <LABEL x="10" y="57" height="20" width="80">Description:</LABEL> 


    <TEXTAREA name="description" x="100" y="55" height="40" width="400"></TEXTAREA> 


  </PAGE> 


  <PAGE name="Technical"> 


    <LABEL x="10" y="27" height="16" width="80">Media type:</LABEL> 


    <COMBOBOX name="media_type" x="100" y="25" height="20" width="120" 


search="true">#13MPEG2-SD#13MPEG2-HD</COMBOBOX> 


    <LABEL x="10" y="57" height="16" width="80">Aspect ratio:</LABEL> 


    <COMBOBOX name="aspect_ratio" x="100" y="55" height="20" width="120" 


search="true">#134:3#1316:9 Anamorphic#1316:9 Letterbox</COMBOBOX> 


    <LABEL x="10" y="87" height="16" width="80">Loudness:</LABEL> 


    <LABEL x="20" y="107" height="16" width="80">Momentary:</LABEL> 


    <TEXTFIELD name="momentary_loudness" x="100" y="105" height="20" width="45" 


search="true"></TEXTFIELD> 


    <LABEL x="20" y="127" height="16" width="80">Integrated:</LABEL> 


    <TEXTFIELD name="integrated_loudness" x="100" y="125" height="20" width="45" 


search="true"></TEXTFIELD> 


    <LABEL x="20" y="147" height="16" width="80">Range:</LABEL> 


    <TEXTFIELD name="loudness_range" x="100" y="145" height="20" width="45" 


search="true"></TEXTFIELD> 


  </PAGE> 


</WINDOW> 


</XML> 
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Following tags, controls and attributes are available:  
Tags 


XML These tags are mandatory and start and end the xml-definition. 
Example: 
<XML> <WINDOW width="400" height="300" 
scrollwidth="300" 
scrollheight="250">controls</WINDOW> </XML>  


WINDOW Defines the window size (mandatory).  
A scrollbox can be defined (optional).  
Example: 
<WINDOW width="400" height="300" scrollwidth="300" 
scrollheight="250">controls</WINDOW>  


PAGE Use to define custom tab pages. The default GV TX/MAM tabs are 
Info and Technical.  
Example: 
<WINDOW width="400" height="300" scrollwidth="300" 
scrollheight="250" > <PAGE 
name="tab1">controls</PAGE> <PAGE 
name="tab2">controls</PAGE> </WINDOW>  


Controls 


CHECKBOX Defines a checkbox.  
Example:  
<CHECKBOX name="checkbox" x="90" y="90" height="100" 
width="100" search="false">label</CHECKBOX>  


COMBOBOX  Defines a combobox. Items in the definition must be separated by 
"#13" (see the example below). As a default, the first item is selected. 
Example: 
<COMBOBOX name="combobox" x="90" y="155" height="20" 
width="62" 
search="true">line1#13line2#13line3#13line4</ 
COMBOBOX>  


DATETIMEPICKER Defines a date or time picker depending on mode (0=date, 1=time). 
The format is optional and depends on the mode used (date or time). 
Default modes are "yyyy-MM-dd" for dates and "HH:mm:ss" for time. 
Example: 
<DATETIMEPICKER name="datetimepicker" x="90" y="70" 
height="20" width="50" 
search="false"format="hh:mm:ss">1</DATETIMEPICKER>  


 


LABEL Defines a text label.  
Example: 
 <LABEL name="label" x="71" y="2" height="20" 
width="40">label</LABEL>  


SPINEDIT Defines a counter spin.  
Example: 
<SPINEDIT name="spinedit" x="90" y="50" height="20" 
width="62" search="false"></SPINEDIT>  
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TEXTAREA Defines a text input box. Max can be used to limit the amount of 
characters that can be used.  
Example:  
<TEXTAREA name="textarea" x="90" y="0" height="100" 
width="255" search="false" max="20"></TEXTAREA> 


TEXTFIELD Text input field (single line). Max can be used to limit the amount of 
characters that can be used.  
Example:  
<TEXTFIELD name="textfield" x="90" y="0" height="20" 
width="40" search="true" max="20"></TEXTFIELD>  


 


TIMECODE Timecode is a specific time format hh:mm:ss:ff, hours, minutes, 
seconds and frames.  
Example: 
<TIMECODE name="timecode" x="90" y="90" height="100" 
width="100" search="false"></TIMECODE>  


 


Attributes 


x,y, width, height These attributes define position and size of the metadata fields.  


Max Defines the maximum number of characters allowed for text inputs.  


Name Defines the column title in GV TX/MAM.  


Searchable Metadata fields are only searchable if "search=true".  


ID Defines the drag order of columns: the attribute: id="0", id="1", id="2" 
etc. defines the order of columns when dragging assets to Playout 
Control. 
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4.4 Manage folders 


4.4.1 Introduction 


In TX/MAM, Inboxes and Outboxes can be configured. Inboxes (watch folders) are automatically 
checked for files. Based on a number of options described in more detail in paragraph 4.4.2, files in 
the Inbox are then automatically ingested.  
 
Each Folder is linked to a user Group and asset type. Files imported from the Folder are linked to 
assets for the specified user group and asset type. Assets are automatically related to the Folder 
asset type.  When ingest has completed, files are moved from the Inbox. 
Files and assets are linked based on the filename (the first part before the file extension) and the 
asset’s external reference.  
 
Outboxes are used to export files or assets to an outbox directory on the Storage server. Outboxes 
are linked to a user Group. Only users in the specified user Group are allowed to export to that Folder. 
Both Inboxes and Outboxes can be configured on the Storage Server (FTP watch folder), or are 
locally available on the GV TX/MAM server, mostly via a mount on the Storage Server. Both Inboxes 
and Outboxes are linked to a user group. 
 


& See also chapter 9 for an explanation of the ingest workflow. 


Example Folder definition. 
 


& Configuration of the Storage server is described in more detail in the Commissioning Manual. 
& The Unregistered box is not used at the moment. 


 


4.4.2 Add a GV TX/MAM folder 


1. Go to Folders and click the Add button. 
2. Specify the Folder Name. 
3. Select the Folder type.  
4. Select the user group that has access to the Folder. 
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5. Specify the Folder path, either on the Storage server or locally on the GV TX/MAM server 
(mount).  


6. Allowed extensions: file types that will be imported, separated by a comma. For example: 
tga,TGA. Other file types will be moved to a failed directory.  


7. Specify the File check interval in seconds. 
8. Select applicable Folder options: 


a. Create new assets:  
If this option is activated, when a file is ingested (automatic ingest via an Inbox) and the 
related asset (based on external reference) does not exist yet, an asset is created with the 
following properties: 


i. the asset type defined for the Folder 
ii. transfer metadata is filled in 


iii. the external reference is set 
If this option is not activated, no asset is created and the file will not be ingested.  
 


b. Allow reingest:  
If this option is activated, when a file is ingested and the related asset (based on external 
reference) already exists, the file will be ingested and will replace the original essence.  
If this option is not activated, the file will not be ingested. 
 


c. Allow update asset type:  
If this option is activated, when a file is ingested and the related asset (based on external 
reference) already exists but as a different asset type than the folder asset type, the file can 
be ingested as the folder asset type if this option is activated. The asset type is updated to 
the Folder’s asset type. 
If this option is not activated, the file will not be ingested. 
 


d. Create imported file:  
The imported directory contains files for all assets that have been ingested. Note that the 
Create imported file option should be activated in GV TX/MAM for the folder to enable this 
functionality. 
When a file is ingested, a file is created in the imported directory with a name that contains 
the asset’s external reference, size, time and date of ingest if this option I activated. When 
this option is not activated, the imported file is not created. By default, these ‘imported’ files 
are deleted after 48 hours. 


 
9. Asset type: select the appropriate asset type.  
10. Click Save to save changes, Cancel to discard. 
 


4.5 Manage menu items 


4.5.1 Introduction 


Custom menu items can be added to the left hand menu. Custom menu items define a view on 
assets in the GV TX/MAM database, based on a query. The example below shows a Menu item Music 
video, followed by a number of example queries. 
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Example definition of menu item Targa. 
 


Example query showing assets with asset type ID 14. 
select id from asset_element where asset_element_type-id=14 
Explanation: asset_element_type-id=10 means asset type with ID=10. 
 
Example query showing video files that have not been ingested yet: 
select id from asset_element where status_int<>1 and file_extension='avf' 
Explanation: 


• status_int = 1 means that the file has been ingested; 


• avf is the default file_extension for video files in GV TX/MAM. 


Example query showing the assets that are scheduled in the future. 
select id from asset_element where updated_date > :today 
Explanation: the field updated_date corresponds with the last scheduled date, so this query will show 
assets that are scheduled in the future. 
 
Example query showing video files that have not been ingested and are scheduled in the future. 
select id from asset_element where status_int<>1 and file_extension='avf' 
and updated_date > :today 
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4.5.2 Add or edit a menu item 


1. In the left hand menu, click Menu items. The Menu items list opens. 
2. To add an item, click the Add button, to edit an item click the menu item you want to edit. 
3. Specify the Menu name as will be displayed in the menu. 
4. In the Insert query.. field, specify a query to filter the assets you want show. 
5. Specify where to place the new item in the menu in Add after... 
6. Select the Focus tab, this is the tab that will be active when opening the menu item. 
7. Select the tabs that will be visible when opening the menu item in Visible tabs.  
8. Sort assets by the metadata field selected here.  
9. Specify a Sort direction for the assets, ascending or descending. 
10. Click Save to save changes.  
 


4.5.3 Delete a menu item 


1. In the left hand menu, click Menu items. The Menu items list opens. 
2. Click the item you want to delete. 
3. Click the Delete button. 
4. Click OK to delete, Cancel to discard. 


 


4.6 Manage jobs, TX values and statuses 
4.6.1 Introduction 


GV TX/MAM lets you define asset jobs and procedures, for example: 
• a job to create a low resolution browse copy of files 
• a procedure to retrieve the asset’s file transfer status 
 
Jobs and procedures can be linked to asset types and will then automatically be executed for all 
assets of that type. 
The picture below shows the jobs and statuses linked to asset type ‘Music Video’: 
• A job Browse copy to create a low resolution copy of files.  


The status Browse created will be displayed in the asset list’s tx_status column. 
• A job Get media info, used to retrieve info about file duration and type.  


This info can then be displayed in the asset list. 
• A status asset ingested that uses a procedure to retrieve information about assets’ file transfer 


status.  
The status asset ingested will be displayed in the asset list’s tx_status column. 


Example asset type with linked jobs and statuses. 
 
TX Statuses are displayed in the asset list’s tx_status column. The example below shows the asset 
list for asset type Music Video. The tx_status column shows the statuses Browse created and asset 
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ingested for each asset.  Info retrieved with the Get media info job is displayed in the DURATION 
column. 
 


Example asset overview. 
 
The Jobs- tab for an asset of the list shows the status of jobs Get media info and Browse copy. Note 
that the Job status can be manually changed. Jobs can be manually executed if this option is 
enabled in the job configuration.  


 
Example Jobs tab. 


& A number of jobs and procedures are configured by default in GV TX/MAM.  
& Job configuration is described in more detail in the Commissioning Manual. 


 


4.6.2 Statuses and values 


Each status is linked to a procedure or Job and can have a number of values. Values can be 
customized. Each value has an ID. Jobs and procedures refer to these IDs. This is explained in more 
detail on the next pages. 
 


Example values in GV TX/MAM.  
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The example below shows the configuration of status Browse created. This status is linked to job 
Browse copy. Possible values for this status are Ok, Failed and New. 


Example TX Statuses. 
 
The status asset ingested? uses a procedure STATUS_ASSET_INGESTED to retrieve information 
about the asset file’s status (Empty, OK or Failed). Procedures can be used to retrieve asset status 
information from the GV TX/MAM database.   
 
RECREATE PROCEDURE STATUS_ASSET_INGESTED ( 
  ID Integer 
) 
RETURNS ( 
   CODE Integer,STATUSINT Integer 
) 
AS 
    
  
BEGIN 
  FOR SELECT STATUS_INT FROM ASSET_ELEMENT WHERE ID = :ID INTO :STATUSINT 
  DO 
  BEGIN 
    IF ((STATUSINT = 3) OR (STATUSINT = 0)) THEN 
      CODE = 1; 
ELSE IF ((STATUSINT = 1) OR (STATUSINT = 100)) THEN 
      CODE = 2; 
    ELSE 
      CODE = 3; 
  END 
END 
 


& Note how the codes refer to the TX values: code 1=empty, 2=Ok and 3=failed.  
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4.6.3 Workflow defining Jobs 


The steps for defining a Job are: 
1. Define TX Values. 
2. Define the asset job. 
3. Add a TX Status and link to the asset job, or specify a procedure. 
4. Link asset types, jobs and statuses. 


Example TX Statuses 
  


4.6.4 Create or modify TX Values 


1. In the left hand menu, click TX Values. The TX Values list opens. 
2. To add an item, click the Add button, to edit an item click the value you want to edit. 
3. In the Title field, specify the name for the value.  
4. To change or select an image, click the Browse button to select a TX Image and/or ES Image. 


You can use .gif and .png images. 
a. The TX Image is displayed in the tx_status column. 
b. The ES Image is displayed on the Essences tab. 


5. Click Save to save changes.  
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4.6.5 Define asset jobs  


1. In the left hand menu, click asset jobs. The asset jobs list opens. 
2. To add an item, click the Add button, to edit an item click the job you want to edit. 
3. In the Name field, specify the name for the job.  
4. Job definition: job configuration is described in the FTP-server user Manual. 
5. Under Manual exec select Yes if it should be possible to manually execute the Job.  
6. Add a short job description in the Description field. 
7. Select Possible values this job can have. 
8. Select the Default TX-status value. 
9. Click Save to save changes, Cancel to discard. 
 


4.6.6 Define TX Statuses 


1. In the left hand menu, click TX Statuses. The TX Statuses list opens. 
2. To add an item, click the Add button, to edit click the item you want to edit. 
3. In the Title field, specify the name for the status.  
4. Now either; 


a. Select an asset job config. 
b. Select a status procedure. 
c. Select the New procedure option and define a procedure in the Procedure content field.  


5. You can add a description of the status in the Description field. 
6. In the Order field you can specify in which order you want to display statuses in the tx_status 


column. 
7. Select Possible values for this status. 
8. Click Save to save changes, Cancel to discard. 
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5 Manage assets 
You need appropriate user rights to work with assets. The superuser or administrator role can assign 
these rights. 
 


5.1 Customize the asset list 


The columns in an asset list show the metadata fields defined for assets of that type. To display 
additional columns: 
■ Right-click the list. 
■ Select the columns you want to add. 


 


Example customize columns. 
 
To change the number of items listed or go to another page, use the options at the bottom of the list. 


 
 


Click the  icon to refresh the list. 
 
 
Create assets 
All assets To create an asset, in the menu, select the All assets or a custom asset list. 


 


Click the Create button. 


user group Select the user group that will have access to this asset. 


type Select the asset type the asset belongs to.  
Note that only the asset types linked to the user group selected in the previous field are 
listed here. 


Category Not used. 
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External 
reference 


Specify the asset’s external reference.  


Create Click Create to create the asset, Cancel to discard. 


 


5.2 Edit asset metadata 
To view or edit an asset's metadata fields: 
1. To edit an asset, select the asset on the All assets or a custom asset tab to open, then select the 


applicable metadata tab. 
2. Edit the metadata fields. 
3. To save changes, click Save. 
 


5.3 Share assets 
Assets are linked to a user Group, but can be shared with other Groups. 
To share assets with a user Group: 
1. Open the asset and go to the Sharing tab. 
2. Select the user Group you want to share the asset with and click Share. 


The status of the asset changes to: Pending. 


Example asset being shared with user Group Customer 2. 
 


Example asset pending for acceptance. 
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Example asset pending for acceptance in the Customer1's share Outbox. 
 


Example asset pending for acceptance in Customer2's share Inbox. 
 


To accept an asset that has been shared with your user Group: 
1. Go to the Inbox > share Inbox. 
2. Click the   icon to accept the asset, click the  icon to decline.  
 
Once accepted, the asset disappears from the Inbox and is added to the asset list. 


Example asset accepted as shown in Customer1's share Outbox. 
 
■ You can remove an asset from the share Outbox with the  icon. 
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5.4 Asset search 


To search for specific assets, click the Search option in the menu on the 
right. Several filter options are available, including search by asset type, 


metadata field or status. 


Example search options 
 


5.5 Filter the asset List 
The asset list can be filtered based on a number of criteria (asset type, field, TX status 
and user group).  
Select the filter you want to use and click the Filter button. 


Example filter options 
 


5.6 Delete assets  


This option will delete both the asset info and related files (Essences).  
Select the asset and then in the top right corner toolbar click the Delete option. 
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5.7 Spotcheck and segmenting (soft parts)  


Use the Spotcheck function to preview the quality of low-res clips or animations via the GV TX/MAM 
web browser and to create soft part segments. 
 


Example Spotcheck tab. 
 


& Since 4.2.1, a new HTML 5 web player has been introduced, which is much faster. The browse 
copy of an asset should be re-created in order to make use of this player. Please contact support 
for more information about this subject. 


 


5.7.1 Spotcheck (QC) 


1. Open the asset you want to view and go to the Spotcheck tab. 


2. Click the  icon for the clip, animation or segment you want to preview. 
3. Use the control buttons, shuttle control and timeline to navigate through the clip. 
4. When finished, click the appropriate QC status icon (the default icons are listed below): 


  


 
This file has not been checked. 


 
This file has been checked and quality was good. 


 
This file has been checked and quality was not good. 
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5.7.2 Create segments 


Example segmenting tab. 
 
To create a new segment: 
1. Select the asset you want to trim, then select the Spotcheck tab. 


2. Click the  icon. 
3. To create a segment with a new external reference, specify an external reference in the 


External_ref field. 
4. Use the control buttons, shuttle control and timeline to navigate through the clip. 


5. Click the tc-in   and tc-out  buttons to set timecode in and out. 
6. Click Save to save. 


 
To add a segment named <external reference>+<suffix>, for example musicclip-1: 
1. Use the control buttons, shuttle control and timeline to navigate through the asset. 


2. Click the tc-in   and tc-out  buttons to set timecode in and out. 
3. Select (new) in the dropdown list. 
4. Click Save Segment. 
5. Select a suffix > OK. 


 
To modify an existing segment:  
1. Use the control buttons, shuttle control and timeline to navigate through the clip. 


2. Click the tc-in   and tc-out  buttons to set timecode in and out. 
3. Select the segment from the dropdown list > Save Segment.  
 


& Segments can be scheduled (drag and drop into POC using the  icon), but are not listed in 
the assets list. 
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5.8 Hardware preview 
The GV TX/MAM HW-preview allows you to play out clips on a GV Edge Channel and to preview in GV 
TX/MAM.  


 
To preview: 
1. In GV TX/MAM, select a clip and go to the Spotcheck tab. 


2. To load the clip, in the player panel, click the  button. 


3. To switch to HW-preview, stop playout by clicking the button. 
4. Click the HW-button and open the dropdown menu, select a Channel. 


5. Click the  button to start HW-preview. 
 


& Note how the HW-button turns orange when in HW-mode, as shown in the example below. 


 
In HW-preview mode the shuttle slider, step, fast forward and go-to-end/beginning options are not 
active. Also note that preview in GV TX/MAM and on the output are not in sync. 


1. To stop HW-preview, stop playout by clicking the  button. 
2. Click the HW-button and open the dropdown menu. 
3. Select Disable. 


 
When a new clip is loaded, GV TX/MAM automatically switches to spotcheck-mode. Note how the 
HW-button turns grey when in normal spotcheck-mode. 


 
Configuration of HW-preview channels is described in the Commissioning Manual. 
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5.9 Work with asset jobs 


To view the Jobs linked to an asset: 
1. Double click the asset, then select the Jobs tab. Information on the Jobs tab includes status, job 


start date and time and description. 
 
To manually change the status of a Job: 
1. In the tx_status column, click the  icon and select the appropriate status. 
2. Click Ok to confirm changes, Cancel to discard. 
 


 
Example Change Job status window. 
 
Setting the Job status to New and the Job progress will force the Job to be restarted. This can also 
be done by manually executing a Job, if this option is configured for that Job.  
 
To manually execute a Job: 
■ In the Manual Exec. column, click the  icon. Note that this option has to be configured.  


 


5.10 Export assets and files 


To export Essence files to the FTP-server: 
• Go to the asset's Sharing tab > Export. 


Files will be exported to the specified outbox on the Storage server. The Outbox menu shows the 
assets which are exported. Assets are removed from the Outbox when transfer has completed.  


 


To export asset info as a CSV-file: 
1. Open the applicable assets list. 
2. Click the Export Part option to export the current page to a given location. 
3. Click the Export All option to export the list to a given location. 
 


& The columns which are shown in the asset list are exported to the csv-file. 
& You can select multiple assets in the asset list using the check box, then export. 


 


5.11 Add messages to assets 


To add comments to an asset: 
1. Enter information in the message box and then click SEND.  


Comments will be displayed in the asset window. 







 


K2 TX/MAM 2.7 for GV Edge: User Guide  071893901 48 


2. Click the  icon to remove a message. 


 Example message displayed on the Essences tab. 
 


5.12 History 


Use this option to view an asset's history, or to add comments to an asset. To display: 
■ Double click the asset, then select the History tab. 
 


5.13 Profile 


 


Use this option to modify your user's credentials or email address. To edit: 
1. Log in with the user you want to edit. 
2. Click the Profile option, then modify properties. Note that credentials are case 


sensitive. 
3. Click Save to save changes. 


 


5.14 About 


 


Show versions and release notes. 


5.15 Ingest files 
Files are ingested via predefined Inboxes. This is a super user or administrator task. 
The ingest workflow is described in chapter 9. 
 


The Commissioning and engineering Manuals describe configuration and administration of the 
Storage server. 
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6 Manage channels 
6.1 Introduction 


Define and manage Channels in GV TX/MAM. The Channel definition is used by the Cobalt 
processes. 
Create a Channel definition for each Channel that you will use and for both the main and backup GV 
Edge nodes. Default Channels are preconfigured (for the main playout). 
 


6.2 Define channels in GV TX/MAM 
1. In the menu, select Channels and click Add. 
2. Select a user group. 
3. Specify an External reference. 
4. Click Create to create the Channel, Cancel to discard. 
5. Edit the Channel as described in the next paragraph. 


 


6.3 Edit channels in GV TX/MAM 


■ To edit a Channel, in the menu select Channels, then select the Channel you want to edit. 
 


On the Info tab: 


Example of a channel configuration in TX-MAM 
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Info 
• Select a user group from the dropdown menu. 
• Channel name: specify a Channel name  
• Playout server ip: the IP-address of the GV Edge playout node (main or backup) this Channel will 


run on. 
• Server port: the playout server port, default 5020 
• Broadcast set: select the appropriate broadcast set: 


Channel Broadcast set 
Single HD/SD 1:broadcast0 
Simulcast 1 of 2 (HD) 1:broadcast0 
Simulcast 2 of 2 (SD) 1:broadcast0 
Preview 2:broadcast1 
Record 4:broadcast3 
JIP 5:broadcast4 


• Opt out: not used  
• Timecode format: select the timecode format for this Channel 
• Is Simulcast: used for JIP only in a simulcast configuration 


 
Playout distri 
• Look ahead (in hours): look ahead time for the playout_distri process in hours 
• Error lookahead (in hours): look ahead time for errors: main Events between current time and 


current time plus error look ahead time are checked 
• Alarm threshold (in minutes): not used 
 
Sequencer 
• Trigger delay (in frames): trigger delay in frames for manual Events  
• Virtual channel: check to specify: no sequencer  
• Disable scenegraph preload: used for JIP, enable for JIP-channel 


 
Schedule sync 
Only fill in this section when you are configuring a backup Channel. 
• Sync with: select the Channel this backup Channel will sync with 
• Look ahead (in hours): look ahead time in hours  
• Accumulate messages: update messages from schedule syncer, in minutes. Messages are 


logged to /var/log/schedulesync.log. 
 
Join In Progress  
• JIP with: only specify when defining a JIP-channel. Select the Channel to JIP with; this should be 


the primary Channel (broadcast set 0). 
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On the System tab: 


Example of a channel configuration  
 
Cache remove 
• max disk usage: in %  
• keep played assets: keep played assets on playout system for <hours>  
• asset cache timeout: keep transferred assets in cache for <seconds> 


 
Transfer speed 
• overall: transfer speed between playout system and GV TX/MAM database in Mb/s 
• partner system: check to use partner system with ip: partner system ip  
• media name: name of the transfer location (optional) 
• check error events: number of error Events that playout_distri re-checks in each cycle, before 


skipping to new Events  
 


Forced distri 
• forced criteria: specify forced files. Forced files are not removed from the playout system.  


Syntax: criterion 1:criterion n. Specify a metadata field or asset type (as defined in GV TX/MAM). 
Place asset types between [assettype].  


• using original filename for: use this option if you want to use the original name for forced files.  
Syntax: criterion 1:criterion n. Specify a metadata field or asset type (as defined in GV TX/MAM). 
Place asset types between [assettype].  


• interval: interval between checks in minutes (>30) 
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Playout distri 
• log level: select a log level. Messages are logged to /var/log/playout_distri.log. 
 
Click the Save button to save changes.  
 


& Note that after changing a Channel name, user rights for the Channel have to be set again.  


 


6.4 Edit the channel asset type 


■ To edit the Channel asset type, in the menu select Channels and click the 
configure icon. 


■ Edit applicable fields and click Save to save changes. 
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7 Manage flags 
Define Playout Control (POC) Flags in GV TX/MAM. 


Example flags definitions. 
 


Example adding a new flag. 
 
1. Select Flags > Create to add a flag, or select a Flag to edit. 
2. Specify a Name, Mask and select an Image. 
3. Check the active option to activate the flag; the flag will be displayed in POC. 
4. Click Save to save changes, Cancel to discard. 
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8 Appendix: Quick Reference 
8.1 Toolbar 


 


Create item. 


 


Add item. 


 


Delete item. 


 


Filter assets in the asset list. 


 


Save item. 


 


Close item. 


 


Search option. 


 


Edit profile (current user). 


 


Cancel option. 


 


Logout. 


 


Version and release info. 


 


8.2 Export options in the assets list 


 


Export all assets in the list to a CSV-file. 


 


Export assets on the current page to a CSV-file. 


 


8.3 Assets 
8.3.1 Info, technical and other custom metadata tabs 


These tabs show metadata info as defined in the metadata definition. 


 


To edit, edit fields, then click Save. 
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8.3.2 Essences tab 


Tx-status The status of file ingest. Note that these status icons can be customized. 


Tc_in Timecode in. 


Tc_out Timecode out. 


Duration File duration in hh:mm:ss:ff. 


Filesize File size 


 Indicates the status of a file’s quality check (spotcheck).   
Note that these status icons can be customized. The default icons are: 


 


This file has not been checked. 
This file has been checked and quality was good. 
This file has been checked and quality was not good. 


 
Click to edit the essence. 


 


8.3.3 Spotcheck tab 


 
Drag a file or segment into POC to schedule an Event. The Event is scheduled with the 
default Format.  


External_ref External reference, click to edit. 


Tx-status The status of file ingest. Note that these status icons can be customized. 


Tc_in Timecode in. 


Tc_out Timecode out. 


Duration File duration in hh:mm:ss:ff. 


 Indicates the status of a file’s quality check (spotcheck).   
Note that these status icons can be customized. The default icons are: 


 


This file has not been checked. 
This file has been checked and quality was good. 
This file has been checked and quality was not good. 


 
Click to start a (low-res) preview. 


 
Click to edit an essence or segment. 


 


 
Use the control buttons, shuttle control and timeline to navigate through the clip. 


 
Click the tc-in  button to set timecode in. 
 


 
Click the tc-out button to set timecode out. 


 


Click to set a QC-status for the selected file or segment. 
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8.3.4 Jobs tab 


Shows the Jobs linked to an asset and their status. 
Tx-status Job status. Note that Job statuses can be customized. 


 Click to manually change the Job status. Note that the status is changed, but the Job is not 
re-executed. 


STARTED Start date and time for this Job. 
Manual Exec 


 


Jobs can only be manually executed if this option is configured. If so, the tool-icon is listed in 
this column. Click to execute the Job. 


 


8.3.5 Sharing tab 


Assets can be shared or exported on the Sharing tab. When shared, this tab shows if the asset has 
been accepted. 


 


Share an asset with another user Group, see chapter 5.3 for an explanation. 


 


Export an asset’s Essence files to the FTP-server, see chapter 5.10 for an explanation. 


8.3.6 History tab 


The asset’s History lists the asset Jobs or user actions performed for the asset. 
 
 


8.4 Asset type pane 


Option Description 


Title The asset type name. 


Link as essence to type  If applicable, link this asset type as an Essence to an asset type.  


Definition XML The asset type’s custom metadata definition. 


Transfer protocol 
 


Specify a transfer protocol for files of this asset type. Transfer settings specify 
amongst others the storage location and are used when fetching files from 
storage. 


Required Not implemented. 


Quality Check Required Not implemented. 


TX Statuses 
Asset jobs 


Select the TX Statuses and Jobs that apply for assets of the type defined here. 
Note that asset jobs and TX Statuses should match. 


Plain/CTRL/SHIFT/ALT drag 
Format 


Specify the Format that will be linked to Events when an asset is 
Plain/CTRL/SHIFT/ALT-dragged into a POC-Playlist. If you do not want to link a 
fixed Format, use the DFLT dummy Format. 


Save Click to save changes. 
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8.5 User group pane 


Option Description 


Name User group name. 


Description Description of the user Group. 


Administrators Activate to assign administrator rights to the Group. 


Superuser Activate to assign superuser rights to the Group. 


Asset type Select the asset type(s) this user Group has access to. 


TX/Dashboard  Select the TX/Dashboard options this user Group has access to. 


Save Click to save changes. 


 


8.6 Users pane 


Option Description 


Username username. 


Password Password. 


Real name The user’s real name. 


E-Mail The user’s e-mail address. 


Secret question Secret question. 


Secret Answer Secret answer. 


Don’t display metadata.. If applicable, specify metadata tabs this user is not allowed to see, comma 
separated. 


Date Format Select a data format for this user. 


Time Format Select a time format for this user. 


Applications Applications the user is authorized for: 


Aser groups Select the user Group(s) the user belongs to. 


Authorization level 


Create The user is allowed to create assets. 


Read The user has read rights for the asset folders. 


Delete The user is allowed to delete assets. 


Mutate The user can edit allowed tabs [see below]. 


Download The user is allowed to export files. 


Upload The user is allowed to accept shared assets. 


Allow Drag&Drop The user is allowed to drag assets into POC.  


List Export The user is allowed to export assets from an asset list. 


Allowed menu items (list) 


<Menu items> Select the Menu items the user has access to. 


 
  







 


K2 TX/MAM 2.7 for GV Edge: User Guide  071893901 58 


Tabs allowed to mutate (only available when the Mutate option is active) 


Metadata The user is allowed to edit metadata. 


Essences The user is allowed to view essences. 


Spotcheck The user is allowed to perform Quality Checks and soft parting. 


Jobs The user is allowed to view and change job statuses. 


Sharing The user is allowed to share assets. 


Save Click to save changes. 


 


8.7 Menu items pane 


Example menu item pane. 
 
Option Description 


Menu name Name of the menu item (as will be displayed in the menu). 


Insert query .. Specify a filter query here. 


Add after .. Specify the menu order here. 


Focus tab The tab that will be active when opening the menu item. 


Visible tabs The tabs that will be visible when opening the menu item. 


Sort by Sort assets by the property selected here.  


Sort direction assets sort order; ascending or descending. 


Save Click to save changes. 
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8.8 Folders pane 


Example of a Folder pane 
 
 
Option Description 


Name The Folder name. 


Folder type The Folder type: 
(Inbox) FTP watch folder: not implemented. 
(Inbox) Local FTP folder 
(Outbox) FTP push folder: not implemented. 
(Outbox) Local push folder 
Explanation: 
Watch folder: this folder is automatically checked for files for ingest. 
Push folder: files can be (manually) exported to this folder. FTP: folder 
on the GV Storage Server. 
Local: folder on the GV TX/MAM server, mostly via a mount on the 
Storage Server. 


User group The user Group that has access to the folder. 


Folder path Folder path. 


Allowed extensions File types allowed in this folder.  


File check interval Interval in seconds at which the folder is checked for files. 


Folder options 


Create new assets  When a file is ingested (automatic ingest via an Inbox) and the related 
asset does not exist yet, an asset is created if this option is activated.  
(Files and assets are linked based on the asset’s external reference. 
This is the filename without extension.)  
The asset will have following properties: 
The asset type defined for the folder; 
transfer metadata is filled in; 
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The external reference is set. 
If this option is not activated, no asset is created and the file will only be 
ingested if the asset already exists.  


Allow reingest   When a file is ingested and the related asset (based on external 
reference) already exists and has content, if this option is activated the 
file will be ingested.  
If this option is not activated, the file will not be ingested. 


Allow update assettype When a file is ingested and the related asset (based on external 
reference) already exists but has a different asset type than the folder 
asset type, if this option is activated the file can be ingested with the 
folder asset type. 
 
If this option is not activated, the file will not be ingested. 


Create imported file Select to create ‘imported’ files. 


Asset type Assets are automatically added to the asset type specified here.  


Save Click to save changes. 


 


8.9 TX Values pane 


Example TX Values window. 
 
Option Description 
Title The value’s name. 
Image Select the image you want to link to this status. 
TX Image To change or select an image, click the Browse button to select a TX 







 


K2 TX/MAM 2.7 for GV Edge: User Guide  071893901 61 


ES Image Image and/or ES Image. You can use .gif and .png images. 
The TX Image is displayed in the tx_status column. 
The ES Image is displayed on the Essences tab. 


Save Click to save changes. 
 


8.10 TX Statuses window 


Option Description 


Title Specifies the name for the status. 


asset job config 
Status procedure 
Procedure content 


Either: 
Select an asset job config. 
Select a status procedure. 
Select the New procedure option and define a procedure in the 
Procedure content field.  


Description Status description. 


Order Specifies in which order statuses are displayed in the tx_status column. 


Possible values Possible values for this status. 


Save Click to save changes. 


 


8.11 Asset jobs window 


Example asset jobs window. 
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• Select Possible values this job can have. 
• Select the Default TX-status value. 
• Click Save to save changes, Cancel to discard. 
• In the left hand menu, click TX Statuses. The TX Statuses list opens. 


 
Option Description 
Name Specifies the name for the Job. 
Job definition Job configuration is described in the FTP-server user Manual. 
Manual exec.  Select Yes if the job should be manually executable.  
Description A short Job description. 
Possible values Select the values this Job can have. These possible values are shown 


when editing the job status. 
Default TX-status value Select the default TX-status value. The default is used when a new 


asset is created. 
Save Click to save changes. 
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9 Appendix: The GV Edge Workflow 
 


 
The integrated GV Edge playout systems and applications are: 
• GV Edge server: Linux-based, software-centric, automated, multichannel, integrated Playout 


Server. Brings all of the components of integrated playout together in a unified system: media 
playout, channel graphics, asset management and automation. 


• GV TX/MAM server: contains the GV TX/MAM database. 
• Playout control: manage and create on-air and off-air Playlists. 
• Channel Composer: create the static and animated, 2D and 3D on-air look of Channels. 
• GV TX/MAM: asset management; create and control assets. 
• Storage: media files storage. 
• GV TX/MAM dashboard: manage the GV Edge services. 
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9.1 Assets 


Asset info is created in GV TX/MAM, or imported. asset info is stored in the GV TX/MAM database.  
Asset files (Essences) are ingested and stored on the Storage server.  
Files and assets are linked based on the asset’s External reference, as shown below: 
Example asset 


Original Filename  External reference assetID Filename in GV 
TX/MAM 


abc123.mpg abc123  153 a0000153.avf 


 
Media files are renamed to a0000<assetID>.<file extension> (7 digits) during ingest. 
The file extension for clip files is renamed to .avf. 
Example: a0000153.avf 
 
When a schedule is imported and assets in the schedule do not yet exist, empty assets are created.  
 
When a Playlist is activated, the playout_distri process will check if asset files are still in cache on the 
playout node. If not, files are fetched from the Storage-server and transferred to the playout 
directories on the GV Edge.   
 


9.1.1 Creating assets via GV TX/MAM 


 
■ Assets (asset info) are created in GV TX/MAM. Until a file has been ingested, these assets are 


called empty assets. 
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9.1.2 Creating assets via Schedule Import, Ingest via the Inbox 


 
 
■ Schedules are imported via POC.  If assets referenced in a schedule do not exist, an asset with 


an External reference is created and applicable custom metadata info is added (empty asset). 
 


& Asset info can be created, but cannot be updated via schedule import. This should be done via the 
GV TX/MAM interface. 


■ Files are ingested via the Inbox. Assets and files are linked based on External reference. If the 
Asset does not yet exist in the GV TX/MAM database, an asset is created. 


 


9.1.3 Ingest via the Inbox, creating assets via GV TX/MAM or Schedule Import 


 
This is a combination of the previous two workflows: 
■ Files are ingested via the Inbox. 
■ Asset info is imported via a schedule, or created or updated via GV TX/MAM. 
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9.2 Channel Design 


A Channel Composer Project contains all the elements that together compose a Channel’s on-air 
design: fixed assets such as logos and straps, Objects, Templates, Applets and Formats. Projects are 
designed in Channel Composer and are then exported to the GV TX/MAM-database or to Storage as 
a Channel Pack.  
 
To refer to dynamic content (Essences), Scene Parameters are defined. These parameters are 
dynamically updated with the assets’ filename when Events are scheduled. Dynamic content 
(Essences) is fetched from Storage for playout. 
 
Example: 
Scene Parameter Event ID Scene Parameter Value when scheduled 
clip 12345 a0000548.avf 
clip 12346 a0000978.avf 
clip 12347 a0000564.avf 
 
Before playout, the Channel Pack is transferred to the playout nodes. Dynamic content is fetched 
from Storage and is also transferred to the playout nodes. 
 


9.3 Schedules  


Schedules can be imported or created in Playout Control (POC). Off-air Playlists are stored in the GV 
TX/MAM database or on the POC client PC. Activated Playlists are stored in the playout database on 
the playout server.  
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10 Appendix: Change an IP address 
After changing the playout nodes’, GV TX/MAM or FTP-servers’ IP address, following adjustments 
need to be made: 


10.1 After you change the IP address of the playout nodes 
■ Change the playout node’s IP address in the GV TX/MAM Channel settings. 
 


10.2 After you change the virtual IP address of the GV TX/MAM servers 
■ On the GVEdge nodes, in /etc/hosts adjust MAIN-DB. Specify the virtual IP of the GV TX/MAM 


servers. 
Example: 


10.250.51.51 MAIN-DB 


  


& You can also set the IP address of the GV TX/MAM server via the IP Manager. 


 


1. On both the GV TX/MAM servers, in /usr/local/apache2/application/configs/txmam.ini, adjust 
project_options.serverip. Specify the virtual IP of the GV TX/MAM servers. 
Example: 


project_options.serverip = "10.250.51.51" 


 


2. On both the GV TX/MAM servers, in /usr/local/apache2/application/configs/txmam.ini, adjust 
ingest.assetHostIp. Specify the virtual IP of the GV TX/MAM servers. 
Example: 


ingest.assetHostIp = "10.250.51.51" 


 


To change the IP address in the POC desktop shortcuts properties  
1. Right-click the POC icon on your desktop > Properties > Shortcut. 
2. In the Target field fill in the GV TX/MAM servers’ virtual IP address.  
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10.3 After you changed the IP address of the FTP server 
1. On both the GV TX/MAM servers, in /usr/local/apache2/application/configs/txmam.ini, adjust: 


o videoFtp.host to the FTP-server IP 
o videoFtp.user to FTP-server user 
o videoFtp.password to FTP-server password 
o videoFtp.path to FTP-server path 


 


& Preferably adjust both the FTP and SMB-settings. 


Example (SMB): 


;Global 


videoFtp.protocol = Smb 


 


;Smb 


videoFtp.Smb.user="delta" 


videoFtp.Smb.password="delta" 


videoFtp.Smb.host="10.250.51.51" 


videoFtp.Smb.path="/system/objects/cobassets/media/browse/" 


 


2. On the main GV TX/MAM server in /system/objects/cobassets/bin/transfer_ftp.xml, adjust the 
transfer metadata.  


3. Then run the /system/objects/cobassets/bin/set.sh script. 
 


10.4 GV TX/MAM server network ports 


FTP Default ports 20 and 21 


SSH/SCP Default port 22 


Samba Default ports 137,138 and 139 


Cobalt database access Default port 5020 


Web based interface Default port 80 


GV TX/MAM hardware player Default ports 5000 and 5001 


 
& Take into account that this information is critical for system administrators to correctly setup the 


firewall. 
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1. Grass Valley product support 
Contact information: http://www.grassvalley.com/support/contact 
U.S Technical Support: +1 800-547-4989 or +1 530 478 4148 or E-mail: Please use our online form 
All other countries Technical Support: +800 80 80 20 20 or +33 1 48 25 20 20 or E-mail: 
callcentre@grassvalley.com 
Training: https://grassvalley.csod.com/LMS/catalog/Main.aspx?tab_page_id=-67&tab_id=6 
 


2. Workstation system requirements for Cobalt 
Any Windows PC will suffice for the Cobalt GUI. Following guidelines can be followed: 
 
• Memory : 2GB or better 
• Graphics card: 128 MB or better 
• Hard disk: 250 GB or better 
• Network: 1 Gbit or better 
• OS: Windows XP, Windows Vista, Windows 7 
• Monitor: WXGA (1280x800) or better (depending on the number of Channels in the vertical POC-


view) 
 
  



https://grassvalley.csod.com/LMS/catalog/Main.aspx?tab_page_id=-67&tab_id=6
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3. Cobalt introduction 
 


 
The Cobalt application runs on a PC and consists of four components: 
• Cobalt Manager: launches the Cobalt components.  
• Playout Control (POC): real-time monitoring and control of on-air Channels; create and modify 


playlists off-air. 
• Asset Manager: replaced by TX/MAM. 
• Week Planner: replaced by TX/MAM. 
 
 
The Cobalt applications run on a (Windows) PC. The Cobalt processes run on the TX/MAM, Playout 
and Storage servers. 
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4. Playout Control (POC) 
Cobalt Playout Control (POC) is used to monitor and manage active and offline Playlists and 
Channels. 
 


 
 
The example POC interface above shows: 


A. The horizontal view shows Channels in a timeline format. 


B. An active Playlist in the vertical view. The ON AIR sign indicates that this Playlist is active. 


C. The Operator Panel, used to trigger actions for a Channel. 


D. The summary and countdown section. 


E. An offline Playlist in the vertical view.   


F. An active Playlist in the vertical view. The ON AIR sign indicates that this Playlist is active. 
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4.1 Starting POC 
To open POC, in the Cobalt Manager click the POC-icon. 


 
 
4.2 Displaying Channels in the horizontal view 


 To open the horizontal view, click the  icon.  


 
Example. 
 
Channel properties 
Double-click the Channel name to view Channel properties. 


 
Example. 
 


To keep current time centered in the horizontal view, on the main menu click View > Keep centered. 


 Select View > Channels > <Channel> and drag the <Channel(s)> on the title bar of the vertical 
view (active Playlist). 


To specify a vertical view for a Channel, in the horizontal view, select the Channel, right-click the icon 
and select an option:  
 


 Show the main Channel in the vertical detailed view. 


 Show the main, backup and most relevant Playlist in the vertical detailed view. 


 Show the main and backup Channel in the vertical detailed view. 


 Show the main and most relevant Playlist in the vertical detailed view. 
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 To remove Channels from the view, in the horizontal view, right-click the Channel > Remove.  
 To change Channel order, in the horizontal view, right-click a Channel > click Move up or Move 


down.  


 


Channels are defined in TX/MAM. 


 
4.3 Opening off-air and on-air Playlists in the vertical view 


 To specify the number of vertical views you want to display, click the  icon. 
The selector opens.  


 Use the cursor to select the number of views you want to display, and then click again to select.  


 
Example 3 vertical Playlists selected. 


To open or create an off-air Playlist: 


 On the main menu, click View > Playlists.  


 Select the Playlist you want to open and drag into the vertical view, on the Playlist’s top bar.  


 Select the <New Playlist> option to create a new Playlist. 


 


To open an on-air, active Playlist: 


 On the main menu, click View > Channels.  


 Select the Channel you want to open and drag into the vertical view, on the Playlist’s top bar.  
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4.4 The Active Playlist 


 
Example active Playlist icons and columns. 
 
Channel properties 
Double-click the Channel name in the Playlist’s top bar to view Channel properties. 


 
Example. 
 
ON AIR 
The ON AIR sign indicates that a Playlist is active. 


 
 
 


4.4.1 Playout System Date and Time 
The clock in the upper right corner of active Playlists shows the playout system's date and time. 


 
Example. 
 


 
If an active Playlist's clock is displayed in red, the dataserver service is not available and needs to be 
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restarted by Engineering or POC is unable to create a connection to the playout server.  
 


4.4.2 Event Status Column  
The Event status column shows the status of Events. Colors of Events can be user defined (linked to 
Formats). 
 


 
: Event selected. 


 
: Under run, empty space between Events.  
The under run is indicated in hours : minutes : seconds : frames. 


 
: Event is playing. 


 
: Overrun, overlap of Events. The underrun is indicated in hours : minutes : seconds : frames. 


 
 


: Status information not yet available (this is the default); Event not checked.  
Click the Check button to retrieve status information for the selected Events. 


 
: Event checked manually. Note that this checked-sign has to disappear to indicate that the 
file is available, resulting in an empty status field. 


 
: Event has no format. 


 
: Asset missing: not in the TX/MAM database. 


 
: Error status: Event not played.  
This can have different causes: Asset missing, file missing, etcetera. 


 
: Fetching Assets from Storage to the playout server. 


 
: Asset requested from Storage. 


 
: Empty Asset: Asset defined, but file not ingested. 


 
: Asset waiting for fetch from Storage. 


 
: Metadata is missing. 


 
: Event is playing. 


 
: Event skipped. 


 


: Event queued.  
Note that you can still change the Manual/Fixed/Follow setting (right-click the Event’s Time 
column to change). 


 
: Event played. 


 
: Event locked: playout will start soon. The Event can no longer be edited. 


 
: Fixed Event: fixed start date and time. 


 
: Follow Event: follows previous Event. 


 
: Manual Event: only started if released. Note that if a manual Event is not released, playout 
of the Playlist pauses until the manual Event is released. 
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4.4.3 Time Column 
The Time Column shows if an Event is 'fixed', 'manual' or 'follow', on the left hand side of the On-Air 
start time and On-Air date. 
 


 
: Fixed Event: fixed start date and time. 


 
: Follow Event: follows the previous Event. 


 


: Manual Event: only started if released.  
Note that if a manual Event is not released, playout of the Playlist pauses until the manual 
Event is released. 


 


4.4.4 The Event Column 
The Event column shows: 


• The Event’s name. 
• The Event number. This number is generated every time an Event is imported, activated or 


manually added to the off-air on on-air Playlist. 
• The Asset id (internal, retrieved from the Asset database upon ingest) or the External 


Reference ID which is the in house ID of the facility. 
This view is configurable. 
 


 
Example. 
 


4.4.5 The Duration/Time Left Column 
The Duration/Time Left Column shows: 


• The duration of an Event. 
• A time bar indicating duration, progress and time left for the Event. 


 


 
Example. 


4.4.6 Format Column 
The Format column shows the Format(s) that are linked to an Event. 
 


 
Example. 
 


4.4.7 Flags Column 
The flag column is configurable and can flag anything from a present/missing subtitle, a present or 
missing language WAV, and etcetera.  
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4.4.8 Channel options 
Below each active Playlist, a number of options are available. 


 
Example. 
 


 Click to open or hide the Summary. 


A summary adds up playout time for specified Events within a specified period. Events can be specified 
based on Format or Asset Type. Following selection criteria are available: 


• Selected Event 
• Current hour  
• Next hour  


 


 
Example selection 
 
The summary displays cumulative playout time for the selected Format or Asset Type: 


• green if <12 minutes  
• red: if > 12 minutes 


 
(Contact Support to modify thresholds.) 
 


 
Example summary 


 
Open or hide the Countdown option. Counts down to the specified Format, Event 
Type, etcetera. 


 
Open or hide the Operator Panel (if available for this Channel). 


 Date picker for the Channel, plus Next day and Previous day options. 
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4.5 Actions on the vertical View for active Playlists 


 
 


 


Start the next Event. 


 


Start the selected Event. Cue first. 


 


Cue the selected Event.  


 


Moves the selected Event one place down in the Playlist. 


 


Moves the selected Event one place up in the Playlist. 


 


Delete the selected Event, or delete selected Events plus all following Events. 


 


Attaches all Follow and Manual events to a Fixed event 


Click the  icon to switch between Clean / Follow / Check / Reapply buttons. 


 


Manually check the status of selected Events. 
 
 


 


Clean the status info for checked Event(s).  
 


 


Reapply a Format if format itself or metadata within the Format has changed. 
 


 
Refresh the view. 


 
Specify filter settings for the Playlist. 


 
Save As Run log. Click the  icon to switch to Export/As Run / Report button. 


 
Export visible Playlist as CSV or XML-file to workstation.  


 


Save report.  
 


 


Searches Events in the Playlist. 
Click the  icon to switch between the Search/Replace button. 


 


Playout system date and time. 
Double-click the clock to display the current Event in the top section of the Playlist. 
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4.6 Asset Search 
The Asset search option allows you to search Assets in the database. Search results can be dragged 
from the search window and dropped in the Playlist. This option can be found next to the horizontal 
view icon. 


 
 
 
4.7 The offline Playlist (vertical view) 


Playlist properties 


Double-click the Playlist name in the Playlist’s top bar to view properties. 


 
Example. 
 
Title bar 
The title bar for offline Playlists is grey. 


 
 
Date picker 
Select a date in the date picker. Click the checkbox at the bottom of the Playlist to list 1 day, as 
specified in the date picker. Uncheck the box to show the complete Playlist. 


 
Example. 
 
The Time Column 
The Time Column shows the active start time, date and Event type: 


 


Fixed Event: fixed start date and time. 


 


Follow Event: follows the previous Event. 


 


Manual Event: only started if released. Note that if a manual Event is not released, 


playout of the Playlist pauses. 
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The Formats Column 
The Format column shows the Format(s) that are linked to an Event. 


Example. 
 
The Duration/Time Left Column 
The Duration/Time Left Column shows the duration of the Event. 
 
Flags 
The Flags shows Event flags. 
 
The Event Column 
The Event column shows: 


• The Event’s name. 


• The Event number. This number is generated every time an Event is imported, activated or 


manually added to the offline on active Playlist. 


• The Asset id (internal, retrieved from the Asset database upon ingest) or the External 


Reference ID (House ID). 


 
This view is configurable. Right-click the Event’s column header and select ExternalRef to display the 
External Reference or Original to display the Asset ID. 


Example. 
 
Playlist options 
Below each active Playlist, a number of options are available. 


 


Click to open or hide the Summary. A summary adds up playout time for the 


selected Event(s). 


 


Date picker.  
Click the arrow icons to display the next or previous day. 


 


Click the checkbox at the bottom of the Playlist to list 1 day, as specified in the 


date picker. Uncheck the box to show the complete Playlist. 


 
 
4.8 Actions on the vertical View for off-air Playlists 
 


 
 
In POC, you can edit Playlists off-air, then activate to a Channel, date and time. Although the majority 
of options for off-air Playlists are the same as for active Playlists [as described in paragraph 4.5], there 
are a few differences that are important to note. 
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Though working off-air, the status of Assets can be verified using the Check button while editing the 
Playlist. 
 


 Note that the title bar for off-air Playlists is grey. 


 Click the checkbox to list 1 day, as specified in the date picker. Uncheck the box to 
show the complete Playlist. 


 


Saves the Playlist to the asset database: 
Save: save the Playlist to the database. 
Save as: save the Playlist as <new name> to the database. 
Export: export the visible Playlist as CSV or XML-file to your workstation. 
Import: import a XML-schedule [see paragraph 4.17 for an explanation]. 
 


Click the  icon to switch between the Save/Save As/Import/Export buttons. 


 


Activates the Playlist to the selected Channel, date and time [see paragraph 4.18 
for an explanation]. 


 
 
4.9 Viewing Events 
Double-click the Event to view properties and secondary Events. 


 
Example. 
 


• Type: fixed, follow or manual 


• Start: this is the Event’s start date and time 


• TC in and TC out: this is the main Asset’s timecode in and out 
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• Duration: this is the Event’s duration 


• Type: fixed, follow on or manual 


• Name: the Event name 


• Asset id: Asset ID 


• Event id: Event ID 


• Ext ref: external reference (house ID) 


• Asset Status: the Asset’s status (after being checked, active Playlists only) 


• Flags: flags and their status (checked if set) 


• The main box shows secondary Events. 


• The Import fields box displays information imported from an external source such as the 


schedule. By double clicking this field, you can replace, add and remove certain fields 


depending on the schedule, for example: 


o Subtitles External Reference Ids 


o Clip/file names for logos 


 
4.10 Creating a new Playlist 
To create a new off-air Playlist: 


 On the main menu, click View > Playlists.  


 Select the <New Playlist> option and drag into the vertical view.  


4.11 Copying a Playlist 


 To copy a Playlist, click the  icon or View > Playlists. 


 Click the Copy button. 


 Specify a Name and (optional) a Default channel. 
 Click Save to save, Cancel to discard. 


When a Playlist is linked to a default Channel only this Channel Pack’s Formats are listed when editing 
Events. 


4.12 Exporting a Playlist as CSV or XML file 
Playlists can be exported as CSV. or XML-file. XML-files can be reimported. 


 To export a Playlist, click the Export button. 


 Click the  icon to toggle between the Save/Save as/Import/Export or As Run/Report/Export 


buttons. 
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 Specify a destination folder. 


 Click Save to export the file, Cancel to discard. 


4.13 Deleting a Playlist 


 To delete a Playlist, click the  icon or View > Playlists. 


 Click the Delete button. 


 Click OK to delete, Cancel to discard. 


 


4.14 Replacing, removing or adding a Format for an Event 


4.14.1 Replacing a Format for an Event 
To replace a Format for an Event: 
  
 Select the Event and right-click in the Formats column. 


 Select the Format you want to replace.   


 Select Replace and select the appropriate Format.  Formats in the currently active Channel Pack 
will be listed.  


 


4.14.2 Removing a Format from an Event 
To Remove a Format from an Event: 
 
 Select the Event and right-click in the Formats column. 


 Select the Format you want to remove.   


 Select Remove.  


 


4.14.3 Adding a Format to an Event 
To Add a Format to an Event: 
 Select the Event and right-click in the Formats column. 


 Select the Format you want to replace.   


 Select Add Format and select the appropriate Format. Formats in the currently active Channel 
Pack will be listed.  
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4.15 Editing an Event 
To edit an Event, double-click the Event you want to edit. This will open the Edit Main Event window. 
 


 
In this window you can edit the selected event: 


• Start date and time 
• TC in and out 
• Duration. 
• Type (fixed, follow on and manual) 
• Name 


 
The Asset Status box will show status information and error messages.   
 
'Import fields' relates to information imported from an external source such as the Schedule. By double 
clicking in this field you can replace, add and remove certain aspects depending on the Schedule, for 
example: 


• Subtitles External Reference Ids 
• Clip/file names for logos 


 
The main box shows the main Event's sub events. 
 
 
4.16 Adding Assets from TX/MAM to POC to create Events 
You can drag and drop Assets from TX/MAM into POC to create Events. The Event is scheduled with 
the default Format. You can modify the Events Formats as described in paragraph 4.14. 
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4.17 Defining Channel Views 


Click the   icon in the Playlist to create a predefined Channel view. 
 
 First set up the Channels and create the view you want to save in the vertical view.  


 Click the  icon, a list of pre-saved Channel views will appear (if available) and/or a save/delete 
option will appear.  


 Click the Save button. 


 In the Save View Settings window, enter the name for the new view and select Save. 


 To delete an existing view, select the view you wish to delete and select Delete. 


 
4.18 Activating Playlists and Scheduling Events 


 
Activate Playlists and schedule Events preferably five minutes in advance to allow for preloading of 
media files. 
 


4.18.1 Activating a Playlist 


 To activate a Playlist, click the Activate button in the Playlist menu.  


 
This will open the Activate Playlist window. 


 Select a start and (if applicable) end date and time.  


 Click Activate to generate the Playlist. 


The message below appears when you are generating Events in the past. Click Yes to generate 
Events in the future, click No to generate Events in the past. 


 
 
Playout of the Playlist will start at the start time of the first Event. 
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4.18.2 Dragging Events from one Playlist into another Playlist to schedule Events 
Events can be dragged from an offline and active Playlists into an active Playlist to schedule Events.  
Note that you cannot drag and drop Events that have already been played out. These Events can be 
copy-pasted. 
 
Events are appended (follow) to the end of the Playlist if dragged into the empty grey area of the 
Playlist, or can be dragged and appended in between other Events. 
 
When added to an empty Playlist, Events are scheduled fifteen minutes in the future. 
When appended to Events in the past, the Event will be scheduled fifteen minutes in the future and an 
under run will occur. To avoid, delete Events in the past before appending Events. 
 


 
Example under run when appending Events to Events in the past. 
 


4.18.3 Dragging Assets from TX/MAM into a Playlist to schedule an Event 


Assets can be dragged from TX/MAM into POC to schedule an Event. Use the  icon to drag 
Assets into POC. The Channel’s Format Rules will automatically be applied when adding the Event. 
 


4.18.4 Copy-paste Events between active Playlists 
Events can be copied-pasted in active Playlists, using CTRL+C (copy) and CTRL+V (paste). 


4.18.5 Schedule Import 


 The Schedule Importer is described in the Schedule Importer User Manual. 
 
Mostly Schedules are created in dedicated scheduling tools and imported into POC using a 
(dedicated) Cobalt Schedule Importer. To open the default Schedule Importer:  


 In POC select (or create) an offline Playlist.  


 Click (Save/Save as/Export) > Import and select the appropriate file. 


 Do you want to keep the existing Schedule?  
Select the appropriate option to start import. 


Note that the Formats and Asset Types referenced in a Schedule have to be defined before Schedule 
import. 
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Events in an offline Playlist have status . This means that Asset status has not been checked yet. 
Asset status is checked when the Playlist activated. 
 
4.19 Checking Event status in the active Playlist 


4.20 Workflow 


The table below describes the statuses Events go through from being scheduled in an active Playlist 
to playout. 


 


When Events are scheduled, the active Playlist 


initially displays this icon. It means that the 


Assets’ status has not been checked yet.  


 


Optional: the Event has been checked manually 
in TX/MAM, but not for file availability on the K2 
Edge.  
Note that in active Playlists this checked-sign has 


to disappear to indicate that the file is available 


on the K2 Edge, resulting in a blank or cleared 


status field. 


 
Format not in Channel Pack. 


 Asset missing. 


 Metadata missing. 


 No Format. 


The Cobalt service dataserver will check if the 
Events’ Assets, metadata and Formats are 
available in TX/MAM. If not, an error messages 
will appear. 
POC will give a warning if no Format is linked to 


the Event. 


 Asset file requested from archive. 


 Asset file waiting for fetch from storage. 


 Fetching asset files from storage to playout. 


Next, if the Asset is OK the Cobalt service 


playout_distri will start checking for file availability 


and fetching files. The Channel definition’s 


lookahead time defines when this process starts 


 Empty Asset. 


 Delivery aborted. 


 Asset file could not be fetched. 


If an error occurs during file fetch or delivery, an 


error message appears. 


 


When the Asset and file availability have been 


checked and the status is OK, the status field is 


blank.  
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Before playout, the Event will be cued. A 


minimum of three Events is automatically 


precued.  


 


Shortly before playout the Event is locked, 


playout will start soon. 


 


The Event is playing. 


 


The Event has been played out. 


 
Use the Clean button to clear status information. 


 
 
Use the Refresh button to refresh the Playlist. 


 
 
Use the Check button to manually check the Event in TX/MAM. Note that file availability on the 
playout node is not checked. 


 
 
 


4.21 Status indicators 


Event status indicators 


 


Event selected. 


 


Under run: the under run is indicated in hours, minutes, seconds, frames. 


 


Event is playing. 


 


Over run: the over run is indicated in hours, minutes, seconds, frames. 


 


Status information not yet available (this is the default).  


 


Event checked manually for availability in TX/MAM, but not for file availability on the 


K2Edge. Note that in active Playlists this checked-sign has to disappear to indicate that the 


file is available on the K2Edge, resulting in a blank of cleared status field. 


 


Asset file requested from archive. 
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4.22 Modifying Events 


4.22.1 Changing the Event type: Fixed, Follow On and Manual Events 
 To specify a fixed start time for an Event, select the Event and right-click in the time column. 


Select the Fixed option. This way you can also create Manual and Follow Events. 


 


Fixed Event: fixed start date and time. 


 


Follow Event: follows the previous Event. 


 


Manual Event: only started if released. Note that if a manual Event is not released, playout of 


the Playlist pauses. 


 
 You can also double-click the Event and then change the Event type. 


 Click Save to save changes, Cancel to discard. 


 


4.22.2 Editing Event Start date and time, TC in and out, Duration 
 To edit an Event, double-click the Event in the Playlist. This will open the Edit Mainevent window. 


 


Asset file waiting for fetch from storage. 


 


Fetching asset files from storage to playout. 


 


Event has no format. 


 


Asset missing: not in the TX/MAM database.      


 


Empty asset: asset defined in the TX/MAM database, but file missing.   


 


Metadata is missing. 


 


Delivery has been aborted. 


 


Asset file could not be fetched.  


 


Event checked and Asset status OK. 


 


Event queued and ready for playout. 


 


Event locked, playout will start soon. 


 


Event is playing. 


 


Event has been played. 


 


Event skipped (after queue and go). 
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You can edit: 
• Start: this is the Event’s start date and time 


• TC in and TC out: this is the main Asset’s timecode in and out 


• Duration: this is the Event’s duration 


• Type: fixed, follow on or manual 


• Name: the Event name 


 Click Save to save changes, Cancel to discard. 


 


4.22.3 Replacing, removing or adding a Format for an Event 
To replace, remove or add a Format to an Event: 
 In the Playlist (this can be an active or offline Playlist) select the Event you want to edit and right-


click in the Formats column. 


Depending on the number of Formats linked to the Event, one of the following windows opens: 


 


Example one Format linked. 


 


Example more than one Format linked. 


• Add format: select the Format you want to add and if applicable, specify offset and duration. 


 
Example. 


• Replace format + timing: replace the Format with the selected Format and if applicable, 


specify offset and duration. 
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• Replacing a Format without timing (if one Format is linked to the Event); select a Format from 


the list. The current Format will be replaced with this Format.  


• Replacing a Format (if more than one Format is linked to the Event); select a Format from the 


list, then select Replace. When replacing, if applicable, specify offset and duration. 


• Removing a Format (only available if more than one Format is linked to the Event); select a 


Format from the list, then select Remove. 


• Replace all formats (only available if more than one Format is linked to the Event), then 


select a Format from the list. 


 


 You can also use the Replace button: 


 


Search for Events and replace the Format based on one of the following criteria: 
Format: replace the Format with the Format specified in the Replace with field. 
 
Click Search to start searching for Events that match the criteria specified. 
Click Replace to replace the selected event. 
Click Replace all to replace all Events that match the search criteria. 
 


 
 


4.22.4 Replacing an Event’s main Asset 
 To replace an Event’s main Asset, drag the Asset from TX/MAM into POC upon the Event you 


want to edit. Use the  icon to drag the Asset into POC.  


 
 You can also use the Replace button: 


 


Search for Events and replace the main Asset based on one of the following criteria: 
Asset ID: replace the main Asset with the Asset specified in the Replace with field 
External reference: replace the main Asset with the Asset specified in the Replace with 
field 
Other metadata fields (match text string in one of the fields in the Event column): 
replace the main Asset with the Asset specified in the Replace with field. 
 
Click Search to start searching for Events that match the criteria specified. 
Click Replace to replace the selected event. 
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Click Replace all to replace all Events that match the search criteria. 
 


 
 


4.22.5 Editing the Event Name 
 To edit the Event Name, double-click the Event and edit the Name field. 


 Click Save to save changes, Cancel to discard. 


 


4.22.6 Removing an Event Flag 
 Double-click the Event in the Playlist. This will open the Edit Mainevent window. 


 Uncheck the Flags that you want to remove from the Event. 


 Click Save to save changes, Cancel to discard. 


 
4.23 Cue and Go, start Next Event 


Events can only be started when they have been cued. This is indicated by the  icon. 
If the Event is not cued, the Go button is not active. 
 
 To manually cue and start an Event, select the Event and click the Cue button. 


 
 
The Event is cued (preloaded); this is indicated by the status icon. 


 
 
 Once cued, the Event can be started by clicking the Go button. 


 
This function takes the selected Event. Any following Events - until the next fixed Event - are rippled. 
 
 To start the next Event (the Event that follows the playing Event) click the Next button. 
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4.24 Reapplying Formats 


If an Event’s Format or metadata has been changed after the Event has been scheduled, you need to 
reapply the Format to make changes effective.   


 To reapply a Format, select the Event and click the Reapply button. 


 


4.25 Creating (empty) Assets in POC  
You can create new (empty) Assets in POC.  


 To add an Asset click the  icon or press or CTRL + i.  


This will open the Create Empty Asset window. 


 Fill in the fields in this window and then click Create to create the Asset, Close to discard. 


 
The Asset will be linked to the appropriate Asset file based on the external reference.  


 
 


Most of the fields (except Name and External Ref) in this dialog box are saved and will be reused, 
even after reopening the dialog or POC. 
 


  
Events created with these placeholder Assets will take the duration as specified in the Create Empty 
Asset dialog. These Events will keep this duration even after the Asset file was properly ingested in 
TX/MAM. 
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4.26 Filtering the Playlist (view) 
You can filter the Playlist (view) based on: 


• status 


• main event name 


• Event ID 


• Asset ID 


• format 


• flag 


• over run and under run 


• main event type 


• External reference 


 
To apply a Filter: 
 Click the Filter button. 


 
The last used filter is applied. 
 Click the arrow next to the Filter button > <filter> to select a filter if filters have been saved. 


 To stop filtering, click the Filter button again. 


 
To define a filter: 
 Click the arrow next to the Filter button > Adjust filter. 


 Select the filter options you want to use. 


 Click Save and specify a Name to save the filter. 


 In the filter options window, click Apply to directly apply the filter, or Cancel if you do not want to 


apply the filter. 


 
To modify a filter: 
 Select the filter you want to modify. 


 Click the arrow next to the Filter button > Adjust filter. 


 Edit the filter options. 


 Click Save. 


 Select the filter you want to save or specify a new Name. 


 Click Save > OK. 


 In the filter options window, click Apply to directly apply the filter, or Cancel if you do not want to 


apply the filter. 


 
To delete a filter: 
 Select the filter you want to delete. 


 Click the arrow next to the Filter button > Adjust filter. 
 Click Save. 


 Select the filter you want to delete. 


 Click Delete > OK. 
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 Click Cancel. 
 In the filter options window, click Cancel again. 


 


 
Example filter options window. 
 
 
4.27 The Operator Panel 
Operator Panels are used to trigger manual actions. Operator Panels are created in Channel 
Composer and are included in the Channel Pack for a Channel. POC will display the Operator Panel 
for the active Channel Pack (if a Panel has been created for the Channel).  
 


Example Operator panel in POC. 
 


 


To open or hide the Operator Panel (if available for the Channel), click the Operator Panel icon 
at the bottom of the active Playlist. 
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4.28 The Settings Window 
 
In the Settings window it is possible to: 
• Ensure that POC is locked after x minutes. 
• Enable/disable the moving of events in the active channel. 
• Enable/disable the sorting on block. 
• Enable/disable that asset data is shown in the event 


details window. 
• Enable/disable the refreshing lists if an update from 


playout is lost. 
• Enable/disable the confirmation on Next/Go. 
• Enable/disable that the time until a next event is shown. 
• Show or hide button titles. 
• Enable/disable editing of a schadule in the past. 


 
 
 
To change the Cobalt Playout Control settings: 
1. On the Menu bar, click Settings. 
2. Select or or deselect the check box of the applicable setting. 
3. Click OK. 
 
 
 
4.29 Channel Packs 


4.29.1 Channel Packs in POC 
When scheduling Events, the Cobalt scheduling process will apply the Channel Pack that has been 
activated for the Events’ planned start time. Example:  
Schedule Channel Pack 


Event with 
Start time: 13/02/12 12:00:00 


 
Channel Pack ID: 2400 
Activation starts:  13/02/12 12:00:00 
 


Event with 
Start time: 13/02/12 12:03:00 


Event with 
Start time: 13/02/12  and so on 


Event with 
Start time: 14/02/12 12:00:00 


 
Channel Pack ID: 2312 
Activation starts:  14/02/12 12:00:00 
 


Event with 
Start time: 14/02/12 12:03:00 


Event with 
Start time: 14/02/12 and so on 


 
The Channel Pack contains the Channel design; Formats, Applets, fixed Assets such as logos and 
banners, and more. Events will play out the Formats they were scheduled with. 
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If a Channel Pack is changed after it has been used in a Schedule, you need to regenerate the  
Schedule (with the new Pack ID) to apply these changes. 
To reapply a Format after it has been changed in an active Playlist, select the Event and click the 
Reapply button. 


 
 
When adding an Event to an active Playlist and the Event uses Formats that are not available in the 
Channel Pack that is active on that Channel, an error message appears. Example: 


 
 
Under View > Channel Packs you can see which Channel Pack is active per Channel. Example: 
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When double-clicking an Event, you can see which Channel Pack (ID) is used. Example:


 
 
In the Channel Pack Manager (which comes with the installation of Cobalt) you can see which 
Channel Packs are activated for which Channels, activation time and contents. Example: 
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4.29.2 The CPK Manager  
Use the CPK Manager to view and manage Channel Packs. 


 Activating or deactivating a Channel Pack on an active Channel can interrupt a broadcast. 
  


Starting the Channel Pack (CPK )Manager 
 To start the CPK Manager, double-click the CPK Manager shortcut on your desktop or start from 


the Start menu.  


 
 
 Specify the TX/MAM server’s virtual IP-address and log in with your credentials.  
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Options 
The example below shows Channel Packs per Project (Grouped). The  icon indicates that a Pack is 
active. The Info window shows properties of the selected Pack. The Contents window shows 
Templates, Formats, Applets and Scene Parameters included in the selected Pack. 


 
Example. 
 


View:  
Grouped 
Channel 


: View Channel Packs Grouped per Project (in chronological order) or by Channel. 


 


Indicates that the Channel Pack is currently active. 
 


 


To remove a Pack from the TX/MAM database, select the Pack and click the 
Remove icon. 


 


To activate a Channel Pack for a Channel: 
 Select the Pack. 


 In the Activation panel, click the Add icon. Specify the Channel and 


activation date/time. 


 Click OK to confirm, Cancel to discard.  


 


To de-activate a Channel Pack: 
 Select the Pack, the applicable Channel and activation date/time definition. 
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 In the Activation panel, click the Remove icon.  


Contents The Contents window lists the Templates, Formats, Applets and Scene 
Parameters included in the Channel Pack.  


 
 


 In active Playlists, leave at least five minutes for the Channel Pack to load; when a new Pack 
needs to be loaded schedule Events at least five minutes in advance of start of playout. 


 
 
4.30 The As Run log and Report  
You can create an As Run log (Events as played out) or Reports (Events as scheduled in the future) 
for active Playlists.  
 


 Click the  icon to toggle between the Export/As Run/Report buttons. 


 


Create the As Run log (Events as played out) for the specified Channel, from start date 
and time to end date and time, as CSV. or XML-file. 


 


Create a Report (Events as scheduled) for the specified Channel, from start date and 
time to end date and time, as CSV. or XML-file. 


 


 
Example export options. 
 
date time duration asset_id name format status 


6/12/2013 17:31:03:18 00:00:10:00 554 Chilli; Uncle Ben's CLP; BGO OK 


6/12/2013 17:31:13:18 00:01:21:09 379 Bath Market;  CLP; TCK; CSQ; BG OK 


6/12/2013 17:32:35:02 00:00:30:00 553 Playground; Aptamil CLP; BGO OK 


6/12/2013 17:52:06:02 00:00:10:00 554 Chilli; Uncle Ben's CLP; BGO OK 


6/12/2013 17:52:16:02 00:00:30:00 553 Playground; Aptamil CLP OK 


6/12/2013 17:52:46:02 00:01:21:09 379 Bath Market;  CLP; TCK; CSQ; BG OK 


6/12/2013 17:54:07:11 00:00:10:00 554 Chilli; Uncle Ben's CLP; BGO OK 


6/12/2013 17:54:17:11 00:02:35:24 556 Datarock; Give it up CLP; CTL; PIP3D; BG OK 


6/12/2013 17:56:53:10 00:00:30:00 553 Playground; Aptamil CLP; BGO OK 


6/12/2013 17:57:23:10 00:04:36:24 555 Rihanna; California King bed CLP; CTL; PIP3D; BG OK 
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6/12/2013 18:02:00:09 00:02:35:24 556 Datarock; Give it up CLP; CTL; PIP3D OK 


6/12/2013 18:04:36:08 00:00:10:00 554 Chilli; Uncle Ben's CLP; BGO OK 


Example excerpt from As Run log (CSV). 
 
4.31 Gangroll 
The Cobalt Playout Control (POC) Gangroll functionality is used to start a queued manual Event on 
multiple Channels at the same time. For example, this can be useful when starting a commercial break 
during a live show that is aired on several Channels simultaneously.  
 


  The steps for working with the gang roll functionality are: 
• Add manual Events to the applicable Playlists. 


• Select the Channels to include in the gang roll. 


• Start the gang roll. 


 


4.31.1 Adding a manual Event to the Playlist 
The gang roll functionality will start the first queued manual Event found in the specified Playlists. 
Playlists are searched starting from the time gang roll is triggered. 
In POC, add manual Events to the applicable Playlists, for instance after a Live Event. 
 


4.31.2 Selecting the Channels to include in the gang roll 
 In POC, on the Playlist’s menu bar, click the Gangroll button. This will open the Gangroll window. 


 
 
 In the Gangroll window, click the Configure button to open the Gangroll Configuration window. 


 


 
Example Gangroll Configuration window.  
 
 In the Gangroll Configuration window, select the Channels that you want to include in the gang 


roll. This means that when the gang roll is started, these Channels will be searched for the first 


manual Event and this Event will be started. 
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 Click Ok to confirm, Cancel to discard. 


 
If a Channel is not available, this Channel is displayed in red. 


 
 


 
The channel configuration is stored and reused, also after reopening the Gangroll window or POC. 
 


 
The trigger delay for manual Events is specified in the Channel definition in TX/MAM. These settings 
need to be the same for all Channels gang roll is used on, otherwise a simultaneous start will not 
occur. 
 


4.31.3 Starting the gang roll functionality 
 To start the gang roll and trigger manual Events Playlists selected in the previous step, in POC, on 


the Playlist’s menu bar, click the Gangroll button to open the Gangroll window. 


 
 


 
Example. 
 
The Gangroll window shows:  


• the Channels that have been selected for the gang roll 


• the broadcast set number 


• the playout system’s IP-address 


• the first available manual Event’s ID and broadcast format 


• the first available manual Event’s start time and duration 


 
The countdown column counts down to Event start.  
The Refresh button refreshes the list of Events. The list does not automatically update; always refresh 
the list before a Go. 
 
If no manual Event can be found, the Channel turns red in the Gangroll window. 


Example no manual Event found. 
 







071884403  Cobalt Client 1.24 for GV Edge User Guide - 39 


If applicable, deselect any Channels you want to exclude from the gang roll. 
 
 Click Go to start the gang roll, click Close to discard. Clicking Go will open the Go event window. 


 


 
 
 Click Go to start the gang roll and trigger Events, click Cancel to discard. 


Once an Event has completed, this is indicated in the Channel column:  . 


 
Example Event completed successfully. 
 
If the Event has not completed successfully, this is indicated in the Channel column with a red marker: 


. 


 
Example event failed. 
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4.32 Join In Progress (JIP)  
JIP requires following software versions: 


• K2 Edge from version 4.0.2 


• Cobalt Playout Control (POC) from version 2.85 


• Channel Composer from version 1.6.2 


The Join In Progress (JIP) feature makes it possible that a second, high priority playlist temporarily 
overrides the normal playlist’s output. When this second playlist is completed, the output resumes the 
normal playlist that kept on playing in the background. JIP works for any situation where a relatively 
short Playlist, such as breaking news, needs temporary control over the main program. The latter is 
suppressed and continues playing in the background until the situation returns to normal.  
JIP works in combination with the primary HD/SD channel and can also be used in a simulcast setup.  
  
 


4.32.1 Prepare POC for JIP 
 In POC, open both Playlists and make sure the normal Playlist is running.  


 Verify that JIP is configured correctly: when correctly configured, a grey JIP indicator icon will 


be shown in POC next to the ON AIR signs for both the normal Channel and the JIP Channel. 


 


 
Example normal and JIP Channels active in POC with grey JIP- icon visible. 
  







071884403  Cobalt Client 1.24 for GV Edge User Guide - 41 


 
 Make sure the Channel Pack that contains the JIP-templates is activated on both the normal 


and JIP Channel. This can be checked in POC > main menu > View > Channel Packs or 


using the Channel Pack Manager. If applicable, activate the JIP Channel pack using the 


Channel Pack Manager. 


Note that the normal and JIP Playlist use the same Channel Pack. 


 If applicable, in the JIP Playlist, schedule Events with the JIP-formats. 


4.32.2 Activate the  JIP Channel and return to normal playout 
 In POC, with the normal schedule running, either manually activate the high priority JIP 


Playlist (manually start an Event in the JIP Playlist with (Cue and) Go or Next, or wait for the 


scheduled activation (Event with fixed start time in the JIP Playlist).  


The moment the JIP Playlist takes control, the JIP-indicator icon above the normal Playlist will 


turn red.  


 
Normal Channel JIP Channel 


JIP configured correctly. Normal Channel active, JIP not active. 


  


JIP configured correctly. JIP Channel active, normal Channel surpressed. 


  


 
 During a gap in the JIP Playlist, or when the JIP Playlist ends, control will automatically return 


to normal output. 


  
Note that you cannot return to normal playout manually, by starting an Event in the normal Playlist. To 
return to normal playout, delete all Events after the current Event in the JIP Playlist. When the current 
Event’s end time is reached, control is returned to normal playout.  
The jipOff template is automatically called when control returns to normal output.  
The moment the normal Playlist takes control, the JIP-indicator icon above the normal Playlist will turn 
grey.  
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4.33 Recording 
With the K2 Edge Recording option you can record a Live input and ingest as an Asset. MXF file types 
can be recorded. 


 What is needed: 
• A default Recording Channel is preconfigured: Record1.  


• To enable, you need the K2-EDGE-SWLX-REC license. 


• You need the RecPack Channel Pack to work with the Recording function. The RecPack 


Channel must be activated on the Recording Channel. 


• Enable recording via the IP Manager. 


 
How to:  


 Enable recording via the IP Manager > Channel configuration > Enable recording channel: 
select On. 


 Create a temporary Playlist. This Playlist is used to schedule Events with the recording 


Formats attached. 


 In TX/MAM, create an empty Asset of the appropriate Asset Type. 


 


 
Example. 
 


 
You can also overwrite an existing Asset. In that case, in the LiveRecord Format set the StartLiveRec 
> overwrite and CheckLiveAssetStatus > Overwrite options to 1. 
 


 Drag the (empty) Asset into a temporary Playlist and attach the LiveRecord Format to the 


Event. 


 Double-click the Event and specify Duration. You do not have to specify an Event Tc in / Tc 


out. 


 
You can also specify the Asset’s duration in TX/MAM, on the Spotcheck tab > Duration.  
 


 Activate the Event to the Record Channel, to the appropriate start date and time. 


Make sure the LiveRec Channel Pack is activated on the Record Channel. 
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Example Recording Event. 
 


 
 If you do not know the recording Event’s duration in advance, schedule a LiveRecord Event 


with a Duration that exceeds the estimated duration. 


 Schedule a manual Event after the recording Event with the IngestOnly Format attached; 


recording will be stopped when the manual Event is triggered and the recording Event’s 


duration is overruled. The IngestOnly Event ingests the recording.  


 
In Playout Control (POC), the Flag column shows following status indicators: 


  Pre-check OK.  


  Recording will not start. The file already exists (and overwrite is not enabled), or the file extension 


not allowed. 


  Recording OK. 


  Recording error. 


 


Ingest successfully finished. 


 
 After ingest, Assets can be shared and exported via the TX/MAM Sharing tab and Export 
options. 


 
 
 
 
 
 
 
 







071884403  Cobalt Client 1.24 for GV Edge User Guide - 44 


 
The LiveRecord Format 


 
Example Event in POC. 
 


• CheckLiveAssetStatus: a check performed before recording starts. Verifies:  


o allowed file extensions 


o if the Asset ID exists in TX/MAM  


o contains the Overwrite option (0 overwrite is not allowed, 1 is allowed) 


 
• StartLiveRec: sends the recording command to nexos, default 6 seconds prior to start. 


o ioInput: specifies the input port that is recorded. Numbering starts at 1; IO1 is 1, IO2 is 


2, etcetera. 


o format: the broadcast format 


 PAL  


 720@50p  


 1080@50i 


 NTSC  


 720@5994p  


 1080@5994i 


 
o preset: the encoding preset, determines amongst others the container/codec 


o mxf-d10-<bitrate> 


 Use for SD. 


 bitrate: 30/40/50 


o xdcam-hd-<bitrate> 


 Use for HD. 
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 bitrate: 30/40/50 


o overwrite: 0 overwrite is not allowed, 1 is allowed 


o vbirecord: 0 do not include vbi info, 1 include vbi info. Only supported for PAL-formats. 


VBI is recorded in the visual area. 


 
• IngestRecording: starts ingesting the previous recording, if any, 6 seconds from start. Starts 


ingesting the current recording, 6 seconds from end. 


 


 
Event parameters can be modified in POC. If you want to work with different parameters than the ones 
predefined, to avoid having to change parameters for each recording we advise to change the Format 
in Channel Composer.  
 
 
The IngestOnly Format 


 
Example Event in POC. 
 


• This Format stops recording when the Event is triggered. 


• Ingests the previous recording. 
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4.34 POC shortcuts 
Activate Playlist Alt+P 


As Run Log Alt+L 


Asset Search Ctrl+Shift+F 


Channel List Ctrl+Alt+C 


Check Me Alt+H 


Clean Alt+C 


Copy Ctrl+C 


Create Asset Ctrl+I 


Cue Alt+G 


Cue & Go Ctrl+Alt+G 


Current Day Alt+Up 


Cut Ctrl+X 


Delete Del 


Down Event Selection Shift+Down 


Down Selected Event Down 


End Event Selection Shift+End 


End Selected Event End 


Export Alt+E 


Filter Exec Ctrl+E 


Filter On/Off Ctrl+O 


Follow Alt+F 


Gangroll Ctrl+Shift+G 


Go Ctrl+G 


Home Event Selection Shift+Home 


Home Selected Event Home 


Import Alt+I 


Move Event Down Ctrl+Down 


Move Event Up Ctrl+Up 
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Next Day Alt+Right 


Page Down Event Selection Shift+Page Down 


Page Down Selected Event Page Down 


Page Up Event Selection Shift+Page Up 


Page Up Selected Event Page Up 


Paste After Selected Event Ctrl+Shift+V 


Paste Before Selected Event Ctrl+V 


Playlist List Ctrl+Alt+P 


Preview Ctrl+P 


Previous Day Alt+Left 


Re-apply Format Alt+A 


Refresh F5 


Replace Ctrl+R 


Report Alt+R 


Save Ctrl+S 


Save As Ctrl+Shift+S 


Schedule 1 Alt+1 


Schedule 2 Alt+2 


Schedule 3 Alt+3 


Schedule 4 Alt+4 


Schedule 5 Alt+5 


Schedule 6 Alt+6 


Schedule 7 Alt+7 


Schedule 8 Alt+8 


Schedule 9 Alt+9 


Scroll Left Left 


Scroll Right Right 


Search Ctrl+F 


Select All Ctrl+A 


Switch to Fixed Ctrl+Alt+I 
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Switch to Follow Ctrl+Alt+F 


Switch to Manual Ctrl+Alt+M 


Take Next Ctrl+N 


Toggle Horizontal View Alt+H 


Up Event Selection Shift+Up 


Up Selected Event Up 


 
 
 


4.34.1 Changing the POC shortcut’s properties 
To change the virtual IP-address of the TX/MAM servers in the POC-shortcut properties: 
 Right-click the POC-shortcuton your desktop > Properties > Shortcut.  
 In the Target field fill in the TX/MAM servers’ virtual IP-address.  
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5. Asset Importer 
The Asset Importer is a separate application. To purchase, contact your Grass Valley account 
manager. 
 
5.1 Asset Importer How to 
This section describes the XML-structure for XML asset import files. 
Use the Asset Importer to: 
• import metadata and/or  
• ingest assets: specify asset's filename origin to ingest (i.e. specify fields filename and origin in 


section type-metadata, see below) 
 
Note that all asset types referenced in a XML-file have to be defined in TX/MAM before importing the 
XML-file. 
 
5.1.1 Explanation XML-file records and attributes 
• bold: records 
• italic: optional/variable 


 
item type format explanation 


header - --   
Cobalt Record na fixed 
Asset Record na specifies main asset 


InternalID Attribute na 


InternalIDs as generated 
by external system are 
recorded within Cobalt 
for efficient 
synchronization. 


LastSaveDate Attribute yyyy-mm-dd 


LastSave information 
can be used to 
efficiently sync assets; 
only items that were 
saved after the last sync 
need to be synchronized 
within Cobalt. 


LastSaveTime Attribute hh:mm:ss:ff see LastSaveDate 


AssetType Attribute as defined in 
Cobalt 


asset type as defined in 
Cobalt Asset Manager; 
specify when importing 
(empty) main asset 


type_metadata Record na base type metadata 
fields for asset type 


<FIELD name="filename">name</FIELD> Record na filename: specify when 
ingesting asset 


<FIELD name="origin">path</FIELD> Record na 


upload directory for 
asset; if not specified, 
the location of the XML-
file is used 


<FIELD name="delete_source_after_ingest"> 
true</FIELD> Record true/false 


only use this option if 
original file (as specified 
in FIELD origin) can be 
deleted after ingest 


<FIELD name="use duration">value</FIELD> Record hh:mm:ss:ff 
define use duration for 
asset, if not specified, 
use duration of Event is 
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used 


custom_metadata Record na 
custom metadata 
field(s), if any for asset 
type 


FIELD Record   
values are mapped to 
fields as defined in the 
Cobalt Asset Manager. 


name Attribute as defined in 
Cobalt 


fields that are not found 
in the asset definition 
will be ignored 


transfer_data (optional) Record   


<FIELD name="type">ftp</FIELD> Record na ftp 
<FIELD name="username">username</FIELD> Record na username ftp-server 


<FIELD name="password"> 
password </FIELD> Record na password ftp-server 


<FIELD name="ip">ip</FIELD> Record na ip-address ftp-server 
<FIELD name="port">port</FIELD> Record na port  ftp-server 


<FIELD name="path"> 
path </FIELD> Record 


na 
path ftp-server 


<FIELD name="file">file</FIELD> Record na filename  


5.1.2 Example XML-file 
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6. Format Control  
Cobalt Format Control allows you to dynamically add formats to or remove formats from blocks of 
events in a playlist, based on custom rules. To which type of events you can add formats depends on 
your user rights. These user rights are managed in TX/MAM. 
 
Rules are made of decisions and actions.  
 
The sample rule below can be interpreted as follows: 
• IF the time of day is between 6 and 9 AND the Asset Type IS ‘Song’, add the Format ‘B-Breakfast’ 


to Events.  
• IF the time of day is between 6 and 9 AND the Asset Type IS NOT ‘Song’ AND the Asset Type IS 


‘Link’, add the Format ‘B-Breakfast fast Lie-in’ to Events.  
 
 


 
 
 
6.1 Starting Format Control 
To open Format Control, double-click the Format Control icon on your desktop. 


 
 
 
6.2 Decisions 
Decisions can be defined based on: 
• Time of day  
• Custom and type metadata: asset type, field, value  
• Schedule (third party schedulers): field, value  
• Block 
• Format 
• Duration (of the main asset of an event)  
 
A decision results in a ‘yes’ or ‘no’.   
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6.3 Actions 
You can define the following actions: 
• Format: add or remove a format from the event(s).  


• Block: start or end a block.  


• Flag: add a flag in POC to the event. 


• Repl. Fmt: replace a format with another format. 


• Del. all Fmt: delete all formats of the event. 


• EventType: set the scheduling method for an event. 


 
6.4 Creating new rules 
 In Format Control, click the New Rule button.  


 
 
A new Rule is added to the list of Rules.  


 Double-click to edit. 
The Edit rule window opens [see next paragraphs for options].  


 
6.4.1 Adding decisions and actions to rules 
 In Format Control, double-click the rule you want to edit.   
 To insert a Decision, on the menu click the Decision option and select the Decision you want to 


add.  
 Click the canvas to insert (if first object on canvas), or, move the cursor over the object you want 


to link the Decision to. The orange mark indicates where the decision can be linked.  
 
 To insert an Action, on the menu click the Action option and select the Action you want to add.  
 Click the canvas to insert (if first object on canvas), or, move cursor over the object you want to 


link the Action to. The orange mark indicates where the action can be linked.  
 
6.4.2 Editing Decisions 
Double-click the object you want to edit. 
 
Time of day 
• Select Greater than / Equal / Smaller than.  
• Specify time of day.  
• Click Save to save, Cancel to discard.  
Combine ‘greater than’ and ‘smaller than’ to specify a time slot.  
 
Metadata 
• Select Asset type / Custom Metadata / Type Metadata.  
• Specify ‘type’, ‘field’ and ‘value’. 
• Click Save to save, Cancel to discard.  
 
Schedule (third party schedulers) 
• Specify ‘field’ and ‘value’. 
• Click Save to save, Cancel to discard.  
 
Format 
• Specify a Format.  







071884403  Cobalt Client 1.24 for GV Edge User Guide - 53 


• Click Save to save, Cancel to discard.  
 
6.4.3 Editing Actions 


Format 
This action applies or removes a format. 
To apply or remove a format: 


1. On the canvas, double-click the block action to edit it. 


2. Select Apply format or Remove format. 


3. Select a format. 


4. Click Save to save the action.  


Block 
This action starts or ends a block [see paragraph Error! Reference source not found. for an 
example]. 
To set the start or the end of a block: 


1. On the canvas, double-click the block action to edit it. 


2. Select Start Block or End block.  


3. BlockValue: specify the name of the block you want to start or end.   


4. Click Save to save the action.  


Example block marker: 


 
This rule defines block SP VEET: IF asset type is Song, block SP VEET starts AND add format SP 
VEET to Events. 
 


Flag  
This action sets a flag in POC. 


To set a flag in POC: 
1. On the canvas, double-click the flag action to edit it. 


2. Select the flag you want to add to the event. 


3. Click Save to save the action.  


Repl. Fmt  
This action replaces a format with another format. 
To replace a format with another format: 


1. On the canvas, double-click the Repl. Fmt action to edit it. 


2. Select the format you want to replace (Replace Format) and the format with which you want to 


replace it (With Format). 
3. Click Save to save the action.  
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Dell all Fmt 
This action deletes all formats that are linked to an event. 
To delete all formats that are linked to an event: 
1. On the canvas, double-click the action to edit it. 


2. Click Save to save the action.  


EventType 
This action sets the way in which an event is scheduled on a playlist. The options that you can set are: 
• Follow (follows after the previous event on the playlist). 


• Manual (the event must be manually started). 


• Fixed (the event is scheduled at a given time). 


To set the scheduling method: 


1. On the canvas, double-click the block action to edit it. 


2. Click Save to save the action. 


6.4.4 Deleting decisions or actions 
• Select the Decision or Action.  
• On the menu, click the Delete button.  
Note that any attached objects are deleted as well. 
 
6.4.5 Arranging objects 
To arrange objects on the canvas, click the Arrange button.  
 
6.4.6 Duplicating rules 
• Select the Rule you want to duplicate from the list.  
• On the menu, click the Duplicate button.  
 
6.4.7 Deleting rules 
• Select the Rule you want to delete from the list.  
• On the menu click the Delete button.  
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6.4.8 Enabling and disabling Rules 
Rules are added to the Rules list in Format Control. Use numbers to assign priority (the order in which 
Rules are applied for a Channel), with 0 being the highest priority. If no number is assigned (the 
priority field is empty) the Rule is not applied. 
 


 To set priority, right-click the priority field for the Rule and Channel. . 
 Use the arrows to set the rule you want to activate. 


 
Example. 


 Set Rules you want to deactivate to  - (empty priority field). 


 
 


 
Example with the Edge Content Rule deactivated for Channel1 and the Hydro Content Rule activated 
with priority 1. 
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1 About this guide 
The Channel Composer 1.6.9 user Guide gives users the latest information and instructions about 
how to use Channel Composer 1.6.9 for GV Edge. 
 


1.1 What’s in this guide 
This user guide is written for users with a basic understanding of broadcasting and Channel design. 
We recommend that users who are new to these concepts take the Channel Composer training. 
 


& This document describes Channel Composer version 1.6.9. Information in this manual may at 
some points differ from your Channel Composer application due to differences in version.  


 
& A number of Example Projects are included in Channel Composer and can be found under File > 


Example Projects. Following topics are explained: 


• Play Video: demonstration of basic video playback. 
• Tickers: various examples of Tickers. 
• Clocks and Counters: various examples of Clocks and Counters. 
• Squeeze back: an example of a squeeze back of the main video. 
• Keying: demonstrates the two main ways of keying, by Player and by Object. 
• Soft cuts: explains Template soft cutting. 
• Scaling: various methods for upscaling, for example from SD to HD, and downscaling. 
• Quality Assurance: various techniques that can be used to counter graphics artifacts commonly seen in 


broadcasting. 
• Optimization: various techniques for playback optimization. 
• Controllers: examples of Controllers; Controllers are an alternative to keyframing for animating Objects. 
• Ground Reflection: demonstrates the Group Object’s ability to generate reflections of its members on the 


ground plane. 
• Sports: an example of the usage of Channel Composer for a sports info Channel. 
• Music: an example of a typical music Channel. 
• Simulcast: an example of a basic HD-SD simulcast project. 
• Tickers: shows how to set up RTic compatible tickers. 
 


1.2 Document conventions 
The formatting of this user guide is designed to help you easily and quickly find information. The 
following table explains what the different formats in this document mean. 
 
Format Refers to Example 
Bold An onscreen object for which a user 


action is needed. Keyboard keys are not 
emphasized. 


Click Save As. 


Italic Placeholder text. 
Hyperlink or cross-reference. 


type password. 
See Chapter 2, Get to know K2 TX/MAM 2.7. 


■  Single-step procedures. ■ On the View menu, click Ruler. 
1.  Multiple-step procedures. 1. On the Tools menu, click Options. 


2. Click the Edit tab. 
& Note:   A note. & Note: Only administrators can 


publish to a server. 
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•  A list item. A user can edit: 
• Objects 
• Materials 
• Visual effects. 


 


1.3 Useful resources 


Do you have a specific question and was the answer not in this user guide? Please visit our website 
or contact Grass Valley support. 
 
To contact Grass Valley support, do one of the following: 
■ Call one of our international support centers with 24/7 availability: 


o France, +800 8080 2020 or +33 1 48 25 20 20. 
o US and Canada, +1 800 547 8949 or +1 530 478 4148. 


■ Call one of our local support centers, open during normal business hours: 
o Asia 


 Hong Kong, Taiwan, Korea and Macau: +852 2531 3058. 
 Indian Subcontinent: +91 22 24933476. 
 Southeast Asia/Malaysia: +603 7492 3303. 
 Southeast Asia/Singapore: +65 6379 1313. 
 China: +861 0660 159 450 Japan: +81 3 5484 6868. 


o Australia and New Zealand: +61 1300 721 495. 
o Central and South America: +55 11 5509 3443. 
o Middle East: +971 4 299 64 40. 
o Near East and Africa: +800 8080 2020 or +33 1 48 25 20 20. 
o Europe 


 Belarus, Russia, Tadzikistan, Ukraine, Uzbekistan: +7 095 2580924 225. 
 Switzerland: +41 1 487 80 02. 
 Italy (Rome): +39 06 87 20 35 28. 
 Italy (Milan): +39 02 48 41 46 58. 
 Spain:  +34 91 512 03 50. 
 Belgium: +32 (0) 2 334 90 30. 
 Netherlands: +31 (0) 35 62 38 42 1. 
 Benelux and Northern Europe: +45 45 96 88 70. 
 Germany, Austria, Eastern Europe: +49 6150 104 444. 
 UK, Ireland, Israel: +44 118 923 0499. 


 
& Answers to frequently asked questions can be found on our forum on the Grass Valley website: 


http://forum.grassvalley.com/forum/ > Smart Playout Center > Channel Composer. 
 
 


& If applicable, register yourself on the forum page: 


 
 



http://forum.grassvalley.com/forum/
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& Channel Composer video tutorials are available on the Grass Valley website: 
http://www.grassvalley.com/apps/doc_show?&set=ips&c=^channel%20composer$|Channel%20Compo
ser&super=broadcast&skin=gvcmsnew&sort=rev > Videos. Following tutorials are available: 


• Creating a Play Clip Template and Format. 
• Creating a Logo Bug Template and Format. 
• Creating a 3D Picture-in-Picture Template and Format. 
• Creating a Ticker Template and Format. 
• Creating a Clip title Template and Format. 
• Creating a Clip title Wipe Template and Format. 
• Creating a 3D picture-in-picture Template and Format. 
• Working with Controllers. 
• Creating a Dynamic Textbox Template. 
 


  



http://www.grassvalley.com/apps/doc_show?&set=ips&c=%5echannel%20composer$|Channel%20Composer&super=broadcast&skin=gvcmsnew&sort=rev

http://www.grassvalley.com/apps/doc_show?&set=ips&c=%5echannel%20composer$|Channel%20Composer&super=broadcast&skin=gvcmsnew&sort=rev
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2 Channel Composer concepts 
Channel Composer is used to create 2D and 3D scenes. Look-and-feel, 
presentation and content metadata is assembled to a complete Channel design, 
ready for on-air presentation. This chapter describes the basic Channel 
Composer concepts. 


 
2.1 Objects  


  


Channel Composer works with Objects such as Clip, Box, 
Still, Animation, Plane and so on. Objects have properties, 
such as opacity, position and scale that can be modified 
and animated.  
The example shows the Object properties window for a 
Clip Object. 
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The Objects window lists all the Objects added to a Project 
(or all Objects included in the selected Template when the 
Filter icon is active as shown in the example on the left.) 
Each Object is placed on its own layer. Objects on higher 
layers overlap Objects on lower layers.  
 
 


& In Channel Composer, one and the same Object 
can be used in different Templates while its properties 
can have different values per Template. 


 


2.2 Templates 


 
Templates are used to transform Objects’ properties such as opacity, position and scale in time. The 
example above shows a Template used to play a Clip. The column on the left lists the Objects 
included in the Template. Each Object has its own track on the Timeline. The player head (the yellow 
vertical line) can be moved, paused and rewinded to preview animations on the Stage.  
Define a Template for on-screen transitions that you want to able to control and time independently 
from each other.  
 


2.3 Formats  


 
A format is a list of secondary Events (Templates and Applets) that together provide a certain on-air 
look and behavior when executed.   
The example above shows the Format Play Clip. The column on the left lists the Templates and 
Applets included in this Format. Templates and Applets are timed on the Format Timeline using 
offsets relative to the main Asset.  
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2.4 Assets 


 


An Object, for example a Clip or Still, can refer to fixed 
content or to dynamic content. 
• Example fixed content: a logo. 
• Example dynamic content: video clips; the Template 


plays out a different video clip each time it is activated. 
 


All the fixed files that belong to a Channel design are added to the Channel Composer Project as 
Assets. These Assets are included in the Channel Pack when the Project is exported to the TX/MAM 
database. Thus, all the fixed design elements needed for playout - logos, straps, and so on - are 
available in the Channel Pack.  
 


2.5 Scene parameters 
To refer to dynamic content, Scene Parameters are defined. These parameters are dynamically 
updated with the assets’ filename when Events are scheduled. Dynamic content is fetched from 
Storage for playout. 
 
Example: 
Scene Parameter Event ID Scene Parameter Value when 


scheduled 
clip 12345 a0000548.avf 
clip 12346 a0000978.avf 
clip 12347 a0000564.avf 
 


2.6 Metadata 
An Object can also refer to a file's metadata fields. This metadata information can be played out, or 
is used to schedule Events. For examples, clip title and artist information is derived for playout from 
the clips' <title> and <artist> metadata fields. 
 


2.7 Test media 
For testing purposes, test media (images, videos) can be added to the Test Media library. Note that 
test media will not be included in the Channel Pack when the Project is exported.  
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2.8 Main event  
In this paragraph we will briefly explain the concepts ´main Asset´ and ‘main Event’ that this manual 
at some points refers to. 
A Playlist lists main Events. Each main Event consists of secondary Events (Templates and Applets). 
 
Example: in a music show Format, Events are built of the following secondary Events: 
• Playout the clip.  


The clip is the main Asset. The dynamic reference to the music clip file (scene parameter usually 
linked to the File property of the Clip Player object) is updated with the clip asset’s filename 
when the Events are scheduled. Dynamic content is fetched from Storage for playout. 


• Fade in the logo 5 seconds after the start of the main Event. 
The logo is a fixed Asset that is included in the Channel Pack 


• Fade out the logo 3 seconds before the end of the main Event. 
 


The secondary Events are timed relative to the main Asset’s duration.  


 
Example playlist in Playout Control, listing main Events.  
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2.9 Projects and channel packs 
A Project contains all the elements that together compose a Channel’s on-air design: fixed Assets, 
Objects, Templates, Applets and Formats. Projects are designed in Channel Composer and are then 
exported to the TX/MAM-database as a Channel Pack. Formats are now available for scheduling.  
Before playout, the Channel Pack is transferred from the TX/MAM database to the playout nodes. 
Dynamic content is fetched from Storage and is also transferred to the playout nodes. 
 
 


 
 
 
 
  


Objects 


Assets 


Formats 


Templates 


Applets 


Project 


Channel Pack 
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2.10 Channel pack activation and scheduling 
When creating a Schedule, the Cobalt scheduling process will apply the Channel Pack that is active 
at the Events’ planned start time. This means that Events are scheduled with the Formats from this 
Pack. Events in a Playlist play out the Formats they were scheduled with. 
 
Example:  
Schedule Channel Pack 
Events are scheduled with  the Assets, Templates, Applets and Formats from: 


Event  
Start time: 13/02/12 12:00:00 


 


 


Channel Pack ID: 2400 
Activation starts:  13/02/12 12:00:00 
 Event  


Start time: 13/02/12 12:03:00 


Event  
Start time: 13/02/12  and so 
on 


Event  
Start time: 14/02/12 12:00:00 


 


 


Channel Pack ID: 2312 
Activation starts:  14/02/12 12:00:00 
 Event  


Start time: 14/02/12 12:03:00 


Event  
Start time: 14/02/12 and so on 


 


 
Example Activation date and time set for a Channel Pack. 
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The Channel Pack's activation period can be specified: 
• in Channel Composer when exporting the Project to the TX/MAM database 
• via the ‘Manage Exports’ option 
• using the Channel Pack Manager.  
Channel Composer ‘Export’ and ‘Manage Export’ options are described in Chapter 5. Note that you 
can also view (not modify) Channel Packs in POC.  
 
  


& When scheduling Events in an active Playlist that uses a different Channel Pack than the currently 
loaded Pack, leave at least one minute for this Pack to load. In other words, schedule Events at 
least one minute in advance of start of playout.  


Example Channel Packs overview in POC. The currently active Pack is highlighted. Note that Channel 
Packs have an asset ID. When a Channel Pack is changed and exported, a new pack with a new asset ID is 
created.  
 


& If a Channel Pack is changed after it has been used in a Schedule, you need to regenerate the 
Schedule (with the new Pack ID) to apply these changes. 
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2.11 Workflow 
■ Channels are designed in Channel Composer. 
■ The Project is then exported to the Cobalt (TX/MAM) database and includes all the design 


elements needed for playout.  
■ Formats are now ready for scheduling.  
■ Before playout, the Channel Pack is transferred from the TX/MAM database to the playout 


nodes. Dynamic content is fetched from Storage and also transferred to the playout nodes.   
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3 Getting started 
3.1 System Requirements (Mac) 
• A Mac computer with a multi-core Intel processor (64-bit). 
• Mac OS X v10.6 (Snow Leopard) or later. 
• Memory: 4GB of RAM. 
• Video card:  


o 512MB of VRAM or more.  
o OpenGL 2.1 and the following OpenGL extensions: 


 EXT_framebuffer_multisample 
 EXT_framebuffer_blit 
 ARB_texture_rectangle 
 APPLE_flush_buffer_range 


o NOT recommended: NVIDIA Quadro cards.  
o Recommended: ATI Radeon HD5670 or better, NVIDIA Geforce GT320 or better. 


 
[See the following link for an overview of the OpenGL support on Mac OS X for your system and video 
card: http://developer.apple.com/graphicsimaging/opengl/capabilities/] 
[See the readme included with the installation image for most recent requirements.] 
 


3.2 Installation (Mac) 
■ Double-click the Channel Composer image (.dmg file) to mount the disk image.  


The disk image icon appears on the desktop and the next window opens. 
■ Drag the Channel Composer icon on the Applications folder, to copy Channel Composer to your 


Applications folder. 
 


You can now start Channel Composer from the Applications folder. 
 


3.3 Requirements (Windows) 
• An Intel/AMD 64-bit multiprocessor PC.  
• A 64bit edition of Windows Vista, Windows 7 or Windows 8. 
• Memory: 4GB of RAM. 
• Video card: 


o 512MB of VRAM or more. 
o OpenGL 2.1 and the following OpenGL extensions: 


 EXT_framebuffer_multisample 
 EXT_framebuffer_blit 
 ARB_texture_rectangle 
 ARB_map_buffer_range 


o NOT recommended: NVIDIA Quadro cards.  
o Recommended: NVIDIA Geforce GTS250 or better. 


[See the readme included with the installation image for most recent requirements.] 
 


& It is not possible to run Channel Composer via Windows Remote Desktop.  
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3.4 Installation (Windows) 
■ Double-click the installer exe file and follow the instructions. 


 
& It is recommended to run Channel Composer as an Administrators group user. The easiest way to 


achieve this is to mark the application to run as Administrator: in Windows Explorer, access 
'Channel Composer.exe' properties, navigate to 'Compatibility' tab and tick 'Run as Administrator' 
checkbox. Channel Composer does not really require elevated privileges to run, but in doing so a 
wider range of thread scheduling priorities become available thus allowing for faster response 
times. Note that Channel Composer does not create or modify any files unless instructed by the 
user, i.e. to save a project on disk. To that effect it is perfectly safe to run Channel Composer as 
Administrators group user. 


 


3.5 Opening Channel Composer 


 


To start Channel Composer, double-click the Channel 
Composer icon. 


 


Channel Composer opens. You can now start working with 
Projects. Chapter 5 explains the options in this window. 
 
 


 
 


3.6 Setting preferences and customizing 
The Channel Composer workspace can easily be customized. One way to do this is by adding or 
removing (View > Windows) windows, or by scaling and repositioning windows (drag and drop). 
Windows can also be added together by dragging a window on top of another. Double-click the 
window's title to dock and undock windows.  Other options to customize Channel Composer include: 
 


Channel Composer > 
Preferences 
 


On the toolbar > Channel Composer > Preferences, you can define 
preferences, for: 
• Nexos: 


o Broadcast Format 
o Multi-Sampling Anti Aliasing: use to improve the design's 


visual quality on your workstation (remove edge line 
roughness and jagged edges). Note that higher sample 
rates impact performance of your workstation. 


o Players: set the big buffer pool size in MB. 
• File:  


o Specify the default Project folder. 
o Autosave: disable (default) or enable autosave every x 


minutes 
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• History: the number of actions tracked in history. 
• Guides: the color of the guides and snap distance. 
• Grid: the color of the grid, spacing and snap distance. 
• Backup System: number of backups to keep. 
• Networking: specify the FTP transfer mode. 


View > Windows On the toolbar View > Windows, you can define which windows you 
want to display or hide. Options are: 
• Project Navigator 
• History 
• Library 
• Project Assets 
• Objects 
• Object Properties 
• Template Timeline 
• Text Styles 
• Scene Parameters 
• Format Timeline 
• Template Rules 


Main menu > View 
 


On the main menu > View , you can set a number of options for the 
Stage: 
• Zoom In: zoom in on the Stage. 
• Zoom Out: zoom out from the Stage. 
• Zoom to 100%: scale the Stage to 100%. 
• Fit in Window: fit the Stage in the available workspace. 
• Rulers: show or hide rulers. 
• Grid: show or hide the grid. 
• Guides:  show or hide guides. 
• Snap to Guides: enable or disable ‘snap to guides’. 
• Snap to Grid: enable or disable ‘snap to grid’. 
• Pixel Perfect Information: show or hide pixel perfect information. 
• Windows: select the windows you want to display. 
• Clean View Mode: activate to hide all windows and display the 


Stage only, deactivate to show windows and the Stage. 


Main toolbar 
 


On the toolbar, you can set a number of options for the Stage: 
• Zoom In: zoom in on the Stage. 
• Zoom Out: zoom out of the Stage. 
• Percentage: zoom the stage to the selected percentage. 
• Fit: fit the Stage in the available workspace. 
• Curtains: Objects may be placed outside of the active Stage area 


to allow animation on to and off of the Stage. The curtains button 
covers this outside area for a clear view of what the final Channel 
output will be. 
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4 Working with projects  
Channel Composer works with Projects. When exported to disk or the TX/MAM 
database, the Project is bundled into a Channel Pack [see also paragraph 3.6].  
 
Options are: 
■ Create a new Project. 
■ Open an existing Project. 
■ Import a Project from a Channel Pack on disk or from the TX/MAM database.  
■ Restore a backup. 
■ Merge Projects. 
 


4.1 Creating or opening a project 


 
 


Following options are available from the Channel 
Composer Welcome screen, and from the File option on 
the main menu: 
• Create a new Project. 
• Open an existing Project. 
• Open an existing Project from a list of recent 


Projects. 
• Import a Project. 
• Restore a Backup. 
 


 
& In the Welcome window, Channel Composer preferences can be set. This can be necessary 
when the Project you want to open uses a different broadcast format than Channel Composer’s 
current format (Channel Composer opens with the broadcast format last used). After changing 
the broadcast format, you have to restart Channel Composer. 
& Instead of changing Channel Composer’s broadcast format, you can load the Project with 
the currently active format and thus change the Project’s broadcast format. Note that this can 
result in an incorrect output resolution and playback speed. 


New Project For a new Project, specify: 
• Name 
• Location 
• Author 
• Description 


New Projects contain three default Templates: 
• nexosInit: this Template is automatically started after a nexos restart and places the Color Bar 


Object on-screen (default). This template can be further customized at will. 
• packInit: this Template is automatically started when a new Channel Pack is started, before the 


first Template in this Pack. This Template can be further customized at will, for example to 
start a Live Player. 


• Template: an empty Template that contains an Out Point for the Color Bar Object (default). We 
advise to remove the Color Bars to save resources [see also the Example Project Optimization]. 


File > Project Settings 
 


Project properties can be viewed under File > Project 
Settings. 
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Note that Export and Channel Pack Asset Type options 
can be reset here. 


File > Merge Project The Merge option can be found under the File option. 


File > Preferences Preferences can be viewed and modified under File > 
Preferences. 


 
 


4.2 Importing a project 
Projects can be imported from a Channel Pack on disk or from the TX/MAM database. 
 
4.2.1 Importing a project from a channel pack on disk 


1. Click File > Import Project > from Disk. 
2. Browse to the folder the Channel pack is located in and select the applicable Channel Pack (.cpk 


file). 
 
4.2.2 Importing a project from the TX/MAM database 


File > Import Project > from TX/MAM 
Database 


1. Click File > Import Project > from TX/MAM Database. 


 


2. Specify the (virtual) IP-address of the TX/MAM 
server. 


3. Fill in the login credentials for the TX/MAM server. 
Note that this user must be defined in Cobalt Asset 
Manager and should have read rights for the 
Channel Pack Asset Type. 


4. Click Next to continue, or Cancel to discard. 


Select Project 5. Select the Channel Pack you want to import. 
6. Click Next to continue or Cancel to discard. 


Select destination folder 7. Select a destination folder for the Project. 
8. Click Next to start the import, Back to go to the 


previous screen or Cancel to discard. 


 
& You can use the Channel Pack Manager to list the Channel Packs that have been exported to a 


TX/MAM database. 


 


4.3 Merging projects 
Merging Projects is an easy means to reuse parts of a Project (Templates, Formats, and Applets). For 
example, to reuse a set of ‘ticker’ and ‘play video’ Templates and Formats, place these items in a 
separate Project, then merge this Project with other Projects to reuse. Merging Projects can also be 
useful when working with several people on a Project. 
The Merge Project functionality has been enhanced with the option to do a replacement merge. 
Using this type of merge, objects and assets in the merged-in project replace objects and assets of 
the same name in the original project. 
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File > Merge 1. Click File > Merge. 
2. Select the type of merge and Project you want to 


merge with the current projects. 
3.  


 


4. Select the appropriate option if performing a 
replacement merge. 


5. Click Open to merge, Cancel to discard. 


 


4.4 Restoring a backup 
Each time a Channel Composer Project is saved, a backup is automatically created. This backup 
contains all project data, except for Project Assets. 
 
To restore a backup: 
1. Click File >Restore Backup. 
2. Select the backup you want to restore and click Restore. 
 


4.5 Exporting a project  
When a Project is exported, a Channel Pack is created. Options are: 
• Export to disk, for example to create a backup: create a Channel Pack and export to the specified 


destination folder. 
• Export to the TX/MAM database: create a Channel Pack and export to the TX/MAM database 


when the design is ready, or to share with other people working on different workstations or 
locations. Once exported to the TX/MAM database, the Channel Pack can be used for 
scheduling. You can specify the Project’s activation period during export, or at a later stage. 


• Export to Playout: create a Channel Pack and export to a playout server for 3rd party scheduling 
or testing purposes. 


 
& Before you can export Projects, at least one CPK (Channel Pack) Asset Type and Format Asset 


Type must be available in Cobalt/TX/MAM. 


 
& To be able to work with Exports, you also need read/write rights for the appropriate Channels and 


CPK (Channel Pack) Asset Types. These user rights are set in Cobalt Asset Manager. 


 
& Channel Packs can be validated against a test schedule. For more information see chapter 12. 


 


4.6 Exporting a project to disk 
1. Click File > Export Project > to Disk. 
2. Specify the destination folder and Channel Pack name. 
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4.6.1 Exporting a project to the TX/MAM database 


 


File > Export Project > to TX/MAM 
Database 


1. Click File > Export Project > to TX/MAM Database. 


 


2. Specify the (virtual) IP-address of the TX/MAM 
server. 


3. Specify the user name and password for the 
TX/MAM database.  


 
& If you select the Remember database server 
option, the database server specified will be saved as 
a property of the Project.  
& (To reset, click Project > Project  Settings > 
Export TX/MAM database server > Reset.) 


 
4. Click Next to continue, or Cancel to discard. 


 


5. Select a Channel Pack Asset type from the Asset 
types listed. The Project will be exported as an Asset 
of this type.  
 


& If you select the Remember Asset type option, 
the Asset type specified will be saved as a property of 
the Project.  
& (To reset, click Project > Project Settings > 
Export > Channel Pack asset type > Reset.) 
 


6. Click Next to continue, Back to go to the previous 
screen or Cancel to discard. 


 


7. To export the Project to the playout server without 
activation, leave the Activate Channel Pack option 
unchecked and click Next. You can activate the pack 
at a later Stage via File > Manage Exports.  
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8. To activate the Project on one or more Channels, 
click the Activate Channel Pack option.  


9. Click the  icon to add a Channel to the activation 
list. To specify an activation date and time, click the 
arrow icon. 
Click OK to save, Cancel to discard. 


10. Click the  icon to delete a Channel from the 
activation list. 


11. Click Next to export and activate the Project, Back to 
go to the previous screen or Cancel to discard. 


 


The Project is exported. All elements needed for playout 
– Assets, Objects, Templates, Applets and Formats – are 
included in the Channel Pack.  
 
Dynamic content will be fetched from Storage, using the 
Scene Parameters defined in the Project. 
 


& Note that only one Channel Pack can be active 
simultaneously per Channel. 


 
 
4.6.2 Exporting a project to playout 


1. Click File > Export Project > to Playout… 
2. Specify the playout server(s) you want to export the Project to: 


a. Server IP 
b. Channel number 
c. Activation time 


 


4.7 Managing exports 
This option lets you manage Channel Packs. Options: 
• View Project Packs, per Channel or Project in chronological order (Grouped). 
• Remove a Pack from the database. 
• Modify the activation properties of a Channel Pack (Channel, activation date/time).  
• View Channel Pack contents. 
 
1. To open, go to File > Manage Exports. The Manage Exports window opens. 
2. Specify the IP-address of the TX/MAM database server. 
3. Specify the user name and password used for the export. This is a Cobalt user. 
 


& Note that this user should have read and/or write rights for the applicable Channel Pack Asset 
Type and Channel. These user rights are set in Cobalt Asset Manager. 


The example below shows Channel Packs per Project (Grouped). The  icon indicates that a Pack is 
currently active in Cobalt. The Info window shows properties of the selected Pack. The Contents 
window shows Templates, Formats, Applets and Scene Parameters included in the selected Pack. 
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View:  
Grouped 
Channel 


View Channel Packs Grouped per Project (in chronological order) or by Channel. 


 Indicates that the Channel Pack is currently active in Cobalt. 
 


 To remove a Pack from the database, select the Pack and click the Remove icon. 


 To list Channels and activation date/time for a Pack, select the Pack in the list. 
 


& Note that only one Channel Pack can be active simultaneously per 
Channel. 


 
To activate a Channel Pack for a Channel: 
1. Select the Pack. 
2. In the Activation panel, click the Add icon. Specify the Channel and activation 


date/time. 
3. Click OK to confirm, Cancel to discard.  


 
To de-activate a Channel Pack: 
1. Select the Pack, the applicable Channel and activation date/time definition. 
2. In the Activation panel, click the Delete icon.  


Contents The Contents window lists the Templates, Formats, Applets and Scene 
Parameters included in the Channel Pack.  
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5 Working with templates 
Templates are used to animate Objects' properties in time.  
 


 
Example Template Timeline. 
 


& Move the player head or use the player buttons or time code fields to preview animations on the 
Stage. 


 


5.1 Opening a template  


 
In the Project window, double-click the Template you want to edit, or select the appropriate 
Template tab in the Template Timeline. 


 


5.2 Creating a new template 


 
In the Project window, click the Add Template icon, or in the toolbar click Project > Add 
Template. 


 


5.3 Renaming a template 


 
In the Project window, select the Template > right-click > Rename, or on the Template 
Timeline double-click the Template name on the tab header. 


 


5.4 Deleting a template 


 
In the Project window, select the Template > click the Delete icon to delete.  


 
To delete a template tab from the Template Timeline (the Template itself will still be 
available in the Project), click the Delete icon on the tab header. 


 


5.5 Copying a template 


 


 
In the Project window, select the Template > right-click > Duplicate Template. 
You can also select the Template on the Template Timeline > click the Duplicate Template 
icon to copy. 
 


& Note that Objects in the source Template are not duplicated; in other words, both 
Templates - the original and the source will use one - and the same Object. If this Object is 
modified in Template A, it will also be modified in Template B.  
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5.6 Displaying object properties on the timeline 
To display not only Objects, but also Object properties on the Timeline, select the Show > Object 
Properties option in the Timeline’s left bottom corner. 
 


 


 
& Note how the distinction between Changing and Unchanging properties is made. A green segment 


between keyframes indicates that the property value changes in between the keyframes. When 
this segment is grey, property values do not change. 


 


5.7 Setting in points and out points 
In and Out Points specify when an Object is active, i.e. audible, visible, and so on. As a default, the In 
Point is set at 00:00:0 and no Out Point is defined.  
 
■ To add an In Point, drag the Object’s In Point (the Object’s activity segment’s start on the 


Timeline) to the appropriate position, or right-click the Timeline on the appropriate position > Set 
In Point. 


■ To add an Out Point, right-click the Object > Enable Out Point, or right-click the Timeline on the 
appropriate position > Set Out Point. 


■ Then drag the Object’s Out Point (the activity segment’s end) to the appropriate position, or right-
click the Timeline on the appropriate position > Set Out Point. 


 
When the Player > Auto-stop at Out Point option is activated (under Object properties), a Stop 
Playback action is automatically inserted when an Out Point is added to a Player on the Template 
Timeline. This will stop the Player. Note that this option only applies for Player Objects. 
 
 


& The Example Project Optimization explains how to work with In and Out Points. 
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Example Audio Object with In and Out Point. Because the Auto-stop at Out Point is enabled for this Object 
(Object properties), the Stop Player action is added to the Out Point, as indicated by the Stop Player icon 


. 
 


5.8 Working with key frames 
Key frames are used to animate Object properties such as position, size and effects over time. A key 
frame is a snapshot of the properties of one or more Objects at a specific point in time. Key frames 
are used to define start, intermediate and end points of an animation. The frames in between these 
key frames are then automatically filled in by Channel Composer. 
    


& You can also use Controllers to animate Objects. For an explanation, see File > Example Projects: 
Controllers. 


 
5.8.1 Adding a key frame 


 To add a keyframe, on the Template Timeline, select the Object(s) you want to 
animate.  
On the Timeline, specify the point in time where you want to start the animation. To 
do this, specify mm:ss:ff  or move the player head to the appropriate position on 
the Timeline.  
Define the Object's properties at his point in time. 


 
Now click the Add keyframe icon to keyframe the Objects’ properties at this point 
in time. 


 
On the Timeline, specify the point the time where want to end the animation. 
Define the Object's properties at that point in time and insert a second keyframe. 
Channel Composer will automatically fill in the Object's animation between the 
keyframes. Any number of keyframes can be defined.  
Move the player head on the Timeline to preview animations. 


The  icon on the Timeline indicates that a keyframe is added.  
The  icon indicates that a keyframe is added to an Object or sub-property on a lower level.  


 
Click to go to the selected Object’s previous keyframe. 


 
Click to go to the selected Object’s next keyframe. 


 
Reverse or timescale selected keyframes. 


 
Define the type of interpolation for the selected keyframes. Options are: 
Constant Speed 
Ease In 
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Ease Out 
Step 


 
5.8.2 Updating keyframes  


Keyframes can be updated on the property level in the Object's properties window. 


 
This icon indicates that keyframes have been defined for a property group.  
Click the icon to display and edit settings. Note that properties’ values are displayed for the 
point in time selected in the Template Timeline. 


 
This icon indicates that keyframes have been defined for a property.  
Click the icon to edit. Click the icon to display and edit settings. Note that properties’ values 
are displayed for the point in time selected in the Template Timeline. 


 
Keyframes can be updated on the Template Timeline: 


 
Click the update icon to update the selected keyframe with the properties defined for the 
Object. 


 
To update all properties’ values of a keyframe for all selected Objects, select the Object(s) > right-
click > Object Keyframes > Update Keyframe. 
 
5.8.3 Deleting keyframes  


On the Template Timeline, open the Template you want to edit. 


 
To delete keyframes: on the Timeline, select the keyframes you want to delete. 
Then click the Delete icon. 


All 
 


To delete all keyframes for a selected Object: right-click the Object > Object 
Keyframes > Delete > From All. 


All + Ripple To delete all keyframes for a selected Object including its sub-Objects: right-click 
the Object > Object Keyframes > Delete > All + Ripple. 


From Selected To delete the selected keyframes from the selected Object: right-click the Object  > 
Object Keyframes > Delete > From Selected. 


 
5.8.4 Copying keyframes  


 
To copy keyframes, on the Timeline select the keyframes you want to copy. Then click 
the copy icon. 


Copy All To copy all keyframes for a selected Object: right-click the Object > Object Keyframes > 
Copy All. 


 Click the Paste icon to paste keyframe(s). 


 
5.8.5 Detaching keyframes 


Detach To detach an Object’s keyframes from other keyframes in an animation, right-click the 
Object > Object Keyframes > Detach. Options are: 
• From All: detach the Object from all keyframes  
• From All + Ripple: detach an Object including its underlying Objects from all 


keyframes 
• From Selection: detach the Object from  the selected keyframes only  
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5.9 Editing template settings 


 


5.10 Adding commands 
■ To add a Command to a Template, drag the Command from the Prefabs library on the Timeline. 
 


 


To display or hide command tracks on the Timeline, click 
the Show > Command Tracks option. This option can be 
found in the bottom left corner of the Template Timeline 


 


The example on the left shows the Timeline with two 
Commands inserted, on two command tracks:  
• a Clear all Command on track 0 


• a Ticker Command on track 1 


 A command track is automatically inserted when a 
Command is dragged on the Timeline.  
To add additional tracks, click the  icon. 


 To delete a command track, click the  icon. 


 
Copy the selected Commands to the clipboard. 


 
Paste clipboard items on the Timeline. 


 


5.11 Setting template rules 
Template Rules can be used to start a Template based on a predefined Event, for example start a 
Template at Ticker End (Event). A Ticker End Event is generated by the Ticker Player when the last 
pixel of the last ticker story has been played out. 


The Template Rules window. 
  


 
Click the Define Template settings icon to specify Template settings:  
• hard or soft cuts 
• priority mode (used for JIP (Join In Progress)) 
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Example Template Rule. 
 


 
Click to add a Rule.  


 
Click to delete the selected Rule.  


Rule Click a Rule to edit. 


 


5.12 Using tryout mode  


 


In tryout mode, the Stage shows a preview of your 
Templates. Note that the output will be exactly the same 
as on the K2 Edge, but will not be guaranteed real-time. 
 


& Using the Opt-out filter makes it possible to 
preview each Channel separately. 


 
To preview Templates in try-out mode: 


 
On the main toolbar, click the Try out mode icon to switch to try-out mode.  
Note that when in Tryout mode, you cannot edit. 


 In the Try-out mode window, double-click Templates to cue. 
In the cue, drag Templates to change order. 


Restart Click Restart to empty the cue. 


Stats Click Stats to display statistics.  
 


& Use the nexos playback statistics tool to generate playout statistics [see also 
chapter 12]. 


Exit Click Exit to exit Tryout mode. 
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Colors Orange indicates that Templates are loading. 
Blue indicates that Templates are playing.  
Grey indicates that Templates have been played.  


 


5.13 Viewing pixel perfect information 
An Object is pixel perfect if it maps its content straight to playout and does not transform the 
content's pixels during the rendering process. Distortions can occur for many reasons. For example: 
the Object is rotated, scaled, positioned in front or behind the 2D plane or on sub pixel coordinates, 
the content is stretched over the surface of a 3D object, texture filtering and/or effects are applied, 
etcetera. These distortions are often unwanted, especially for 2D-elements such as text and main 
clips. 
 
To display Objects' pixel perfect information, on the toolbar select the View > Pixel Perfect option.  
 
An exact match is displayed in green: Pixel perfect. Discrepancies are displayed in red: 
• Material distortion: the material applied transforms pixels. 
• Not on 2D plane: the plane on which content is displayed is not on the 2D plane (not on the z-


coordinate 0). 
• Shape/size mismatch: the plane on which content is displayed is bigger or smaller than the 


content's dimensions.  
• Rotated: the plane on which content is displayed is rotated. 
• Sub-pixel coordinates: one or more edges of an Object are on sub-pixel coordinates. 
• Texture filtering on: texture filtering is enabled. 
• Effect on: the Object has an effect. 
• Height is not an even value: the interlaced content is displayed on a plane that does not have a 


height that is an even number (in pixels). 
 


& The Example Project Quality Assurance explains various Channel Composer techniques that can be 
used to counter graphics artifacts commonly seen in broadcasting. Examples demonstrate how to 
deal with the most common causes of distortions for 2D elements: sub pixel positioning and 
texture filtering of interlaced content. 


 


5.14 Creating an operator panel 
Operator Panels are created in Channel Composer for use in Cobalt Playout Control (POC). Each 
Project can have one Operator Panel. An Operator Panel consists of buttons representing Templates, 
Applets and Scene Parameters. When a button is clicked in POC, the Template, Applets and Scene 
Parameters associated with the button are triggered on the playout server.  
When a Project is exported to the TX/MAM database and the Project Pack is activated, the Operator 
Panel will be available for the related Channel in Cobalt Playout Control (POC). 
 
To create an Operator Panel: 
1. Decide which Templates you want to be able to operate via the Panel in POC.  
2. On the main menu, go to Project > Operator Panel Settings. 
3. A dialogue opens listing the Templates, Applets and Scene Parameters in the current Project. 


Select the check boxes in front of the items  that you want to use on your Operator Panel. 
4. When finished, click Save. 
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Example Operator Panel Settings in Channel Composer. 
 


5.15 Working with Objects 


 


Channel Composer works with Objects. Objects are placed on the Stage 
and are animated in time on the Template Timeline. 
 
 
 
 


 
& A number of Example Projects that explain how to work with Objects is included in Channel 


Composer.  You can find these projects under File > Example Projects. 


 
5.15.1 Adding objects  


To add an Object to a Template: 


Template Timeline ■ On the Template Timeline, first select the Template you want to add the 
Object to. Now there are different options for adding Objects: 


 
■ On the toolbar, click the Add Object icon, then select the type of Object 


you want to add and double-click. 







 


Channel Composer 1.6.79 User Guide 071884304 33 


Assets window 
Test Media window 
Prefabs window 


■ You can select an Asset form the Assets or Test Media or Prefabs 
Library window and drag this Asset on the Stage. An Object which 
refers to this Asset is automatically created.  


Objects window ■ You can also select an existing Object in the Objects window. Then 
right-click > Add to Template, or drag the Object on the Template. 


 
& Note that in Channel Composer, one and the same Object can be used in different Templates and 


its properties can have different values per Template. 


 
5.15.2 Modifying an object's properties   


There are several ways to edit an Object's properties: 


Object window To open an Object's properties window: click the Object on the Stage, in 
the Objects window or on the Template Timeline. 
(If the Object window is not visible, enable the window: toolbar > View > 
Windows > Object). 
Or double-click the Object in the Objects window, on the Template 
Timeline or Stage. 


Stage Objects can also be transformed on the Stage. Select the Object and 
drag the handles to modify the Object. 


 
 
5.15.3 Transforming gizmo 


You can transform Objects (position, scale, rotation) either in the Object window, or on the Stage 
using the transform gizmo. Note that how the handles work depends on if the gizmo is in 2D or 3D 
mode. 


 
Scale: move the cursor over the inside of the Object handlers until this cursor appears. 
Then drag to scale the object. 


 
Rotate: move the cursor over the Object handlers until this cursor appears. Then drag to 
rotate the Object around the Z-axis. 


 
Free rotate or arc ball rotate (3D only): move the cursor over the center of the Object’s 
movement axes to activate this cursor and rotate the Object around its X, Y and Z-axes.  


 
Move the Object on the Z-axis (3D): move the cursor over the movement axes’ arrow head 
to activate. 


 
Grab the Object to move on the Stage.  


 
The movement axes can be customized in the main toolbar: 
■ View: the axes are aligned with the current view. 
■ Group: the axes are aligned with the group the Object is in. 
■ Object: the axes are aligned with the Object. When the Object rotates, the axes will rotate as well. 
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Example 3D Box with the X, Y and Z-movement axes aligned with the Object. 
 
 
5.15.4 Layering objects 


The Objects window lists all Objects in a Project or Template. Each Object is placed on its own layer. 
Objects on higher layers overlap Objects on lower layers. To change, drag Objects into the 
appropriate order, or use the Arrow icons. 
 
5.15.5 Grouping objects 


Objects can be grouped, so they can be modified and animated as a group. To group objects: 
■ Select the Object you want to group, either by [CTRL/CMD]+clicking them in the Objects window, 


or by drawing a selection with the cursor around the relevant Objects on the Stage. 
■ On the main menu select Objects > Group, or on the Stage right-click the selection > Group. 
■ You can open the group to edit individual Objects within the group: Objects > Open Group, or on 


the Stage right-click the group > Open Group. When finished, close the group. 
■ To ungroup Objects: Objects > Ungroup, or on the Stage right-click the group > Ungroup.  
 
 
5.15.6 Locking objects 


Lock Objects to prevent unwanted selection, or to protect the Object from being selected and 
modified accidently.  


 
To lock or unlock Objects, in the Objects window or on the Template Timeline, select the 
Object. Then click the Lock icon. 


 
5.15.7 Switching to 2D or 3D mode 


Use this option to toggle the 2D and 3D handles of the transform gizmo: 


 
Click the 2D-icon to enable the 2D-handles. 


 
Click the 3D-icon to switch to 3D-handles.  


 
Show or hide 3D editing guides when editing a Group. 


 
5.15.8 Exporting prefabs 


Objects and all the properties you defined for them can be exported to the Prefabs library for later 
reuse. 


 
To export an Object to the Prefabs library: select the Object, then in the Object window click 
the Export icon. 
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In the Library > Prefabs, the star icon (as shown in the example on the left) indicates that 
the prefab is a custom made Object. 


 
5.15.9 Copying objects 


To copy an Object (duplicate): 
1. In the Objects window or on the Stage, select the Object > right-click > Copy.  
2. To paste  > right-click the Objects window or the Stage > Paste.  
 


& Note that the Object is also added to the active Template. 


 
5.15.10 Deleting objects 


Objects can be removed from a Template (and still be available in the Project), or deleted from the 
Project. 
■ To remove an Object from a Template, select the Object on the Template Timeline or Stage > 


right-click > Remove from Template. Or Objects > Remove from Template. 
■ To delete an Object from a Project, select the Object in the Objects window > Delete. Note that 


the Object will be removed from any Templates it was used in. 
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6 Object types 
6.1 Stage objects 
The Channel Composer Stage objects are: 
 


 
: Analogue Clock Object   


 
: Live Object 


 
: Animation Object  


 
: Mesh clip Object  


 
: Audio Object  


 
: Plane Object  


 
: Box Object   : Sphere Object  


 
: Clip Object  


 
: Still Object  


 
: Command Object 


 
: Text Object  


 
: Cylinder Object  


 
: Ticker Object   


 
: Group Object   : Subtitles Object 
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6.2 Transform and blending properties 


 


The Transform and Blending options allow you 
to: 
• position an Object 
• scale an Object 
• rotate an Object 
• specify projection  
• blend an Object 
 
The Transform and Blending options are 
available: 
• in the Object window 
• or transform Objects on the Stage, using the 


transform gizmo 
 
This paragraph explains a number of tools for 
the Transform and Blending options. 
 


 


  
Use these options to position Objects from center (default), or from 
the upper left corner. 


Place on 2D Plane Place the front of the object on the 2D plane (i.e. on z-coordinate 0). 


 Lock aspect ratio when scaling. 


 
Scale in pixels instead of in %. 


 
Reset the Object (scaling/rotation) to 100%. 


Counter scale for 16:9. Select to scale back the Object in screen horizontal direction to 
counter the horizontal stretching that occurs when the object is 
viewed in 16:9 anamorphic widescreen mode. 


Rotation The angles are with respect to the axes of the Group the Object 
resides in. For example, if the Object is on the Stage, the Stage is the 
Group. The Object is rotated in the following order: x, y, z. 
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Euler interpolation Generate the Object's rotation by combining the individually animated 
rotation angles. 


Camera You can either use a perspective (depth) and specify its angle 
(default 55%), or use an orthographic view (no perspective). 


 


Scaling Tools: 
• Scale to fit screen: scale object to fit screen (no aspect ratio). 
• W: scale object to fit screen width (keeping aspect ratio). 
• H: scale object to fit screen height (keeping aspect ratio). 
• Scale 1:1: scale object to 1:1 aspect ratio, based on height. 
• Scale 4:3: scale object to 4:3 aspect ratio, based on height. 
• Scale 16:9: scale object to 16:9 aspect ratio, based on height. 
• Straighten: remove skewing. An Object is skewed if its axes are 


not perpendicular to each other. This sometimes happens to 
Objects within a Group when the Group is scaled and then 
ungrouped. 


Blending Following blending modes can be selected: 
• Normal 
• Lighten 
• Multiply 
• Darken  
• Maximum 
• Mask 


 


6.3 Various players  
Objects such as ‘Clip’, ‘Audio’ and ’Still’ use a Player to play out content. Players can be used to 
control playout. Different actions can be defined. The default is: Play. Players can be modified in the 
Object and Objects window. Example Players: 
• Still Player 
• Ani Player 
• Plasma Player 
• Clip Player 
• Audio Player 
• Gradient Player 
• Live Player 
• Text Player 
• Ticker Player 
• Subtitle Player 
 


 


• No Action: The Player's current action is continued. 
• Play: Start the Player. 
• Stop: Stop the Player. 
• Link to: Link this Player to another Player. The Object will now play out the 


content from the Player you linked to. This option can be used to save 
resources (only one stream will be used).  


 
For clips, animations and tickers additional options are: 
• Pause: Pause the Player. 
• Resume: Resume the Player after a Pause. 
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Auto-stop at Out 
Point 


If this option is selected, a Stop Playback action is automatically inserted 
when an Out Point is added to a Player on the Template Timeline. This will 
stop the Player. 


 
For some Objects, a test feed (procedurally generated video) can be used 
during editing. 
 


 
& As a default, Player actions are defined from 00:00:00. To define an action at another point in time, 


work with keyframes or move the Object’s In Point. 


 
Example Pause player icon on the Timeline. 
 
 To stop a Player, three options are available:  
• Set an Out Point and leave the Player’s Auto-Stop at Out Point option activated (default).  
• Create a separate Template with a Player Stop Action. 
• Keyframe a Player Stop Action. 
 


6.4 The main player 
 For each Channel, one main Player can be defined.  


 
The main player role has following properties: 
• The main Player has priority over other Players when resources are assigned. 
• If the main Player contains an embedded Closed Caption subtitle stream, this stream will be 


played out. If other Clips contain subtitle streams, these streams will not be played out. In other 
words, only the main Player’s subtitle stream will be played out.  


• The main Player is the source for the ATC (HD) or VITC (SD) timecode signal in the SDI-output. 
Only one signal can be sent out, i.e. from the main Player.  


• If the main Player is a Live Player and this Player transfers VBI-data from the SDI-input, this VBI-
data will be transferred to SDI-out instead of any VBI-data generated by the K2 Edge server. This 
means that VBI-data from the input such as subtitles and teletext is passed to the output 'as is'. 


• The main Player role can be assigned at any point in time, but is only active if between an In and 
out Point.  


 
The main Player command is automatically added for the first Clip or Live Object that is added to a 
Template. 
 


& For Join In Progress (JIP)-mode, a main Player role can be assigned for both normal and high 
priority mode. Still, only one main Player will be active, depending on the JIP-mode (normal or high 
priority). 
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6.5 Live objects 


 
Use the Live Object to play out a live feed from a K2 Edge input port 
 


& The table below describes the mapping between the system’s ports and the SDI ports as defined 
in Channel Composer. 
 


Up to AVS1.5 (NexusPci board): 
AVS ports IO1i  IO1o  IO1o IO2  IO3  IO4  IO5  IO6  IO7  IO8  
CC SDIs SDI 0  SDI 8  SDI 8  SDI 1  SDI 2  SDI 3  SDI 4  SDI 5  SDI 6  SDI 7  
 
From AVS 2.0 and K2 Edge (TRX board): 
AVS-K2 Edge ports IO1  IO2  IO3  IO4  IO5  IO6  IO7  IO8  
CC SDIs SDI 0  SDI 1  SDI 2  SDI 3  SDI 4  SDI 5  SDI 6  SDI 7  
 


& Keep in mind to stop the Live Object when switching to a non-live Event, to save resources. This 
can be done by adding the Live Object with an out point at 00:00:00:00 to, for example, the Play 
Clip Template. The Auto-Stop at Out Point option for the Live Player should be enabled. 


  


6.6 RTic compatible tickers 
 


 


This paragraph explains how to create RTic-compatible Tickers. 


& Example Templates for RTic-compatible Tickers can be found under File > Example Projects > 
RTic Ticker. 


 
To create RTic-compatible Tickers:  
■ Create a Template to place the Ticker on-screen. For an example see the Ticker In Template in the 


example Project RTic Ticker. This Template can have any name. 
■ For each Ticker, create the following Templates: 


o set_ticker_story<ticker_number>: set ticker stories for <ticker_number>. 
o clear_ticker_stories<ticker_number>: clear ticker stories for <ticker_number>. 


 


 


Note that Template names for RTic-compatible Tickers must exactly match the syntax 
described above. 
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6.6.1 The set_ticker_story<ticker_number> template 


 


This Template sets ticker stories for the Ticker with <ticker_number> and contains 
the Add Ticker Story Command. 
 
 


 
 


& Tickers and ticker stories are numbered starting from 0. For more information on Commands, see 
paragraph 5.10. 


 
■ Add the Add Ticker Story command to the set_ticker-story<ticker_number> Template and edit the 


Command (double-click on the Timeline to edit). 


Example Add Ticker Story Command. 
 
• Player: select the Ticker > <ticker_number> you want to update. 


Example selecting a Ticker Player. 
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• Number: select the story number you want to update, or link a scene parameter. 
• Text: fill in a story, or link a scene parameter. 
• Story Graphics: if you want to include stills or animations in your stories, select a Still or ANI-


Player. You can either select a TGA-graphic or ANI-animation to include in your stories, or link a 
scene parameter. 


Scene parameter names for RTic-compatible Tickers must exactly match the following syntax: 
d. ticker_content 
e. ticker_story_nr 
f. ticker_still 
g. ticker_ani 


 
• Text Styling: you can either select a predefined Text Style or define a Custom Style (Font, 


Alignment, Styling) for your stories. Add font files to your Project Assets. 


Example Scene Parameters used for a Ticker. 
 
6.6.2 The clear_ticker_stories<ticker_number> template 


 


This Template clears ticker stories for the Ticker with <ticker_number> and 
contains the Ticker Command. 
 


& Tickers and ticker stories are numbered starting from 0. 
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Example Ticker Command. 
 
3. Player: select the Ticker > <ticker_number> you want to clear. 
4. Select the Clear Command. 
 


& The Story Pause and Unpause Commands are not available for RTic Tickers. 


 


6.7 Animations 


 


Use the ANI Object to play out an animation. 
 


& Use the ANI Generator to create an animation from a series of TGAs. 


6.7.1 Supported formats 


Animated graphics are played back using the Composer native animation file format. Composer 
animation files are compressed video files and can be generated from TGA sequences. The TGA files 
must be in 32 bit, uncompressed, with alpha channel format. Composer automatically crops 
fullscreen animations with a transparent background. 
 


6.7.2 Prefabs 


Following prefabs are available: 
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6.7.3 Example 


Example ANI Object playing out a fixed ANI-file. 
 
 


& Please refer to the relevant paragraphs 
for an explanation of Players, quality, on-
screen visibility and audibility, properties such 
as transform and blending, and so on. 


 


 


 


6.7.4 The ANI generator 


The ANI Generator converts a sequence of TARGA files to an animation (ANI) file. The generator adds 
the animation as Project Asset and to the Channel Pack when the Project is exported. It also adds it 
as a Test Asset to the Library. 
 


6.7.5 Working with the ANI Generator 


To create an animation:  
1. Go to Project Assets > Tools > Generate Ani. 
2. Select a TARGA from the directory that contains the files you want to add to the sequence. A 


sequence is created of all files with the same file name. 
 
Example. 
1. In the Ani Generator Settings window, select a Decimation value.  


a. A higher quality results in a bigger file size. 
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b. If necessary, click the Advanced button to set the maximum bit rate. 


& Use with caution, Channel Composer automatically sets the highest possible bit rate. 


2. Select the applicable options: 
a. Top field first: the top field of each frame in the animation is played out first in time. 
b. Flip targas vertically. 
c. Reverse targa sequence: the last TARGA in the sequence becomes the first frame in the 


animation. 
 


6.7.5.1 TARGA Requirements 


• Files must be 32 bit uncompressed TARGA files. 
• All files must have the same dimensions. 
• File dimensions must be a factor of 16, such as 32. If not, the encoder will add pixels resulting in 


slightly larger dimensions than the input TARGAs. 
• TARGAs should be numbered sequentially: for example targa_01.tga, targa_02.tga, targa_03.tga 


and not targa_01.tga, targa_03.tga, targa_04.tga. Numbering does not have to start at 0. 
• Numbering should be added to the end of the filename: for example targa_01.tga and not 


01_targa.tga. 
• The sequence must contain at least 2 files. 


 
 
6.7.6 Subtitles  


 Channel Composer supports the following subtitle output formats: 
• In-Vision subtitling 
• Teletext subtitling 
• Closed Captioning subtitling 


 


6.7.6.1 Introduction 
Channel Composer supports the following subtitle output formats: 
■ In-Vision subtitling 
The open In-Vision format produces subtitles as graphical images that are made permanently visible 







 


Channel Composer 1.6.79 User Guide 071884304 46 


on screen. They cannot be switched off. Due to the graphical nature of this format, a large set of 
unicode characters are supported. Using the grid (described below), placement of subtitles on screen 
can be controlled. Using the Object Properties tab in Channel Composer, the font style can be 
controlled. 
 
■ Teletext subtitling 
Closed Teletext subtitling is a character based protocol originally developed for the PAL broadcast 
format. Subtitles are added to the broadcast signal. Subtitles can be shown (optionally) on screen on 
TV-sets that support the Teletext protocol. The grid and font style editing features do not apply. 
 
 
■ Closed Captioning subtitling 
Closed Caption subtitles are similar in nature to Teletext subtitles. It is a character based protocol 
originally developed for the NTSC broadcast format. Subtitles are added to the broadcast signal. 
Subtitles can be shown (optionally) on suitable TV-sets. The character set is relatively limited. The 
grid and font style editing features do not apply. 
 


6.7.6.2 Properties 


Properties of the Subtitle Object are described in more detail in the sections below.  
 
Action 
Actions for the subtitle Player can be set here. These are: 
• No Action. 
• Play (default). 
• Stop. 
 
File 
The following subtitle file formats are supported: 
• EBU STL files. Other STL file formats are not supported. 
• SRT files with UTF-8 encoding. Other encoding formats are not supported. 
 
To upload a subtitles file: 
• Behind the File box, click the … button. 
 
Auto-Stop at Out Point 
Automatically stops the Player when an Out Point is reached. 
 
Mode 
To set the type of subtitles that must be played out, select one of the following from the Mode box: 
• In-Vision subtitling (open), which the viewer cannot switch off. 
• Teletext subtitling (closed), which the viewer can switch off on the set top box of his television 


provider. 
• Closed Captioning (closed, 608/708 format) which the viewer can switch off on the set top box of 


his television provider. 
 
To adjust the position of In-Vision, Teletext or Closed Caption subtitles: 
• In the Object pane under Transform > Position, enter the new X, Y and Z coordinates. 
 
To rotate In-Vision, Teletext or Closed Caption subtitles: 
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• In the Object pane under Transform > Rotation, enter  the new angle for the X, Y and/or Z axis. 
 
Language 
The language selected here is used to optimize subtitle output, depending on the output format 
selected. When the language needed is not found in the menu, select the nearest match. 
 


& The EBU STL file format covers five different language groups (character sets), but at the moment 
only the Latin (for western languages) and Cyrillic (for Russian languages) groups are supported. 
 


& The SRT file format with UTF-8 encoding covers the full Unicode character set, but at the moment 
only the left-to-right going languages are supported. 


 
The table below shows which output formats are supported for the different input file formats and 
language group combinations: 
 


File format Language 
group 


In-Vision Teletext Closed 
Captioning 


EBU STL Latin yes yes yes 
EBU STL Cyrillic yes yes no 
SRT Left-to-right yes no no 


 


 
In Point 
The In Point defines the time (as defined in the input file) of the first subtitle that must be shown 
when playback of the subtitle file is started. This option makes it possible to skip a number of initial 
subtitles entries, or restart subtitling in the middle of a clip, for example after a commercial break. 
 
Grid 
For output formats In-Vision, a grid - built of a number of slots - must be defined. The number of grid 
slots, the slot dimensions and the position of the grid on screen can be fully customized. For 
example it is possible to cover the full screen with the grid, or to define a grid of just a couple of slots 
(for example 6) and place it near the bottom of the screen. 
 
The grid has two important characteristics: 
1. It takes two adjacent slots to place a single line of subtitle text. In other words, the maximum 


font height is the height of two slots added together. 
2. A subtitle line can start at any slot, except the last (bottom) slot in the grid. 
 
 
For example, a grid comprised of 6 slots will allow for a maximum of 3 subtitle lines to be shown. 
When placing a single line of subtitle text on a six-slot grid, that line can start at any of the slots 
except for the last one (since it takes two slots to render a single line). 
 
The vertical position field as defined in the STL input file format will be used to place a subtitle on a 
given pair of adjacent slots. If the range of vertical positions described in the STL file exceeds the 
number of available slots, the range will be scaled down to the number of slots available in the grid. 
 
Styling 
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For output modes In-Vision a Text Style must be defined. Remember that the font height cannot be 
more than the height of two slots. If the subtitles appear clipped on screen, try to reduce the font 
height, or increase the grid slot height (and if needed reduce the number of slots). 
 
Select Text Styles for Normal, Bold and Italic text. Note that Text Styles are defined in Channel 
Composer, in the Text Styles window. 
 


6.7.6.3 Mode Specific 


Fade Dur 
For In-Vision mode, use the Fade Duration menu to define the number of fields or frames (depending 
on broadcast mode) used to fade-in the subtitle text on screen. 
 
Teletext Page 
For Teletext subtitling format, the subtitles will be made available on the Teletext page defined here. 
 


6.7.6.4 Workflow subtitles 
1. Link the subtitle essence to the appropriate Asset Type. 
2. Ingest subtitle files. 
3. Create Formats in Channel Composer for subtitle playout. 


 


6.7.6.5 Subtitles in TX/MAM 


• Link the subtitles essences to the appropriate Asset Type. Create a Subtitle Asset Type, then 
Link as essence to type. 


• Subtitles are ingested via the Subtitle Inbox. Subtitle files and programs are linked based on the 
file name. 
 


Example: 
Filename (essence) Asset (external reference) 


abc123.mpg abc123 
 


abc123_eng.stl English subtitle belonging to the Asset with ext. 
reference abc123 


 
 


  When you want to add subtitle files to an Asset that was created before the subtitle essence 
link was added to the Asset Type, you have to re-create the Asset. Otherwise the link with the subtitle 
essence will not be recognized. 
 


6.7.6.6 Subtitle workflow in Channel Composer 


For subtitle playout, create a Format that contains: 
• a Play Clip template 
• a Subtitle applet that updates the parameters used for subtitle playout (pre-event) 
• a Subtitle template to place the subtitle grid online and play out subtitles using the parameters 


set by the applet 
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To stop subtitle playout for Events without subtitles, create a template to stop the subtitle player and 
add this template to the relevant Formats. 
 
The subtitle applet and templates are described in more detail below. 
 


Example Format Program with subtitles: 
 


6.7.6.7 The Subtitle Applet 


The get-sub-essences applet [included in the Commissioning Quick Start Channel Pack] is executed 
pre-event and updates the scene parameters listed in the table below. Scene parameters are used to: 
• check if a subtitle essence is available, if not, the subtitle player is stopped 
• start the subtitle player if a subtitle essence is available 
• synchronize subtitle playout with the time in code in from the video 


 
Parameter Value Explanation 
essence name manual text: Subtitle Specifies the subtitle Essence name 


as defined in TX/MAM, in this 
example ‘Subtitle’. 


scenepar file name   manual text: subtitle The applet updates this scene 
parameter with the subtitle file name. 


scenepar player 
action 


manual text: subtitle_player_action The applet updates this scene 
parameter with the subtitle player 
action: 
2: start (subtitle file present) 
3: stop (no subtitle file present) 


scenepar subtitle manual text: subtitle_inpoint The applet updates this scene 
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inpoint   parameter with the video’s tc-in. 
template name    manual text: Subtitle Specifies the name of the subtitle 


template, in this example ‘Subtitle’. 
 
  


Note that the parameters and values can be renamed, but the order in which parameters are 
added to the applet should match the table above.  


 
& Note that naming of the parameter values in the applet and the scene parameters in the template 


must match. 


 


6.7.6.8 The Subtitle Template 


After the applet has updated the scene parameters (pre-event), the subtitle template: 
• Starts the subtitle player if a subtitle file is available, if not, the subtitle player is stopped [scene 


parameter subtitle player action] 
• synchronizes playout of the subtitle file [scene parameter subtitle] with the timecode in from the 


video [scene parameter subtitle inpoint]  
 


The subtitle template is also used to place the subtitle grid on-screen. 
 
In Channel Composer, add following scene parameters to this template: 
Scene parameter Value  
subtitle manual text: Empty 
subtitle_inpoint  manual text: Empty 
subtitle_player_action manual text: Empty 
 


& Note that naming of these scene parameters can be changed but that parameter values in the 
applet and the scene parameters in the template must match. 
 


6.7.6.9 The Subtitle Out Template 


The Subtitle Out template is used to stop the subtitle player when switching to an Event without 
subtitles, for example a Commercial. Add this Template to Formats that do not play out subtitles. 
The Template sets the subtitle player action scene parameter to value 3 (stop player). 
 


& Note that in an alternative workflow the subtitle applet and template can be added to all Events in 
a Playlist, for example Programs and Commercials. In that case, no Subtitle Out template is 
needed to stop the subtitle player.  The applet and template will stop the subtitle player if no 
subtitle file is present. 


 
In Channel Composer, add following scene parameters to this template: 
Scene parameter Value 
subtitle manual text: Empty  
subtitle_inpoint  manual text: Empty  
subtitle_player_action manual text: 3 
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& Note that naming of these scene parameters can be changed but that parameter values in the 
applet and the scene parameters in the template must match. 


Example Format Commercial 
 


6.7.6.10 Flags 


POC will display following flags for subtitle Events:  
 


Subtitles OK 


Subtitles  Error  
 


Flag configuration: 
Exp: 6  Mask: 64     
Exp: 7  Mask: 128   Subtitles OK 
Exp: 8  Mask: 256   Subtitles  Error 
 


6.7.6.11 Example 


Example Event in POC with updated subtitle scene parameters. Note how the subtitle inpoint 
matches the main Event’s tc in: 
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6.7.6.12 Applet command line arguments 


The applet’s command line arguments are: 
a. Optout 
b. Queue 
c. Main Event Id 
d. Subtitle Essence Name 
e. Subtitle File Sp Name 
f. Subtitle Player Action Sp Name 
g. Subtitle In Point Sp Name 
h. Subtitle Tpl Name 


 


6.7.7 Controllers 


 


A controller automatically animates properties of an Object. Controllers can be an 
alternative to keyframing. Controllers are ideal for animations that are endlessly 
repeating, or animations that depend on real-time data.  


& Controllers are also described in an Example Project. 


 
Available Controllers are: 
• Anchor 
• FromTo 
• Link 
• Oscillate 
• Stack 
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All Objects’ properties can be animated.  
Per frame, the Object property values for rendering are determined as follows: 
Value0 = a value from keyframes or the default Template value. 
Value(N, for the Nth Controller for the property, with N > 0 and Wet-dry in [0…1] =  
(1 – Wet-dry)  * Value(N - 1) + Wet-dry * Controller-value. 
 
Example: property Opacity has a constant value 50 and a Controller Link with Wet-dry 25% and 
Oscillate with Wet-dry 75%. The value for the Opacity property will be: 
( 0.75 * 50 + 0.25 * Link-value ) * 0.25 + Oscillate-value * 0.75 
 
 


6.7.7.1 Anchor 


Use an Anchor to keep (one or more sides of) an Object in a specific position: align the Object’s Left, 
Right, Bottom, Top, Back or Front to an Anchor Point X, Y or Z.  


 
Example Anchor. 
 


6.7.7.2 Stack 


The Stack Controller is used to tightly stack grouped Objects on the X, Y or Z-axis and avoid overlap, 
for example to align a number of Text Groups. Note that this Controller can only be used for Groups. 







 


Channel Composer 1.6.79 User Guide 071884304 54 


Example Stack Controller for a Group. 
 


6.7.7.3 FromTo 


Use a FromTo Controller to animate a property from one to another value, for example move from 
Position Z 5000 to Position Z 0 using a FromTo controller with a Duration taken from the Scene 
Parameter Move Duration. This Controller is similar to a keyframed animation with two keyframes. 
However, the ‘From’ and ‘To’-values can be linked to a Scene Parameter. This cannot be done with 
keyframes. 
 


 
Example FromTo Controller. 
 


6.7.7.4 Oscillate 


Use an Oscillate Controller to oscillate (Sinus, Sawtooth, Square or Triangle) an Object’s properties 
(note that only one property can be oscillated).  
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Example Oscillate Controller (Spin Z prefab). 
 


6.7.7.5 Link 


The Link Controller is used to link a property of a source Object to a property of a target Object. In the 
example below, the target’s color amount is linked to the height of a Cylinder using a Link Controller. 
The target property is calculated as Offset + Scale x Source. 
 


 
Example Link Controller. 
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6.7.7.6 Controllers How to 


 To add a Controller to an Object, right-click the Object in the Objects window or on the Stage 
> Add Controller > select the Controller you want to add > OK. 


 Controllers are edited in the Object window. 


 To work with real-time data to control properties, use Scene Parameters. 


Example Controller using a Scene Parameter to dynamically set the Max Value for the oscillation of a 
Height property. 
 


& When animating individual Rotation properties, Euler Interpolation should be enabled for the target 
Object. 
 


& To rotate around separate axes (for example, only the y-axis), we advise to use Controllers. Also, 
you need to enable Euler interpolation. 
 


& The example Project Controllers shows a number of examples of Controllers.  


 
6.7.8 GPIO command 


The Channel Composer GPIO command can be used to manipulate an output pin of one 
of the configured GPIO devices.   
 
 
 


To add a command to a Template, drag the command from the Library > Command on the Timeline. 
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The example on the left shows the Timeline with a GPIO 
command inserted on a command track. 


 
A command track is automatically inserted when a 
command is dragged on the Timeline.  
To add additional tracks, click this icon. 


 
To delete a command track, click this icon. 


 
 


Copy selected keyframes or commands to the clipboard. 


 
Paste clipboard items on the Timeline. 


 
Double-click the GPIO Command on the Template Timeline to edit its properties in the Object 
window: 


Device Supported device names are:  
■ DB9M – Represents the internal GPIO device, available through the DB9 socket 


on the back of the machine. 
■ VBI – Represents the virtual GPIO device that does GPIO-over-VBI on the video 


output(s) of the associated nexos channel. Alternatively, real device names 
VBI0, VBI1, VBI2, etc. can be used to explicitly address the GPIO devices 
dedicated to channels 0, 1, 2, etc.  
 


& Note that GPIO devices must be defined in the nexos-gpio-params.txt file in 
order to use them here. In case of VBI devices, only the real devices VBI0, VBI1, 
etcetera should be defined.  


Output pin The number of the GPIO output pin to be manipulated. The first pin is 1.  


Value  Supported values are:  
• 0 – Disables the pin, a logical 'off' or 'low'. 
• 1 – Enables the pin, a logical 'on' or 'high'. 


Example GPIO Command properties. 
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7 Working with assets, metadata and scene parameters 
& See also paragraph 3.4 for an explanation of Assets, Metadata and Scene Parameters. 


 


7.1 Adding assets 
To add assets to a project, go to the Projects Assets window > Assets. 


 
: Click to add an Asset.  


 
: Click to delete the selected Asset.  


 
& Assets are included in the Channel Pack. For testing purposes, you can add test media to the Test 


Media library. These files will not be included in the Channel Pack. 


 


7.2 Importing metadata definitions 
Metadata can be used for on-air presentation or to trigger Events. To work with metadata, import the 
relevant metadata definitions from Cobalt Asset Manager or TX/MAM first. 
 
1. In Asset Manager/TX/MAM, copy the Asset Type's metadata definition to a .xml file and save 


this file on your workstation: 
a. In Cobalt, open the Asset Manager. 
b. On the main menu, click Settings > Manage Assets. 


The Manage Asset Type Window opens. 
c. Select the relevant Asset type in the list and click Properties. 
d. The Edit Asset Type Window opens. 
e. You can now copy the xml-definition to a simple text editor or xml-editor on your workstation. 


Save the file with the extension .xml on your workstation. 


 
Example XML-definition. 
 
1. In Channel Composer go to the Project Assets > Metadata window. 


2. Click the  icon to import the .xml file.  
3. The metadata definition (.xml file name) and metadata fields will be listed in the Metadata 


window.  
4. Metadata fields can now be linked to Scene Parameters [see the next paragraph for more 


information on this topic]. 
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Example XML-definition in Channel Composer. 
 


7.3 Creating and editing scene parameters 
To work with scene parameters: 
■ Create scene parameters. 
■ Link parameters to Object properties in the Object window. 
■ Link parameters to content (specify a parameter type) on the Format Timeline. 
 
7.3.1 Creating scene parameters 


To define a scene parameter, go to the Scene Parameters window.  


 
Click to add a Scene Parameter, then specify a name (characters and/or numbers).  


 
Click to delete the selected Scene Parameter.  


New You can create Scene Parameters directly in the Object window [see the next paragraph]. 
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7.3.2 Linking scene parameters to properties 


To link a Scene Parameter to an Object property: 
1. Open the Object's properties window. 
2. Click the arrow  behind the property you want to define a Scene Parameter for. 
3. Click Link to Scene Parameter. You can now select an existing Scene Parameter, or create a new 


parameter. 


 
7.3.3 Linking scene parameters to content 


Scene Parameters are linked to content in the Format Timeline. A Scene Parameter can be linked to: 
• A dynamic reference: the main Asset in an Event. 
• An external reference: an Asset’s external reference. 
• A fixed Asset reference: a reference to an Asset in the TX/MAM database (Cobalt Asset ID). 
• Manual Text: manual text. 
• Import Field: custom Event data. 
• An Asset from the Channel Composer Assets pool. 
• A metadata field. 
 
To link, in the Format Timeline: 
1. Open the Format (double click in the Project window) and expand the appropriate Object's 


properties. 
2. Right-click the Scene Parameter's value field. 
3. Select Change Parameter Type. 
4. Select the appropriate parameter type. 
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Example Play Template on the Format Timeline, 
with parameter clip linked to a dynamic 
reference. 


 
To link a Scene Parameter to a metadata field or Asset from the Channel Composer pool: 
1. Open the Format and expand the appropriate Object's properties. 
2. Right-click the Scene Parameter's value field. 
3. Drag and drop the metadata field or Asset from the Project Assets window on the Scene 


Parameter's value field. 
 
Click Clear Parameter to clear a Scene Parameter value. 


 The yellow icons in the example on the left 
indicate that a Scene Parameter has been 
defined for an Object or property. 


 
7.3.4 Adding a test clip for a format 


 
To specify a test clip for the Format's main Event, click upon the Test clip button in the 
upper right corner of the Format Timeline, then select a file from the Test Media folder. 
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8 Working with applets 
8.1 Creating a new applet 


 
In the Project window click the add applet icon. 


 


Parameters 
■ To define parameters for an applet, click the  


icon and specify a name. 
■ To delete a parameter, select and then click the 


 icon. 
 
Applet binary 
■ To add an applet binary, click the  icon, then 


select the binary file. 
■ To delete a binary, select and then click the  


icon. 
 
Note that applets (and the parameters included in 
them) can be added to Formats, while the binary file 
is added at a later Stage. 


 


8.2 Renaming an applet 
Rename In the Project window, select the applet > right-click > Rename.  
 


8.3 Deleting an applet 


 
In the Project window, select the applet > click the delete icon to delete.  


 
& Chapter 11.7 describes how to add applets to a Format, and how to time applets.  
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9 Working with formats 
Formats time sub events (Templates and Applets) relative to the main Event. 
 


Example Format Timeline with Template NNL Small expanded. 
 


9.1 Opening the format timeline 


 
To open the Format Timeline, in the Project window double-click the Format you want to 
edit.  


 


9.2 Creating a new format 


 
In the Project window click the Add Format icon, or in the toolbar click Project > New 
Format. 


 


9.3 Renaming a format 


 
Formats can be renamed in the Project window. Select the Format > right-click > Rename. 


 


9.4 Deleting a format 


 
 In the Project window, select the Format > click the delete icon to delete.  


 


9.5 Adding templates to a format 


 
1. To add Templates to a Format, open the relevant Format on the Format Timeline. 
2. Then drag Templates from the Projects window upon the Format Timeline. 


 


9.6 Timing templates  
• In the Format Timeline expand the Template's properties first, if applicable; click the  icon 


behind the Template. 
• Select Timing Mode; click the arrow icons. Following options can be set: 
• From start: absolute timing offset in hh:mm:ss:ff from start 
• From end: absolute timing offset in hh:mm:ss:ff from end 
• Relative: timing offset in percentage from start 
• Not active: not active 
• Specify Timing Offset: enter values manually or move the Template on the Timeline to specify 


the timing offset. 
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Example timing setting for Template Play. 
 


9.7 Setting an optional output 
■ To define an optional output Channel for a Template or Applet, click the  icon > Opt-Out > 


select main (0) or another Channel number. The default is main. 
 


& For an example of how to use this option, see paragraph 9.10, Simulcast. 


 


9.8 Adding applets to a format 


 
To add an applet to a Format, open the relevant Format on the Format Timeline. 
Then drag the applet from the Projects window upon the Format Timeline. 


 


9.9 Timing applets  
• On the Format Timeline expand the applet's properties first, if applicable; click the  icon 


behind the applet. 
• Select Timing Mode; click the arrow icons. Following options can be set: 
• From start: absolute timing offset in hh:mm:ss:ff from start 
• From end: absolute timing offset in hh:mm:ss:ff from end 
• Relative: timing offset in percentage from start 
• Not active: not active 
• Pre Event: the applet is executed before the Event is checked by playout distri (the applet is used 


to write Event information back to the database). 
• Subtitle: almost the same as pre Event; the applet is executed before the Event is checked by 


playout distri, the first parameter is executed by sequencer at Event start, the start time in the 
parameter is replaced by the start time of the Event. 


• Post Asset: the applet is executed after the Asset has been checked by playout distri (note for 
applet developers: this applet can use shared memory*). 


• Pre Asset:  the applet is executed before the Asset has been checked by playout distri (note for 
applet developers: this applet can use shared memory*). 
 


& Note for applet developers: for extra information concerning the Asset, shared memory can be 
used, also to supply playout distri with information 


 
• Specify Timing Offset: enter values manually or move the applet on the Timeline to specify the 


timing offset. 
 


 
Example timing setting for an applet. 
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9.10 Using simulcast templates 
For simulcast broadcasts, two instances of each Template are created: one is played out on the HD-
channel, the other one is played out on the SD-channel. The playout Channel is defined in the Format, 
using the Template’s Opt-Out option setting.   
 
The example below shows a Play Clip Format. The Clip and Logo Templates have been created for SD 
and HD. The HD-Templates are played out on Channel main, HD in this example. The SD-Templates 
are played out on Channel 1, SD in this example. The playout Channel is specified in the Format, with 
the Opt-Out option. Note that you do not create separate Formats for HD and SD, but only add both 
the HD and SD Templates per Format. 
    


& For an example of a Simulcast project, see File > Example Projects: Simulcast. 


Example Format that plays out two instances of a Template; to Channel Main (HD) and Channel 1 (SD), as 
defined with the Opt-Out option. 
 
In Cobalt, you only have to schedule one Channel. Formats will be played out on the 2 Channels 
defined in the Templates (in the example above main and 1).  HD and SD-settings are defined on the 
K2 Edge, via the IP Manager. 
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10 Channel pack validation 
Channel Packs should be validated against a test schedule. The playback 
statistics tool can be helpful with this.  
 
While the test schedule is played out on a test server - using hardware, content and a schedule 
closely similar to the ones used for actual playout - the statistics tool is displayed as an on-screen 
overlay and shows real-time playback information: 
• the current and peak amount of active players per type 
• the amount of active templates and objects 
• the amount of upload bandwidth from system RAM to the graphics card RAM, which is 


“expensive” 
• the durations of the update and render phases in milliseconds and the sum of both durations 


(total) 


Example nexos playback statistics tool overlay. 
 


& Testing on a representative K2Edge system, against a representative schedule, with 
representative content, is the only way to determine if a channel pack is ready for on-air usage. 
Only go on air with a validated channel pack! 
 


& Please note that these statistics can also be viewed using the statistics option in Channel 
Composer Try-out Mode. However, Channel Composer cannot measure the durations of the 
update and render phases. This can only be done on a test playout server. Monitoring playback 
statistics during playout of a test schedule gives a good sense of the actual system load 
templates generate when run.  
 


10.1 Basic testing and further analysis  
This paragraph describes how you can test your Channel Packs. You can run the test schedule and 
statistics tool, without continuously monitoring (basic testing). If unacceptable peak values have 
occurred, further analysis is required. 
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10.2 Basic testing 
1. Create and start the test schedule on the test server. Make sure the test schedule uses the 


Channel Pack you want to validate [see also paragraph 2.10]. 
2. Start the playback statistics tool [see paragraph 10.4]. 
3. Run the test schedule. You do not have to monitor statistics continuously. Check peak values at 


the end of the test: if the statistics tool’s outline is red [see also paragraph 10.5.4], unacceptable 
peak values have occurred and further testing is required.  


 


& If peak values are instantly red from the start, run the command again to reset. 


 


10.3 Further analysis 
1. Start the test schedule on the test server. 
2. Start the playback statistics tool as described in paragraph 10.4. 
3. Monitor the statistics tool to identify overloads. Paragraph 10.5.4 describes how to interpret 


measures. 
 


10.4 Starting playback statistics 
1. Login on the test playout server, for example via PuTTy. 
2. Within the /system/objects/code folder, type:  


 


./nexcommand <channel number> 0 complex '{cmd=nre;subcmd=control;stats-
sw=true;perfstats-sw=true;}' 
 


a. Replace <channel number> with the number of the Channel you are running the test 
schedule on. 


 
& Re-enter this command to reset peak values if applicable. 


 


10.5 Interpreting playback statistics 


10.5.1 Current and peak player amounts (cur | peak) 


Use these numbers to determine if started players - especially players that create a lot of load such 
as ‘clip’, ‘ani’ and  ‘live‘ - are stopped later on. Values should stabilize and then decrease at some 
point in time.  
 
Example: if a template running a fixed length animation is started, the current ani-value will first 
increase by one. If the template is well designed (i.e. the player is stopped on the timeline at some 
point) the value should decrease by one sometime later.  
 


& Note that the number next to ‘clip’ will probably always be one, since usually a full screen clip is 
always running.  
 


When to act: if the player amounts keep increasing over a longer period of time, or if amounts are 
high for important player types: 
• clip > 2 
• big ani > 2 
• live > 2 
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• text > 20 
• fullscreen clip + fullscreen ani + fullscreen live > 3 
• fullscreen still > 2 
How to act:  check your templates for the existence of Out Points. Ideally, every player should have 
an Out Point, except for probably the main Clip and Live players that run continuously. 
 
10.5.2 Update time (update tm) 


Shows the duration in milliseconds of the update phase. Within the update phase, the states of all 
active objects are updated.  
 
All durations listed below are based on NTSC. For PAL, add 25% to values. 
When to act: when this value exceeds ~5ms. 
How to act:  
 
■ If this value peaks above 5ms but then immediately falls back to an acceptable value:  


This probably means that nexos is overloaded due to too many simultaneously occurring object 
In Points. 


 
Spread In Points of objects across multiple frames, where possible. 


 
■ If this value stays above 5ms:  


This probably means that too many objects and/or templates are active at the same time.  
 


Reduce the amount of running objects and/or templates. Use Out Points to deactivate 
objects. 


 
10.5.3 Render time (render tm) 


Shows the duration in milliseconds of the render phase. During this phase, all active (visible) objects 
are rendered on screen. 
 
When to act: when this value exceeds ~9ms. 
How to act:  
■ If this value peaks above 9ms but then immediately falls back to an acceptable value:  


This probably means that too much content is being uploaded from system RAM to GPU RAM at 
the same time. 


 
Spread In Points of visible objects (Clips, Stills, Lives, Text etc.) across multiple frames, where 
possible. 


 
■ If the value stays above 9ms:  


Multiple potential reasons, in order of decreasing likelihood: 
 


• Too many running Clip/Ani/Live objects. 
Reduce the amount of running players.  


• Dimensions of Clip/Ani/Live/Still/Text content are too big. 
Reduce dimensions (e.g. crop dimensions, do not use HD content when only SD content is 
needed, do not use full screen images for a small logo in the corner, disable Progressive Image 
on large Still and Text objects). 
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■ If the pixel-sum of all static graphics running simultaneously is greater than the pixel-sum of 2 
HD Stills, the nexos texture cache is probably full. By default, the texture cache can handle 2 HD 
Stills. All extra content needs to be uploaded to the GPU, which increases rendering time. This 
can be solved by increasing the size of the texture cache. Please contact Grass Valley for 
Support. 


• Too many graphical effects. 
Reduce the number of effects. Please be aware of the Quality Scaler effect which can be quite 
“expensive” in terms of rendering. Generally only one Quality Scaler should be active at any time. 


• Too many graphical layers. 
Layering is too complex. Reduce the amount of groups containing layered groups (in other words 
nested groups). For example by disabling Layer Objects on Groups. This flattens a group to a 
single layer.  


 
10.5.4 Measure bars 


The vertical yellow line shows peak values that have been measured: 


Example. 
 
The green or red horizontal bar shows current values. Red indicates that high values are measured, 
green indicates that values are within safe margins: 


Example. 
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If the overlays outline turns red, this indicates that very high values for the total of update and render 
times have occurred at some point during the test: 


Example. 
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11 Quick reference 
11.1 The Channel Composer workspace 
The Channel Composer workspace consists of the Stage and a number of windows that can be 
arranged and customized [see chapter 2 for more information]. The example below shows a default 
empty Channel Composer workspace (Mac) in Template editing mode. In Format Editing a number of 
windows are not visible. 
 


 
 


A The main menu. 


B The main toolbar. 


C 
The Projects window lists the Formats, Templates and Applets that have been defined for a 
Channel. Three windows are docked on this window: the Object window (view and edit an 
Object's properties), the Library (the prefabs and test media libraries) and the Project 
Assets window (view and edit the Project's Assets and metadata).  


D The Objects window lists the Objects available in the Project and shows their layering. 


E 
Actions can be viewed and redone or undone in the History window. Two windows are 
docked on this window: the Scene Parameters window (view and edit Scene Parameters) 
and the Text Styles window (view and edit text styles). 


F 
Objects are animated in time on the Template Timeline. Each Template is displayed on its 
own tab. Formats are edited in the Format Timeline (not activated in the example above). 
Each Format is displayed on its own tab. Note that in Format editing mode, some windows 
are hidden. 


G The Stage represents the Channel´s output. 







 


Channel Composer 1.6.79 User Guide 071884304 72 


11.2 The main menu 
11.2.1 Channel Composer 


About Channel 
Composer 


Displays the Channel Composer version.  


Preferences Set Channel Composer preferences: 
• Nexos: 
• Broadcast Format 
• Multi-Sampling Anti-Aliasing: use to improve the design's visual quality 


on your workstation (remove edge line roughness and jagged edges). 
Note that higher sample rates impact performance of your workstation. 


• Players: set the big buffer pool size in MB. 
• File:  
• Specify the default Project folder.  
• Autosave: disable (default) or enable auto save every x minutes. 
• History: the number of actions tracked. 
• Guides: the color of the guides and snap distance. 
• Grid: the color of the grid, spacing and snap distance. 
• Backup System: number of backups to keep. 
• Networking: specify the FTP transfer mode. 
Note that changes require a restart of Channel Composer to take effect. 


Services Set service preferences: 
• No Services Apply 
• Services Preferences 


Hide Channel 
Composer 


Hide Channel Composer. 


Hide Others Hide other applications. 


Show all Show all applications on your desktop. 


Quit Channel 
Composer 


Quit Channel Composer. 


 
11.2.2 File 


New Project Create a new Project.  


Open Project  Open an existing Project. 


Recent Projects Lists recent Projects, select to open. 


Save Project  Save the Project under its current name. 


Save Project As Save the Project with a different name, or at a different location. 


Export Project Export the Project as a Channel Pack to disk, or to a TX/MAM Database, 
Playout. 


Import Project Import a Channel Pack from disk or the TX/MAM Database. 


Manage Exports See chapter 4.5 and 4.6for more information. 


Merge Project Merge or replacement merge the current Project with the selected Project. 


Example Projects List and open an example Project. 


Restore Backup Restore a Project backup. 
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Exit Exit Channel Composer. 
 
11.2.3 Edit 


Undo Undo the previous action. 


Redo Redo the previous action. 


Copy Copy the selected Object(s). 


Paste Paste the copied Object(s).  


Delete Delete the selected Object(s). 


Select All  Select all Objects on the Stage or within the opened Group. Hidden Objects 
are selected as well. 


Select None  Deselect all Objects. 
 
11.2.4 View 


Zoom In  Scale the Stage. 


Zoom Out Scale the Stage. 


Zoom to 100%  Scale the Stage to 100%. 


Fit in Window  Fit the Stage in the workspace available. 


Rulers Show or hide rulers. 


Grid Show or hide the grid. 


Guides Show or hide guides. 


Snap to Grid  Snap Objects to the grid. 


Snap to Guides  Snap Objects to the guides. 


Pixel Perfect 
Information  


Show pixel perfect Information. 


Windows Show or hide windows: 
• Project Navigator  
• History  
• Library  
• Project Assets  
• Objects  
• Object Properties 
• Template Timeline  
• Text Styles  
• Scene Parameters  
• Format Timeline 
• Template Rules 


Clean View Mode Select to show the Stage only, deselect to show the Stage plus active 
windows. 


 
11.2.5 Project 


New Template Add a Template to the Project. 


New Format Add a Format to the Project. 
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Project Settings Format 
Displays: 
• Frame Size 
• Aspect Ratio 
• FPS 
• Interlaced 
• Name 
• Location 
To edit, go to Channel Composer > Preferences. 
 
Info 
Edit: 
• Author 
• Description 
 
Export 
Specify or reset export settings: 
• TX/MAM Database server: IP address 
• Channel Pack Asset type 


 
11.2.6 Objects 


Align Align the selected Object. Options are: 
• Left 
• Right 
• Top 
• Bottom 
• Front 
• Back 
• Vertical Center 
• Horizontal Center 
• Rotation 


Group  Group selected Objects.  


Ungroup  Ungroup selected group of Objects. 


Open Group  Temporarily open a group of Objects to edit Objects, then close group. 


Close Group Close an open group (regroup Objects). 


Arrange Move the selected Object: 
• Move to Front 
• Move Up 
• Move Down 
• Move to Back 


Tools Lists the tools that have been applied for the selected Object. 


Add Controller Add a controller: 
• Anchor 
• FromTo 
• Link 
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• Oscillate 
• Stack for Groups 


Refresh Players Click to refresh all Players. 


  


11.3 Main toolbar 


 
Add an Object to the canvas: 


 
 


Add an Analogue Clock Object to the Stage.  


 
 


Add an Animation Object to the Stage. 


 
 


Add an Audio Object to the Stage. 


 
 


Add a Box Object to the Stage. 


 
 


Add a Clip Object to the Stage. 


 
 


Add a Cylinder Object to the Stage. 


 
 


Add a Group Object to the Stage. 


 
 


Add a Mesh clip Object to the Stage. 


 
 


Add a Plane Object to the Stage. 


  Add a Sphere Object to the Stage. 


 
 


Add a Still Object to the Stage. 


 
 


Add a Text Object to the Stage. 


 
 


Add a Ticker Object to the Stage.  


 
Import a 3D-Object. 


 
Lock aspect ratio. 


 
Switch to 2D-mode. 


 
Switch to 3D-mode. 


Group 
View 
Object 


Customize the movement axes: 


• View: axes are aligned with the current view. 
• Group: axes are aligned with the group the Object is in. 
• Object: axes are aligned with the Object. When the Object rotates, the axes will rotate as 


well. 


 
Show or hide 3D editing guides when editing a Group. 


 
Click to zoom in, or select a zoom percentage. 


 
Click to zoom out, or select a zoom percentage. 


 
Fit the Stage on the workspace available. 







 


Channel Composer 1.6.79 User Guide 071884304 76 


 
Grab the canvas. 


 
Add curtains to the Stage. 


 Toggle 16:9 view mode. 


 
Refresh Players. 


 
Switch to try-out mode. 


  


11.4 The mode icons   


 
Show small icons. 


 
Show medium icons. 


 
Show large icons. 


 
Icon view mode. 


 
List view mode. 


 


11.5 The stage 


 
The Stage represents the Channel's output. 
The Stage allows editing and previewing of the Objects (clip, logo, ticker, etcetera) that 
together compose a Channel's output.  
The Stage can be customized as described in chapter 2.  


 


11.6 The template timeline 
Double-click a Template in the Project window to open the Template Timeline. Each Template is 
displayed on its own tab. 


 


 
Rewind (the player head on the Timeline). 


 
Play (the player head on the Timeline). 


 
Pause (the player head on the Timeline). 


 Shows the position of the player head on the Timeline in mm:ss:ff, or enter 
values to place the player head on the Timeline. 


 
Click to add a keyframe.  
The  icon on the Timeline indicates the keyframe is added to an Object or 
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property.  
The   icon indicates that the keyframe is added to an Object or sub-
property   on a lower level.  


 
Click to update the selected keyframe. 


 
Go to the previous keyframe. 


 
Go to the next keyframe. 


 Define interpolation for the selected keyframes. Options are: 
• Constant Speed 
• Ease In 
• Ease Out 
• Ease In & Out 
• Step 


 
Select all items on the Timeline. 


 
Copy the selected keyframes or commands to the clipboard. 


 
Paste clipboard items on the Timeline.  


 
Delete the selected keyframes or commands. 


 
Reverse the selected keyframes / timescale the selected keyframes’ duration 
(in frames). 


 
Copy a Template to a new Template. 
 


& Note that Objects in the source Template are not duplicated; in other 
words, both templates, the original and the source will use one and the 
same Object. If this Object is modified in Template A, it will also be 
modified in Template B.  


 
Define settings for hard (default) or soft cuts. When soft cuts are used,  the 
property values of this Template are slowly blended in. 


 
Enable or disable grid snap and set snap distance. 


 This option can be found in the bottom left corner of the Template Timeline. 
Click the arrow to define what information is displayed on the Template 
Timeline: 
• Command Tracks: Display or hide command tracks. 
• Object Properties: Display or hide Object properties. 


 
When the pickup button is deactivated [as shown in the example on the left], 
the Object, sub object or property will not be modified by the Template.  
As a default, this option is activated:  


 
Click the hide and lock icons to hide/unhide and lock/unlock Objects on the 
Stage. 


 This option can be found in the bottom left corner of the Template Timeline. 
Use the slider to zoom the Timeline in or out. 
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11.7 The format timeline 
Double-click a Format in the Project window to open the Format Timeline. 


 
Example Format Timeline. 
 


 
Click to start preview of the Format. 


 
Click to stop preview of the Format. 


 
Select an output Channel. The output Channel for Templates is set with the 
Opt-Out option. 


 
Click to scroll to start (t=0) 


 
Format Settings for color. Use to specify the color of Events with this Format 
in POC. 


 
Unselect exclude a Template from the Format. Note that in the Channel Pack 
the Template will also be excluded from the Format. 


 This option can be found in the bottom left corner of the Format Timeline. Use 
the slider to zoom in or out on the Timeline. 


 
To specify a test clip for a Format's main Event, drag a clip (Asset or test file) 
upon the window in the upper right corner of the Format Timeline. 


 
[Timing options, opt-out and Scene Parameters are described in chapter 9. To open these properties, 
click the arrow icon in front of the Template.] 
 


 
Example properties for Template clip, in the Format Timeline. 
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11.8 The project window 


 


The Project window lists the Templates, Formats and 
applets included in a Project.  
Double-click a Template or Format to open the 
Template or Format Timeline. 
Right-click items to rename. 
 


 
Add a Template to the Project. 


 
Add a Format to the Project. 


 
Add an applet to the Project. 


 
Delete the selected item. 


 


11.9 The objects window  


 


The Objects window lists the Objects that have been 
added to a Project, or to a Template when the Filter 
option is activated.  
 
Each Object can be used in different Templates, and 
can have different properties per Template.  
In Channel Composer, each Object is placed on its 
own layer. Objects on higher layers overlap Objects on 
lower layers.   
 
The  icon can be used to display only the Objects 
included in the Template that is selected on the 
Template Timeline. 


 
Add an Object. 


 
Delete the selected Object. 


 
Move the selected Object one layer up. 


 
Move the selected Object one layer up. 


 
Show only the Objects included in the Template selected in the Template Timeline. 


 
The Object is visible on the Stage (click icon to hide). 


 
The Object is hidden on the Stage (click icon to display). 


 
The Object is unlocked (click icon to lock). 
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The Object is locked (click icon to unlock). 


 
A Scene Parameter has been defined for an Object property. 


 
A Scene Parameter has been defined for a sub object. 


 
 


11.10 The object window 


 


The Object window shows properties for the selected 
Object (select an Object either in the Objects window, 
on the Stage or in the Template Timeline).  
Click the arrows   to expand properties. 


Icons, buttons and menus 


 
Open the properties window for the Object you 
previously selected. 


 
Open the properties window for the Object you 
selected next. 


 
Move one level up. 


 
Export the selected Object to the prefabs library. 


 
Close all property groups. 


 Click icon to open the property group, or to edit a 
property. 


 
This icon indicates that keyframes have been defined 
for the Object. Click the icon to display and edit 
settings. Properties are displayed for the point in time 
selected on the Template Timeline. 


 
This icon indicates that keyframes have been defined 
for a property. Click the icon to display and edit 
settings. Properties are displayed for the point in time 
selected on the Template Timeline. 


 
This icon indicates that a Scene Parameter has been 
defined for a property in the property group. Click the 
icon to display.   


 
This icon indicates that a Scene Parameter has been 
defined for this property. Click the icon to edit. 
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This icon indicates that Scene Parameters and 
keyframes have been defined for the Object. Click the 
icon to display.   


 
This icon indicates that Scene Parameters and 
keyframes have been defined for a property. Click the 
icon to edit. 


 


Reset property, or edit keyframes and Scene 
Parameters.  
 
To open this window click the , or 
icon displayed behind the property.  
Options: 
• Reset: reset settings for the selected property to 


the default values. 
• Reset All: reset settings for all properties to the 


default values. 
• Update Keyframe: update the selected keyframe 


with the new values defined. 
• Delete Keyframe: delete the selected keyframe. 
• Link to Scene Parameter: link this property to a 


Scene Parameter. 


 


11.11 The project assets window 


 


The Project Assets window lists Assets and Metadata 
definitions for a Project. 


 
Assets 


 
Add an Asset. 


 
Delete the selected Asset. 


 
Show small icons. 
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Show medium icons. 


 
Show large icons. 


 
Icon view mode. 


 
List view mode. 


 
 
Metadata 


 
Import a .xml definition. 


 
Click to delete the selected definition or field.  


 


11.12 The scene parameters window 


 


This window lists the parameters that have been 
defined for the Project. 
 


 
Add a Scene Parameter. 


 
Delete the selected Scene Parameter. 


Rename  Right-click the Scene Parameter > Rename. 


 


11.13 The history window 


 


The History window lists actions performed, and 
allows undoing or redoing of these actions. 
The History window can be customized as described 
in paragraph 2. 


 
Undo the selected action. 
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Redo the selected action. 


 


11.14 The library window 


 


The library window lists and lets you manage prefabs 
and test media. 
Note that test media are not included in the Channel 
pack. 
 


 
Show small icons. 


 
Show medium icons. 


 
Show large icons. 


 
Icon view mode. 


 
List view mode. 


 
 


11.15 The text styles window 


 


This window lists and lets you manage the Text styles 
that have been defined for the Project. 
 


 
Add a Text style. 
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Delete the selected Text style. 
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12 Hotkeys 
& Note that for Windows, ‘CMD’ should be read as ‘CTRL’. 


 


12.1 Global hotkeys 
These hotkeys are accessible from everywhere. 


CMD-O open Project. 


CMD-P  Toggle Pixel Perfect Information. 


CMD-S save Project. 


CMD-SHIFT-S save Project as. 


CMD-Z undo. 


CMD-Y redo. 


CMD-C copy. 


CMD-V paste. 


CMD-A select all. 


CMD-D select none. 


CMD-+ zoom in. 


CMD-- zoom out. 


CMD-ALT-F zoom to 100%. 


CMD-ALT-N fit Stage in window. 


CMD-ALT-R toggle ruler’s visibility. 


CMD-ALT-G toggle grid visibility. 


CMD-ALT-U toggle guides visibility. 


CMD-SHIFT-G toggle snap to grid. 


CMD-SHIFT-U toggle snap to guides. 


CMD-1 toggle Project Navigator visibility. 


CMD-2 toggle History visibility. 


CMD-3 toggle Library visibility. 


CMD-4 toggle Project Assets visibility. 


CMD-5 toggle Objects visibility. 


CMD-6 toggle Object Properties visibility. 


CMD-7 toggle Template Timeline visibility. 


CMD-8 toggle Text Styles visibility. 


CMD-9 toggle Scene Parameters visibility. 


CMD-0 toggle Format Timeline visibility. 
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CMD-SHIFT-T new Template. 


CMD-SHIFT-F new Format. 


G group Objects. 


U ungroup Object. 


ALT-A add Object to Stage. 


SHIFT-SPACE toggle Clean View Mode. 


SHIFT-2 toggle allow only 2D transformations. 


SHIFT-3 toggle allow 2D and 3D transformations. 


SHIFT-A toggle lock Object aspect ratio. 


SHIFT-M  toggle 16:9 (anamorphic widescreen) mode 


SHIFT-Z toggle 3D editing guides visibility. 


O open group. 


C close group. 


SHIFT-C toggle curtains. 


CMD-T toggle Template Try-out Mode. 
 


12.2 Stage hotkeys 


Mouse wheel zoom in/out. 


left/right/up/down/pgdn/pgup nudge (=move by one pix) left/right/up/down/fwd/bck 


SHIFT + 
left/right/up/down/pgdn/pgup 


big nudge left/right/up/down/fwd/bck 


Middle mouse (hold) grab Stage. 


R reset rotation of selection. 


SHIFT + Object movement constrain movement to X or Y axis. 


Del remove selected Objects from Template. 


Del delete selected Objects. 


      


12.3 Template timeline hotkeys 


A select all Timeline items. 


D delete Timeline selection. 


[/] go to previous/next keyframe. 


left/right decrease/increase player head time by one frame. 


+/- zoom in/out. 


R rewind. 
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Space toggle play/pause. 


K insert/update keyframe for selection. 
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GV EDGE 4.2.1 
Quick Start Guide 
 


For more information 


1. Unpack the following items. 


 


 See the GV Edge documentation on the USB stick or download the latest GV Edge 
Documentation Set from the Grass Valley website. 


GV Edge items 
• Licenses 
• Warranties 


USB stick contents: 
• GV Edge 4.2.1 Documentation Set 


 


 


2. Find the GV Edge documentation on the USB stick or download the 
latest GV Edge Documentation Set from the Grass Valley website. 


3. Read the following documentation to install GV Edge: 
a. Release Notes 
b. Quick Start Guide 
c. GV Edge 4.2.1 Service and Installation Manual 


 


     


    
 


 
 


 
 



http://www.grassvalley.com/docs/Manuals/ips/gv_edge/071-8929-00_GV_Edge_4.2_Documentation_Set.pdf

http://www.grassvalley.com/docs/Manuals/ips/gv_edge/071-8929-00_GV_Edge_4.2_Documentation_Set.pdf
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Copyright © Grass Valley, a Belden brand. All rights reserved. This product may be covered by one or more U.S. and foreign 


patents. 


 
Dolby is a registered trademark of Dolby Laboratories.   
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1 Contact support 
 
Do you have a specific question and was the answer not in these release notes? Please visit our 
website or contact Grass Valley support. 
 
To contact Grass Valley support, do one of the following: 
■ Call one of our international support centers with 24/7 availability: 


o France, +800 8080 2020 or +33 1 48 25 20 20. 
o US and Canada, +1 800 547 8949 or +1 530 478 4148. 


■ Call one of our local support centers, open during normal business hours: 
o Asia 


 Hong Kong, Taiwan, Korea and Macau: +852 2531 3058. 
 Indian Subcontinent: +91 22 24933476. 
 Southeast Asia/Malaysia: +603 7492 3303. 
 Southeast Asia/Singapore: +65 6379 1313. 
 China: +861 0660 159 450 Japan: +81 3 5484 6868. 


o Australia and New Zealand: +61 1300 721 495. 
o Central and South America: +55 11 5509 3443. 
o Middle East: +971 4 299 64 40. 
o Near East and Africa: +800 8080 2020 or +33 1 48 25 20 20. 
o Europe 


 Belarus, Russia, Tadzikistan, Ukraine, Uzbekistan: +7 095 2580924 225. 
 Switzerland: +41 1 487 80 02. 
 Italy (Rome): +39 06 87 20 35 28. 
 Italy (Milan): +39 02 48 41 46 58. 
 Spain:  +34 91 512 03 50. 
 Belgium: +32 (0) 2 334 90 30. 
 Netherlands: +31 (0) 35 62 38 42 1. 
 Benelux and Northern Europe: +45 45 96 88 70. 
 Germany, Austria, Eastern Europe: +49 6150 104 444. 
 UK, Ireland, Israel: +44 118 923 0499. 


 


2 System requirements 
 
The GV Edge 4.2.1 release has the following system requirements: GV Edge 4.2. 
 


3 Release components 
 
The GV Edge 4.2.1 release includes the following components: 
• GV Edge 4.2.1 
• TXMAM 2.7 
• Cobalt Server 4.2.1 and Client 1.24 (including Playout Control) 
• RTic 2.47  
• Channel Composer 1.6.9 
 


& Note: The GV Edge 4.2.1 USB installer has the option to automatically run your own scripts 
immediately after installing the GV Edge software. 
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4 Release changes 
 
Our changes for this release are focused on new features and enhancements of existing features. GV 
Edge 4.2.1 is the last release of the GV Edge product line. Future releases will only contain defect 
patches. 
 


4.1 Enhancements 


4.1.1 Input 


• Support for Dolby E decoding from file. Assets (either video or audio) which contain Dolby E 
audio tracks are now decoded and are inserted into PCM streams accordingly.  


• Absolute time code in the header of LXF files are supported for playout with absolute time codes. 
• Time code tracks in GXF files are now recognized and can be used for playout with absolute or 


relative time codes. 
 


4.1.2 Output 


• Support for auto-crop detection for still images with transparency. Full screen images with a 
transparent background are now automatically cropped whereby the transparent background is 
removed.  


• Support for audio watermarking insertion based on the Civolution SNAP audio embedder. For 
each audio channel you can now add audio watermarking. This includes multiple watermarks for 
simulcast or multicast channel configurations. For more information about this subject, see the 
GV Edge 4.2.1 User Guide. 1  


• Transport Stream over IP support. It is now possible to stream the GV Edge video output over IP 
for one or multiple channels: 


o Customizable video, audio, teletext, data and pmt pid’s 
o Customizable bitrate 2 
o YUV 4:2:0 or YUV 4:2:2 
o Long GOP or Iframe only structure 
o 4:3 or 16:9 aspect ratio 
o Customizable TS packet group size 
o Customizable target IP and port 
o Multiple ethernet outputs 
o Customizable TTL 
o Audio streams 


 Up to 16 audio channels supported per video stream 
 Selectable bitrate (64,80,96,112,128,160,192) 
 Also supports watermark insertion 


o Teletext services 
 Customizable VBI lines 
 Customizable teletext page numbers and language 


o Data streams 3 
 Customizable bit rate 
 Optional pass-through of data streams for TS files containing data streams 
 Optional to display in the program map table (PMT) 


o Optionally enable or disable the SDI output when using TS-over-IP 
o For more information about TS-over-IP, see the GV Edge 4.2.1 User Guide 
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• TS-over-IP supports automatic quality control that lowers the output bitrate and quality to 
prevent congestion in worst case scenarios. 


• The amount of subtitle players that can be used is now customizable (was 9). The current 
default is set to 10. For more information how to increase or decrease the amount of subtitle 
players please contact support. 


• VITC service can now be configured on one or multiple VBI lines (was already available on VBI 
line number 19 for PAL and 12 for NTSC). Information on all lines are identical. 


 
1The use of audio watermark insertion requires a valid watermarking license provided by Civolution for 


each channel on a GVEdge. 
2The minimal bitrate for SD is 8000 Kbit/s and the maximum is 50000 Kbit/s. The minimum bitrate for HD 


streams is 25000 Kbit/s and the maximum is 50000Kbit/s. 
3Inserting data into the data streams requires custom project development. Please contact your account 


manager for any additional data that needs to be added to the data streams. 
 


4.1.3 Channel Composer 


• Channel composer has been rebranded with Grass Valley’s new company branding. 
• Channel composer now is able to use a different internal port number when the default is already 


in use. 
 


4.1.4 GV Edge Server 


• Updated kernel version to 3.4 improving the overall performance of the CPU cores 
• Updated schedulesync application by improving the schedule requests from the main server. 


 


4.1.5 GV Edge IP Manager 


• The IP Manager has been rebranded with Grass Valley’s new company branding. 
• The GBE Channel configuration has been removed from the menu. Instead the TS-over-IP feature 


has been added to enable streaming output. For more information about this subject, see the GV 
Edge 4.2.1 User Guide. 4 


• Configuration for Watermarking has been added to the IP Managers menu. 
• Configuration for audio routing in favour of Dolby E decoding is added. 
• The IP Managers front panel now has an improved warning message when the playout server is 


not accessible or encoded process is not running. 
• Enabled the selection for 2x and 3x SD channel configurations. 5 
 
4 The use of TS-over-IP requires an additional license per channel. Please contact your account manager 
how to acquire this license. 
 
5 On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD content containing a 
maximum bitrate of 25000 Kbit/s On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD content containing a 


maximum bitrate of 25000 Kbit/s 


4.1.6 Video Delay Server web interface 


 


4.1.7 Weekplanner 


• It is now possible to drag multiple assets into Weekplanner at once from TX/MAM 
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4.1.8 Cobalt Playout Control 


• Schedule importer now has the option turn off the possibility to overwrite the asset type 
• It is now possible to drag multiple assets into POC Scheduler at once from TX/MAM 
• When the status of an asset has changed, the events for which it is scheduled will be re-checked 
• Events that have been played on a JIP channel are now also visible in a AsRun generated list 
• Option to display tc-in/out including leading 00 hours 
 


 


4.1.9 GV TXMAM web interface 


• TX/MAM has been rebranded with Grass Valley’s new company branding. 
• TX/MAM now contains a new spot-check player that improves the playout of browse copies 6 
• The spot-check player can now be used for previewing ANI files as well 
• User groups have been added as a search option for filtering assets  
• Asset types have been added as a sort option for columns 
• It is now possible to multi-drag assets in TX/MAM, making it possible to add multiple assets to 


POC Scheduler or Weekplanner at once 
• In the channel configuration you can set the duration how long an asset will be kept in the 


servers cache, after transferring it, before it will be removed 
 


65 In order to use the new player for existing assets, the browse copy of existing assets need to be created 
again. Please contact support for more information on this topic. 
 


4.1.10 TX/MAM server 


• LibAV has been added to TX/MAM resulting in a new codec and format for browse copies. 
• When changing channel settings this is directly updated on the playout server as well. 
• The asset inbox importer process is now automatically restarted after changes have been made 


in the menu item Folders 
• Fetching assets from an external storage now also support DNS addresses instead of IP only  
• It is now possible to have assets removed from the DIVA gateway cache  
• External references can contain slashes  
• It is now possible to have the external references contain the file extension 
 


4.2 Fixes 


 


4.2.1 Output 


• Fixed spontaneous resets of text object using counter values when running two or more timer 
objects simultaneously 


• Fixed memory leak  when activating large channel packs occasionally 
• Fixed incorrect handling of partition headers in the RIP table that resulted in being unable to seek 


in some files. 
• Improved seek algorithm for MXF files where the index table contains a negative timecode offset 
• A fix has been implemented so embedded subtitles in MXF will correctly be played (subtitle pass 


through) when the embedded teletext data in the ANC does not have contain data packets. 
• Fixed issue where clips did not play due to socket limitation 
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• Fixed issue where a channel pack could not contain more than 250 objects 
• Fixed issue where animations are cut off at the bottom 
• Fixed issue where 0x20 space characters did not function as fillers for subtitles 
• Fixed issue where $6 subtitle notation resulted in subtitle cut off after +200 characters 
• Fixed issue where progressive clips to lead to a memory leak. 
 


4.2.2 GV Edge IP Manager 


• Fixed issue where updating IP Manager resulted in users actions having no effect 
 


4.2.3 TX/MAM web interface 


• Delete multiple assets will ask confirmation on every asset which is scheduled in the future 
 


4.2.4 Cobalt Playout Control 


• Derived / soft parted assets will now correctly check the status of the main asset to determine if 
the asset is empty 


• Using CTRL-X now correctly cuts an event instead of only copying it 
• After add or re-apply formats the event indicates a flag if metadata is missing 
• Disable shortcut keys for modify action for user without write rights 
• Disable Up/Down buttons for user without write rights 
• Export TC-in/out to playlist 
• Correctly save very large schedules 
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End-of-life recycling notice 
 
Grass Valley’s innovation and excellence in product design also extends to the programs we’ve 
established to manage the recycling of our products. Grass Valley has developed a comprehensive 
end-of-life product take back program for recycle or disposal of end-of-life products. Our program 
meets the requirements of the European Union’s WEEE Directive, the United States Environmental 
Protection Agency, and U.S. state and local agencies. 
 
Grass Valley’s end-of-life product take back program assures proper disposal by use of Best 
Available Technology. This program accepts any Grass Valley branded equipment. Upon request, a 
Certificate of Recycling or a Certificate of Destruction, depending on the ultimate disposition of the 
product, can be sent to the requester. 
 
Grass Valley will be responsible for all costs associated with recycling and disposal, including 
freight. However, you are responsible for the removal of the equipment from your facility and packing 
the equipment to make it ready for pickup. 
 


 
 
Safety summaries 
 
Safety summary 


Read and follow the important safety information below, noting especially those instructions related to 
risk of fire, electric shock or injury to persons. Additional specific warnings not listed here may be 
found throughout the manual. 


 WARNING: Any instructions in this manual that require opening the equipment cover or enclosure 
are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform 
any servicing other than that contained in the operating instructions unless you are qualified to do 
so. 


Safety terms and symbols 


Terms in this manual 


Safety-related statements may appear in this manual in the following form: 


 


 WARNING: Warning statements identify conditions or practices that may result in personal injury or 
loss of life. 


 CAUTION: Caution statements identify conditions or practices that may result in damage to equipment 
or other property, or which may cause equipment crucial to your business environment to become 
temporarily non-operational. 


 


 


For further information on the Grass Valley product take back system please 
contact Grass Valley at + 800 80 80 20 20 or +33 1 48 25 20 20 from most 
other countries. In the U.S. and Canada please call 800-547-8949, and ask to 
be connected to the EH&S Department. Additional information concerning the 
program can be found at: www.grassvalley.com/about/environmental-policy. 
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Terms on the product 


These terms may appear on the product: 


 


DANGER — A personal injury hazard is immediately accessible as you read the marking. 


WARNING — A personal injury hazard exists but is not immediately accessible as you read the 
marking. 


CAUTION — A hazard to property, product, and other equipment is present. 


 


 


Symbols on the product 


The following symbols may appear on the product: 


  
Indicates that dangerous high voltage is present within the equipment enclosure that may 
be of sufficient magnitude to constitute a risk of electric shock. 


 Indicates that user, operator or service technician should refer to product manual(s) for 
important operating, maintenance, or service instructions. 


 This is a prompt to note fuse rating when replacing fuse(s). The fuse referenced in the text 
must be replaced with one having the ratings indicated. 


 Identifies a protective grounding terminal which must be connected to earth ground prior to 
making any other equipment connections. 


 Identifies an external protective grounding terminal which may be connected to earth 
ground as a supplement to an internal grounding terminal. 


 Indicates that static sensitive components are present which may be damaged by electrostatic 
discharge. Use anti-static procedures, equipment and surfaces during servicing. 


 


 


Warnings 


The following warning statements identify conditions or practices that can result in personal injury or 
loss of life. 


Dangerous voltage or current may be present — Disconnect power and remove battery (if applicable) 
before removing protective panels, soldering, or replacing components. 


 


Do not service alone — Do not internally service this product unless another person capable of 
rendering first aid and resuscitation is present. 


 


Remove jewelry — Prior to servicing, remove jewelry such as rings, watches, and other metallic 
objects. 


 


Avoid exposed circuitry — Do not touch exposed connections, components or circuitry when power is 
present. 
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Use proper power cord — Use only the power cord supplied or specified for this product. 


 


Ground product — Connect the grounding conductor of the power cord to earth ground. 


 


Operate only with covers and enclosure panels in place — Do not operate this product when covers or 
enclosure panels are removed. 


 


Use correct fuse — Use only the fuse type and rating specified for this product. 


 


Use only in dry environment — Do not operate in wet or damp conditions. 


 


Use only in non-explosive environment — Do not operate this product in an explosive atmosphere. 


 


High leakage current may be present — Earth connection of product is essential before connecting 
power. 


 


Dual power supplies may be present — Be certain to plug each power supply cord into a separate 
branch circuit employing a separate service ground. Disconnect both power supply cords prior to 
servicing. 


 


Double pole neutral fusing — Disconnect mains power prior to servicing. 


 


Use proper lift points — Do not use door latches to lift or move equipment. 


 


Avoid mechanical hazards — Allow all rotating devices to come to a stop before servicing. 


 


 


Cautions 


The following caution statements identify conditions or practices that can result in damage to 
equipment or other property 


 


Use correct power source — Do not operate this product from a power source that applies more than 
the voltage specified for the product. 


Use correct voltage setting — If this product lacks auto-ranging power supplies, before applying 
power ensure that the each power supply is set to match the power source. 


 


Provide proper ventilation — To prevent product overheating, provide equipment ventilation in 
accordance with installation instructions. 


 


Use anti-static procedures — Static sensitive components are present which may be damaged by 
electrostatic discharge. Use anti-static procedures, equipment and surfaces during servicing. 
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Do not operate with suspected equipment failure — If you suspect product damage or equipment 
failure, have the equipment inspected by qualified service personnel. 


 


Ensure mains disconnect — If mains switch is not provided, the power cord(s) of this equipment 
provide the means of disconnection. The socket outlet must be installed near the equipment and 
must be easily accessible. Verify that all mains power is disconnected before installing or removing 
power supplies and/or options. 


 


Route cable properly — Route power cords and other cables so that they are not likely to be damaged. 
Properly support heavy cable bundles to avoid connector damage. 


 


Use correct power supply cords — Power cords for this equipment, if provided, meet all North 
American electrical codes. Operation of this equipment at voltages exceeding 130 VAC requires 
power supply cords which comply with NEMA configurations. International power cords, if provided, have 
the approval of the country of use. 


 


Use correct replacement battery — This product may contain batteries. To reduce the risk of explosion, 
check polarity and replace only with the same or equivalent type recommended by manufacturer. 
Dispose of used batteries according to the manufacturer’s instructions. 


 


Troubleshoot only to board level — Circuit boards in this product are densely populated with surface 
mount technology (SMT) components and application specific integrated circuits (ASICS). As a 
result, circuit board repair at the component level is very difficult in the field, if not impossible. For 
warranty compliance, do not troubleshoot systems beyond the board level. 


 


 


Sicherheit – Überblick 


Lesen und befolgen Sie die wichtigen Sicherheitsinformationen dieses Abschnitts. Beachten Sie 
insbesondere die Anweisungen bezüglich 


Brand-, Stromschlag- und Verletzungsgefahren. Weitere spezifische, hier nicht aufgeführte 
Warnungen finden Sie im gesamten Handbuch. 


 


 WARNUNG: Alle Anweisungen in diesem Handbuch, die das Abnehmen der Geräteabdeckung oder 
des Gerätegehäuses erfordern, dürfen nur von qualifiziertem Servicepersonal ausgeführt werden. 
Um die Stromschlaggefahr zu verringern, führen Sie keine Wartungsarbeiten außer den in den 
Bedienungsanleitungen genannten Arbeiten aus, es sei denn, Sie besitzen die entsprechende 
Qualifikationen für diese Arbeiten. 
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Sicherheit – Begriffe und Symbole 


In diesem Handbuch verwendete Begriffe 


Sicherheitsrelevante Hinweise können in diesem Handbuch in der folgenden Form auftauchen: 


 


 WARNUNG: Warnungen weisen auf Situationen oder Vorgehensweisen hin, die 


Verletzungs- oder Lebensgefahr bergen. 
 


 VORSICHT: Vorsichtshinweise weisen auf Situationen oder Vorgehensweisen hin, die zu Schäden an 
Ausrüstungskomponenten oder anderen Gegenständen oder zum zeitweisen Ausfall wichtiger 
Komponenten in der Arbeitsumgebung führen können. 


 


Hinweise am Produkt 


Die folgenden Hinweise können sich am Produkt befinden: 


GEFAHR – Wenn Sie diesen Begriff lesen, besteht ein unmittelbares Verletzungsrisiko.  


WARNUNG – Wenn Sie diesen Begriff lesen, besteht ein mittelbares Verletzungsrisiko. 


 VORSICHT – Es besteht ein Risiko für Objekte in der Umgebung, den Mixer selbst oder andere 
Ausrüstungskomponenten. 


 


Symbole am Produkt 


Die folgenden Symbole können sich am Produkt befinden: 


  
Weist auf eine gefährliche Hochspannung im Gerätegehäuse hin, die stark genug sein kann, 
um eine Stromschlaggefahr darzustellen. 


 Weist darauf hin, dass der Benutzer, Bediener oder Servicetechniker wichtige Bedienungs-, 
Wartungs- oder Serviceanweisungen in den Produkthandbüchern lesen sollte. 


 Dies ist eine Aufforderung, beim Wechsel von Sicherungen auf deren Nennwert zu achten. Die 
im Text angegebene Sicherung muss durch eine Sicherung ersetzt werden, die die 
angegebenen Nennwerte besitzt. 


 Weist auf eine Schutzerdungsklemme hin, die mit dem Erdungskontakt verbunden werden 
muss, bevor weitere Ausrüstungskomponenten angeschlossen werden. 


 Weist auf eine externe Schutzerdungsklemme hin, die als Ergänzung zu einem internen 
Erdungskontakt an die Erde angeschlossen werden kann. 


 Weist darauf hin, dass es statisch empfindliche Komponenten gibt, die durch eine 
elektrostatische Entladung beschädigt werden können. Verwenden Sie antistatische 
Prozeduren, Ausrüstung und Oberflächen während der Wartung. 


 


 


Warnungen 


Die folgenden Warnungen weisen auf Bedingungen oder Vorgehensweisen hin, die Verletzungs- oder 
Lebensgefahr bergen: 
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Gefährliche Spannungen oder Ströme – Schalten Sie den Strom ab, und entfernen Sie ggf. die Batterie, 
bevor sie Schutzabdeckungen abnehmen, löten oder Komponenten austauschen. 


 


Servicearbeiten nicht alleine ausführen – Führen Sie interne Servicearbeiten nur aus, wenn eine 
weitere Person anwesend ist, die erste Hilfe leisten und Wiederbelebungsmaßnahmen einleiten kann. 


 


Schmuck abnehmen – Legen Sie vor Servicearbeiten Schmuck wie Ringe, Uhren und andere 
metallische Objekte ab. 


 


Keine offen liegenden Leiter berühren – Berühren Sie bei eingeschalteter Stromzufuhr keine offen 
liegenden Leitungen, Komponenten oder Schaltungen. 


 


Richtiges Netzkabel verwenden – Verwenden Sie nur das mitgelieferte Netzkabel oder ein Netzkabel, 
das den Spezifikationen für dieses Produkt entspricht. 


 


Gerät erden – Schließen Sie den Erdleiter des Netzkabels an den Erdungskontakt an. 


 


Gerät nur mit angebrachten Abdeckungen und Gehäuseseiten betreiben – Schalten Sie dieses Gerät 
nicht ein, wenn die Abdeckungen oder Gehäuseseiten entfernt wurden. 


 


Richtige Sicherung verwenden – Verwenden Sie nur Sicherungen, deren Typ und Nennwert den 
Spezifikationen für dieses Produkt entsprechen. 


 


Gerät nur in trockener Umgebung verwenden – Betreiben Sie das Gerät nicht in nassen oder feuchten 
Umgebungen. 


 


Gerät nur verwenden, wenn keine Explosionsgefahr besteht – Verwenden Sie dieses Produkt nur in 
Umgebungen, in denen keinerlei Explosionsgefahr besteht. 


 


Hohe Kriechströme – Das Gerät muss vor dem Einschalten unbedingt geerdet werden. 


 


Doppelte Spannungsversorgung kann vorhanden sein – Schließen Sie die beiden Anschlußkabel an 
getrennte Stromkreise an. Vor Servicearbeiten sind beide Anschlußkabel vom Netz zu trennen. 


 


Zweipolige, neutrale Sicherung – Schalten Sie den Netzstrom ab, bevor Sie mit den Servicearbeiten 
beginnen. 


 


Fassen Sie das Gerät beim Transport richtig an – Halten Sie das Gerät beim Transport nicht an Türen 
oder anderen beweglichen Teilen fest. 


 


Gefahr durch mechanische Teile – Warten Sie, bis der Lüfter vollständig zum Halt gekommen ist, 
bevor Sie mit den Servicearbeiten beginnen. 
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Vorsicht 


Die folgenden Vorsichtshinweise weisen auf Bedingungen oder Vorgehensweisen hin, die zu Schäden an 
Ausrüstungskomponenten oder anderen Gegenständen führen können: 


 


Gerät nicht öffnen – Durch das unbefugte Öffnen wird die Garantie ungültig. 


 


Richtige Spannungsquelle verwenden – Betreiben Sie das Gerät nicht an einer Spannungsquelle, die 
eine höhere Spannung liefert als in den Spezifikationen für dieses Produkt angegeben. 


 


Gerät ausreichend belüften – Um eine Überhitzung des Geräts zu vermeiden, müssen die 
Ausrüstungskomponenten entsprechend den Installationsanweisungen belüftet werden. Legen Sie 
kein Papier unter das Gerät. Es könnte die Belüftung behindern. Platzieren Sie das Gerät auf einer 
ebenen Oberfläche. 


 


Antistatische Vorkehrungen treffen – Es gibt statisch empfindliche Komponenten, die durch eine 
elektrostatische Entladung beschädigt werden können. Verwenden Sie antistatische Prozeduren, 
Ausrüstung und Oberflächen während der Wartung. 


 


CF-Karte nicht mit einem PC verwenden – Die CF-Karte ist speziell formatiert. Die auf der CF-Karte 
gespeicherte Software könnte gelöscht werden. 


 


Gerät nicht bei eventuellem Ausrüstungsfehler betreiben – Wenn Sie einen Produktschaden oder 
Ausrüstungsfehler vermuten, lassen Sie die Komponente von einem qualifizierten Servicetechniker 
untersuchen. 


 


 


Kabel richtig verlegen – Verlegen Sie Netzkabel und andere Kabel so, dass Sie nicht beschädigt 
werden. Stützen Sie schwere Kabelbündel ordnungsgemäß ab, damit die Anschlüsse nicht beschädigt 
werden. 


 


Richtige Netzkabel verwenden – Wenn Netzkabel mitgeliefert wurden, erfüllen diese alle nationalen 
elektrischen Normen. Der Betrieb dieses Geräts mit Spannungen über 130 V AC erfordert Netzkabel, die 
NEMA-Konfigurationen entsprechen. Wenn internationale Netzkabel mitgeliefert wurden, sind diese 
für das Verwendungsland zugelassen. 


 


Richtige Ersatzbatterie verwenden – Dieses Gerät enthält eine Batterie. Um die Explosionsgefahr zu 
verringern, prüfen Sie die Polarität und tauschen die Batterie nur gegen eine Batterie desselben Typs 
oder eines gleichwertigen, vom Hersteller empfohlenen Typs aus. Entsorgen Sie gebrauchte Batterien 
entsprechend den Anweisungen des Batterieherstellers. 


 


Das Gerät enthält keine Teile, die vom Benutzer gewartet werden können. Wenden Sie sich bei 
Problemen bitte an den nächsten Händler. 
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Consignes de sécurité 
Il est recommandé de lire, de bien comprendre et surtout de respecter les informations relatives à la 
sécurité qui sont exposées ci-après, notamment les consignes destinées à prévenir les risques 
d’incendie, les décharges électriques et les blessures aux personnes. Les avertissements 
complémentaires, qui ne sont pas nécessairement repris ci-dessous, mais présents dans toutes les 
sections du manuel, sont également à prendre en considération. 


 


 VERTISSEMENT: Toutes les instructions présentes dans ce manuel qui concernent l’ouverture des 
capots ou des logements de cet équipement sont destinées exclusivement à des membres 
qualifiés du personnel de maintenance. Afin de diminuer les risques de décharges électriques, ne 
procédez à aucune intervention d’entretien autre que celles contenues dans le manuel de 
l’utilisateur, à moins que vous ne soyez habilité pour le faire. 
 


Consignes et symboles de sécurité 


Termes utilisés dans ce manuel 


Les consignes de sécurité présentées dans ce manuel peuvent apparaître sous les formes suivantes: 


 


 AVERTISSEMENT: Les avertissements signalent des conditions ou des pratiques susceptibles 
d’occasionner des blessures graves, voire même fatales. 
 


 MISE EN GARDE: Les mises en garde signalent des conditions ou des pratiques susceptibles 
d’occasionner un endommagement à l’équipement ou aux installations, ou de rendre l’équipement 
temporairement non opérationnel, ce qui peut porter préjudice à vos activités. 


 


Signalétique apposée sur le produit 


La signalétique suivante peut être apposée sur le produit : 


DANGER — risque de danger imminent pour l’utilisateur. 


AVERTISSEMENT — Risque de danger non imminent pour l’utilisateur. 


MISE EN GARDE — Risque d’endommagement du produit, des installations ou des autres equipements. 


 


Symboles apposés sur le produit 


Les symboles suivants peut être apposés sur le produit: 


  
Signale la présence d’une tension élevée et dangereuse dans le boîtier de l’équipement ; 


cette tension peut être suffisante pour constituer un risque de décharge électrique. 


 Signale que l’utilisateur, l’opérateur ou le technicien de maintenance doit faire référence 
au(x) manuel(s) pour prendre connaissance des instructions d’utilisation, de maintenance 
ou d’entretien. 


 Il s’agit d’une invite à prendre note du calibre du fusible lors du remplacement de ce dernier. Le 
fusible auquel il est fait référence dans le texte doit être remplacé par un fusible du même 
calibre. 


 Identifie une borne de protection de mise à la masse qui doit être raccordée correctement 
avant de procéder au raccordement des autres équipements. 
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 Identifie une borne de protection de mise à la masse qui peut être connectée en tant que 
borne de mise à la masse supplémentaire. 


 Signale la présence de composants sensibles à l’électricité statique et qui sont susceptibles 
d’être endommagés par une décharge électrostatique. Utilisez des procédures, des 
équipements et des surfaces antistatiques durant les interventions d’entretien. 


 


Avertissements 


Les avertissements suivants signalent des conditions ou des pratiques susceptibles d’occasionner 
des blessures graves, voire même fatales: 


 


Présence possible de tensions ou de courants dangereux — Mettez hors tension, débranchez et 
retirez la pile (le cas échéant) avant de déposer les couvercles de protection, de défaire une soudure 
ou de remplacer des composants. 


 


Ne procédez pas seul à une intervention d’entretien — Ne réalisez pas une intervention d’entretien 
interne sur ce produit si une personne n’est pas présente pour fournir les premiers soins en cas 
d’accident. 


 


Retirez tous vos bijoux — Avant de procéder à une intervention d’entretien, retirez tous vos bijoux, 
notamment les bagues, la montre ou tout autre objet métallique. 


 


Évitez tout contact avec les circuits exposés — Évitez tout contact avec les connexions, les 
composants ou les circuits exposés s’ils sont sous tension. 


 


Utilisez le cordon d’alimentation approprié — Utilisez exclusivement le cordon d’alimentation fourni 
avec ce produit ou spécifié pour ce produit. 


 


Raccordez le produit à la masse — Raccordez le conducteur de masse du cordon d’alimentation à la 
borne de masse de la prise secteur. 


 


Utilisez le produit lorsque les couvercles et les capots sont en place — N’utilisez pas ce produit si les 
couvercles et les capots sont déposés. 


 


 


Utilisez le bon fusible — Utilisez exclusivement un fusible du type et du calibre spécifiés pour ce 
produit. 


 


Utilisez ce produit exclusivement dans un environnement sec — N’utilisez pas ce produit dans un 
environnement humide. 


 


Utilisez ce produit exclusivement dans un environnement non explosible — N’utilisez pas ce produit 
dans un environnement dont l’atmosphère est explosible. 
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Présence possible de courants de fuite — Un raccordement à la masse est indispensable avant la 
mise sous tension. 


 


Deux alimentations peuvent être présentes dans l’équipement — Assurez vous que chaque cordon 
d’alimentation est raccordé à des circuits de terre séparés. Débranchez les deux cordons d’alimentation 
avant toute intervention. 


 


Fusion neutre bipolaire — Débranchez l’alimentation principale avant de procéder à une intervention 
d’entretien. 


 


Utilisez les points de levage appropriés — Ne pas utiliser les verrous de la porte pour lever ou déplacer 
l’équipement. 


 


Évitez les dangers mécaniques — Laissez le ventilateur s’arrêter avant de procéder à une intervention 
d’entretien. 


 


 


Mises en garde 


Les mises en garde suivantes signalent les conditions et les pratiques susceptibles d’occasionner 
des endommagements à l’équipement et aux installations : 


 


N’ouvrez pas l’appareil — Toute ouverture prohibée de l’appareil aura pour effet d’annuler la garantie. 


 


Utilisez la source d’alimentation adéquate — Ne branchez pas ce produit à une source d’alimentation 
qui utilise une tension supérieure à la tension nominale spécifiée pour ce produit. 


 


Assurez une ventilation adéquate — Pour éviter toute surchauffe du produit, assurez une ventilation 
de l’équipement conformément aux instructions d’installation. Ne déposez aucun document sous 
l’appareil – ils peuvent gêner la ventilation. Placez l’appareil sur une surface plane. 


 


Utilisez des procédures antistatiques - Les composants sensibles à l’électricité statique présents dans 
l’équipement sont susceptibles d’être endommagés par une décharge électrostatique. Utilisez des 
procédures, des équipements et des surfaces antistatiques durant les interventions d’entretien. 


 


N’utilisez pas la carte CF avec un PC — La carte CF a été spécialement formatée. Le logiciel enregistré 
sur la carte CF risque d’être effacé. 


 


N’utilisez pas l’équipement si un dysfonctionnement est suspecté — Si vous suspectez un 
dysfonctionnement du produit, faites inspecter celui-ci par un membre qualifié du personnel 
d’entretien. 


 


Acheminez les câbles correctement — Acheminez les câbles d’alimentation et les autres câbles de 
manière à ce qu’ils ne risquent pas d’être endommagés. Supportez correctement les enroulements 
de câbles afin de ne pas endommager les connecteurs. 
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Utilisez les cordons d’alimentation adéquats — Les cordons d’alimentation de cet équipement, s’ils 
sont fournis, satisfont aux exigences de toutes les réglementations régionales. L’utilisation de cet 
équipement à des tensions dépassant les 130 V en c.a. requiert des cordons d’alimentation qui 
satisfont aux exigences des configurations NEMA. Les cordons internationaux, s’ils sont fournis, ont 
reçu l’approbation du pays dans lequel l’équipement est utilisé. 


 


Utilisez une pile de remplacement adéquate — Ce produit renferme une pile. Pour réduire le risque 
d’explosion, vérifiez la polarité et ne remplacez la pile que par une pile du même type, recommandée par 
le fabricant. Mettez les piles usagées au rebut conformément aux instructions du fabricant des piles. 


 


Cette unité ne contient aucune partie qui peut faire l’objet d’un entretien par l’utilisateur. Si un 
problème survient, veuillez contacter votre distributeur local. 
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Certifications and compliances 


 


Canadian certified power cords 
Canadian approval includes the products and power cords appropriate for use in the North America 
power network. All other power cords supplied are approved for the country of use. 


 


FCC emission control 
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. Changes or modifications not 
expressly approved by Grass Valley can affect emission compliance and could void the user’s 
authority to operate this equipment. 


 


Canadian EMC Notice of Compliance  
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital 
apparatus set out in the Radio Interference Regulations of the Canadian Department of 
Communications. 


 


Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables 
aux appareils numériques de la classe A préscrites dans le Règlement sur le brouillage radioélectrique 
édicté par le ministère des Communications du Canada. 


 


EN55013 1/2 Class A warning 
This product has been evaluated for Electromagnetic Compatibility under the EN 55013-1/2 standards 
for Emissions and Immunity and meets the requirements for E4 environment. 


This product complies with Class A (E4 environment). In a domestic environment this product may 
cause radio interference in which case the user may be required to take adequate measures. 


 


FCC emission limits 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesirable operation. 


 


Safety certification 
This product has been evaluated and meets the following Safety Certification Standards: 


Standard Designed/tested for compliance with: 


ANSI/UL 60950-1 


 


Safety of Information Technology Equipment, including 


Electrical Business Equipment (Second edition 2007). 


IEC 60950-1 with CB cert. Safety of Information Technology Equipment, including 
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Electrical Business Equipment (Second edition, 2005). 


 


CAN/CSA C22.2 No. 60950-1 Safety of Information Technology Equipment, including 


Electrical Business Equipment (Second edition 2007). 


BS EN 60950-1 Safety of Information Technology Equipment, including 


Electrical Business Equipment 2006. 


 


 
ESD Protection 
Electronics today are more susceptible to electrostatic discharge (ESD) damage than older equipment. 
Damage to equipment can occur by ESD fields that are smaller than you can feel. Implementing the 
information in this section will help you protect the investment that you have made in purchasing 
Grass Valley equipment. This section contains Grass Valley’s recommended ESD guidelines that 
should be followed when handling electrostatic discharge sensitive (ESDS) items. These minimal 
recommendations are based on the information in the Sources of ESD and Risks area. The information 
in Grounding Requirements for Personnel is provided to assist you in selecting an appropriate 
grounding method. 


 


Recommended ESD Guidelines 
Follow these guidelines when handling Grass Valley equipment: 


• Only trained personnel that are connected to a grounding system should handle ESDS items. 
• Do not open any protective bag, box, or special shipping packaging until you have been 


grounded. 
NOTE: When a Personal Grounding strap is unavailable, as an absolute minimum, touch a metal 
object that is touching the floor (for example, a table, frame, or rack) to discharge any static 
energy before touching an ESDS item. 


• Open the anti-static packaging by slitting any existing adhesive tapes. Do not tear the tapes 
off. 


• Remove the ESDS item by holding it by its edges or by a metal panel. 
• Do not touch the components of an ESDS item unless it is absolutely necessary to configure 


or repair the item. 
• Keep the ESDS work area clear of all nonessential items such as coffee cups, pens, wrappers 


and personal items as these items can discharge static. If you need to set an ESDS item 
down, place it on an anti-static mat or on the anti-static packaging. 


 


 


Sources of ESD and Risks 
The following information identifies possible sources of electrostatic discharge and can be used to 
help establish an ESD policy. 


 


Personnel 


One of the largest sources of static is personnel. The static can be released from a person’s clothing 
and shoes. 
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Environment 


The environment includes the humidity and floors in a work area. The humidity level must be 
controlled and should not be allowed to fluctuate over a broad range. Relative humidity (RH) is a 
major part in determining the level of static that is being generated. For example, at 10% - 20% RH a 
person walking across a carpeted floor can develop 35kV; yet when the relative humidity is increased 
to 70% - 80%, the person can only generate 1.5kV. 


Static is generated as personnel move (or as equipment is moved) across a floor’s surface. Carpeted 
and waxed vinyl floors contribute to static build up. 


 


Work Surfaces 


Painted or vinyl-covered tables, chairs, conveyor belts, racks, carts, anodized surfaces, plexiglass 
covers, and shelving are all static generators. 


 
Equipment 


Any equipment commonly found in an ESD work area, such as solder guns, heat guns, blowers, etc., 
should be grounded. 


 


Materials 


Plastic work holders, foam, plastic tote boxes, pens, packaging containers and other items commonly 
found at workstations can generate static electricity. 


 


Grounding Requirements for Personnel 
The information in this section is provided to assist you in selecting a grounding method. This 
information is taken from ANSI/ESD S20.20-2007 (Revision of ANSI/ESD S20.20-1999). 


 


Product Qualification 


Personnel Grounding Technical 
Requirement 


 


Test Method 


 


Required Limits 


Wrist Strap System* 


 


ANSI/ESD S1.1 (Section 5.11) < 3.5 x 107 ohm 


 


Flooring / Footwear System – 
Method 1 


 


ANSI/ESD STM97.1 < 3.5 x 107 ohm 


Flooring / Footwear System – 
Method 2 (both required) 


 


ANSI/ESD STM97. 


1ANSI/ESD STM97.2 


 


< 109 ohm 


 


ANSI/ESD STM97.2 < 100 V 


 


 


Product qualification is normally conducted during the initial selection of ESD control products and 
materials. Any of the following methods can be used: product specification review, independent 
laboratory evaluation, or internal laboratory evaluation. 
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Compliance Verification 


Personnel Grounding Technical 
Requirement 


 


Test Method 


 


Required Limits 


Wrist Strap System* 


 


ESD TR53 Wrist Strap Section 


 


< 3.5 x 107 ohm 


 


Flooring / Footwear System – 
Method 1 


 


ESD TR53 Flooring Section and 


ESD TR53 Footwear Section 


< 3.5 x 107 ohm 


Flooring / Footwear System – 
Method 2 (both required) 


 


ESD TR53 Flooring Section and 


ESD TR53 Footwear Section 


< 1.0 x 109 ohm 


 


 


* For situations where an ESD garment is used as part of the wrist strap grounding path, the total 
system resistance, including the person, garment, and grounding cord, must be less than 3.5 x 
107ohm.  
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1 About this guide 
The GV Edge 4.2.1 User Guide gives users the latest information and instructions 
about how to use GV Edge 4.2.1 for GV Edge. 
 
 


1.1 What’s in this guide 


This document describes how you can work with GV Edge 4.2.1. 
 


1.2 Document conventions 


The formatting of this user guide is designed to help you easily and quickly find information. The 
following table explains what the different formats in this document mean. 
 
Format Refers to Example 
Bold An onscreen object for which a user action 


is needed. Keyboard keys are not 
emphasized. 


Click Save As. 


Italic Placeholder text. 
Hyperlink or cross-reference. 


Type password. 
See Chapter 2, Get to know Composer. 


■  Single-step procedures. ■ On the View menu, click Ruler. 
1.  Multiple-step procedures. 1. On the Tools menu, click Options. 


2. Click the Edit tab. 
& Note: A note. & Note: Only administrators can 


publish to a server. 


•  A list item. A user can edit: 
• Objects 
• Materials 
• Visual effects. 


 


1.3 Useful resources 


The following related resources might also help you to learn about the features of Channel 
Composer: 
• GV Edge 4.2.1 Quick Start Guide. 
 


1.4 Contact support 
 
Do you have a specific question and was the answer not in this user guide? Please visit our website 
or contact Grass Valley support. 
 
To contact Grass Valley support, do one of the following: 
■ Call one of our international support centers with 24/7 availability: 


o France, +800 8080 2020 or +33 1 48 25 20 20. 
o US and Canada, +1 800 547 8949 or +1 530 478 4148. 


■ Call one of our local support centers, open during normal business hours: 
o Asia 


 Hong Kong, Taiwan, Korea and Macau: +852 2531 3058. 
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 Indian Subcontinent: +91 22 24933476. 
 Southeast Asia/Malaysia: +603 7492 3303. 
 Southeast Asia/Singapore: +65 6379 1313. 
 China: +861 0660 159 450 Japan: +81 3 5484 6868. 


o Australia and New Zealand: +61 1300 721 495. 
o Central and South America: +55 11 5509 3443. 
o Middle East: +971 4 299 64 40. 
o Near East and Africa: +800 8080 2020 or +33 1 48 25 20 20. 
o Europe 


 Belarus, Russia, Tadzikistan, Ukraine, Uzbekistan: +7 095 2580924 225. 
 Switzerland: +41 1 487 80 02. 
 Italy (Rome): +39 06 87 20 35 28. 
 Italy (Milan): +39 02 48 41 46 58. 
 Spain:  +34 91 512 03 50. 
 Belgium: +32 (0) 2 334 90 30. 
 Netherlands: +31 (0) 35 62 38 42 1. 
 Benelux and Northern Europe: +45 45 96 88 70. 
 Germany, Austria, Eastern Europe: +49 6150 104 444. 
 UK, Ireland, Israel: +44 118 923 0499. 
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2 Get to know GV Edge 4.2.1 
2.1 GV Edge Front Panel 
 


 
GV Edge front panel with LCD-panel (IP Manager). 


 


 


2.2 GV Edge Back Panel  


 
GV Edge back panel. 


 


 


2.3 Indicators and status information 
2.3.1 Power supply indicator 


green ON 


Connectors 


IPM IP Manager 


M Mouse (not connected) 


KBD Keyboard 


USB USB 


COM Serial COM 


VGA VGA 


eth0-3 eth0-3 


LTC LTC 


GPIO GPIO (open collector) 


AC Power supplies 


GL blackburst/trilevel sync 


IO1-IO8 SDI IOs. Bypass can be enabled on IO1 (in) and IO2 (out). 







 


071884603  K2 Edge 4.2.1 User Guide - 23 


red Failure 


LED off Standby 


 


2.3.2 IP Manager connection indicator 


Left LED 


yellow (blink) System online 
 


Right LED 


green Speed 100 Mbps 
 


2.3.3 LAN connection indicator 


Left LED 


green (blink) System online 
 


Right LED 


green Speed 100 Mbps 


orange Speed 1 Gbps 
 


2.3.4 LEDs (hard disks)  


Top LED (activity) 


green  Indicates read/write actions on the disk. 
 


 


Bottom  LED 


green Hard disk OK. 


red (blink) Hard disk not in RAID and probably broken. 


orange (blink) Hard disk will fail soon. 


blue (blink) No hard disk detected. 


blue  Hard disk seems slower than usual. 


green (pulse) Hard disk is being added to the RAID (RAID rebuild). 
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2.4 The IP Manager web interface 


 
Example IP Manager menu via the web browser. The system’s hostname is shown in the upper right 


corner and on the web page’s tab. The highlighted menu item shows where you are in the navigation 


tree. 


 


■ To confirm changes, click Set. 
 


Some changes in Channel settings require a restart of the render engine (nexos): select OK to set 


changes. Next press the Activate button that appeared to activate the required changes. 


& When nexos is restarted, this will result in a black output for as long as the current event is 
running. 


2.4.1 System configuration > Network configuration 


• Hostname: the GV Edge hostname 



http://10.250.51.129/?path=0:





 


071884603  K2 Edge 4.2.1 User Guide - 25 


• IP-manager: specify network settings for the IP Manager. Note that the IP Manager has its own 
IP address. 


o Use DHCP: On/Off  
o IP address  
o Netmask 
o Gateway 
o Nameserver 


• GVEdge: specify network settings for the GV Edge server 
o Network port <nr> 


 Method: DHCP or Manual 
 IP address 
 Netmask 
 The system’s MAC address is displayed. 


o Gateway 
o Nameserver 


• TX/MAM server virtual IP: the TX/MAM servers’ virtual IP address 
 


2.4.2 System configuration > Channel configuration 


• Audio Channel Routing 1: Decoded Dolby E audio routing for channel 1 
• Audio Channel Routing 2: Decoded Dolby E audio routing for channel 2 
• Audio Channel Routing 3: Decoded Dolby E audio routing for channel 3 
• Video Bypass: enable (activate) or disable the bypass  
• Channel layout: select one of the following presets: 


o  1xSD (1) : single SD (with preset 1) 
o  1xSD (2) : single SD (with preset 2) 
o  1xHD (1) : single HD (with preset 1) 
o  1xHD (2) : single HD (with preset 2) 
o  1xSD+preview (1) : single SD + preview (preset 1) 
o  1xSD+preview (2) : single SD + preview (preset 2) 
o  1xHD+preview (1) : single HD + preview (preset 1) 
o  1xHD+preview (2) : single HD + preview (preset 2) 
o  Simulcast 
o 2x SD 
o 3x SD 
o  Custom setup 


• Region: select PAL or NTSC 
• HD-format: for HD-channels, select 720p or 1080i 
• Genlock: select Blackburst or Trilevel sync 
• Audio channels: specify audio groups per SDIO 


o SDIO1-8:  
 Single audio group 
 Two audio groups 
 Three audio groups 
 Four audio groups 


• SDI port misc:  
o SDIO in 


 VBI: Enabled/Disabled 
 HBI: Enabled/Disabled 


o SDIO out 



http://10.250.51.129/?path=0:
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 Key/Fill 
 


• Enable recording channel: enable or disable the recording channel: On/Off 
• Enable JIP channel: enable or disable the JIP channel: On/Off 
• Delay: not used for the GV Edge, only for VDS (Video Delay Server) 
• GPIO: configure one or multiple GPIO services 
• TS-over-IP 1: Configure TS-over-IP for channel 1 
• TS-over-IP 2: Configure TS-over-IP for channel 2 
• TS-over-IP 3: Configure TS-over-IP for channel 3 
• Watermarking 1: Configure audio watermarking for channel 1 
• Watermarking 2: Configure audio watermarking for channel 2 
• Watermarking 3: Configure audio watermarking for channel 3 
• Time Settings 
 


On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD content 
containing a maximum bitrate of 25000 Kbit/s 


 


2.4.3 System configuration > Time settings  


Set the system date and time. 


• Current date: yyyy-mm-dd 
• Current time: hh:mm 


 


2.4.4 System monitoring > SNMP monitoring 


• SNMP monitoring:  
o Enable SNMP: On / Off 
o RO community 
o RW community 
o Enable SNMP traps: On / Off 
o Trap IP: IP number where to the trap needs to be send 
o Trap community: trap community name 
o Trap re-send interval (minutes) 
o MIB type:   


 GVEdge MIB   
 Legacy MIB 


 


2.4.5 System monitoring > System info 


• System info: 
o RAID partition free space (K) 
o Memory installed (MB) 
o CPU usage (percentage) 
o Non-running programs 
o Serial number and system installer version 
o PSU status 
o GPU Temperature (Celsius) 
o HD raid status 
o HD SMART status 



http://10.250.51.129/?path=0:

http://10.250.51.129/?path=1:
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o HD temperature (Celsius) 
o Fans (speed in rotations per minute) 
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2.4.6 System monitoring > UDP Monitoring 


• UDP Monitoring: 
o Resolution: 320x240/ 240x180/ 160x120 
o Aspect Ratio: 4:3/ 16:9 
o Video Bitrate: in kbit/s 
o Audio Enabled: On/Off  
o Audio Bitrate: in kbit/s 
o Ethernet Output: select On to enable monitoring and start streaming, Off to disable. 
o IP address: IP address of the target workstation (can be a multicast address) 
o IP-port: port the player will listen to. Default 4000  


 


2.4.7 System administration 


• Server start/stop 
• Reboot 
• Shutdown 
• Forced power off: only use when a shutdown is not possible. 
• Forced reset: only use when a Reboot is not possible. 


 
• Manage services 


Services are: 
• database 
• dataserver 
• encoderd 
• firebird 
• nexos 
• playout_distri 
• pt_guard 
• schedulesync0  
• sequencer0  


 
Options for each service are: 


• View the service’s version and status. 
• Start the service. 
• Stop the service. 
• Restart the service. 


 


2.5 GV Edge network ports 


FTP Default port 20 and 21 


SSH/SCP Default port 22 


Cobalt database access Default port 5020 


Web based interface Default port 80 


ptsockse Default port 5000  


nexos complex socket  Default port 5001 


UDP-monitoring Default port 4000 


 



http://10.250.51.129/?path=1:

http://10.250.51.129/?path=2:
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2.6 Channel Presets 


The GV Edge contains 8 bidirectional SDI-ports. A number of presets have been defined for the GV 
Edge. These presets can be selected via the IP Manager. 
 
Possible Channel configurations on a single GV Edge server: 
• Single Channel HD 
• Single Channel SD 
• Single Channel HD + Preview Channel 
• Single Channel SD + Preview Channel 
• Simulcast 
 


Single  Simulcast  Preview  Preset 
HD or SD - - hd1/hd2/sd1/sd2 
HD  - Preview hdpr1/hdpr2 
SD - Preview sdpr1/sdpr2 
HD 
 


SD - sim1 


& Note that available options depend on licenses purchased. 


 


Single Channel SD 


• Preset 1 
o Channel Single Inputs: IO1(SD),IO3(SD),IO5(SD),IO6(SD) 
o Channel Single Outputs: IO2(SD),IO4(SD),IO7(SD), IO8(SD) 


• Preset 2 
o Channel Single Inputs: IO1(SD),IO3(SD),IO5(HD),IO6(HD) 
o Channel Single Outputs: IO2(SD),IO4(SD),IO7(SD),IO8(SD) 


 
Single Channel HD 


• Preset 1 
o Channel Single Inputs: IO1(HD),IO3(HD),IO5(HD),IO6(HD) 
o Channel Single Outputs: IO2(HD),IO4(HD),IO7(HD),IO8(HD) 


• Preset 2 
o Channel Single Inputs: IO1(HD),IO3(HD),IO5(SD),IO6(SD) 
o Channel Single Outputs: IO2(HD),IO4(HD),IO7(HD),IO8(HD) 


 


Single Channel SD + Preview 


• Preset 1 
o Channel Single Inputs: IO1(SD), IO3(SD), IO4(SD) 
o Channel Single Output: IO2(SD), IO5(SD), IO6(SD) 
o Preview Channel Input: IO7(HD) 
o Preview Channel Output: IO8(HD) 


• Preset 2 
o Channel Single Inputs: IO1(SD), IO3(HD), IO4(HD) 
o Channel Single Output: IO2(SD), IO5(SD), IO6(SD) 
o Preview Channel Input: IO7(HD) 
o Preview Channel Output: IO8(HD) 
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Single Channel HD + Preview 


• Preset 1 
o Channel Single Inputs: IO1(HD), IO3(HD), IO4(HD) 
o Channel Single Output: IO2(HD), IO5(HD), IO6(HD) 
o Preview Channel Input: IO7(HD) 
o Preview Channel Output: IO8(HD) 


• Preset 2 
o Channel Single Inputs: IO1(HD), IO3(SD), IO4(SD) 
o Channel Single Output: IO2(HD), IO5(HD), IO6(HD) 
o Preview Channel Input: IO7(HD) 
o Preview Channel Output: IO8(HD) 


 


Simulcast 


• Preset 1 
o Channel HD Inputs: IO1(HD), IO3(HD) 
o Channel HD Output: IO2(HD), IO4(HD) 
o Channel SD Input: IO5(SD), IO6(SD) 
o Channel SD Output: IO7(SD), IO8(SD) 


 
2x SD 
• Preset 1 


o Channel 1 SD Inputs: IO1(SD), 3(SD) 
o Channel 1 SD Output: IO2(SD), 4(SD) 
o Channel 2 SD Inputs: IO5(SD), 7(SD) 
o Channel 2 SD Output: IO6(SD), 8(SD) 


 
3x SD 
• Preset 1 


o Channel 1 SD Input: IO1(SD) 
o Channel 1 SD Output: IO2(SD) 
o Channel 2 SD Input: IO3(SD) 
o Channel 2 SD Output: IO4(SD) 
o Channel 3 SD Input: IO5(SD) 
o Channel 3 SD Output: IO6(SD) 


 
 
 
Customized Preset 


Not covered in this user guide. Please contact customer services for more information about 


customized channel configurations. 


 


On AVS 1.5 and 1.6 servers, 2x and 3x SD is only supported in combination with SD content 


containing a maximum bitrate of 25000 Kbit/s 
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2.7 GV Edge IOs 


2.7.1 Tiles 


The GV Edge contains 8 bidirectional SDI-ports. One video format can be configured per tile. IO1 is 
always configured as input and IO2 as output to be able to use the bypass relay. A number of presets 
have been defined for the GV Edge. These presets are selected via the IP Manager.  
 


  
IOs and tiles. 


2.7.2 Bypass 


Ports IO1 (input) and IO2 (output) can be internally connected to bypass a Channel. When set to 
bypass, the signal of the main Channel is ignored, and instead the feed received at IO1 is made 
available at IO2. Bypass is enabled via the IP Manager. 
 


2.7.3 Master and Slaves 


To make a Channel's signal available on several SDI-outputs, one or more of the IO-ports can be 
configured to become slave outputs. By default, the signal provided by a slave output is an exact 
copy of the master output signal. A slave output uses the properties of the master Output it refers to, 
and thus cannot introduce another broadcast format for the same Channel. 
 


2.7.4 Genlock 


If enabled, the SDI-output synchronizes to the frame rhythm of the genlock (blackburst) signal 
connected to the blackburst BNC-socket on the back of the server. If disabled, or when no genlock 
signal can be detected, the output will synchronize to an internal clock. Genlock can only be set for 
master outputs. 
 


2.8 GPIO  and LTC pins 
■ GPIO: DB9M  
■ GPIO: 410E 
 


LTC - DB9M 
LTC_out + (positive) pin 2 


LTC_out - (negative) pin 4 


LTC_out GND GND ground) pin 1 


LTC_in + (positive) pin 7 
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LTC_in - (negative) pin  8 


LTC_in GND  GND (ground) pin 9 
 


GPIO - DB9M/DTMF 
GPI0 pin 1 


GPI1 pin 2 


GPI2 pin 3 


GPI3 pin 4 


GPI4 pin 5 


GPI5 pin 6 


GPI6 pin 7 


GPI7 pin 8 


GND pin 9 
 


& For information about how to configure the GPIO pins on the GV Edge, see chapter 0,   
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& Configure audio channel routing for Dolby E 


GV Edge supports decoding of Dolby E audio channels from file based content. Assets (either video 
or audio) which contain Dolby E audio tracks can be decoded and inserted into PCM streams 
accordingly. 
 
The GV Edge is compliant with all Dolby E configurations. Only one type of routing can be configured 
per channel. The GV Edge is capable of simultaneously decoding a total of 2 Dolby E streams in an 
asset. When an asset contains more Dolby E streams, only the first 2 will be decoded. 
 


& Changing the audio routing requires a restart of the render engine (nexos). Restarting nexos will 
result in a black output for as long as the current event is running. 


 


To configure a Dolby E audio routing: 
1. In the IP Manager under Channel Configuration,  go to Audio Routing Channel 1, 2 or 3 depending 


on the channel. 
1. Enable or disable the Dolby E decoding: 


a. If you wish to enable Dolby E decoding, select the On button under Dolby E Enabled 
b. If you wish to disable Dolby E decoding, select the Off button under Dolby E Enabled 


2. For each audio output channel, select the input you want to use 
a. Selecting none will result in no audio being passed on to the corresponding audio output 


channel in front of the dropdown box. 
b. Selecting audio input 1 to 16  will result forwarding the audio of the selected input to this 


output. 
c. Selecting 1st or 2nd Dolby E filter will forward the selected Dolby E Channel, right of the Input 


Channel dropdown, to the corresponding audio output channel in front of the dropdown box. 
3. If a Dolby E filter is selected, then select the Dolby E channel you would like to use from the 


dropdown box on the right. 
Click Set to save changes, then Activate to activate changes. 
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2.9 Cross conversion  
From release 4.1 GV Edge supports cross conversion between different broadcast signals. This 
means that the system is capable of transforming a broadcast signal from one type towards another. 
For example, a playout system renders and broadcasts a 720@59.94p signal. When using a live-input 
of type NTSC the GV Edge will detect that the input and output formats are not compatible (but 
related) and will automatically insert a cross conversion filter. This cross conversion filter will 
deinterlace/interlace the frames and correct the frame rate. 
 
Cross conversion is automatically applied to clips, SDI-feeds and animations as indicated in the 
tables in section 2.9.1. 
 
A number of services embedded in clips and in the VBI-data in SDI-streams, such as AFD, ATC and 
CDP, are extracted from the input source and made available in the output, possibly converted to a 
suitable alternative format (for example ATC and VITC).  
 


2.9.1 Supported broadcast formats 


The following tables define the GV Edge supported broadcast formats with their related supported 
input media formats. For all of these tables we recognize the following conversion types: 
• AR – Aspect Ratio conversion. Under user control via Channel Composer template. 
• Cross – Cross conversion between formats with different but related frame rates, converting 


from interlaced to progressive format or vice versa. Fully automatic. 
• Down – Downscale of larger video format to fit smaller broadcast format. Under user control via 


Channel Composer template. 



mailto:720@59.94p
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• Up – Upscale of smaller video format to fit larger broadcast format. Under user control via 
Channel Composer template. 


 


PAL SD, 720x576, interlaced, 25 frames/sec, AR 4:3 


Accepted input 
media formats 


Frame 
rate1 


Conversions Comments 


PAL 25 None Native format. 


720@50p 50 AR, Cross, Down Different (but related) frame rate, automatically cross 
converted from a progressive to an interlaced format. This 
includes conversion of a selected set of services. Video is 
scaled down via a Channel Composer template.  


1080@50i 25 AR, Down Close to native format in terms of video and audio, just more 
pixels. Video is scaled down via a Channel Composer template. 


 
1 Frame rate for all tables is in frames per second. 


 


NTSC SD, 720x480, interlaced, 29.97 frames/sec, AR 4:3 


Accepted input 
media formats 


Frame 
rate 


Conversions Comments 


NTSC 29.97 None Native format. 


720@5994p 59.94 AR, Cross, Down Different (but related) frame rate, automatically cross converted 
from progressive to interlaced format. This includes conversion 
of a selected set of services. Video is scaled down via a 
Channel Composer template. 


1080@5994i 29.97 AR, Down Close to native format in terms of video and audio, just more 
pixels. Video is scaled down via a Channel Composer template. 


 


 


720@50p HD, 1280x720, progressive, 50 frames/sec, AR 16:9 


Accepted input 
media formats 


Frame 
rate 


Conversions Comments 


PAL 25 AR, Cross, Up Different (but related) frame rate, and automatically cross 
converted from an interlaced to a progressive format. This 
includes conversion of a selected set of services. Video is 
scaled up via a Channel Composer template. 


720@50p 50 None Native format. 


1080@50i 25 Cross, Down Different (but related) frame rate, and automatically cross 
converted from interlaced to progressive format. This includes 
conversion of a selected set of services. Video is scaled down 
via a Channel Composer template. 
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720@5994p HD, 1280x720, progressive, 59.94 frames/sec, AR 16:9 


Accepted input 
media formats 


Frame 
rate 


Conversions Comments 


NTSC 29.97 AR, Cross, Up Different (but related) frame rate, and automatically cross 
converted from an interlaced to a progressive format. This 
includes conversion of a selected set of services. Video is 
scaled up via a Channel Composer template. 


720@5994p 59.94 None Native format. 


1080@5994i 29.97 Cross, Down Different (but related) frame rate, and automatically cross 
converted from interlaced to progressive format. This includes 
conversion of a selected set of services. Video is scaled down 
via a Channel Composer template. 


 


1080@50i HD, 1920x1080, interlaced, 25 frames/sec, AR 16:9 


Accepted input 
media formats 


Frame 
rate 


Conversions Comments 


PAL 25 AR, Up Close to native format in terms of video and audio, just less 
pixels. Video is scaled up via a Channel Composer template. 


720@50p 50 Cross, Up Different (but related) frame rate, automatically cross 
converted from progressive to interlaced format. This includes 
conversion of a selected set of services. Video is scaled up via 
a Channel Composer template. 


1080@50i 25 None Native format. 


 


1080@5994i HD, 1920x1080, interlaced, 29.97 frames/sec, AR 16:9 


Accepted input 
media formats 


Frame 
rate 


Conversions Comments 


NTSC 29.97 AR, Up Close to native format in terms of video and audio, but less 
pixels. Video is scaled up via a Channel Composer template. 


720@5994p 59.94 Cross, Up Different (but related) frame rate, automatically cross 
converted from progressive to interlaced format. This includes 
conversion of a selected set of services. Video is scaled up via 
a Channel Composer template. 


1080@5994i 29.97 None Native format. 
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2.9.2 Service extraction 


A number of services embedded in clips and in the VBI-data in SDI-streams are extracted from the 


input source and made available in the output, possibly converted to a suitable alternative format. 


These extracted services will survive cross conversion, although some of the conversions are lossy. 


The following sections describe each of the services recognized by the extraction process, with a list 


of the recognized sources. 


AFD 
GV Edge supports the following input sources for extraction of the Active Format Description (AFD) 


service, in order of priority: 


 Input source Condition 


1 AFD objects defined on the timeline of a Channel Composer template.  


2 AFD ANC packets found in an MXF file, embedded in accordance with the SMPTE 436M-
2006 specification, section 6: MXF Ancillary Data Packet wrapping specifications. 


Main Player (*) 


3 AFD ANC packets found in the user data of an MPEG stream. Main Player   


4 AFD objects found embedded in the VBI-section of an SDI-stream of all supported 
broadcast formats. 


Main Player 


 


(*) Input sources with the main Player condition are only recognized when the associated Channel 


Composer Player object was assigned the main player role. At any given time, only one main player 


can have this role. 


 


Currently supported AFD outputs are: 


 AFD output 


1 AFD ANC objects in VBI for SD output via SDI encoder. Any broadcast format. 


2 AFD ANC objects in VBI luma stream for HD via SDI encoder. Any broadcast format. 
 


CDP 
The following input sources are supported for extraction of the Caption Distribution Packet (CDP) 


service, in given order of priority: 


 Input source Condition 


1 A STL subtitle rendered in CEA-608 format. The 608 subtitle data will end up in the CDP’s 
embedded 608 section. 
This input source can co-exist with the next #2 source. 
This input can also co-exist with #3 and #5. If present, 608 subtitle data from #3 and #5 
will be overwritten. 
 


 


2 CEA-608 XDS commands placed on the timeline of a Channel Composer template. The XDS 
data will end up in the CDP’s embedded 608 section. 
This input source can co-exist with the previous #1 source. 
This input can also co-exist with #3 and #5. If present, 608 XDS data from #3 and #5 will 
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be overwritten. 


3 CDP objects found embedded in VBI section of an incoming SDI stream. Main Player 


4 CDP objects created from CEA-608 metadata as a result of cross conversion from SD to HD 
format. See the CEA-608 section below on how the 608 metadata came into existence in 
the first place. 


Main Player 


5 CDP ANC packets found in an MXF file, embedded conform the SMPTE 436M-2006 
specification, section 6: MXF Ancillary Data Packet wrapping specifications. 


Main Player 


ATC / VITC 
The following input sources are supported for extraction of the Ancillary Time Code (ATC) and Vertical 


Interval Time Code (VITC) services, in given order of priority: 


 Input source Condition 


1 Any clip. The time code represents clip time. Main Player 


2 ATC objects found embedded in VBI section of HD SDI stream. Main Player 
 


That is, the ATC/VITC output reflects the time code of either the currently playing clip (if playing with 


main player role) or the currently playing SDI stream (again, only if playing as main player). 


The extracted time code is emitted as VITC for SD-channels and ATC for HD channels. 


CEA-608 
The following input sources are supported for extraction of the CEA-608 closed caption service, in 


given order of priority: 


 Input source Condition 


1 An STL subtitle rendered in CEA-608 format. 
This input source can co-exist with the next #2 source. 


 


2 CEA-608 XDS commands placed on the timeline of a Channel Composer template. 
This input source can co-exist with the previous #1 source. 


 


3 CEA-608 objects found embedded in VBI section of an incoming SDI stream in NTSC 
broadcast format. 


Main Player 


4 CEA-608 objects created from CDP metadata as a result of cross conversion from HD to SD 
format. 


Main Player 


 


2.10 The main player 
In Channel Composer, Objects such as ‘Clip’, ‘Audio’ and ’Still’ use a Player to play out content. 


Players can be used to control playout. Different actions can be defined. The default is: Play. Players 


can be modified in the Object and Objects window. 


 


& One main Player can be active per Channel. 


 


The main Player role has following properties: 


• The main Player has priority over other Players when resources are assigned. 
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• If the main Player contains an embedded Closed Caption subtitle stream, this stream will be 
played out. If other Clips contain subtitle streams, these streams will not be played out. In other 
words, only the main Player’s subtitle stream will be played out.  


• The main Player is the source for the ATC (HD) or VITC (SD) timecode signal in the SDI-output. 
Only one signal can be sent out, i.e. from the main Player.  


• If the main Player is a Live Player and this Player transfers VBI-data from the SDI-input, this VBI-
data will be transferred to SDI-out instead of any VBI-data generated by the GV Edge server. This 
means that VBI-data from the input such as subtitles and teletext is passed to the output 'as is'. 


• The main Player role can be assigned at any point in time, but is only active if between an In and 
Out Point.   


 
 


2.11 Video Delay Server 


The GV Edge Video Delay Server (VDS) can be enabled on the GV Edge Server. This server can delay 
incoming or outgoing SDI-signals out of the box. The VDS delays video, audio, subtitles, teletext and 
other services included in the signal. 
 


& See chapter 8 how to configure VDS 
 


2.11.1 System requirements 


The VDS functionality needs a system with six hard disk drives to work properly. 
 


2.11.2 Setup types 


You can set up the VDS to be used in three ways: 
 
• To delay: the VDS delays the incoming signal with x minutes and plays it out. You can configure 


the delay in the IP Manager.  
• To delay and add an overlay graphic: the VDS delays the incoming signal with x minutes, adds 


overlay graphics to it and plays it out. To add overlay graphics, you need a VDS channel pack and 
a template that must be triggered through the use of GPIO. If you do not have the Channel 
Composer application, you can set this up in the IP Manager. If you do have the Channel 
composer, you add the overlay graphic to a template in a channel pack, export it to the playout 
system and trigger the template through GPIO. 


• To delay and to add overlay and scheduled graphics: the VDS delays the incoming signal with x 
minutes, adds overlay graphics to it and is scheduled in Cobalt for automated playout. This 
scenario is possible if you have a GV Edge Server with the REC option. This functionality is 
configured by a GV service engineer and therefore not described in this user guide. 


 


2.12 Join In Progress 
The Join In Progress (JIP) feature makes it possible that a second, high priority playlist temporarily 
overrides the normal playlist’s output. When this second playlist is completed, the output resumes 
the normal playlist that kept on playing in the background. JIP works for any situation where a 
relatively short Playlist, such as breaking news, needs temporary control over the main program. The 
latter is suppressed and continues playing in the background until the situation returns to normal.  
JIP works in combination with the primary HD/SD channel and can also be used in a simulcast 
setup.  
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& See chapter 12 how to configure the JIP feature 


2.12.1 System requirements 


JIP requires following software versions: 
• GV Edge 4.0.2 or higher 
• Cobalt Playout Control (POC) 2.85 or higher 
• Channel Composer 1.6.2 or higher 
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2.12.2 The JIP-workflow  
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3 Get started 
3.1 Prepare GV Edge installation 


3.1.1 4 Shipping kit contents 


■ Check if the shipping kit contains: 
• • GV Edge server 
• • USB-stick with documentation 
• • Licenses and warranties. 
 


3.1.2 GV Edge size 


■ Make sure that the GV Edge fits into the location where you wish to install it. 
Size (WxHxD) 436 x 44x620mm/17.2"x 1.7"x 24.4"  (excl. connectors & front panel) 


 


3.1.3 Installation site requirements 


■ Make sure that the location where you install the GV Edge meets the following requirements: 
Temperature 10˚C to 25˚C / 32˚F to 86˚F 


Relative humidity 10% to 90% non-condensing 


 
& CAUTION: Wait until the server has acclimatized to server room temperature and humidity before power 


on. 


 


3.1.4 Cable advice 


■ Use CAT 6/ CAT 6e cables and compatible connectors for HD playout systems. 
 


3.1.5 System requirements 


If you choose to upgrade the GV Edge 4.2 software, the following software is required: GV Edge 4.0 or 
higher. 
 


3.2 Install GV Edge 


The steps for installation and network configuration of the GV Edge nodes are: 
1. Put the servers in the rack and connect cables and IOs. 
2. Configure the IP Manager. 
3. Configure the GV Edge network settings via the IP Manager web interface. 
4. Select a preset for Channel configuration. 
5. If applicable, configure the time settings. 
6. If applicable, configure licenses. 
 


3.2.1 Connect GV Edge to a LAN and connecting the IP Manager 


1. Connect the following cables: 
a. Connect the LAN network cable to eth0. 
b. Connect the network cable for the IP Manager to IPM. 
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3.2.2 Connect the IOs 


■ Connect IO1through IO8. 
 


& Note that presets are defined for port configuration. For more information about these presets, 
see section 2.6, Channel Presets. Bypass can be enabled on IO1 (in) and IO2 (out). 


 


3.2.3 Connect the VGA-monitor (optional) 


VGA-monitor (console) Connect to VGA  
Keyboard (console) Connect to KBD 
 


3.2.4 Connect blackburst, GPIO and LTC (optional) 


■ Connect: 
• Blackburst to GL 
• GPIO to  GPIO 
• LTC to LTC 
 
 


3.2.5 Connect the power cables and power on 


■ Connect the GV Edge to the power cable and then plug the power cable into a socket.  
 


& GV Edge automatically powers on when connected to a power source. To power on manually, 
press the rotary knob. When powered on, the LCD panel lights up. 


 


3.3 Configure GV Edge 
The IP Manager enables remote server configuration, monitoring and administration.  The IP Manager 


is accessible through the web, or through the LCD panel on the front of the server. Two menus are 


available: 


• the GV Edge-menu: standard menu 
• the IP Manager menu: also available when the system is unreachable (note that this menu has 


less options) 
If the system is unreachable, press the knob for 3 seconds to switch from the GV Edge menu to the IP 


Manager menu. 


 


& Changing settings and executing commands through the IP Manager can interrupt a broadcast. 


 


3.3.1 Set up Yast 


You can also configure network settings with Yast.  
To enable Yast: 
1. Login on the GV Edge as root. On the command line enter: yast [enter]. 
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2. Use [TAB] to select [Next], then press [Enter]. 
3. The next screen opens. 


 
Example Yast screen. 
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4. Select the network card that is already configured (here Super Micro). 
5. Select [Edit] and then press [Enter]. 


The next screen opens. 
 


 
Example Yast screen. 


 
6. Use [TAB] to navigate through and change applicable settings. 
7. To change the hostname or name server, select [Hostname and Name Server], then press [Enter]. 
8. To change the gateway, select [Routing], then press [Enter]. 
9. To save settings, select [Next]. To discard, select [Abort].  
10. In the initial screen, select [Finish] to activate the settings. 
 
The system can now be accessed with SSH, FTP, Cobalt, etcetera. 
 


3.3.2 Set up the IP Manager 


After power on and startup, first configure the IP Manager via the GV Edge's LCD-panel:  
1. Go to Network configuration > IP-manager. 
2. Specify: 


a. Use DHCP: On/Off  
b. IP address: note that the IP Manager has its own IP address.  
c. Netmask 
d. Gateway 
e. Nameserver 


3. Select Set/OK to save changes. 
 
You can now access the IP Manager via a web browser. 
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3.3.3 Open the IP Manager in a browser 


To access the IP Manager: 


■ enter the IP Manager's IP address in a web browser and log in with the credentials for the IP 
Manager (admin/proot123).  


 


3.3.4 Open and edit the IP Manager on an LCD front panel 


Use the rotary knob to operate the IP Manager via the front panel: 
 
1. Turn the rotary knob backwards and forwards to scroll through options. 
2. Press the rotary knob to select an item. Selected items are marked by [], <>, an arrow, or are 


highlighted. 
3. To confirm changes, rotate the knob to the OK option, and then press the knob. 
 


& Some changes in Channel settings require a restart of the render engine (nexos). Restarting nexos 
will result in a black output for as long as the current event is running. 


4. select OK to set changes and then Activate settings to activate changes. Note that you may have 
to scroll to this option.  


5. To discard changes, return to the main menu from a sub menu or rotate the knob to the 
back/cancel/discard option, and then press the knob. 


 


3.3.5 Configuring the GV Edge hostname and network settings 


Once you set up the IP Manager web interface, you can continue with the configuration of the GV 
Edge through the IP Manager web interface. 


Specify a hostname 


To specify a hostname: 
1. Go to Network configuration > Hostname 
2. Specify the GV Edge hostname. 
3. Click Set to save changes. 
 


Configure the GV Edge network settings 


To configure the GV Edge’s network settings: 
1. Go to Network configuration > GVEdge. 
2. Specify network settings for the GV Edge server.  


o Default port 0 is used: 
 Method: Auto, using DHCP/Manual or Manual 
 IP address 
 Netmask 
 The system’s MAC address is displayed. 
 Gateway 
 Nameserver 


 


3. Click Set to save changes. 
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3.3.6 Specify the IP address of TX/MAM 


Specify the TX/MAM servers’ virtual IP address: 
1. Go to Network configuration > TX/MAM server virtual IP. 
2. Click Set to save changes. 
 


3.3.7 Configure channels and ports 


1. Open the IP Manager via the web interface and log in with your IP Manager credentials. 
2. Go to Channel Configuration > Channel layout. 
3. Select one of the following presets: 


•  1xSD (1) : single SD (with preset 1) 
•  1xSD (2) : single SD (with preset 2) 
•  1xHD (1) : single HD (with preset 1) 
•  1xHD (2) : single HD (with preset 2) 
•  1xSD+preview (1) : single SD + preview (preset 1) 
•  1xSD+preview (2) : single SD + preview (preset 2) 
•  1xHD+preview (1) : single HD + preview (preset 1) 
•  1xHD+preview (2) : single HD + preview (preset 2) 
•  Simulcast 
• 2x SD 
• 3x SD 
•  Custom setup 


4. Go to Channel Configuration > Region and select PAL or NTSC 
5. Go to Channel Configuration > HD-format: for HD-channels, select 720p or 1080i 
6. Go to Channel Configuration > Genlock: select Blackburst or Trilevel sync 
7. Go to Channel Configuration > Audio channels: specify audio groups per port 


• SDIO1-9  
o Single audio group 
o Two audio groups 
o Three audio groups 
o Four audio groups 


8. Go to Channel Configuration > SDI port misc 
• SDIO1 


o VBI: Enabled/Disabled 
o HBI: Enabled/Disabled 


• SDIO2-8 
o Key/Fill 


9. Enable JIP channel: On/Off 
10. Enable recording channel: On/Off (only visible with recording license) 
11. Click Set to save changes, then Activate to activate changes. 
 


3.4 Set the time 
Preferably a LTC-signal (Linear Timecode) is used to synchronize time codes. If this is not possible, 


other options are:  


• NTP sync (Network Time Protocol) to a NTP- server. 
• Free running (system  uses an internal clock) 
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3.4.1 Set up NTP 


1. Edit /system/objects/code/setdate 
f. NTPSERVER: specify the NTP-server's IP address  
g. ZONE: specify time zone [see options below], the ZONE-setting determines offset relative to 


CET/GMT. 
 


2. To test settings, from Linux command line enter: /system/objects/code]# setdate -ntp 
[enter] 
 
If settings are incorrect, an error message will be displayed. 


3. To ensure that time is regularly synced, edit /etc/crontab.  
a. Remove the "#" in front of the line: #00 * * * * root 


/system/objects/code/setdate -ntp >/dev/null 2>&1 


Result: 00 * * * * root /system/objects/code/setdate -ntp >/dev/null 
2>&1 


3.4.2 Set the time manually  


 To set the date, log in via putty (ssh) as user root. 


 Go to the /system/objects/code folder: 


 ...code]#  cd /system/objects/code [enter] 


 Execute script setdate, use the –help option for an explanation: 


...code]# ./setdate –help [enter] 


Example:  


...code]# ./setdate -m 07/29/08 11:37:47 [enter] 


Explanation: 


-m = manual 


07 = month 


29 = day of month 


08 = year 


11 = hours 


37 = minutes 


47 = seconds 
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To request the date from the NTP server configured in setdate: 


 ...code]# ./setdate -ntp [enter] 


 


ZONE options are listed on the next pages. 


 


• Options listed below are case sensitive.  


• Insert a “/” sign behind continent names.  


• Place ZONE names between quotes. 


Example: “Europe/Amsterdam” 
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CET 
CST6CDT 


Cuba 


EET 


EST 


EST5EDT 


Egypt 


Eire 


Factory 


GB 


GB-Eire 


GMT 


GMT+0 


GMT-0 


GMT0 


Greenwich 


HST 


Hongkong 


Iceland 


Iran 


Israel 


Jamaica 


Japan 


Kwajalein 


Libya 


MET 


MST 


MST7MDT 


NZ 


NZ-CHAT 


Navajo 


PRC 


PST8PDT 


Poland 


Portugal 


ROK 


Singapore 


Turkey 


UCT 


UTC 


Universal 


W-SU 


WET 


Zulu 


iso3166.tab 


posixrules 


zone.tab 


 


Africa/ 
Abidjan 


Accra 


Addis_Ababa 


Algiers 


Asmara 


Asmera 


Bamako 


Bangui 


Banjul 


Bissau 


Blantyre 


Brazzaville 


Bujumbura 


Cairo 


Casablanca 


Ceuta 


Conakry 


Dakar 


Dar_es_Salaam 


Djibouti 


Douala 


El_Aaiun 


Freetown 


Gaborone 


Harare 


Johannesburg 


Kampala 


Khartoum 


Kigali 


Kinshasa 


Lagos 


Libreville 


Lome 


Luanda 


Lubumbashi 


Lusaka 


Malabo 


Maputo 


Maseru 


Mbabane 


Mogadishu 


Monrovia 


Nairobi 


Ndjamena 


Niamey 


Nouakchott 


Ouagadougou 


Porto-Novo 


Sao_Tome 


Timbuktu 


Tripoli 


Tunis 


Windhoek 


 


America/ 
Adak 


Anchorage 


Anguilla 


Antigua 


Araguaina 


Argentina 


Aruba 


Asuncion 


Atikokan 


Atka 


Bahia 


Barbados 


Belem 


Belize 


Blanc-Sablon 


Boa_Vista 


Bogota 


Boise 


Buenos_Aires 


Cambridge_Bay 


Campo_Grande 


Cancun 


Caracas 


Catamarca 


Cayenne 


Cayman 


Chicago 


Chihuahua 


Coral_Harbour 


Cordoba 


Costa_Rica 


Cuiaba 


Curacao 


Danmarkshavn 


Dawson 


Dawson_Creek 


Denver 


Detroit 


Dominica 


Edmonton 


Eirunepe 


El_Salvador 


Ensenada 


Fort_Wayne 


Fortaleza 


Glace_Bay 


Godthab 
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Goose_Bay 


Grand_Turk 


Grenada 


Guadeloupe 


Guatemala 


Guayaquil 


Guyana 


Halifax 


Havana 


Hermosillo 


Indiana 


Indianapolis 


Inuvik 


Iqaluit 


Jamaica 


Jujuy 


Juneau 


Kentucky 


Knox_IN 


La_Paz 


Lima 


Los_Angeles 


Louisville 


Maceio 


Managua 


Manaus 


Martinique 


Mazatlan 


Mendoza 


Menominee 


Merida 


Mexico_City 


Miquelon 


Moncton 


Monterrey 


Montevideo 


Montreal 


Montserrat 


Nassau 


New_York 


Nipigon 


Nome 


Noronha 


North_Dakota 


Panama 


Pangnirtung 


Paramaribo 


Phoenix 


Port-au-Prince 


Port_of_Spain 


Porto_Acre 


Porto_Velho 


Puerto_Rico 


Rainy_River 


Rankin_Inlet 


Recife 


Regina 


Rio_Branco 


Rosario 


Santiago 


Santo_Domingo 


Sao_Paulo 


Scoresbysund 


Shiprock 


St_Johns 


St_Kitts 


St_Lucia 


St_Thomas 


St_Vincent 


Swift_Current 


Tegucigalpa 


Thule 


Thunder_Bay 


Tijuana 


Toronto 


Tortola 


Vancouver 


Virgin 


Whitehorse 


Winnipeg 


Yakutat 


Yellowknife 


 


Antarctica/ 
Casey 


Davis 


DumontDUrville 


Mawson 


McMurdo 


Palmer 


Rothera 


South_Pole 


Syowa 


Vostok 


 


Arctic/ 
Longyearbyen 


 


Asia/ 
Aden 


Almaty 


Amman 


Anadyr 


Aqtau 


Aqtobe 


Ashgabat 


Ashkhabad 


Baghdad 


Bahrain 


Baku 


Bangkok 


Beijing 


Beirut 


Bishkek 


Brunei 


Calcutta 


Choibalsan 


Chongqing 


Chungking 


Colombo 


Dacca 


Damascus 


Dhaka 


Dili 


Dubai 


Dushanbe 


Gaza 


Harbin 


Hong_Kong 


Hovd 


Irkutsk 


Istanbul 


Jakarta 


Jayapura 


Jerusalem 


Kabul 


Kamchatka 


Karachi 


Kashgar 


Katmandu 


Krasnoyarsk 


Kuala_Lumpur 


Kuching 


Kuwait 


Macao 


Macau 


Magadan 


Makassar 


Manila 


Muscat 


Nicosia 
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Novosibirsk 


Omsk 


Oral 


Phnom_Penh 


Pontianak 


Pyongyang 


Qatar 


Qyzylorda 


Rangoon 


Riyadh 


Riyadh87 


Riyadh88 


Riyadh89 


Saigon 


Sakhalin 


Samarkand 


Seoul 


Shanghai 


Singapore 


Taipei 


Tashkent 


Tbilisi 


Tehran 


Tel_Aviv 


Thimbu 


Thimphu 


Tokyo 


Ujung_Pandang 


Ulaanbaatar 


Ulan_Bator 


Urumqi 


Vientiane 


Vladivostok 


Yakutsk 


Yekaterinburg 


Yerevan 


 


Atlantic/ 
Azores 


Bermuda 


Canary 


Cape_Verde 


Faeroe 


Faroe 


Jan_Mayen 


Madeira 


Reykjavik 


South_Georgia 


St_Helena 


Stanley 


 


Australia/ 
ACT 


Adelaide 


Brisbane 


Broken_Hill 


Canberra 


Currie 


Darwin 


Eucla 


Hobart 


LHI 


Lindeman 


Lord_Howe 


Melbourne 


NSW 


North 


Perth 


Queensland 


South 


Sydney 


Tasmania 


Victoria 


West 


Yancowinna 


 


Brazil/ 
Acre 


DeNoronha 


East 


West 


 


Canada/ 
Atlantic 


Central 


East-Saskatchewan 


Eastern 


Mountain 


Newfoundland 


Pacific 


Saskatchewan 


Yukon 


 


Chile/ 
Continental 


EasterIsland 


 


Etc/ 


GMT 


GMT+0 


GMT+1 


GMT+10 


GMT+11 


GMT+12 


GMT+2 


GMT+3 


GMT+4 


GMT+5 


GMT+6 


GMT+7 


GMT+8 


GMT+9 


GMT-0 


GMT-1 


GMT-10 


GMT-11 


GMT-12 


GMT-13 


GMT-14 


GMT-2 


GMT-3 


GMT-4 


GMT-5 


GMT-6 


GMT-7 


GMT-8 


GMT-9 


GMT0 


Greenwich 


UCT 


UTC 


Universal 


Zulu 


 


Europe/ 
Amsterdam 


Andorra 


Athens 


Belfast 


Belgrade 


Berlin 


Bratislava 


Brussels 


Bucharest 


Budapest 


Chisinau 


Copenhagen 


Dublin 
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Gibraltar 


Guernsey 


Helsinki 


Isle_of_Man 


Istanbul 


Jersey 


Kaliningrad 


Kiev 


Lisbon 


Ljubljana 


London 


Luxembourg 


Madrid 


Malta 


Mariehamn 


Minsk 


Monaco 


Moscow 


Nicosia 


Oslo 


Paris 


Podgorica 


Prague 


Riga 


Rome 


Samara 


San_Marino 


Sarajevo 


Simferopol 


Skopje 


Sofia 


Stockholm 


Tallinn 


Tirane 


Tiraspol 


Uzhgorod 


Vaduz 


Vatican 


Vienna 


Vilnius 


Volgograd 


Warsaw 


Zagreb 


Zaporozhye 


Zurich 


 


Indian/ 
Antananarivo 


Chagos 


Christmas 


Cocos 


Comoro 


Kerguelen 


Mahe 


Maldives 


Mauritius 


Mayotte 


Reunion 


 


Mexico/ 
BajaNorte 


BajaSur 


General 


 


 


Mideast/ 
Riyadh87 


Riyadh88 


Riyadh89 


 


Pacific/ 
Apia 


Auckland 


Chatham 


Easter 


Efate 


Enderbury 


Fakaofo 


Fiji 


Funafuti 


Galapagos 


Gambier 


Guadalcanal 


Guam 


Honolulu 


Johnston 


Kiritimati 


Kosrae 


Kwajalein 


Majuro 


Marquesas 


Midway 


Nauru 


Niue 


Norfolk 


Noumea 


Pago_Pago 


Palau 


Pitcairn 


Ponape 


Port_Moresby 


Rarotonga 


Saipan 


Samoa 


Tahiti 


Tarawa 


Tongatapu 


Truk 


Wake 


Wallis 


Yap 


 


US/ 
Alaska 


Aleutian 


Arizona 


Central 


East-Indiana 


Eastern 


Hawaii 


Indiana-Starke 


Michigan 


Mountain 


Pacific 


Samoa
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4 Configure audio channel routing for Dolby E 
GV Edge supports decoding of Dolby E audio channels from file based content. Assets (either video 
or audio) which contain Dolby E audio tracks can be decoded and inserted into PCM streams 
accordingly. 
 
The GV Edge is compliant with all Dolby E configurations. Only one type of routing can be configured 
per channel. The GV Edge is capable of simultaneously decoding a total of 2 Dolby E streams in an 
asset. When an asset contains more Dolby E streams, only the first 2 will be decoded. 
 


& Changing the audio routing requires a restart of the render engine (nexos). Restarting nexos will 
result in a black output for as long as the current event is running. 


 


To configure a Dolby E audio routing: 
4. In the IP Manager under Channel Configuration,  go to Audio Routing Channel 1, 2 or 3 depending 


on the channel. 
5. Enable or disable the Dolby E decoding: 


a. If you wish to enable Dolby E decoding, select the On button under Dolby E Enabled 
b. If you wish to disable Dolby E decoding, select the Off button under Dolby E Enabled 


6. For each audio output channel, select the input you want to use 
a. Selecting none will result in no audio being passed on to the corresponding audio output 


channel in front of the dropdown box. 
b. Selecting audio input 1 to 16  will result forwarding the audio of the selected input to this 


output. 
c. Selecting 1st or 2nd Dolby E filter will forward the selected Dolby E Channel, right of the Input 


Channel dropdown, to the corresponding audio output channel in front of the dropdown box. 
7. If a Dolby E filter is selected, then select the Dolby E channel you would like to use from the 


dropdown box on the right. 
Click Set to save changes, then Activate to activate changes. 


 


 
Example of a 5.1 Dolby E audio routing 
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The Dolby E Channel dropdown box contains all possible Dolby E audio channels that could be 
available in a Dolby E stream. Selecting a Dolby E channel that is not available in a source file will 
result in a silent output. 
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5 Configure the GPIO pins 
The GV Edge Server GPIO pins have no special purpose defined, and go unused by default. This 
chapter describes how you can create four types of rules to define the purpose of GPIO pins with the 
GV Edge IP Manager. These are rules for the following GPIO types: 


• GPIO for internal GPIO devices connected through the DB9 socket on the back of the GV Edge 
Server (DB9M). 


• GPIO for incoming dual-tone multi-frequency signals (DTMF), such as sub-audible cue tones that 
are often used to prompt the insertion of a TV commercial. 


• GPIO over vertical blanking interval (VBI) data streams (SD PAL, 1080@50i and 720@50p). Virtual 
device names such as VBI0 and VBI1 can be assigned to GPIO devices dedicated to channels 0, 
1, et cetera.  


 
 


5.1 Set a rule for a DB9M device 


The IP manager contains two default rules for DB9M devices: 
• The first rule triggers a ‘LOGO IN’ template to display a logo on screen. 
• The second rule triggers a ‘LOGO OUT’ template that removes a logo from the screen. 
 
To change a default rule: 
1. Open the IP Manager web interface and log in as usual. 
2. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
3. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
4. Repeat step 5 for the other seven pins. 
5. If you want a time cheat to be applied, select the Timecheat check box. 
6. If you do not want a time cheat to be applied, continue with the next step. 
7. If you do not want to trigger an action for the trigger signal, select None. 
8. If you want to run a Linux shell script, do the following: 


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. In the Cheat delay box, type the delay you want to apply in hh:mm:ss:ff. for the incoming 


stream. 
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d. Click Set. 
9. If you want to trigger a Channel Composer template, do the following: 


a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


10. If you want to disable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


11. If you want to enable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: on. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


12. If you want to disable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


13. If you want to enable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


 


 
 
To add and setup a new DB9M rule:  
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click DB9M. 
3. In the DB9M pane, click New DB9M rule. 
4. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
5. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
6. Repeat step 5 for the other seven pins. 
7. If you want a time cheat to be applied, select the Timecheat check box. 
8. If you do not want a time cheat to be applied, continue with the next step. 
9. If you do not want to trigger an action for the trigger signal, select None. 
10. If you want to run a Linux shell script, do the following: 


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. In the Cheat delay box, type the delay you want to apply in hh:mm:ss:ff. for the incoming 


stream. 
d. Click Set. 


11. If you want to trigger a Channel Composer template, do the following: 
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a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


12. If you want to disable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


13. If you want to enable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: on. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


14. If you want to disable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


15. If you want to enable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


 


5.2 Set a rule for an incoming DTMF signal 


The GV Edge render engine (nexos) can decode and recognize DTMF signals in the incoming audio 
streams from the incoming SDI feed or media files. Nexos monitors all incoming audio channels to 
detect DTMF signals. When a pre-defined signal is detected, you can let nexos use that signal as a 
trigger for a certain system action.  
 
To set a rule for how all channels must handle an incoming DTMF signal: 
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click DTMF. 
3. In the DTMF pane, click New DTMF rule. 
4. In the DTMF sequence box, enter the trigger signal, such as 123*. 
5. If you want to trigger no action for the trigger signal, select None in the type box. 
6. If you want to run a Linux shell script, do the following: 


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. Click Set. 


7. If you want to trigger a Channel Composer template: 
a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


8. If you want to disable DB9M outgoing GPIO, do the following: 
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


9. If you want to enable DB9M outgoing GPIO, do the following: 
a. Select DB9M GPI out: on in the type box. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


10. If you want to disable the censor on a SDI output port, do the following: 
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
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c. Click Set. 
11. If you want to enable the censor on a SDI output port, do the following:  


a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


 


5.3 Set a rule for a single channel GPIO-over-VBI device 
 
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click the applicable VBI device (VBI0, VBI1, etc.). 
3. In the DTMF pane, click New VBI rule. 
4. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
5. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
6. Repeat step 5 for the other seven pins. 
7. If you want a time cheat to be applied, select the Timecheat check box. 
8. If you do not want a time cheat to be applied, continue with the next step. 
9. If you want to trigger no action for the trigger signal, select None. 
10. If you want to run a Linux shell script,  


a. In the type box, select Script. 
b. In the Argument box, type the script name preceded by the full path. 
c. In the Cheat delay box, type the delay you want to apply in hh:mm:ss:ff. for the incoming 


stream. 
d. Click Set. 


11. If you want to trigger a Channel Composer template,  
a. In the type box, select Template. 
b. In the Argument box, type the applicable template name. 
c. Click Set. 


12. If you want to disable DB9M outgoing GPIO,  
a. In the type box, select DB9M GPI out: off. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


13. If you want to enable DB9M outgoing GPIO,  
a. In the type box, select DB9M GPI out: on. 
b. In the Argument box, type the applicable pin number. 
c. Click Set. 


14. If you want to disable the censor on a SDI output port,  
a. In the type box, select censor IO: off. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


15. If you want to enable the censor on a SDI output port,  
a. In the type box, select censor IO: on. 
b. In the Argument box, type the applicable SDI port number. 
c. Click Set. 


 


5.4 Delete a GPIO rule 


 
To delete a rule: 
■ Click Delete. 
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6 Configure TS-over-IP 
In the GV Edge IP Manager, you can enable a Transport Stream over IP (TS-over-IP) output stream 
that is sent to one or multiple IP addresses. This feature supports separate audio streams and 
teletext subtitle services. This chapter describes how you can configure TS-over-IP. 
 


6.1 Add a TS-over-IP stream 


 
To add a TS-over-IP stream in the IP Manager: 
1. Under Channel Configuration, do one of the 


following: 
a. If you wish to enable non-simulcast 


output, click TS-over-IP 1 . 
b. If you wish to enable simulcast output or 


a second TS-over-IP output, click TS-
over-IP 2. 


2. In the PMT pid box, enter the correct pid for 
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the program map table. 
a. Make sure to use a unique pid. 


3. Enable or disable video output: 
a. If you wish to enable a video output, 


select the On button under Video 
enabled. 


b. If you wish to disable a video output, 
select the Off button under Video 
enabled. 


 
 
4. In the Video bitrate box, type the bit rate in Kbit/s that you wish to use. 
5. Under GOP structure, do one of the following: 


a. If you wish to enable long GOP, select Long GOP. 
b. If you wish to disable long GOP and use I-frames, select Iframe only. 


6. Under Aspect ratio, select the correct aspect ratio. 
7. If you wish to add one or multiple audio 


streams, do the following: 
a. Click the New audio stream button to 


add an audio stream to the output. 
b. In the new window, click OK. 
c. In the navigation pane on the left, 


click the name of the new audio stream, 
such as Audio stream 1. 


d. In the Pid box, enter a correct and 
unique pid for the audio stream. 


e. Under Enabled, select On or Off to 
enable or disable the audio stream.  


f. In the Language box, type the correct 
3-character ISO-639 language code for 
the audio. 


g. In the Bitrate box, select the 
applicable audio bit rate in Kbit/s. 


h. In the Channel 1 box, select the audio 
channel that you wish to connect to 
the first channel of the stream. 


i. In the Channel 2 box, select the audio 
channel that you wish to connect to 
the second channel of the stream. 


j. In the Type box, select the audio type 
that you wish to use as a descriptive 
tag, such as Undefined, Clean effects, 
Hearing impaired or Visual impaired 
commentary. 


k. At the bottom of the Audio stream X 
pane, click Set. 


l. Repeat steps a through k until you 
have added all audio streams. 
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8. If you wish to add a teletext service, under 
Teletext services, do the following: 
a. Click New teletext service to add teletext 


subtitles to the output. 
b. In the new window, click OK. 
c. In the navigation pane on the left, click 


the name of the new teletext service, such 
as Teletext service 1. 


d. In the pid box, enter a correct and unique 
teletext pid. 


e. In the VBI lines box, type the number(s) of 
the VBI lines for this teletext service. 


f. In the Language box, type the 3-character 
ISO-639 language code. 


g. In the Page number box, type the correct 
page number for the teletext subtitles. 


h. If you wish to add a new subtitle stream 
to this teletext subtitle service, do the 
following: 


i. Click the New stream button. 
ii. In the new window, click OK. 


iii. In the Language box, type the 3 
character ISO-639 language code. 


iv. In the Page number box, type the 
correct page number for teletext 
subtitles. 


i. At the bottom of the pane, click Set. 
j. If you wish to add extra teletext services, 


repeat steps a through i until you have 
added all teletext services. 


 


 


9. If you wish to add a data stream, under Data streams, do the following: 
a. Click New data stream to add a new data stream to the output. 
b. In the new window, click OK. 
c. In the navigation pane on the left, click the name of the new data stream, such as Data 


stream 1. 
d. In the pid box, enter a correct and unique Data pid. 
e. In the Data bitrate box, type the bitrate in Kbit/s that you wish to use. 
f. Under Show in pmt, select On or Off to show the data stream in the pmt (Program Map 


Table) 
g. At the bottom of the page, click Set. 
h. If required, you can repeat these steps for each new data stream 


 
10. Under Ethernet output enabled, select On or Off to enable or disable Ethernet output. 
11. Add one or multiple target 


IP addresses: 
a. In the Target IP box, 


type the target IP 
address. 


b. If necessary, in the 
Target port box, type 
the correct port. 


c. If necessary, in the TTL 
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box, type the correct 
Time to Live. 


d. If necessary, in the Eth 
interface box, select the 
correct Ethernet port 
for the output. 


e. In the TS packet group 
size box, type the 
correct packet size (in 
bytes). 


f. If you wish to add 
another target IP 
address, repeat steps a 
through e until you 
have added all target IP 
addresses. 


12. Click Set to save and apply your settings. 
 


& When you click Set, a temporary glitch can occur in the output that you have configured.  
& The minimum SD video bit rate is 7000 Kbit/s. The maximum SD video bit rate is 50000 Kbit/s. 


The minimum HD video bit rate is 25000 Kbit/s. The maximum HD video bit rate is 50000 Kbit/s. 
& You can add multiple audio streams. An audio stream has two mono channels.  
& GV Edge has the following audio types with which you can describe the type of audio that is part 


of the Transport Stream. These are Undefined (not defined), Clean effects (the audio contains no 
language), Hearing impaired (audio that emphasizes speech over background sounds), Visual 
impaired commentary (audio with additional commentary to assist the visually impaired). 


& GOP stands for Group Of Pictures. 
& When you use the same PID twice for audio and video, TS-over-IP does not result in any output or 


in jittered output.  
& Inserting data into the data streams requires custom project development and is out of the scope 


of this document. 


 


6.2 Remove an audio stream 
To remove an audio stream in the IP Manager: 
1. In the navigation pane on the left, click the name of the audio stream that you wish to remove, 


such as Audio stream 1. 
2. In the Audio stream pane on the right, click the Delete audio stream button. 
 


6.3 Remove a teletext subtitle service 


To remove a teletext subtitle service in the IP Manager: 
1. In the navigation pane on the left, click the name of teletext service that you wish to remove, 


such as Teletext service 1. 
2. In the Teletext service pane on the right, click the Delete service button. 
 
 


6.4 Remove a target IP address 


To remove a target IP address in the IP Manager: 
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1. In the navigation pane on the left, under Channel configuration, click the TS-over-IP stream of 
which you wish to remove a target IP address. 


2. In the pane on the right-hand side, click the Delete button next to the IP address that you wish to 
remove. 


 


6.5 Remove a data stream 
To remove a data stream: 
1. In the navigation pane on the left, click the name of data stream that you wish to remove, such 


as Data stream 1. 
2. In the Data stream pane on the right, click the Delete button. 
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7 Configure audio watermarking  
If you have bought a GVEdge with audio watermarking enabled, you can enrich one or multiple audio 
channels with watermarking. This feature is based on the integration of the Civolution Watermarking 
Embedder. This chapter explains how you can configure audio watermarking. 
 
To enable watermarking on GVEdge, a license is required. The license is unique for each playout 
server. To get the license, contact support. 
 
In the IP Manager of GVEdge, you can configure audio watermarking for a channel.  
 


& You must configure audio watermarking for each separate channel, even in a multi-channel or 
simulcast setup. 


 
To configure audio watermarking for a channel in the IP Manager: 
1. In the navigation pane on the 


left, click Watermarking 1. 
2. In the Watermarking 1 pane, 


click New Watermark Channel. 
3. In the new window, click OK. 


 
 


 
4. Configure the new watermark 


channel: 
a. In the navigation pane on 


the left, click Audio 
Watermark Channel 1. 


b. Under Audio Watermark 
Enabled, select On to 
enable audio 
watermarking.  


c. In the Channel name box, 
type the correct channel 
name. 


d. To add one or multiple 
audio channels that must 
have audio watermarking, 
do the following: 


e. Click the New Audio 
Channel button. 


f. Click OK. 
g. In the Audio Channel box, 


select the output audio 
channel that must contain 
the watermarking. 


h. In the Audio Type box, 
select the audio type of the 
output audio channel. 


i. Click Set to apply and save 
your changes. 


 


5. Repeat steps 4. through 4.i  
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until you have added all audio 
channels that must be 
watermarked. 


 
& In case of using TS-over-IP, when changes have been applied and the output turns out black, make 


sure all the watermarking audio channels have been configured in the TS-over-IP audio channels 
as well. 


& Note that “5.1 Left Surround”, “5.1 Right Surround” and “5.1 Low Frequency Emitter” are not 
supported by the Civolution Watermarking and thus the Watermarking will not be applied on these 
channels 


Delete a watermarked audio output channel 
To delete a watermarked audio output channel: 
■ In the Audio Watermark Channel X pane, click the Delete button next to the audio channel of 


which you wish to delete the watermarking.  
 
Delete audio watermarking from the current television channel: 
■ In the Audio Watermark Channel X pane, click the Delete Watermark Channel button at the 


bottom of the pane.  
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8 Configure the VDS 
This chapter describes how to configure the GV Edge Video Delay Server (VDS) 
that can be enabled on the GV Edge Server. This server can delay incoming or 
outgoing SDI-signals out of the box. The VDS delays video, audio, subtitles, 
teletext and other services included in the signal. 
 
To enable the VDS on GVEdge, a license is required. To get the license, contact support. 
 


8.1 Set a delay in the IP Manager 
To set a delay in the IP Manager: 
1. Open the IP Manager. 
2. In the IP Manager, click on Delay.  
3. In the Delay pane in the Maximum delay time box, enter the maximum delay time for the disk and 


compression ratio used (hh:mm:ss:ff). 
4. In the Delay time box, enter the delay time (hh:mm:ss:ff): 
5. Under Delay port, select the input or output that you want to delay. 


a. If you do not want a delay, select Disabled. 
b. If you want to delay all outputs from the main channel, select Out: Main channel:  
c. If you want to use the preview channel to view the delayed channel, select Out: Preview 


channel. 
d. If you want to delay the selected SDI input, select In: SDI<number>. 
Note: SDI ports are shown as they are named in IP Manager>Channel Configuration. 


6. Under Preview output, do one of the following: 
a. If you want to delay an input, select None. 
b. If you want to delay an output, select the output channel(s) that must serve as a non-delayed 


preview channel. 
7. If you want HD output, set the output quality: 


a. If the output must be 43 Mb/s, select Very High. 
b. If the output must be 38 Mb/s, select High. 
c. If the output must be 36 Mb/s, select Normal. 
d. If the output must be 31 Mb/s, select Low. 
e. If the output must be 25 Mb/s, select Very Low. 
f. If you want SD output, continue with the next step. 
Note: SD output is produced at a fixed quality of 18 MB per second. 


8. Click Activate. 
9. Click Set. 
 


8.2 Set a delay and add an overlay graphic 


This type of delay makes use of Channel Pack VDS Basic. This standard channel pack is 
available on the VDS. The nexosInit template in this pack puts the signal from input IO1 (SDI 0 in 
Channel Composer) on screen and automatically adjusts the input to the aspect ratio of the output. 
 


8.2.1 Scenario without Channel Composer 


If you do not have Channel Composer, you add a full screen overlay graphic (such as a bug TGA in a 
full screen file with a transparent background) the following way: 
 
1. In your browser, type the IP4 address of the VDS, such as 100.250.250.100. 
2. Log in as usual. 
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3. Click on the Select file button to upload a full screen overlay graphic. 
4. In the new window, select the file and click OK. 
 
After a template is triggered by GPIO, the exported channel pack is active. The next section explains 
how to set up a rule for this in the IP Manager. 
 
Templates triggered by GPIO: 
• are triggered immediately in case of delayed input. 
• are delayed in case of delayed output. 
 
To trigger a template with GPIO: 
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click DB9M. 
3. In the DB9M pane, click New DB9M rule. 
4. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
5. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
6. Repeat step 5 for the other seven pins. 
7. If you want a delay to be applied, select the Timecheat check box. 
8. If you do not want a delay to be applied, continue with the next step. 
9. In the type box, select Template. 
10. In the Argument box, type the applicable template name. 
11. Click Set. 
 


8.2.2 Scenario with Channel Composer 


If you have Channel Composer, you first add the overlay graphic to Channel Pack VDS Basic: 
1. Copy Channel Pack VDS Basic to a local disk. 
2. In Channel Composer, click Import from disk. 
3. Change the channel pack as needed. 
4.  If you want to add an overlay graphic to the channel pack, add a template to Channel Pack 


VDS Basic. 
5. After the channel pack is changed, export it to the playout system. 
 
Secondly, you export the channel pack to the playout system: 
1. In Channel Composer, go to File > Export > to Playout. 
2. Click the plus-icon to specify a system to export the pack to. 
3. Specify the playout system’s IP Address. 
4. Select Channel nr. 0. 
5. Specify start of Activation time. 
6. Click OK to add to the list. 
7. When the list is complete, click Next. 
 
To trigger a template with GPIO: 
1. Open the IP Manager web interface and log in as usual. 
2. Under Channel Configuration > GPIO, click DB9M. 
3. In the DB9M pane, click New DB9M rule. 
4. In the GPI Action box, select the applicable trigger, such as ‘GPI-5 off’, which means that pin 5 


switches to off. 
5. In the pin8 box, select the applicable status that must be applied to pin 8. (0= low, 1=high, x= 1 or 


0) 
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6. Repeat step 5 for the other seven pins. 
7. If you want a delay to be applied, select the Timecheat check box. 
8. If you do not want a delay to be applied, continue with the next step. 
9. In the type box, select Template. 
10. In the Argument box, type the applicable template name. 
11. Click Set. 
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9 Configure UDP monitoring  
Use this option to monitor Channel 0 (the single HD or SD Channel, or the HD 
Channel in a simulcast setup) via IP. When enabled, a MPEG- transport stream 
with encoded video, graphics, subtitles and audio (first stereo track) is sent over 
Ethernet using the UDP-protocol. A video player such as VLC is installed on a 
workstation to view output. 
 


9.1 Activating UDP Monitoring 
■ Enable monitoring via the IP Manager > System monitoring > UDP Monitoring > Ethernet Output: 


select On. 
 


& You need a license to enable the monitoring functionality. 


 


Settings: 
• Resolution: 320x240/ 240x180/ 160x120 
• Aspect Ratio: 4:3/ 16:9 
• Video Bitrate: in kbit/s 
• Audio Enabled: On/Off  
• Audio Bitrate: in kbit/s 
• Ethernet Output: select On to enable monitoring and start streaming, Off to disable. 
• IP address: IP address of the target workstation (can be a multicast address) 
• IP-port: port the player will listen to. Default 4000  
 


9.2 Setting up an UDP client 


To receive the stream at the client, you can use a media player such as VLC 
(http://www.videolan.org/vlc/) on a local workstation to view the video and audio content contained 
within the mpeg transport stream: 
1. Start the VLC-player. 
2. Select Media > Open Network Stream > Network. 
3. Enter the network URL: udp://@:XXXX, where XXXX = the IP-port specified in the IP Manager. 
4. If applicable select Show more options and set Caching to 100 ms. 
5. Click Play to start streaming. 
 


To receive streams from multiple GV Edge servers, in the IP Manager configure a unique target IP-
port for each GV Edge. For example if your client PC IP is 10.250.51.60, set up as: 
• GV Edge1: 10.250.51.60:4000 
• GV Edge2: 10.250.51.60:4001 
• GV Edge3: 10.250.51.60:4002 



http://www.videolan.org/vlc/
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Example. 


 
To enable multicast delivery: 
• Verify with your network administrator that the routers in your network are multicast-enabled. 
• Verify with your network administrator which multicast addresses are available on the network. 
• In the IP Manager, specify the multicast destination IP address available for network monitoring. 
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10 Preview Channel 
To set up the Preview Channel: 
1. Configure the Preview Channel via the IP Manager presets [see paragraph 2.6]. 
2. Define a preview Channel in TX/MAM as described in the Commissioning and TX/Mam User 


Manuals. 
3. In Channel Composer create a Format and Template to play out the clip and activate on the 


Preview Channel. 
 


& An example channel Preview1 and Channel Pack are preconfigured.  
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11 Configure a recording  
With the GV Edge Recording feature you can record a Live input and ingest as an 
Asset. MXF file types can be recorded. 
 
What is needed: 
• To enable, you need the GV-EDGE-SWLX-REC license. 
• A default Recording Channel is preconfigured: Record1.  
• You need the RecPack Channel Pack to work with the Recording function. The RecPack Channel 


Pack must be activated on the Recording Channel. 
• Enable recording via the IP Manager. 
 


11.1 Set up a recording 


How to:  
1. Enable recording via the IP Manager > Channel configuration > Enable recording channel: select 


On. 
2. Create a temporary Playlist. This Playlist is used to schedule Events with the recording Formats 


attached. 
3. In TX/MAM, create an empty Asset of the appropriate Asset Type. 
 


 
Example. 


 


& You can also overwrite an existing Asset. In that case, in the LiveRecord Format set the 
StartLiveRec > overwrite and CheckLiveAssetStatus > Overwrite options to 1. 
 


4. Drag the (empty) Asset into a temporary Playlist and attach the LiveRecord Format to the Event. 
5. Double-click the Event and specify Duration. You do not have to specify an Event Tc in / Tc out. 
 


& You can also specify the Asset’s duration in TX/MAM, on the Spotcheck tab > Duration.  


 


6. Activate the Event to the Record Channel, to the appropriate start date and time. Make sure the 
LiveRec Channel Pack is activated on the Record Channel. 
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Example Recording Event. 


 


7. If you do not know the recording Event’s duration in advance, schedule a LiveRecord Event with a 
Duration that exceeds the estimated duration. 


8. Schedule a manual Event after the recording Event with the IngestOnly Format attached; 
recording will be stopped when the manual Event is triggered and the recording Event’s duration 
is overruled. The IngestOnly Event ingests the recording.  
 


In Playout Control (POC), the Flag column shows following status indicators: 


  
Pre-check OK. 


  
Recording will not start. The file already exists (and overwrite is not enabled), or the file extension not 
allowed. 


  
Recording OK. 


  
Recording error. 


 
Ingest successfully finished. 


& After ingest, Assets can be shared and exported via the TX/MAM Sharing tab and Export options. 
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11.2 The LiveRecord Format 


 
Example Event in POC. 


 


■ CheckLiveAssetStatus: a check performed before recording starts. Verifies:  
• allowed file extensions 
• if the Asset ID exists in TX/MAM  
• contains the Overwrite option (0 overwrite is not allowed, 1 is allowed) 
 
■ StartLiveRec: sends the recording command to nexos, default 6 seconds prior to start. 
• ioInput: specifies the input port that is recorded. Numbering starts at 1; IO1 is 1, IO2 is 2, 


etcetera. 
• format: the broadcast format 


o PAL  
o 720@50p  
o 1080@50i 
o NTSC  
o 720@5994p  
o 1080@5994i 


• preset: the encoding preset, determines amongst others the container/codec 
o mxf-d10-<bitrate> 


 Use for SD. 
 bitrate: 30/40/50 


o xdcam-hd-<bitrate> 
 Use for HD. 
 bitrate: 30/40/50 


o overwrite: 0 overwrite is not allowed, 1 is allowed 
o vbirecord: 0 do not include vbi info, 1 include vbi info. Only supported for PAL-formats. 


VBI is recorded in the visual area. 
 







 


071884603  K2 Edge 4.2.1 User Guide - 76 


■ IngestRecording: starts ingesting the previous recording, if any, 6 seconds from start. Starts 
ingesting the current recording, 6 seconds from end. 


 
Event parameters can be modified in POC. If you want to work with different parameters than the 
ones predefined, to avoid having to change parameters for each recording we advise to change the 
Format in Channel Composer.  
 


11.3 The IngestOnly Format 


 
Example Event in POC. 


 


• This Format stops recording when the Event is triggered. 
• Ingests the previous recording. 
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12 Configure JIP 


Setting up JIP consists of the following steps: 
1. Activate JIP via the GV Edge IP Manager. 
2. Define a JIP Channel in Cobalt. 
3. Define JIP-templates plus the jipOff template in Channel Composer. 
4. Optional: create Format Rules to replace normal formats with JIP-formats for the JIP Channel. 
 


12.1 Activate the JIP channel 
1. Open the IP Manager web interface; enter the IP Manager's IP-address in a web browser and log 


in. 
2. Go to Channel Configuration > Enable JIP channel > select On.  
3. Click Set > Activate. Note that activating changes will interrupt playout. 


 
 
Example JIP enabled in IP Manager. 
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12.2 Set up a JIP channel in TX/MAM 
To create a JIP Channel definition in TX/MAM:  
1. Go to TX/MAM in your web browser and login. 
2. Go to the Channel menu  
3. On the top right of the Channel page, press Add 
4. Select the user group and fill the required JIP External Reference and press Create 
5. Go to the Info tab and specify the following settings 


a. Channel name: a name for the Channel, for example ‘JIP-Main’.  
b. Server ip (playout): the IP-address of the GV Edge playout node (main or backup) this 


Channel will run on. 
c. Broadcast set: select 5:broadcast-4 
d. Server port: server port, default 5020 
e. Timecode format: Select the correct broadcast format. 
f. Opt out: opt out channel: main 
g. Join In Progress: select the Channel to JIP with; this should be the primary Channel 


(broadcast set 0) 
h. Other settings can be left default 
i. When finished, click the Save button on the top right of the page to save changes or press 


Cancel to discard. 
 


 
Example JIP Channel definition in TX/MAM 


 
& When correctly configured, a grey JIP indicator icon  will be shown in Cobalt Playout 


Control (POC) next to the ON AIR signs for both the normal Channel and the JIP Channel. 
 


&  When a Channel (name) has been modified or created, user rights have to be set again in the User 
Right menu in TX/MAM.  







 


071884603  K2 Edge 4.2.1 User Guide - 79 


 


12.3 Set up the JIP backup channel 
The GV Edge backup node runs a process (schedulesync) that synchronizes schedules from the 
main playout server to the backup playout server.  
To define the JIP Channel for the backup server: 
1. First define the Channel for the main node with the main node’s IP-address as described in the 


previous paragraph. For example ‘JIP-Main’. 
2. Then define the Channel for the backup node, with the backup node’s IP-address.  


For example ‘JIP-Backup’.  
3. Fill in the schedule-syncer section.  


sync with: specify the Channel on the main node that you want to backup, in this example ‘JIP-
Main’. 


 
 


12.4 Create a JIP template 
&  For more information about Channel Composer, see the Channel Composer User Guide. 


 
How it works 
The normal and JIP Playlists use the same Channel Pack. This Pack contains the “normal” and JIP-
templates, plus the jipOff template described below. JIP-templates must have the following 
characteristics: 
• Objects in the JIP-templates should be placed on higher layers than Objects used in the normal 


templates so that the JIP video output will (partially) overlay the normal program output (that 
continues to play in the background). 


• JIP-templates should not interfere in any way with the normal playout templates. Therefore, the 
JIP template should use dedicated (player) objects. 


 
Control is returned to the normal Playlist when the JIP Playlist ends, or temporarily during a gap in 
the JIP Playlist.  
To restore to normal output, any changes caused by the various JIP-templates must be undone. The 
players that were started by any of the JIP-templates must be stopped. To achieve this, a template 
with the reserved name jipOff is created and added to the Channel Pack. This template should stop 
all players used in the JIP-templates.   
The jipOff template will be automatically called when the JIP Playlist ends and control is returned to 
normal output.  
 


Note: 
Gaps in the JIP-Playlist are supported. During a gap, control will temporarily return to normal output. 
When an Event starts in the JIP Playlist, control is automatically returned to the JIP Channel. 
 


 Note: 
Keep in mind not to change the JIP Playlist within 10 seconds before it ends, since the jipOff 
template is preloaded in these 10 seconds. 
 


 Note: 
The quality of restoring to normal output depends on the jipOff template. If incomplete, or not 
defined at all, normal output cannot be restored.  
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To create JIP-templates: 
 In Channel Composer, define the templates and formats for the JIP channel design.  


o Make sure these templates use dedicated (player) objects.  
o Also note that JIP Objects should be placed on higher layers (this can be checked in the 


Channel Composer Objects window) than the Objects used in the templates for normal 
playout. 


 Create a jipOff template that stops all the players used in the JIP-templates. Note that the name 
for this template (jipOff) is fixed. 


 Export and activate the Channel Pack to both the primary Channel (broadcast set 0) and the JIP 
Channel (broadcast set 4). Note that the normal and JIP Playlists use the same Channel Pack. 
You can also activate the Pack in a later stage.  


 


12.5 Enable simulcast 
To allow for Channel differences in a simulcast setup, different jipOff templates can be defined for 
each of the two Channels by adding a channel number suffix to the template name as shown below:  
Template name Description 


jipOff Automatically triggered when returning to normal output. Works for any 


Channel. Only used when no dedicated channel specific template could be 


found. 


jipOff-chan0 Automatically triggered when returning to normal output on the first channel. If 


not found, template jipOff is used instead.  


jipOff-chan1 Automatically triggered when returning to normal output on the second 


channel. If not found, template jipOff is used instead. 


 
 


12.6 Create format rules 
To make sure only JIP-templates and formats are used in the JIP Channel, you can define a Format 
Rule that replaces normal formats with JIP-formats for the JIP Channel. 
Example Rule activated for the JIP Channel: IF Format = Clip THEN replace the Clip-format with the 
JIP-Clip-format.  
 


& For more information on format rules, see the Cobalt User Guide. 


 


12.7 Prepare Playout Control (POC) 
1. In POC, open both Playlists and make sure the normal Playlist is running.  
2. Verify that JIP is configured correctly: when correctly configured, a grey JIP indicator icon will be 


shown in Cobalt Playout Control (POC) next to the ON AIR signs for both the normal Channel and 
the JIP Channel. 
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Example normal and JIP Channels active in POC with grey JIP- icon visible. 
 
3. Make sure the Channel Pack that contains the JIP-templates is activated on both the normal and 


JIP Channel. This can be checked in POC > main menu > View > Channel Packs or using the 
Channel Pack Manager. If applicable, activate the JIP Channel pack using the Channel Pack 
Manager. 
Note that the normal and JIP Playlist use the same Channel Pack. 


4. If applicable, in the JIP Playlist, schedule Events with the JIP-formats. 
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13 IP address change scenario 
When you change the IP address of the playout nodes’, TX/MAM or FTP-servers’, 
you must change how the playout system is set up. This chapter explains how to 
do that. 
13.1 Change the IP address of the playout nodes 


■ In the TX/MAM Channel settings, change the IP address of the playout nodes. 
 


13.2 Change the virtual IP address of the TX/MAM servers 
1. On the GVEdge nodes, in /etc/hosts, adjust MAIN-DB.  


a. Specify the virtual IP of the TX/MAM servers. 
 
Example: 10.250.51.51 MAIN-DB 


  


& You can also set the IP address of the TX/MAM server via the IP Manager. 


 


2. On both the TX/MAM servers, in /usr/local/apache2/application/configs/txmam.ini, adjust 
project_options.serverip.  
a. Specify the virtual IP of the TX/MAM servers. 


Example: project_options.serverip = "10.250.51.51" 
 


 


3. On both the TX/MAM servers, in /usr/local/apache2/application/configs/txmam.ini, adjust 
ingest.assetHostIp. Specify the virtual IP of the TX/MAM servers. 
Example: ingest.assetHostIp = "10.250.51.51" 


 


4. To change the IP address in the POC desktop shortcut properties  
Right-click the POC icon on your desktop > Properties > Shortcut.  
In the Target field fill in the TX/MAM servers’ virtual IP address.  


 


 


13.3 Change the IP address of the FTP server 
1. On both the TX/MAM servers, in /usr/local/apache2/application/configs/txmam.ini, adjust: 
• videoFtp.host to the FTP server IP 
• videoFtp.user to FTP server user 
• videoFtp.password to FTP server password 
• videoFtp.path to FTP server path 
 


Preferably adjust both the FTP and SMB-settings. 


Example (SMB): 
;Global 


videoFtp.protocol = Smb 


 


;Smb 


videoFtp.Smb.user="delta" 
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videoFtp.Smb.password="delta" 


videoFtp.Smb.host="10.250.51.51" 


videoFtp.Smb.path="/system/objects/cobassets/media/browse/" 


 


2. On the main TX/MAM server in /system/objects/cobassets/bin/transfer_ftp.xml, adjust the 
transfer metadata.  


3. Then run the /system/objects/cobassets/bin/set.sh script. 
 


13.4 Change the IP address of a standalone demo server 


■ Run the script /system/txmam_fix_ip.sh. 
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14 Maintain GV Edge 


 
WARNING: When working with the server’s internal components, make sure to avoid 
electrostatic discharge. Shut down the GV Edge via the IP Manager web interface or 
front panel and remove the mains plug to avoid electric shock. 


14.1 Turn on the GV Edge  
GV Edge automatically powers on when connected to a power source.  
 
To power on manually: 
■ Push the rotary knob on the front panel. 
 
When powered on, the LCD panel lights up. When system start has completed, color bars are visible 
on the SDI (video) output screen. 
 


14.2 Turn off the GV Edge 


 CAUTION: Always use the IP manager option Shutdown (includes halt) or halt the server 
from the command line before power off to avoid data loss or corruption. 
A forced power-off or reset can lead to data loss or corruption. 


To turn off the GV Edge: 
■ Shut down the GV Edge through the IP Manager web interface or front panel. 
 
When powered off, the LCD panel turns off. 
 
In emergency cases the following IP Manager options can be used: 
• Forced power-off: forced hardware power down (no software halt, for emergency use only)  
• Forced reset: forced hardware reset (no software halt, for emergency use only)  
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14.3 Replace the front bezel 


 
CAUTION: To avoid electrostatic discharge, make sure that you are properly grounded. You do not 
have to halt or turn off the GV Edge when replacing a single power supply. Hard disks are hot 
swappable and redundant.  
 
WARNING: Any instructions in this user guide that require the opening of the covers or enclosures 
of the GV Edge must be done by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any servicing other than that contained in the operating instructions unless 
you are qualified to do so. 
 


1. Loosen the thumb screws from the unit. 


 
 


2. Carefully slide out the bezel and disconnect the display cable. Pull the display cable from the 
connector and not from the wire. A small flat screw driver can be used to push the connector’s 
tabs out. 


 
 


3. Remove the bezel from the unit by lifting up the hinges on the side. 
4. Remove the two hinges from the sides of the bezel by unfastening the screws. 


 


 
 


5. Fasten the hinges to the new bezel (FRU 761051600) using a torque of 6 to 8 kgfcm (5.2 to 6.9 
lbs). 
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6. Insert the front assembly replacement in the GV-Edge unit and reconnect the display cable. 
 


 
7. Make sure the bezel is flushed and aligned with the frame. 
8. Fasten the thumb screws. 


 


 
 


 


14.4 Replace a hard disk 


 
CAUTION: To avoid electrostatic discharge, make sure that you are properly grounded. You do 
not have to halt or power off the GV Edge when replacing a single power supply. Hard disks are 
hot swappable and redundant.  
  
WARNING: Any instructions in this manual that require opening the equipment cover or enclosure 
are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform 
any servicing other than that contained in the operating instructions unless you are qualified to do 
so. 
 


 & Hard disks are hot swappable. You do not have to halt and shut down the GV Edge when 
replacing a single disk. 


The disk/HDD physical positions on the GV Edge are: 
 


HDD 1 HDD 3 HDD 5  


HDD 0 HDD 2 HDD 4 


 
To replace a hard disk: 
1. Type halt to turn off the GV Edge system. 
2. Remove the front panel of the GV Edge Server. 


a. Loosen the two thumb screws at the left and right side of the front panel.  
b. Remove the front panel. 


3. Find the location of the hard disk drive that you wish to remove. 
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4. To the right of the tray of the drive that 
you wish to replace, move the colored 
lock paddle to release the handle. 


 


 
5. Use the handle to remove the hard disk 


drive. 


 
6. Slide the replacement hard disk drive into the empty tray.  


The hard drive automatically engages with its connector. 
7. Make sure that the lock paddle is in ‘’locked” position.  
8. Close the front panel. 


a. Put the front panel in the correct position on the front of the GV Edge. 
b. Tighten the two thumb screws at the left and right side of the front panel. 


 


 
& To rebuild the disk, contact support. 


 
 


14.5 Replace a redundant power supply 


 
CAUTION: To avoid electrostatic discharge, make sure that you are properly 
grounded. You do not have to halt or power off the GV Edge when replacing a single 
power supply. Hard disks are hot swappable and redundant.  
 
WARNING: Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any servicing other than that contained in the operating 
instructions unless you are qualified to do so. 
 


To replace a power supply: 
 
1. Open the front panel. 
2. Pull the level to the left and keep in this position while pulling the power supply forward to 


remove from the server. 
3. Slide the replacing power supply in its bay and close the front panel. 
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14.6 Install a new version of GV Edge 
 


To install or upgrade to a new version of GV Edge 


1. Connect the USB installer to the GV Edge Server. 
2. Press the F11 key to enter the BIOS. 
3. In the BIOS window, select the option to boot the USB installer. 
4. In the installer window, select the applicable installation or upgrade type. 
5. Reboot after installation or upgrade. 
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1 About this guide 
The RTic 2.47 User Guide gives users the latest information and instructions 
about how to use RTic 2.47 for GV Edge. 
 
 


1.1 What’s in this guide 
• Chapter 2, Get to know RTic, on page 8, provides a general description of RTic 2.47’s 


characteristics. 
• Chapter 3, Get started, on page 14, helps you to get familiar with the window that opens when 


you launch RTic 2.47. It describes its toolbars, panes and tabs, as well as its basic elements. 
 


1.2 How to use this guide 
You can use Chapter 2 of this guide to find general information about Composer, such as a brief 
explanation of this application, and its basic elements. This chapter also explains the setup of the 
Composer workspace and the tools it includes.
 


1.3 Document conventions 


The formatting of this user guide is designed to help you easily and quickly find information. The 
following table explains what the different formats in this document mean. 
 
Format Refers to Example 
Bold An onscreen object for which a user action 


is needed. Keyboard keys are not 
emphasized. 


Click Save As. 


Italic Placeholder text. 
Hyperlink or cross-reference. 


Type password. 
See Chapter 2, Get to know RTic 2.47. 


■  Single-step procedures. ■ On the View menu, click Ruler. 
1.  Multiple-step procedures. 1. On the Tools menu, click Options. 


2. Click the Edit tab. 
& Note:   A note. & Note: Only administrators can 


publish to a server. 


•  A list item. A user can edit: 
• Objects 
• Materials 
• Visual effects. 


 
 


1.4 Contact support 


Do you have a specific question and was the answer not in this user guide? Please visit our website 
or contact Grass Valley support. 
 
To contact Grass Valley support, do one of the following: 
■ Call one of our international support centers with 24/7 availability: 


o France, +800 8080 2020 or +33 1 48 25 20 20. 
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o US and Canada, +1 800 547 8949 or +1 530 478 4148. 
■ Call one of our local support centers, open during normal business hours: 


o Asia 
 Hong Kong, Taiwan, Korea and Macau: +852 2531 3058. 
 Indian Subcontinent: +91 22 24933476. 
 Southeast Asia/Malaysia: +603 7492 3303. 
 Southeast Asia/Singapore: +65 6379 1313. 
 China: +861 0660 159 450 Japan: +81 3 5484 6868. 


o Australia and New Zealand: +61 1300 721 495. 
o Central and South America: +55 11 5509 3443. 
o Middle East: +971 4 299 64 40. 
o Near East and Africa: +800 8080 2020 or +33 1 48 25 20 20. 
o Europe 


 Belarus, Russia, Tadzikistan, Ukraine, Uzbekistan: +7 095 2580924 225. 
 Switzerland: +41 1 487 80 02. 
 Italy (Rome): +39 06 87 20 35 28. 
 Italy (Milan): +39 02 48 41 46 58. 
 Spain:  +34 91 512 03 50. 
 Belgium: +32 (0) 2 334 90 30. 
 Netherlands: +31 (0) 35 62 38 42 1. 
 Benelux and Northern Europe: +45 45 96 88 70. 
 Germany, Austria, Eastern Europe: +49 6150 104 444. 
 UK, Ireland, Israel: +44 118 923 0499. 
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2 Get to know RTic 
 
 
This chapter introduces you to RTic, its basic features, its workflow and the 
elements within the application, such as sources, events and targets. It also 
explains the elements of the RTic user interface. 
 
The Real Time information collector (RTic) with which you can collect data from a broad variety of 
sources, and then process and broadcast this data directly on air. RTic is installed on and runs from 
a workstation. RTic connects to the playout or test system via the RTic System object [see 
paragraph 4.2 for an explanation]. 
 


 
 
 


2.1 Workflow 


RTic defines data flows: data is grabbed from a source, processed and sent to a target. Events allow 
you to further control data grabbing; events are used to trigger data grabbing. The system object 
specifies the playout system. 
 
  
The steps below describe the RTic workflow: 
 
1. Specify the data source. Data can be grabbed from a variety of sources such as text, XML, CSV, 


and more. Data can be either "single record", for example a text fragment, or "multirecord ", for 
example an CSV source. 


2. Process the data. Options include: trim text, word wrap text, merge graphics, define decisions 
and conditions for processing data, select records from a multirecord source, and more. 


3. Specify the target. Define a target: send the data to a scene parameter, a ticker, etcetera. 
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4. Link an event to the target. Events are used to control data grabbing. An event triggers data 
grabbing, for example according to an update interval or each time a specified data file is 
modified.  


5. Define the output system. The system object specifies the playout system. 


 
 
  
The example above shows a simple dataflow: 
1. Text is grabbed from a text file, specified by the Text file object. 
2. The text is trimmed as defined by the Trim object. 
3. The Target object defines the target; in this example a scene parameter.  
4. The onTime Event defines the interval for data grabbing. 
5. The system object defines the playout system.  
 
  


& Most RTic objects contain a test grab option. You can use this option to test incoming data at 
several stages in the workflow. 


  
 


2.2 RTic Objects 
2.2.1 Sources 


Data can be grabbed from: 
• text, file or manual  
• XML, file or socket  
• CSV files  
• and more  
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2.2.2 Processing 


Data processing options include: 
• trim text  
• merge graphics  
• word wrap  
• select a record and parameter  
• define decisions and conditions for processing data  
• and more  
 


2.2.3 Events 


Events are used to control data grabbing. For example, define an update interval, or check for 
changes in a data file. Events are linked to Targets. In Grabber active mode, the Event updates the 
related Target according to the specified trigger. The following events can be selected: 


- Time 
- Socket 
- FileDate 


 
 


2.2.4 Targets 


Data can be sent to different targets: 
• scene parameters 
• tickers  
• templates  
• and more  
 


2.2.5 System 


This object specifies the playout system. 
  
 


2.3 Multi-record sources 
2.3.1 What is a multi-record source 


CSV, SQL, XML-files, etcetera are multirecord sources. Information is structured and stored in 
records. Each record describes an entity, for instance 'Title' or 'Artist'. Records contain parameters, 
also referred to as fields, attributes, columns, tags, and so on, depending on the source. Each 
parameter contains a value. 
• In a Comma Separated Value (CSV) file, each record is terminated by the operating system's 
line separator and the parameters within a record are separated by a separation character. 
• In a text file, each separate line represents a record. 
• In a XML-source, tags are used to define and structure nodes and records. Records or 
attributes hold values. 
 


2.3.2 The Record select object 


Use mulitrecord objects in combination with a Record sel object. The Record sel object is used to: 
• Select a range of records to grab from the source, for example grab records 10 to 20. 
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• Select a parameter to grab from the records selected in step 1, for example grab parameter 
'Company' (from records 10 to 20). 
 


2.3.3 Multi-record sources and scene parameters 


Each multirecord source parameter is written to a separate scene parameter or story. If 20 
parameters are grabbed from a source, 20 consecutive scene parameters will be updated. A pitch (a 
step value between consecutive scene parameters) can be defined. 
 
Example CSV with 3 rows and 3 columns A,B,C: 
 A B C 
1 row1-columnA row1-columnB row1-columnC 
2 row2-columnA row2-columnB row2-columnC 
3 row3-columnA row3-columnB row3-columnC 
 
Example Record select object: 
 


The test grab shows record 1, i.e. row 1.  
This record contains 3 parameters, i.e. 3 columns. 
The Record select object defines: 
• records 1-3 will be grabbed; grabbing starts at record 1, the number of records to grab is 3  
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• from these 3 records, parameter, i.e. column B (the grab parameter), will be grabbed  
  
 
  


2.4 The RTic workspace 


The RTic workspace consists of a menu and the Canvas. The project name is displayed in the upper 
left corner. The project’s creation and last save date are shown in the bottom right corner. The 
navigator window can be used to select a portion of the Canvas. 


 


2.5 The RTic menu 


2.5.1 File 


• New 
• Open  
• Save  
• Save as 
• Set project as default  
• Exit 
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2.5.2 Mode  


[See chapter 2,6 for an explanation] 
• Off  
• Grabber active  
• Designer 
• Show content 
 


2.5.3 Messages 


• Show Error log 
• Clear Error log 
• Show Message log 
• Clear Message log  
 


• New project 
• Open project 
• Save project 
• Save as project 


• Align objects horizontally 
• Align objects vertically  


• Specify a grid in pixels 


• Categories and objects 
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2.6 RTic modes 


 


2.6.1 Designer 


Designer mode: switch to this mode when building projects. 
In this mode, you can manually test grab data. To test grab, verify if the system object is connected. 
In Designer mode, you need to connect manually to the playout server. Note that data is actually sent 
to system.  
 
 


2.6.2 Grabber Active 


Playout mode: activates the RTic project.  
In this mode, Events – and thus (automatic) data grabbing - are activated. In Grabber Active mode, 
RTic automatically connects to the playout server(s) as specified in the System object(s). Projects 
cannot be altered. 
 
 


2.6.3 Off 


Deactivates the RTic project. Events – and thus (automatic) data grabbing - are deactivated. In this 
mode, you can manually test grab data. To test grab, verify if the system object is connected. Note 
that data is actually sent to system. Projects cannot be altered. 
 
 


2.6.4 Show content 


Select this option to display the results of the last grab underneath objects. 
 
 
  


3 Get started 
3.1 System requirements 


RTic runs on Windows. The minimum system requirements are: 
• Vista or Windows 7 
• 32 or 64 bit  
• 4GB RAM 
• 2.4 Ghz CPU 
 
 


3.2 Open RTic 
■   To open RTic click the RTic icon on your desktop. 
 


4 Work with objects  
4.1 Add an object to the Canvas 
■  To add an object to the Canvas, on the menu, first select the appropriate category, click the 


object you want to add, and then click the Canvas. 







 


RTic 2.47 for GV Edge: User Guide 071886002- 15 


 
 


4.2 Move an object on the Canvas 
■  To move an object on the Canvas, select the object, and then move while keeping the mouse 


pressed.   
 
 


4.3 Link an object 
1.  Select the object.  
2.  Keep mouse pressed while dragging the object on top of target object.  
 


4.4 Link a second object to an object (two inputs) 
1.  Select the object.  
2.  Keep the mouse and the [Shift]-key pressed while dragging the object on top of target object. 
The second link is indicated by a yellow arrow.  
 


4.5 Unlink an object 
1.  Select the object.  
2.  Right-click > Unlink.   


Example options when right-clicking an object. 
 


4.6 Cut, copy, paste, delete 


■  To cut, copy, paste or delete an object, right-click the object, then select the appropriate 
option. You can also use the Windows shortcuts and the [delete]-key. 
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4.7 View properties 


■  To view an object’s properties, right-click the object, then select Properties. 
 


4.8 Rename an object 


■  To rename an object, right-click, then rename.  
 


4.9 Grab data or show content 


■  To grab data or show content, right-click the object, then select the appropriate option.   
 


4.10 The Record Select object 


Use the Record Select object to specify which records and parameters (i.e. which fields, text lines, 
columns, and so on) you want to grab from a multirecord source.  
  
1. Insert a Process > Record Sel object.  
2. Drag the multirecord source on top of Record Sel object.  
3. Double-click the Record Sel object to edit:  
4. Specify the first record you want to grab, for example start grabbing at record 5. 
5. Specify the number of records you want to grab.  
6. Click the Test grab button. 
7. The record table shows the first record from the multirecord source.  
8. To scroll through records, change the record number in the bottom right corner.  
9. In the record table, select the parameter you want to grab.  
10. Drag this parameter into the Grab parameter field while keeping the mouse pressed. 
11. If applicable, select a sorting order in which the Record select object’s output will be written to 


the scene parameters: 
a. no sorting 
b. Sort (ascending) 
c. Sort (descending) 


12. Sort (user table) file: click to use a Table object to define the sorting order. 
13. AlphaSort: click to sort in alphabetical order. If this option is not checked, values are sorted in 


numerical order. 
14. You can optionally specify a parameter to sort on by dragging this parameter from the record 


table into the sort on parameter box. 
15. Click Sa ve  to s a ve  the  s e lec tion.  
 
To test grab output of the Record select object, link the Record select object to a target and use the 
target's Test grab option. 
 
 


& Each parameter (value) is written to a separate scene parameter. For example, if 10 record 
parameters are grabbed, 10 consecutive scene parameters are updated, also if parameters are 
empty. A pitch can be defined. 


 


4.11 The Channel Composer Ticker 


Use this object to update a Channel Composer Ticker.  
 







 


RTic 2.47 for GV Edge: User Guide 071886002- 17 


The ticker data flow is defined in RTic: the data source, processing and data grabbing.  
Ticker templates (to place the ticker on-screen, set and clear ticker stories) are defined in Channel 
Composer. 
 


4.11.1 Workflow 


 
  
In RTic, the steps for defining a Ticker are: 
1. Add a System object. 
2. Add a Ticker Target object.  


This object specifies the ticker’s playout Channel, ticker number and the story mode (for 
example: a triple part story ticker with a TGA). 


3. Link the Ticker to the System object. This object specifies the playout system.  
4. Add and link a Source object to the Ticker.  


Ticker stories will be grabbed from this object.  
5. If applicable, add Process objects to process the data grabbed from the Source.  
6. Link an Event to the Ticker to control data grabbing.  
 
The steps for defining a Ticker in Channel Composer are: 
1. Create a Template to place the Ticker on-screen.  
2. Create a Template to set ticker stories.  
3. Create a Template to clear ticker stories. 
 
 


& Example Templates for tickers can be found in Channel Composer under File > Example Projects > 
RTic Ticker. 


& The Channel Composer User Guide explains how to create tickers in Channel Composer. 


 


4.11.2 Example RTic ticker data flow 
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Explanation: 
• The Ticker object specifies the playout Channel, Ticker number and story mode. In this 


example: a triple story ticker with a TGA. 
• Stories are grabbed from a multirecord XML-source. Record select objects are used to select 


fields from this source and update the story parts 1, 2, 3. The ticker_ani scene parameter is 
updated with the TGA-filename. 


• Trim and Table objects are used to edit and replace text strings. 
• The onTime Event updates the Ticker (grabs stories) at a predefined interval.  
• The System object links the ticker to the playout system.  
 


4.11.3 Tickers and multirecord sources 


When working with more than one ticker story, you will probably use a multirecord source to feed the 
stories [see also the example above]. The Record select object specifies the first and the number of 
records to grab from the source, plus the grab parameter (which column).  
Each parameter (value) is written to a separate story part. For example, if 10 record parameters are 
grabbed, in 10 consecutive stories part 1 is updated, also if parameters are empty. A pitch can be 
defined. 
When linking the Record select and the Ticker objects, you define to which part of the Ticker the 
parameters are written: part 1, 2, 3 or the TGA/ANI.  
Define a Record select object for each story part, as shown in the example in paragraph 10.2. When 
working with a single story mode Ticker, you only need to de fine one Record select object and write 
stories to part 1. Example showing two Record select used to update story parts 1 and 2: 
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This Record select object grabs column 5 (name) from a CSV-file. 20 records (rows) will be grabbed 
starting from record 2.  20 consecutive stories will be updated. 
 


& Note that the example shows row 1 from the CSV-file’s grabbed data, which is the file header. 


The Ticker Story properties window defines that story part 1 will be updated with the output from the 
Record select object. 
This means that part 1 from 20 consecutive stories, starting story 0,  will be updated with info from 
the name column. 
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This Record select object grabs column 10 (title) from a CSV-file. 20 records (rows) will be grabbed, 
starting from record 2.  This means that 20 consecutive stories will be updated. 


The Ticker Story properties window defines that story part 2 will be updated with the output from the 
Record select object. 
 
This means that part 2 from 20 consecutive stories, starting story 0, will be updated with info from 
the name column. 


 
This picture shows the Ticker object after a test grab, with input from four  Record select objects (IDs 
6, 7, 8 and 9) updating story part 1 with the artist name, story part 2 with the track title and story part 
3 with the album name. The TGA-value is updated with the graphic player ID as defined in Channel 
Composer, here ‘1’.  
In this example, all values are grabbed from (different columns in) the same CVS-file.  


4.11.4 How to 


  
You can include TGAs and ANIs in your tickers. To do so: 
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1. In Channel Composer, graphic Players are defined in the Ticker property page. Add the Still or 
ANI file as a fixed Asset to the Channel pack. 


2. In RTic select a story mode that includes a TGA (or ANI). Update the TGA (or ANI)-field with the 
Player ID, as shown in the example below. 


 
Channels, tickers and stories are numbered starting from 0. 
1.  Insert a Targets > Channel Composer Ticker Object.  
2.  Link the appropriate System object to the Ticker target. 
3.  Link the appropriate Event object to the Ticker target. 
4.  Double-click the Ticker object to edit.  
5.  In the Ticker on layer box, select the Channel and ticker number.  
6.  Select a Ticker story mode (single story mode, triple story with TGA or ANI, etcetera).  
7.  If appropriate, check the Cache stories option.   
8.  Click Save to save the ticker, click Cancel to discard. 
 
To link Sources (and Process objects) to a Ticker: 
1. Link the appropriate Source (or Process) object(s) to the Ticker Object. 
2. Linking a Source or Process object to the Ticker object will open the Ticker Story properties 


window. Here you select: 
a. Story part: the story part you want to update: part-1/part-2/part-3/TGA or ANI.  


Note that the Ticker object defines the Ticker story mode. For single stories, select part-1 
here. 


b. s ta rt  s tory num be r: the  (firs t) s tory num be r you wa nt to  upda te 
c. pitch: if a pplica ble , s e lec t  a  s tep va lue  be tween cons ecutive  s to rie s  (only a pplie s  when 


grabbing stories from a multirecord source).  
3.  Click Save to save input properties, Cancel to discard.  
   


& The number of tickers that can be played out per Channel depends on your K2 Edge license. 


Example. 
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Stories overview: 


• num: index 
• story: a story number (256 max) 
• type: story part 1/2/3/TGA (depending on ticker mode)  
• id: object ID of the data source 
• source: name of the data source  
• value: data grabbed from the source. 
• updated: date and time of the last update. 
 


View grabbed data 


Double-click a value field to view grabbed data. 
 


Grab sources 


Use the Grab sources option to test incoming data. Note that the System object must be connected 
and that data is actually sent to the system. 
 


Clear strings  


Use the clear strings option to clear values when testing. 
 


Example Ticker Story properties window. 
 
The Ticker Story properties window automatically opens when linking an object to the Ticker object. 
You can also open and edit this window by double-clicking a story in the Channel Composer Ticker 
properties window. 
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4.12 The Channel Composer Template 


 
Use this object to start a Channel Composer template, and update the scene parameters in this 
template. 
1. Insert a Targets > Channel Composer Template object.  
2. If not already inserted, insert a System > K2 Edge System object.  
3. Configure and connect the system and Channel on which templates are stored.  
4. Link the appropriate System object to the Template object.  
5. Click the load template icon to list the templates available on the connected playout system and 


Channel. RTic will list all the available Templates from the active Channel Pack. 
6. In the templates box, select a template. 
7. Select a start mode for the template:  


a. start template at every grab 
b. do not start template automatically  
c. start template when grab results in changed data 
d. remote controlled 


8. Click Save to save changes, click Cancel to discard.  
 
To link sources to the scene parameters in a template: 
1. Link the appropriate Source (or if applicable Process) object(s) to the Template object.  
2. A dropdown menu that lists the template’s available scene parameters opens. 
3. Select the scene parameter you want to update. 
4. Leave the layer value at the default. This value is included for backwards compatibility. 
5. Click Save to save settings, Cancel to discard. 
 


4.12.1 Scene parameters overview: 


• chan: the channel number 
• name: the scene parameter name 
• type: the type of input field read from the template 
• id: object ID of the data source 
• source: name of the data source  
• value: data grabbed from the source. 
• updated: date and time of the last update. 
 


4.12.2 View grabbed data 


Double-click a value column field to view grabbed data. 
 


4.12.3 View link data 


Double-click a source column field to view the link sources dialog window. 
 


4.12.4 Grab sources 


Use the Grab sources option to test incoming data. Note that the System object must be connected 
and that grabbed data is actually sent to the system. 
 


4.12.5 Clear strings 


Use this option to clear values when testing. 
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4.13 The K2 Edge object 


Use this object to specify a K2 Edge playout system. 
 
To define the system and connect: 
1. Insert the System > K2 Edge object.  
2. Double-click to edit.  
3. Enter the playout server’s IP-address.  
4. Enter the IP-socket, the default port is 5000. 
5. Specify the playout Channel number. Channels are numbered starting from 0. 
6. You do not have to specify the number of layers, leave at the default.  
7. Click Connect to connect. 


The status bar turns green.  
8. Click Save to save the connection, Cancel to discard.  
9. To link a System object, drag the System object on top of the other object and not vice versa. 


Example. The system is connected. 
 


& To link a System object, drag the System object on top of the other object and not vice versa. 
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4.14 The Scenepar object  


Use this object to update a scene parameter (without starting the template). 
1. Insert a Targets > Scenepar object.  
2. If not already inserted, add a System > K2 Edge System object.  
3. Specify and connect to the system and Channel on which templates are stored.  
4. Link the System object to the Scenepar object. 
5. Click the Get Scenepars icon to load the scene parameters available on the selected system and 


Channel. RTic will list the scene parameters from the active Channel Pack. 
 
To link scene parameters and sources: 
1. Link the  a ppropria te  Sourc e  (or if a pplica ble  P roce s s ) obje c ts  to  the  Scenepa r ob jec t .  
2. A dropdown menu that lists available scene parameters opens. 
3. Select a scene parameter. 
4. Leave the layer value at the default. This value is included for backwards compatibility. 
5. Optionally select one of these options: 


a. update in use scenepars only (and do not clear all scenepars before grab): only used scene 
parameters  


b. force clear all scenepars before grab: all scene parameters are cleared before a grab 
6. Click Save to save settings, Cancel to discard. 
 
  


4.14.1 Scene parameters overview: 


• chan: the channel number 
• name: the scene parameter name 
• type: the type of input field read from the template 
• id: object ID of the data source 
• source: name of the data source  
• value: data grabbed from the source. 
• updated: date and time of the last update. 


 


4.14.2 View grabbed data 


Double-click a value field to view grabbed data. 
 


4.14.3 Grab sources 


Use the Grab sources option to test incoming data. Note that the System object must be connected 
and that data is actually sent to the system. 
 


4.14.4 Clear strings 


Use the clear strings option to clear values when testing. 
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5 Work with events 
In RTic, switch to Grabber active mode to test. 
 


5.1 Insert and link an event or target 
1.  Open the Events menu.  
2.  Insert the appropriate Event object.  
3.  Drag the Event on the Target object to link.  
 


5.2 Trigger an onSocket Event through a socket 
1. In RTic, rename the Event object: right-click the object > rename to <Event_name>.  
2. To trigger the Event, send a trigger via a connected socket on port 5005: EVENT <Event_name>  
 
Example command to trigger event "Event_name": ./ptsockcl 192.168.7.9 5005 "EVENT Event_name" 
 
• IP: the RTic workstation’s  IP-address 
• port 5005: the default RTic listen port  
 
 


& Quotes are used to send the EVENT command as a single argument. 


 


5.3 Toggle an onTime Event through a socket 


In RTic, rename the onTime object: 
■ Right-click the object > rename to <Timer_name>.  
 
To trigger the Event: 
■ Send a trigger via a connected socket on port 5005: TIMER <Timer_name> [on/off/toggle] 
 
Example command to start event "ontime": 
./ptsockcl 192.168.7.9 5005 "TIMER ontime on"  
 
• IP: the RTic workstation’s  IP-address  
• port 5005: the default RTic listen port  
 


& Quotes are used to send the EVENT command as a single argument. 


 
& Quotes are used to send the EVENT command as a single argument. 
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6 Work with decisions 
6.1 Add a decision 


Use the Process > Decision object to specify a decision string: if the string is matched, data is 
passed.  
1. Insert two Source or  Process objects:  


a. the first object outputs the data you want to send to the target  
b. the second object outputs the decision string  


2. Insert a Process > Decision object.  
3. Link the objects inserted in the first step to the Decision object. Make sure to link the object that 


sends the decision parameter second in order (yellow arrow).  
4. Double-click the Decision object to edit.  
5. In the Decision parameter box, enter the decision string.  
6. Click Save, then close object.  
 


6.2 Reverse a decision 


To reverse the decision – i.e. only pass data if the decision string is not matched: 
■ Check the Decision object's Inverse box. 
 


6.3 Compare sources 1 and 2 


To compare sources 1 and 2 (only pass data if output from sources 1 and 2 is the same): 
■ Leave the Decision parameter box empty. 
 
 


7 Work with texts  
7.1 Replace, remove, add and convert strings 


You can replace, remove, add and convert characters with the Process > Trim and Table objects. 
1. Open the Process menu > insert a Trim or Table object.  
2. Double-click to edit.  
3. Link to the appropriate Sources.  
 


7.2 Merge two text strings  
1. Insert the Process > Add object.  
2. Link two text Source or Process objects to the Add object. 
 
Output from the object that is linked second in order (yellow arrow) is placed behind output from the 
first object. To reverse this order, check the reverse add box. 
 


7.3 Add a word wrap 
1. Insert a Process wWrap2us object. 
2. Drag a text Source or Process object on the wWrap2us object to link. 
 
  
The wWrap2us object automatically writes separate text lines to separate scene parameters and can 
be used without Record select object.  
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7.3.1 Multirecord 


Text lines are processed as separate records. 
To work with multi language/special signs, use unicode encoded sources. 
 
  


7.3.2 Unicode 


To ensure that complex script and right-to-left languages are shown correctly in RTic and later 
(unicode version), the following options should be enabled on the PC running the RTic client: 
Start > Settings > Control panel > Regional and language options > Languages > Supplemental 
language support. 
Enable options: 
• Install files for complex script and right to left languages  
• Install files for East Asian languages  
 


8 Work with images 
& It is advised to use TGA-files as a source. 


1. Gra b the  na m e of the  TGA-file(s) from a single or multirecord object. 
o Note that the file name must include the file extension (.tga).  


2. If applicable, add a Process object to edit the file name. Link the Source and Process objects.  
3. Add a Local TGA object.  
4. Link the Local TGA object and the object that outputs the file name(s).  
5. Double-click the TGA object.  
6. Specify a directory (local) to grab file(s) from.  
 


8.1 Merge TGAs from 2 sources: 
1. Insert an Add TGA object.  
2. Specify the TGA file(s) as described above and link the two flows to the Add TGA object. 


The first flow (green link) is placed at the bottom and determines the maximum width and height.  
 


& The Local Add object automatically renames the TGA-files.  
& The Add TGA object can be preceded by a Local TGA object, Add TGA object or Graph object.  


 


8.1.1 Merge TGAs from one multisource 


1. Insert the multisource object and specify the TGA-files as described above. Grab multiple records 
from the multisource.  


2. Insert an Add TGA object.  
3. Link the flow to the Add TGA object. 


The first record is placed at the bottom and determines the maximum width and height.  
 


& The Test Add option does not work in combination with multisource objects. 


 


8.1.2 Image conversion 


Converts a BMP to TGA, or vice versa. If applicable, modify alpha and sharpness. 
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1. Specify the source file: path and filename.  
a. Use a (manual) source object to specify the file path and name. 


Note that you can also use the Local TGA object to specify the path, you can use the Add 
TGA object to specify the filename.)  


b. If applicable, process the source using an object such as the Trim object. 
2. Insert and link a PICconv object.  
3. Double-click the PICconv object to edit.  
4. Specify the target format and filename. Make sure to specify the target format file extension.  
5. If appropriate, modify alpha and sharpness.  
 


Example: Adding TGAs together from 2 sources 
 
• In this example the name of 2 TGAs (without file extension) is grabbed from an XML-source.  
• The Record select object is used to select the appropriate record and parameter. 
• The Table and Trim objects are used to add the file extension .tga.  
• The Add object adds the 2 TGAs together. The yellow link indicates the "second' object. This 


object (i.e. file) is placed on top.  
• Output is sent to a scene parameter.  
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9 Work with XML 
9.1 Specify an XML-source 
1. Insert a Sources > XML object.  
2. Double-click the object to edit.  
 


9.2 Select records from the XML-source 
1. Double-click the XML-object to edit.  
2. Click Select Records. 
3. The XML-record selector opens. This window shows the structure and content of the XML-


source.  
4. Click the + and _ signs to collapse and expand the XML-nodes.  
5. In the left window, select the top node.  
6. In the center window, select a record. 
7. The right window lists the selected record(s).  
8. Click Save to save the selection.  
9. Click Test grab to test grab the selection.  
 


9.3 Link the XML-object and Record select object 


■ Drag the XML-object on top of a Record select object to link. Then use the Record select object 
to select record(s) and parameters.  


 
 


& Note that it is advised not to use special strings in XML-sources to avoid translation to a special 
character sequence.  
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10 Work with SQL 
1. Insert a Process > ADOSQL object.  
2. Double-click the object to edit.  
3. In the ODBC source box, select the ODBC Source. 
4. If not listed in the dropdown menu, first specify a source via Start > Settings Administrative tools 


> Data sources (ODBC) or another tool.  
5. If applicable, specify a user and password for database.  
6. Specify a query.  
 
The query can be:  
• Fixed 


Define a query in the ADOSQL object. 
• Dynamic 


The ADOSQL object defines a query with dynamic references ($1, $2, etcetera). Values are 
grabbed from a different source that is linked to the ADOSQL object. Specify the separation sign 
that separates the values (if more than one) in the Separator string box. 


 
Example: 
• The ADOSQL object defines the query: select * from $1 where $2='$3'  
• The separator string is: ,  
• Input for the query is grabbed from another source.  
• Input is: Employee, Department, IT  
• Resulting in query: grab all from table Employee where Department=IT 
 


& Note that for some database types (references to) text strings in queries must be enclosed in 
(single) quotes. 


& Always test grab to test the query. 
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11 Quick reference cards for objects 
 


11.1 Record sel Object 


Use this object to specify the (range of) record(s) and parameters to grab data from. 


11.1.1 Type 


Process; Record sel Object 
 


11.1.2 Properties 


• Start grabbing at record: define the first record to start grabbing data from  
• Number of records to grab: define the  number of records to grab data from  
• Grab parameter: select a parameter (attribute/tag) to grab data from: drag and drop from the 


record test table  
• Select sorting type to use: specify a sorting order for record test table (optional)  
• no sorting  
• Sort (ascending)  
• Sort (descending) 
• Sort (user table file) 
• Alpha sort: sort in alphabetical order  
• Sort on parameter: optional, select a parameter (other than the grab parameter) to sort on  
• Record test table: shows an example record, the default is 1. A record number can be selected in 


the bottom right corner [Select current test record number]. Fill this table using the Test grab 
button.  


 


11.2 onTime Object 


Use this object to generate a timed Event. This Event can be toggled on/off via a socket. 
 


11.2.1 Type 


Events; onTime Object 
 


11.2.2 Properties 


• Update every: specify interval in seconds  
• Update only in period: check to specify a period  
• Toggle: toggle Event on/off  
• Reset counter: reset the counter  
 
 


11.3 onFileDate Object 
This object generates an Event when a specified file's Save date changes. 
 


11.3.1 Type 


Events; onFileDate Object 
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Explanation 
 


11.3.2 Properties 


• File to check: specify the file name and location. 
 
 


11.4 onSocket Object 


Use this object to generate Events via a socket (port 5005). Use the Simulate Event button to test or 
manually trigger functionality. 
 


11.4.1 Type 


Events; onSocket Object 
 


11.4.2 Properties 


n/a 
 


11.5 Add TGA Object 


Use this object to merge TGAs and display the graphics on top of each other. Use the Test Add 
option in the properties window to test the merge. 
 


11.5.1 Type 


Process; Add TGA Object 
 
 


11.6 Add Object 


Use this object to combine two text strings (sources). Multiple Add objects can be linked to combine 
more than two strings. The yellow link (to the Add object) indicates the string that is second in 
playout order. 
 


11.6.1 Type 


Process; Add Object 
 


11.6.2 Properties 


• reverse add: check this box to reverse the strings’ playout order  
 
 


11.7 20.11 Color Object 


Use this object to specify a color for text strings. 


11.7.1 Type 


Process; Color Object 
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11.7.2 Properties 


• default color: check this box to specify a default color for strings and select a default color  
• conditional color: if applicable, specify a string and select the color to apply if this string is 


matched  
• maximum saturation: specify the maximum saturation percentage, the default is 70%  
 


11.8 Decision Object 


Use this object to define a decision: if the string is matched, data is passed through. 
 


11.8.1 Type 


Process; Decision Object 
 


11.8.2 Properties 


• Decision parameter: specify a string or character; if matched, data is passed 
• Inverse: check this box to inverse the condition: if the string or character is not matched, data is 


passed 
 


11.9 Float Object 


Use this object to perform calculations on data (floats). 
 


11.9.1 Type 


Process; Float Object 
 


11.9.2 Properties 


• multiplication object: specify a multiplication factor  
• division factor: specify a division factor  
• number of leading zeros: specify the number of digits to display  
• thousands grouping sign: specify a thousands grouping sign to display  
• decimal separation: specify a decimal separation symbol to display  
• number of decimals: specify the number of decimals to display  
 


11.10 Graph Object 
Use this object to translate data to a line or bar graph. Use the Test grab option to test incoming data 
and to fill the record table. 
 
 


11.10.1 Type 


Process; Graph Object 
 







 


RTic 2.47 for GV Edge: User Guide 071886002- 35 


11.10.2 Properties 


• Graph name: (optional) specify a name, the name will be displayed in graph  
• Graph split mode: select how to render the graph; line and/or background and/or grid and/or 


labels  
• Graph type: select a type; line or bar graph  


o total picture width, in pixels  
o total picture height, in pixels  
o graph width, in pixels  
o graph height, in pixels  


• Background TGA file: select a TGA-file to be used as background. Note that the background 
option should be selected for Graph split mode.  


• Brush TGA file: select a TGA-file to be used as brush for drawing lines. For bar graphs, this 
should be a 100% bar.  


• Legend font: select a TTF-font and specify the font size for the graph name. The TTF-font file 
must be located on the workstation.  


o legend x-position: position of the legend within the graph in pixels, relative to the upper 
left corner  


o legend y-position: position of the legend within the graph in pixels, relative to the upper 
left corner  


• Label font: select a TTF-font and specify a font size for the label. The TTF-font file must be 
located on the RTic workstation.  


• Horizontal axis: drag and drop a parameter from the record table  
• Advanced settings: click this button for advanced options  
• Vertical axis: drag and drop a parameter from the record table  
• Advanced settings: click this button for advanced options  
• Optional 2nd output file: (optional) specify the location and filename to create a 2nd output file 
• Generate Graph: click to generate the graph  
 


& The Graph object is not part of the standard RTic-installation. 
& Preferably use a local font and picture files (background and brush) to enhance render times. 


 


11.11 Integer Object 


Use this object to perform calculations on data (integers). 
 


11.11.1 Type 


Process; Integer Object 
 


11.11.2 Properties 


• multiplication object: specify a multiplication factor  
• division factor: specify a division factor  
• number of leading zero´s: specify the number of digits  
• thousands grouping sign: specify a thousand grouping sign  


 


11.12 Local TGA Object 


Use this object to specify the local pictures directory (path). 
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11.12.1 Type 


Process; Local TGA Object 
 


11.12.2 Properties 


• Local TGA directory: specify the local pictures (TGA) directory  
 


11.13 PICconv Object 


Use this object to scale and/or adjust sharpness and/or convert a picture file to a BMP-file or TGA-
file. The PICconv object can convert a broad variety of formats, including: 
• JPG  
• TIF  
• GIF  
• ICO  
• PSD  
 


11.13.1 Type 


Process; PICconv Object 
 


11.13.2 Properties 


• target format: select and output format  
o BMP (for files without transparency)  
o TGA (for files with transparency) 
o target filename: specify the target filename, including extension  


• target picture width: specify width, in pixels  
• target picture height: specify height, in pixels  
• fill alpha: check this box to replace transparency with opaque (for TGAs only)  
• soft/sharp: check this box and specify softness/sharpness (for TGAs only)  
 


& The aspect ratio of the source is not automatically constrained. 


  


11.14 Tab Object 


Use this object to insert a tab in front of a string. 


11.14.1 Type 


Process; Color Object 
 


11.14.2 Properties 


• horizontal TAB position in pixels: specify the horizontal tab position, in pixels  
 


11.15 Table Object 


Use this object to replace (a) predefined text string(s) with another string. 
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11.15.1 Type 


Process; Table Object 
 


11.15.2 Properties 


• Table: up to 50 strings (each string can be a number of words) can be defined. The input string is 
replaced by the output string.  


• Case sensitive: check this box for a case sensitive comparison  
• Trim leading/trailing: check this box to remove leading spaces, trailing spaces and control 


characters  
• Use as value table: if checked, values (floats) in the column 'input string' are handled as a range 


of increasing values  
• Save to file: save the table to a file (*.tab)  
• Open from file: open a table file (*.tab)  
• Clear table: click to clear the table  
• Clear line: click to clear a selected line  
 


11.16  TEXTlen Object 
Use this object to apply a string length or number of lines as a condition for passing through text to 
the target. 
 


11.16.1 Type 


Process; TEXTlen Object 
 


11.16.2 Properties 


• line length test: check this box to enable this condition  
• text longer or equal to: specify a minimum text length (spaces included)  
• and text shorter or equal to: specify a maximum text length (spaces included)  
• number of lines test: check this box to enable this condition  
• number of lines greater or equal to: specify a minimum number of lines  
• and number of lines smaller or equal to: specify a maximum number of lines  
 


11.17 Trim Object 
Use this object to trim data. 
 


11.17.1 Type 


Process; Trim Object 
 


11.17.2 Properties 


• replace control characters: check this box to replace control characters with a space  
• remove control characters: check this box to remove control characters  
• remove double spaces: check this box to remove all double spaces in the data  
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• chars to replace: specify characters (without a space in between) you want to replace with a 
space  


• chars to remove: specify characters (without a space in between) to be removed  
• use trimming values: check this box to enable, parameters below can be combined:  


o chars to remove from end: specify the number of chars to remove from the end of the 
string (spaces included)  


o chars to remove from start: specify the number of chars to remove from the start of the 
string (spaces included)  


o maximum number of chars: specify the maximum number of characters in the string 
(from start, spaces included). Characters exceeding this limit are removed.  


• convert to lower case: check this box to convert a string to lower case  
• convert to uppercase: check this box to convert a string to upper case  
• capitalize: check this box to convert the first character of a string to upper case, other characters 


to lower case  
• leading string: specify the characters or text to put in front of the string  
• trailing string: specify the characters or text to add to the end of the string  
 
 


11.18 Wordwrap Object 


Use this object to wrap text. Specify the maximum number of characters per line (spaces included). 
When this limit is exceeded, the text is wrapped. 
 


11.18.1 Type 


Process; Wordwrap Object 
 


11.18.2 Properties 


• word wrap in characters: specify the maximum number of characters allowed per line. 
 


11.19 wWrap2us Object 


Use this object to wrap text. Specify a maximum number of characters per line (spaces included). 
When this limit is exceeded, the text is wrapped. The Wordwrap object must always be used in 
combination with a Record sel object. 
 


11.19.1 Type 


Process; wWrap2us Object 
 


11.19.2 Properties 


• word wrap in characters: specify the maximum number of chars allowed per line  
• split words if necessary: check this box to enable splitting of words  
• leave enters: leave [hard returns] from the source in the data  
• start grabbing at line: specify a line to start grabbing at (make sure to check the 'leave enters' 


option)  
• number of lines to grab: specify the number of lines to grab. Text lines are automatically written 


to separate scene parameters.  
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11.20 CVS Object 


Use this object to grab data from a CVS-file. In a CVS-file, values are separated by a special 
character, usually a comma. Other characters such as tabs and semicolons can be used as well. Use 
character T to specify a tab separator. Use the Test grab option in the properties window to test 
incoming data. 
 


11.20.1 Type 


Sources; CVS 
 


11.20.2 Properties 


• Separation character: specify the separation character used in the file, the default is a comma.  
• Select file to use: specify the file to grab data from  
 


11.21 Date Object 
Use this object to grab the current date (RTic workstation date). 
 


11.21.1 Type 


Sources; Date 
 


11.21.2 Properties 


• Date formats: select one of the displayed date formats  
• DAY/MONTH table: double-click 'use column' to specify a custom name for days or months  
 


& Multiple Date objects can be combined using the Add object. 


 


11.22 CSV Object 
Use this object to grab data from an CSV-file. Use the Test grab option to test incoming data. 
 
 


11.22.1 Type 


Sources; CSV 
 


11.22.2 Properties 


• Select CSV input file to use: select the CSV file  
• Sheet name: specify the name of the sheet to grab data from, case sensitive  
• Left-top cell: specify a cell range, the left-top cell (start of range, for example A1)  
• Right-bottom cell: specify a cell range, the right-bottom cell (end of range, for example G28)  
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11.23 Manual Text Object 


Use this object to create a manual text source. This source can only be updated in RTic. Most 
commonly used for static texts. 
 


11.23.1 Type 


Sources; Manual text 
 
 


11.24 Socket XML Object 
Use this object to grab XML-strings from a socket, using the RTic socket server. Use the Test grab 
option to test incoming data. 
 
 


11.24.1 Type 


Sources; Socket XML 
 


11.24.2 Properties 


• IP socket: specify the socket  
• Server status: displays the RTic socket server status  
• Connect status: displays the number of clients connected to the socket  
• Start: start RTic the socket server  
• Stop: stop RTic the socket server  
• Select (designer mode) XML file to use: select a file: for designing and test purposes only! Note: 


select a file with a XML-structure that matches the XML-data that will be grabbed from the 
socket. Select records: click this button to open a node and the record selector  


• selected node: select the node you want to grab data from (click the Select records button to 
open the selector)  


• selected record: select the record you want to grab data from (click the Select records button to 
open the selector)  


 


11.25 Text File Object 


Use this object to grab data from a text file. Use the Test grab option to test incoming data. 
 


11.25.1 Type 


Sources; Text File 
 


11.25.2 Properties 


• local textfile: check this box to select local text file  
• remote textfile from URL: check this box to select a remote file (URL)  
• Fill in URL to use: specify the URL, full address: for example http://www.example.com  
• Select local file to post as request: specify a request file, if applicable  
• Select local file send after receive: specify a confirmation file, if applicable  
• Username: specify a username, if applicable  
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• Password: specify a password, if applicable  
• Proxy server: specify the proxy server IP, if applicable  
• Proxy port: specify the proxy server port, if applicable  
 


11.26 Time Object 


Use this object to grab the current time (RTic workstation system time). 
 


11.26.1 Type 


Sources; Time 
 


11.26.2 Properties 


• Time formats: select one of the displayed time formats.  
 


& Multiple Time objects can be combined using the Add object. 


 


11.27 XML Object 


Use this object to grab data from a XML-file. Use the Test grab option to test incoming data. 
 


11.27.1 Type 


Sources; XML 
 


11.27.2 Properties 


• Local XML: select a local file (LAN)  
o selected node: use the Select records option to select a node  
o selected record: use the Select records option to select a record  


• URL XML: specify the URL, full address: for example http://www.example.com/file.xml  
o Select a local file to post as request: specify request file, if applicable  
o Select a local file to send after receive: specify confirmation file, if applicable  
o Username: specify a username, if applicable  
o Password: specify a password, if applicable  
o Proxy server: specify the proxy server IP, if applicable  
o Proxy port: specify the proxy server port, if applicable  


• selected node: use the Select records option to select a node  
• selected record: use the Select records option to select the record  
 


11.27.3 SchedIt XML: 


Source file designated by SchedIt. 
• selected node: use the Select records option to select a node 
• selected record: use the Select records option to select the record 
 


& Click Select Records to browse through the XML-structure. 
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11.28 XML Vote Object 


Use this object to grab and analyze XML voting results. Use the Test grab option to test incoming 
data. 
 


11.28.1 Type 


Sources; XML Vote Object 
 


11.28.2 Properties 


• Fill in incoming XML directory: specify the directory for incoming XML-files (LAN). Note that after 
being processed, files are removed from this directory.  


• Fill in storage XML directory: specify the directory: files that match the condition " the parameter 
grabbed is no longer than 2 chars, if the specified parameter was not found or empty" are written 
to this directory  


• 'not recognized' filename: specify the path and filename, if " the parameter grabbed is 3 or more 
chars long" the file is moved and renamed to the specified path and filename. Note that this file 
is overwritten each time results are processed.  


 
Results are presented in the following format: 
• index•0•text•A•num•1•perc•33•perc3•033•total•3•  
• index•1•text•B•num•2•perc•66•perc3•066•total•3•  


o index shows serial number  
o text shows the value grabbed (parameter field)  
o num is the times this value was found.  
o perc shows occurrence as a percentage  
o perc3 is the same value, but is always 3 digits long  
o total indicates the number of files used (i.e. files that matched the parameter name and 


where the value was less than 3 chars)  
• single processing (on/off): if checked, single file processing is enabled. Files are processed one 


by one; processing stops after one file has been processed (starting with the oldest file found).  
If not checked, all files in the XML input directory are processed in one Event.  


• Select Records: click this button to select and browse an XML-file, then select a node, record and 
parameter 


• selected node: select the node you want to grab  
• selected record: select the record you want to grab  
• parameter name: select the parameter you want to grab  
• Reset Vote: ---  
 


& To write vote results to a target, link a Record select object to the XML vote object, select a 
parameter and specify the target. 


 


11.29 ADOSQL Object 


Use this object to grab data from a database using a query. Use the Test grab option to test 
incoming data. 
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11.29.1 Type 


Process; ADOSQL Object 
 


11.29.2 Properties 


• ODBC source: select the ODBC source or database  
• user name: enter the database username  
• password: enter the database password  
• separator string: specify the separator string that is used in the database to separate records 
• odbc data query string: specify a query  
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12 Legacy Quick Reference Cards 
12.1 onTickfill Object (Legacy] 


Use this object to check the number of stories in the ticker buffer. If the number of stories in the 
buffer is less than a predefined threshold, new stories are grabbed from a source. 
This object can only be used when in the TemplatoR Ticker Initialise (Angle) Object the ticker-mode 
is specified as "story once". 
 


12.1.1 Type 


Events; onTickfill Object 
 


12.1.2 Properties 


• ticker status file: specify file in format: \\ip\delta\tickfillx.y. This status file is automatically 
generated.  


o ip: ip  
o x: layer  
o y: ticker ID  


• ticker story threshold: specify number of stories that should be available in ticker buffer  
• Toggle on/off: toggle Event on/of  
 


& This Event can be toggled  on/off via a socket. 


 


12.2 Indigo Object [Legacy] 
Properties 
• IP address: system IP address  
• IP socket: socket  for applications, set at default  
• Connect status: displays status  


o green: connected  
o red: disconnected  


• Number of layers: select the number of layers for the broadcast set  
• Board positioning table  


o layer: layer number  
o position: board position 


• Connect: connect to the system  
• Disconnect: disconnect  
 
  


12.3 SMS Gate Object [Legacy] 
12.3.1 SMS_Gate target 


This target can send (simulate sending) sms-messages to the sms_gate (1.2.0.3) application. 
This way there is no need to have an actual sms modem installed when demonstrating the sms_gate 
application. 
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12.3.2 XML source 


This source reads the XML output (outbox messages) created by the sms_gate application by 
sending an http request (http://127.0.0.1 ) and reading the returned XML data. 
Settings:  use the URL XML option and Fill in the URL to use: http://127.0.0.1  (any text behind the IP-
address is ignored) for sending requests and retrieving the outbox messages. 
Or use local XML and then c:\smsgate_folder\XMLoutput.xml to read a previous xml output (This is a 
local file created by the sms_gate application when an http-request is done. So this can be the 
output from previous request). 
  


12.3.3 SMS_gate 1.2.0.3 Application 


When using RTic as an input for messages select the Moderator input enabled from and fill in the 
http address and the name of the input target (i.e. the RTic sms_gate target name. This should be 
the exact same name that is used in RTic, e.g.: http://127.0.0.1/my_RTic_sms_gate_target_name) 
Otherwise, when using al modem as input, select SMS serial modem connected to. 
 
 


12.4 Template Object [Legacy] 
Use this object to start a template script based on incoming data, and, if applicable, update the 
template's user strings. Use the Grab sources option to test incoming data. 
 
 


12.4.1 Type 


Targets; Template Object 
 


12.4.2 Properties 


• Template file: select the template (BTS script)  
• Queue: select a queue number  
• Trigger template options:  


o do not start template automatically  
o start template on every grab  
o start template when grab results in changed data 
o remote controlled 


• Template dynamic: this field is automatically filled, using the Grab source option, if  the ‘template 
dynamic’ option is enabled.  


• Use dynamic template name: check this box to enable dynamic template selection  
 


12.4.3 Template overview 


Columns: 


• layer: layer number  
• num: userstring number  
• type: media type  
• id: object ID  
• source: name of data source  
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• value: data grabbed from source  
• updated: date and time last update  
 


Input properties 


The Input properties window automatically opens when linking an object (input) to the Template 
object. 
• Available in this template: select a userstring number (lists userstrings available in template) / 


dynamic template option  
 


Connect 


To be able to edit the Template object, connect to the System object. 
 
 


12.5 Nexus Template Object [Legacy] 


Each userstring 0 to 511 can contain up to 2084 characters. Use this object to start a template script 
based on incoming data, and, if applicable, update the template's userstrings. Use the Grab sources 
option to test incoming data. 
 
 


12.5.1 Type 


Targets; Template Object 
 


12.5.2 Properties 


• Template file: select the template (BTS script)  
• Queue: select a queue number  
• Trigger template options:  


o do not start template automatically  
o start template on every grab  
o start template when grab results in changed data 
o remote controlled 


• Template dynamic: this field is automatically filled, using the Grab source option, if  the ‘template 
dynamic’ option is enabled.  


• Use dynamic template name: check box to enable dynamic template selection  
 


12.5.3 Template overview 


Columns: 


• layer: layer number  
• num: userstring number  
• type: media type  
• id: object ID  
• source: name of data source  
• value: data grabbed from source  
• updated: date and time last update  







 


RTic 2.47 for GV Edge: User Guide 071886002- 47 


 


Input properties 


The Input properties window automatically opens when linking an object (input) to the Template 
object. 
 
• Available in this template: select a userstring number (lists userstrings available in template) / 


dynamic template option  
 


Connect 


To be able to edit the Template object, connect to the Nexus system object. 
 
 


12.6 Ticker Object [Legacy] 


Use this object to update tickers. Use the Grab sources option to test incoming data. 
 


12.6.1 Type 


Targets; Ticker Object 
 


12.6.2 Properties 


• Ticker on Layer: select a layer and ticker ID  
• cache stories (don't update when identical): check this box to cache stories  
• Ticker story mode: check this box to select a story mode  
 


12.6.3 Story overview 


Columns: 


• num: -  
• story: story number (0-98)  
• type: story part 1/2/3/TGA (depending on ticker mode)  
• id: object ID  
• source: name of the data source  
• value: data grabbed from the  source  
• updated: date and time the last update  
 


12.6.4 Edit userstring properties 


Double-click number to edit properties. 
• Story part: story part 1/2/3/TGA (depending on ticker mode)  
• start number: story number  
• pitch: when grabbing data from a multi record source, the step value between consecutive 


stories  
 


& Double-click the value to view grabbed data. 
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Input properties 


The Input properties window automatically opens when linking an object to the Ticker object. 
• Story part: select the part of the story that you want to update: part-1/part-2/part-3/TGA  
• start number: select the (first) story number  
• pitch: the step value between consecutive stories, only applies when grabbing stories from a 


multi record source  
 


12.7 Userstring Object [Legacy] 


Use this object to update userstrings. The Userstring object contains all available userstring 
numbers on a system. Multiple sources can be related to a single Userstring object. Use the Grab 
sources option to test incoming data. 
 


12.7.1 Type 


Targets; Userstrings Object 
 


12.7.2 Properties 


• Layer tabs: layer tabs represent layers  
 


Columns: 


• num: userstring number 
• type: -  
• id: object ID  
• source: name of the data source  
• value: data grabbed from the source  
• updated: date and time the last update  
 


Edit userstring properties 


Double-click the userstring number to edit userstring properties (only for filled userstrings). 
• layer/board: layer  
• start number: the userstring number  
• pitch: when grabbing data from a multi record source, the step value between consecutive 


userstring numbers  
 


& Double-click the 'value field' to view grabbed data. 


 


12.7.3 Input properties 


The Input properties window automatically opens when linking an object (input) to the Userstrings 
object. 
• layer/board: select a layer  
• start number: select the userstring number you want to update  
• pitch: when grabbing data from a multi record source, the step value between consecutive 


userstring numbers  
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& To update a template's userstrings, use a Template target object and trigger the template script.  


 
& Use the clear strings option to clear strings when testing. 


 
 


12.8 Nexus Userstr object [Legacy] 
Each userstring 0 to 511 can contain up to 2084 characters. Use this object to update userstrings. 
Double-click the value field to view grabbed data. 


12.8.1 Type 


Targets; Userstrings Object 
 


12.8.2 Properties 


• Layer tabs: layer tabs represent layers  
 


Columns: 


• num: userstring number 
• type: -  
• id: object id  
• source: name of the data source  
• value: data grabbed from the source  
• updated: date and time of the last update 
 


Input properties 


The Input properties window automatically opens when linking an object (input) to the Userstrings 
object. 
• layer/board: select a layer  
• start number: select the userstring number you want to update  
• pitch: when grabbing data from a multi record source, the step value between consecutive 


userstring numbers  
 


Edit userstring properties 


Double-click userstring number to edit userstring properties (only for filled userstrings). 
• layer/board: the layer  
• start number: the userstring number  
• pitch: when grabbing data from a multi record source, the step value between consecutive 


userstring numbers  
 
 


12.9 Nexus System Object [Legacy] 
To define the playout system and connect: 
1. Insert a System > Nexus object.  
2. Double-click the object to edit.  
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3. Enter the system’s IP-address.  
4. Enter the IP-socket. Default port: 5000.  
5. Specify the number of layers (boards) for the broadcast set.  
6. Fill in the board positioning table for the broadcast set.   
7. Click Connect to connect. The status bar turns green when connected.  
8. Click Save to save the connection, Cancel to discard.  
 


& To link a System object, drag the System object on top of the other object (not vice versa). 


 


12.10 Tickers [Legacy] 


Before ticker stories can be viewed on-screen, initialize and start the ticker. Initializing clears the 
ticker buffer. 
 


12.10.1 Insert, link and edit a ticker 


1. Insert a Targets > Ticker Object.  
2. Link the appropriate System > System object to the Ticker target: as a result the layer table lists 


available layers.  
3. Double-click the Ticker object to edit.  
4. In the Ticker on layer box, select a layer and ticker ID.  
5. Select a Ticker story mode.  
6. If appropriate, check the Cache stories option.  
7. Click Save to save the Ticker, click Cancel to discard.  
 


12.10.2 Link a source to a Ticker 


1. Insert the appropriate Source/Process object(s) to grab stories from.  
2. Link objects to Ticker. 
3. The Input properties window opens.  


a. Select a story part: part-1/part-2/part-3/TGA.  
b. Select a TGA if applicable to specify a TGA-file (include file extension). 
Note that the Ticker object defines the Ticker story mode (single story mode, triple story with 
TGA, etcetera).  


4. Select the (first) story number.  
5. Select a step value between consecutive stories; only applies when grabbing stories from a 


multirecord source.  
6. Click Save to save properties, click Cancel to discard.  
 
To execute a script after last story, use $L. The script can for instance trigger an Event in RTic. Note 
that it is advised not to use special strings in XML-sources, to avoid translation to a special character 
sequence.  
 


12.11 Userstrings [Legacy] 


12.11.1 Output to Userstring(s) 


1. Insert a Target > Nexus Userstr object.  
2. Drag the object (source or process) that outputs userstring(s) on top of the Userstring object. 


The userstring properties window opens.  
3. Specify a layer number.  
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4. Specify a start number: the number of the userstring you want to update, or first userstring 
number in case of a multirecord source.  


5. Specify a pitch: only applicable if more than one userstring is updated (multirecord source).  
 


12.12 Template Target [Legacy] 
First define a System object for the system that templates (scripts) are located on and connect. Use 
the Grab sources button to test incoming data. Use the Read template button to view template info. 
 


12.12.1 Insert and link System and Template objects 


1. Insert a Target > Nexus Template object.  
2. If not already inserted, insert a System > Nexus System object.  
3. Specify and connect to the system on which templates are stored.  
4. Link the System and Template objects.  
 


12.12.2 Edit Template objects 


Fixed template 
1. Double-click the Template object to edit.  
2. In the Template file box, select the template (BTS).  
3. Make sure the Use dynamic template box is not checked.  
4. Leave the Template dynamic field empty.  
5. Select a queue.  
6. Select a start mode for the template.  
7. If applicable, (un)check the Cache option.  
8. Click Save to save changes, Cancel to discard.  
 


Dynamic templates 
1. Double-click the Template object to edit.  
2. To work with dynamic templates, check the Use dynamic template box.  
3. Leave the Template dynamic field empty. This field is automatically updated when working with 


dynamic templates.  
4. In the Template file box, select any one of the dynamic templates to fill the userstring table. Note 


that the dynamic templates must address the same userstrings (numbers and layers).  
5. To update the dynamic template (grab file name), link the appropriate object to the Template 


object.  
Note that the filename must include the file extension (.bts).  


6. Click Save to save changes, Cancel to discard.  
7. When linking objects to the Template object (inputs), a dropdown menu that lists available 


userstrings opens. Select the Dynamic template option.  
 


Specify inputs 


To link sources and userstrings: 
1. Link  the  a ppropria te  obje c t(s ) to  the  Tem pla te  objec t .  
2. When linking, a dropdown menu that lists available userstrings for the linked template opens:  


a. select the userstring you want to update, or  
b. select the dynamic template option  
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& The userstring table automatically lists the userstrings defined in the selected template. 


 


12.13 Toggle onTickfill Event via socket [Legacy] 
■ In RTic , re na m e the  onTickfill objec t: right-click object > rename to <Ticker_name>.  
■ To trigge r the  Event, s end a  trigge r via  a  connec ted s ocke t on port  5005: TICKFILL 


<Ticker_name> [on/off/toggle]  
 
Example command to start event "Ticker_name": 
./ptsockcl 192.168.7.9 5005 "TICKFILL Ticker_name on" 
 
• IP: the RTic workstation’s  IP-address 
• port 5005: the default RTic listen port  
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1 Screen resolutions and frame rates 
The GV Edge platform supports the following screen resolutions and frame rates: 
 
Format Screen resolution Frame rate (fps) 


PAL 720x576  25  


NTSC 720x486 29.97 


720@50p 1280x720  50 


720@5994p 1280x720 59.94 


1080@50i 1920x1080  25 


1080@5994i 1920x1080 29.97 


 
& When formats have different but related frame rates, some of the formats above can be 


automatically converted for playout. The next table shows the supported combinations: 


 
Output format Input format combinations 


PAL PAL, 720@50p, 1080@50i 


NTSC NTSC, 720@5994p, 1080@5994i 


720@50p PAL , 720@50p, 1080@50i 


720@5994p NTSC, 720@5994p, 1080@5994i 


1080@50i PAL , 720@50p, 1080@50i 


1080@5994i NTSC, 720@5994p, 1080@5994i 


 
& GV Edge does not automatically convert input combinations with different and unrelated frame 


rates, such as 25 fps and 29.97 fps, 50 and 29.95 fps, and so on. 


 
 


2 Video formats 
The GV Edge platform supports the following video formats: 
 
Format Codec Bit rate (Mb/s) Supported wrappers 


SMPTE D10 30 / IMX 30 SMPTE D10 
(MPEG-2 4:2:2P@ML) 


30 MOV 7, MXF 6 


SMPTE D10 40 / IMX 40 SMPTE D10 
(MPEG-2 4:2:2P@ML) 


40 MOV 7, MXF 6 


SMPTE D10 50 / IMX 50 SMPTE D10 
(MPEG-2 4:2:2P@ML) 


50 MOV 7, MXF 6 


DV25 DV25 25 MOV 7, MXF 6, GXF, LXF 


DVCAM DV25 25 MOV 7, MXF 6, GXF, LXF 


DVCPRO25 DVCPRO25 25 MOV 7, MXF 6, GXF, LXF 


DVCPRO50 DVCPRO50 50 MOV 7, MXF 6, GXF, LXF 


DVCPROHD1 DVCPROHD 115 MOV 7, MXF 6, GXF, LXF 


XDCAM HD (LP, SP, HQ) MPEG HD 18, 25, 35 MOV 7, MXF 6 
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(MPEG-2 MP@HL) 


XDCAM HD422 MPEG HD422 
(MPEG-2 4:2:2P@HL) 


50 MOV 7, MXF 6 


XDCAM EX SP MPEG HD 
(MPEG-2 MP@HL-1440) 


25 MOV 7, MXF 6 


XDCAM EX HQ MPEG HD 
(MPEG-2 MP@HL) 


35 MOV 7, MXF 6 


MPEG-2 4:2:0 SD 3 MPEG-2 MP@ML Max 15 MOV 7, MPG 5, MXF 6, GXF, 
LXF 


MPEG-2 4:2:2 SD 3 MPEG-2 4:2:2P@ML Max 50 MOV 7, MPG 5, MXF 6, GXF, 
LXF 


MPEG-2 4:2:0 HD 2 3 MPEG-2 MP@HL Max 100 MOV 7, MPG 5, MXF 6, GXF, 
LXF 


MPEG-2 4:2:2 HD 2 3 MPEG-2 4:2:2P@HL Max 100 MOV 7, MPG 5, MXF 6, GXF, 
LXF 


AVC Intra 50 1 H.264  
(MPEG-4 AVC Hi10-Intra-
P@L4) 


50 MXF 6, GXF 


AVC Intra 100 1 H.264 
(MPEG-4 AVC Hi4:2:2-
Intra-P@L4.1) 


100 MXF 6, GXF 


H.264/AVC 1 4 H.264 (MPEG-4 AVC  
HiP@L4.1) 


Max 50 MOV 7, MXF 6 


Apple ProRes 4:2:2 LT 1 Apple ProRes 4:2:2 LT Max 100 MOV 7 


 


1 This video content requires a 24 GB GV Edge server, with 6 hard disk drives. 
2 Formats with bit rates lower than 50 Mb/s can be played out on a 12 GB GV Edge Server. Formats   
with higher bit rates need a 24 GB server with 6 hard disk drives. 
3 Both I-frame only and long-GOP formats are supported. 
4 H.264/AVC format: 4:0:0 (monochrome) is not supported. 
5 Supported are MPEG-2 Transport Stream and MPEG-2 Program Stream. 
6 Only Operational Pattern (OP)1a is supported. A maximum number of 36 embedded streams are   
supported. Frame accurate seeking requires availability of a Random Access Pack (RIP) for MXF files 
encoded with variable frame size (VBE). 
7 Both self-contained MOV files (internal essences) and MOV files with external essences are   
supported.MOV files containing external essences are only supported on GV Edge servers. It is not 
possible to ingest MOV files in this format into TX/MAM. 
 


& For supported embedded audio formats, see section 3, Audio formats. 
& The maximum GOP size for all video formats is 15 frames. 
& Progressive output and progressive formats are not supported on Nexus-AVS 1.5. 
& Grass Valley works hard to ensure compatibility with all leading industry formats. However, to 


uphold reliable playout, we strongly recommend the validation of content files for new projects. 
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3 Audio formats 
The GV Edge platform supports the following audio formats: 
Format Bit depth Sample rate (kHz) 


BWF or WAV 16 or 24 bit LPCM 48 


MPEG 1 Layer 2 / MP2 16 bit 48 


Dolby E decoding 16, 20 or 24 bit 48 


 
& GV Edge supports the BBC Audio Description format (voice overs for the visually impaired) in 


separate WAV files and video files with embedded LPCM audio. 
& TX/MAM browse copies only use the first stereo audio pair of ingested material. Other audio 


tracks in the original material are not available in the TX/MAM video player. 
& For Dolby E, only decoding is supported. 
& For Dolby E decoding, all channel configuration options (e.g. 5.1, 5.1+2, 7.1, etc) are supported. 
& Watermarking insertion is supported, based on the Civolution SNAMP Embedder SDK. Enabling 


audio watermarking requires a license provided by Civolution. 
 
 


4 Still image formats 
The GV Edge platform supports the following still image formats: 
Format Pixel format (bpp) Compression Alpha channel 


BMP 24 No No 


TGA 32 No Yes 


 
 


5 Recording formats 
GV Edge provides support for the following recording formats: 
Format Codec Bit rate (Mb/s) Supported wrappers 


SMPTE D10 30 / IMX 30 
SMPTE D10 
(MPEG-2 4:2:2P@ML) 


30 MXF 


SMPTE D10 40 / IMX 40 
SMPTE D10 
(MPEG-2 4:2:2P@ML) 


40 MXF 


SMPTE D10 50 / IMX 50 
SMPTE D10 
(MPEG-2 4:2:2P@ML) 


50 MXF 


XDCAM HD422 30 
MPEG HD422 
(MPEG-2 4:2:2P@HL) 


30 MXF 


XDCAM HD422 40 
MPEG HD422 
(MPEG-2 4:2:2P@HL) 


40 MXF 


XDCAM HD422 50 
MPEG HD422 
(MPEG-2 4:2:2P@HL) 


50 MXF 


 


& For embedded audio, all default recording settings listed above record audio in 16 bit LPCM 
format, sampled at 48 kHz and up to 8 stereo pairs. 


& In case of XDCAM HD422, content a GOP size of 12 frames is used (IBBPBBPBBPBP) for PAL 
based content. For NTSC based content a GOP size of 15 frames is used (IBBPBBPBBPBBPBP). 


& Record to file is not supported on Nexus-AVS 1.5 
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6 Animation formats 
The GV Edge platform supports the following animation formats: 
Format Codec Bit rate (Mb/s) Supported wrappers 


GVEdge Animation MPEG-2 4:2:0P@HL, MPEG-2 
4:2:2P@HL 


Max 100 ANI 


Apple Quicktime RLE Apple Quicktime RLE Max 100 MOV 


 
& GV Edge animation files are compressed video files and can be generated from TGA sequences. 


The TGA files must be in the following format: 32 bit, uncompressed and with alpha channel. 
 
 


7 3D object formats 
The GV Edge server accepts the platform’s native mesh clip 3D file format. This format offers a 
simple but effective mesh animation system in which a 3D object defines each frame. The import 
feature in Channel Composer converts the following industry standard 3D object files into mesh 
clips: 
Format Details 


3DS The Autodesk 3ds Max format. 


 
& Channel Composer imports: mesh data (vertices, faces, uv coordinates, smoothing groups), 


materials (Channel Composer automatically creates a material for each 3DS material) and the first 
key frame of the animation track. 


& Channel Composer does not import any non-mesh objects (such as lights and cameras) and 
additional key frames. 


& For more information about the mesh clip format, see the Channel Composer User Guide on the 
GV support site. 


 
 


8 Subtitle formats 
The GV Edge platform supports the following subtitle formats: 
Format In-vision / closed Script 


EBU STL In-Vision / closed Latin, Cyrillic 


SRT In-Vision UTF-8, with bold and italics markup 


 
& GV Edge 4.2 does not support DVB subtitles. In addition, up to this moment GV Edge provides 


support for subtitle formats with left-to-right text direction.  
 


8.1 In-Vision captions 
With Channel Composer you can design the look of In-Vision captions. A subtitle grid is used to 
position the subtitles in the active area of the picture and you can edit the style of the text. 
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8.2 Closed captions 


The following closed caption subtitles are supported: 


PAL 


Format SD / HD 


WST / OP42 SD 


OP47 HD 


 
& In case of level 1 and level 1.5 formats, GV Edge supports packet 26, packet 28 and the National 


Option Subset. Up to 10 WST scripts are supported, which can be played out on VBI lines. 


 


N
TSC 


Format SD / HD Standard 


CEA-608 SD  


CEA-708 HD SMPTE 436m-2006, 6.1 


 
& In case of CEA-608/708, GV Edge supports them when these formats are wrapped in a caption 


distribution packet (CDP). In addition, only Latin script is supported (played out on line 21). 
 
 


9 Ancillary data formats 
9.1 Aspect ratio 


The following ancillary data formats for aspect ratio signalling are supported: 


PAL 


Format SD / HD Standard 


AFD SD / HD SMPTE 2016 


Video Index SD RP186 


Wide Screen Signaling SD WSS 


 


N
TSC 


Format SD / HD Standard 


AFD SD / HD SMPTE 2016 


Video Index SD RP186 


 
& AFD, Video Index and WSS can be played out on schedule with the use of specific Channel 


Composer templates that include the designated command objects for each format. For more 
information about this subject, see the Channel Composer User Guide on the GV support site. 


& AFD can be extracted from external live sources or from MXF files conforming to the SMPTE 
436M standard. The extracted AFD data read becomes part of the SDI output during playout. 
 


9.2 Time code 


Format SD / HD Source Standard 


ATC HD External live source SMPTE 12M-2 


VITC SD Internal video decoder SMPTE 266M 


 
& GV Edge does not support time code tracks embedded in video files. 
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9.3 Miscellaneous 


Format Standard 


CNI ETSI EN 300 321 


V-Chip CEA-608-E 


XDS CEA-608-E 


Audio Watermarking (Civolution) NATM (48Khz) 


 
& XDS can be extracted from external live sources or from MXF files. The extracted XDS data from 


these sources becomes part of the SDI output during playout. XDS can also be played out on 
schedule with the use of Channel Composer templates including a Rating command object. For 
more information about how to do this, see the Channel Composer User Guide on the GV support 
site. 


& Watermarking insertion is supported, based on the Civolution SNAMP Embedder SDK. Enabling 
audio watermarking requires a license provided by Civolution.  


 
 


10 TS-over-IP 
The GV Edge platform supports the Transport Stream over IP allowing the following formats: 
 


10.1 Video 


Type Option 


Codec MPEG-2 


Chroma format YUV 4:2:0 / 4:2:2 


GOP Structure Long GOP / Iframe only 


Aspect ratio 4:3 / 16:9 


Bitrate HD: 25000 <> 50000 
SD: 8000 <> 25000 


PID Custom 


TS packet group size Custom 


 


10.2 Audio 


Type Standard 


Codec MPEG1- Layer 2/MP2 


Language Custom 


Bitrate 64,80,96,112,128,160,192 Kbit/s 


PID Custom 


 


10.3 Teletext 


Type Standard 


Language Custom 


Page number 1 <> 999 







 


07188460301   GV Edge 4.2.1 Datasheet v1.0 User Guide - 10 


VBI Lines Custom 


PID Custom 


 
 


10.4 Data 


Type Standard 


Bitrate Custom 


PID Custom 


PMT Optional 
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